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Support

If you experience any problems with your software, please get in touch with
our support team. It is compulsory that you register Samplitude before using
one of the offered support options. Help is also available at the official
Samplitude website:

www.samplitude.com

This website will lead you to the Samplitude user service page containing,

among other things, the following free offers:

— FAQs (frequently asked questions) and general tricks and tips. In most cases
you’ll find the solution to your problem here. If not, use the support contact.

— Support forum: You are not alone. Perhaps other users had a similar problem
and can help you solve yours. Our support staff is also a regular contributor.

— Download section: Updates, improvements and patches are likewise offered
via download. Many problems you may experience are well-known to us,
and can be solved by downloading the latest patch. Besides patches, there
are also wizards for checking and optimizing your system.

— Newsgroup: here you can find a direct line to all other Samplitude users.

All Countries incl. USA:
You can also reach our support team either by email, telephone or fax.

Email: proservice@magix.net
Phone: +49 (0)351 4174616 (weekdays from 10 a.m. — 3 p.m. CET)

Fax:  +49 (0)3514 796 2410

Please have the following information at hand:

— Program version

— Configuration details (operating system, processor, memory, hard drive,
etc.)

— Sound card configuration (type, driver)

— Information regarding other software installed

For current price information regarding upgrades, etc. please contact your
local dealer or distributor, or contact MAGIX AG directly on

Tel:  +49 (0) 5741 345 525
Email: samplitude @magix.net”
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New Virtual Project (VIP)

A new Virtual Project is created, which is immediately presented in a new
window in the Samplitude workspace.

Setup for new Project (VIP) il

File Path: IC:'\,MAGIX\SeqUDiaB\AudiDRNEW v| [:||
¥ Create Mew Project Subdirectany
—Fresets
Froject Template: I — LI
Mixer Setup: I LI
Surround Setup: I LI
Project Options ... |
— Track Mumber——— —Sample Rate
1 Track 44100 | e
2 Tracks
@ 4Tracks — Default Project Length:
" B Tracks
1 min B0 min
‘s .
Custam: |1E € 10 min ~ IM— min

[ Multi Source Session, Source Mumber: |1

[0]:4 Cancel | Help |

ProjecT TEMPLATE: You can choose between previously selected project
templates in this list field. It includes all project settings such as track number,
device assignment, etc. Use “Save Project as Template” to save project templates.

MixeR SETUP: Lets you choose a predefined mixer setup. Mixer setups consist
of number and type of the tracks or busses, and all input/output and effect
routings. Read more in “Mixer Setup”. If you want to create a surround project
you should set the format here. Read more in “Mixer Setup” and “Surround”.

Project OptIONS: Opens the Project Options Dialog. All settings (e.g. Grid,
BPM, CD arrange mode, autosave, etc.) made here apply to every newly created
VIP. For this purpose they are saved in a special VIP (templates/template.VIP).

15
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The “template.VIP” file can also be edited directly. You can then also make
additional settings as default settings for your project:

— Record arming setting of the first track

— Some mixer setup settings

Playback mode

Track and master effects settings (e.g. compressor mode, effects folder)

— Grid offsets: Sets the Grid Start time in respect to the VIP start time.

Track NumBer: The track number of the Virtual Project is determined here.
You can add tracks later using the “Track -> Add new tracks... ” command.

SaMPLE RaTE: Defines the sample rate of the Virtual Project.

Note: Objects with nearly any sample rate, audio format or coding can be loaded
irrespective of the VIP sample rate.

NaMmEe: The name of the new VIP should be included here.

CREATE NEw PROJECT SUBDIRECTORY: A subdirectory bearing the name of the
project is automatically created in the Virtual Projects folder (refer to Settings/
Paths). This is the easiest method of keeping all files which belong to a project
consistent.

DeraurT Project LENGTH: The VIP is created with this length (1, 10, 60 min
or a predefined value).

Shortcuts: e

Open Project = Virtual Project

A multi-track project in Samplitude. The dialog looks for files with the .VIP
extension.

When loading a Virtual Project, all associated Wave Projects are opened, if
they were not opened prior to loading the VIP. The windows of the individual
Wave Projects remain minimized to prevent screen clutter. They are initially
only visible as icons, and will be covered if the VIP is maximized.

When loading or recording .WAV files into the VIP window, each resulting
Object has a time stamp, reflecting its original time position. Any VIP opens
in a dedicated window in the Samplitude workspace.

Shortcuts: 0

Open Project > MIDI (*.mid)
Allows you to import single or multiple MIDI files into a VIP.

Refer to the MIDI chapter for more details.

Shortcuts: Shift + m
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Open Project > RAM Wave (RAP)

RAM Wave Project. RAM Wave Projects contain audio data in Samplitude’s
proprietary format. These files are loaded into the RAM of your computer,
including their associated graphic files, marker position information, etc.

Shortcuts: I

Open Project > HD Wave (HDP)

HD Wave Project. HD Wave Projects contain audio data which is directly loaded
from the hard disk, plus graphical information, marker position information,
etc. These files are stored in WAV format.

Note: If a VIP is the active window, all loaded WAV Projects are immediately
turned into objects in the VIP. Any selected Range’s beginning determines the position
and track where the Object is created.

An exception is, when the CD Arrange Mode from the Menu CD is set. The Objects
are placed completely independent from any selected range. Instead, the Objects are
placed in sequence (one after the other) with a pre-determined gap between them.
The gap can be set with CD->Set Pause Time. The gap represents the space between
individual tracks on a CD.

Shortcuts: Ctrl+1

Open Project - Object (*.0bj)

An Object which has been saved in this format contains playback instructions
(link to a Wave Project, track, time position, parameters, etc.) for audio data.
Objects are used in Virtual Projects.

Note: You can also use Windows Explorer to drag & drop saved Objects directly into
VIP Projects.

Open Project > Edit List (*.EDL)

This function allows you to open an Edit Decision List in D-Vision Video
Systems format. A Virtual Project that resembles the EDL is created. The list
is a text file that contains information about the WAV files used, the Object
borders, Volume, Panorama Automation, Mute, Lock and Fade information.
This effectively makes Samplitude VIPs compatible with any application that
supports this format, including EDL Convert Pro by CuiBono Soft. EDL
conversion applications support the conversion to any other exchange- or project
formats, including ProTools sessions, Sadie projects, AES31, OpenTL, OMF
and many more.

Open Project - Table Of Contents (*.TOC)

Table of Content (TOC): Table of Content of a CD mastered in Samplitude.
You can create .TOC files by using the command “Export TOC” from the “Make
CD” dialog. When loading a TOC, the associated Wave Project, which contains

17
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the raw audio data for the CD, is opened in a new VIP. In this VIP all CD track
markers are set properly according to the CD.

Load audio file

Opens a file for loading audio files. The following formats are supported:
Wave files ((WAV), MPEG files (.mp2, mp3, mpg), Apple files (.aif;.aiff), Sound
Designer 2, Windows Media (.asf,.wma), Ogg Vorbis (.ogg), and Video for
Windows soundtrack (.avi) and other video files (for MIDI files refer to
Importing MIDI files).

You can open a AVI file to edit the audio track of the video directly (without
importing the audio data from the video file). After finishing an edit, replace
the audio in the Video with the “Export Video Sound” command from this
menu.

The file formats .WAV, MPEG, OGG, AIFF and AVI are read directly by
Samplitude; all other formats are imported when opened, i.e. saved on the
hard drive as a new Wave Project.

You can also load several files simultaneously. To do this, expand your selection
via Ctrl+Click or expand to a range of files via Shift+Click.

Note: Due to a peculiarity of Windows Explorer, the line in the file selection
menu is laid out from back to front. Therefore, if you, for example, click on
Trackt, Tracka Tracks (using “Ctrl”), you will see “Tracks”, “Track2”, “Track1”
in the input field. (They are also loaded in this order.) So, if you want to load
several individual titles, select them in the reverse order to which you would
like them to be arranged in the project. However, if you select a range in Explorer
(via Shift+Click), for example an entire folder, you should proceed as follows:
First select the last title in the list. Then click on “Shift” and mark the first title
of the list. If you now click on “Open”, all tracks are in the VIP in the proper
order.

If a VIP is opened, new Objects are created simultaneously in the VIP which
refer to loaded audio files. If no area has been selected in the VIP, the files are
positioned after the last Object.

More positioning options for several files should be adjusted in the “Options
for loading audio files” menu.

Each audio file can be previewed before loading.

Note: The preview function uses the standard output device of the Windows
Multimedia system (as do the system sounds). Many audio cards deactivate the
normal Window MME Sound System when using the ASIO driver. This results in
error messages in the preview function. A preview function when using the ASIO
driver is first deactivated by default. However, you can activate it again (“Options
for loading an audio file”) if you select a different audio device for the multimedia
functionality of your PC, for example, the onboard sound available on most modern
PCs. Alternatively you may use the new File Browser function among the new
Manager dialogues.

Key w
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Load Audio CD Trackls)
See “CD Menu”

Save Project

The current project is saved with the name displayed in the project window. If
you have not yet specified a name for your project, Samplitude will ask you to
do so.

Shortcuts: s, Ctrl + s

Save Project as

You can redefine the path and name of a new project with this function. RAM
Projects and Virtual Projects are saved with the new names. (The source file
remains as it was.) HD Wave Projects are renamed on the hard disk. Samplitude
does not generate a copy of these, thereby saving space on your hard drive for
Wave Projects.

Shortcuts: Shift + s

Save complete VIP in

This function in the “Project” menu allows you to save a VIP, along with all
required Wave Projects (*.RAP. *.HDP), into a specified directory. This makes
it easy to copy all files used in a VIP to, for instance, a backup disk.

Cory ONLY sAMPLES USED IN VIP: Only the portions of Wave Projects that are
actually used by Objects in the VIP are copied. This is the equivalent of using
the “Remove unused samples” command (Tools menu) on the saved VIP after
copying.

Use of this function can conserve (a lot of) storage space, but there’s a catch.
The downside is that after performing this function, Objects can only be made
shorter, as all audio data outside the Object borders was removed. To circumvent
this side effect, you can define a "security range” in samples. This number of
samples will be left in the Wave Project - before and after the Object border —
leaving a few samples in reserve, should you wish to change a fade in/out, for
example. The default value is 22050 samples (= 5ooms, at a 44.1 kHz sample
rate).

Save Project as EDL

The active Virtual Project is saved as an Edit List in the EDL text format. The
Edit List is a text file that contains information about the WAV files used, the
Object borders, and volume and panorama automation information.

This effectively makes Samplitude VIPs compatible with any application that
supports this format, including EDL Convert Pro by CuiBono Soft. EDL
conversion applications support the conversion to any other exchange- or project
formats, including ProTools sessions, Sadie projects, AES31, OpenTL, OMF
and many more.
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Save Project as Template

You can use this option to create project templates, which save all project
related settings (grid type, track number etc.), without saving the Objects and
HDP’s used in the project. You can load templates when you create a new
Multi-track project. This is a very convenient and useful feature which will
speed up your work considerably and make it easier to maintain consistency
across multiple projects. You should use this function and not derive new,
empty VIPs from existing projects with the “Save as” command as different
rules apply for the handling of projects paths for these two functions.

Burn Project Backup on CD

This option allows you to easily create data CD or DVD backups of whole
projects. For this purpose, the external MAGIX CDR CD/DVD-burning
application is launched. Please refer to the mxcdr online help for more
information.

Save Object

This function allows you to save a single Object. This is especially useful where
you wish to transfer material between VIP Projects, or would like to preserve
certain parts of a VIP (by saving them to single Objects). Another use is the
creation of a proprietary sound effects library.

Note: You can use Windows Explorer to drag & drop multiple Object files into a VIP
for easy access.

The default file extension for Object files is *.o0bj.

Note: It is important to ensure that only one Object is selected for saving. If more
than one Object is selected, the first selected Object in the lowest numbered track (i.e.
track 1) will be saved.

Save Format

Sessions in Samplitude are a quick way to restore the screen layout to the way
the windows and toolbars were situated when the session was saved. Let’s
assume that you have a VIP open, the Mixer window, and several HDP windows.
When you save a session and reopen it, Samplitude will reposition all open
windows at the exact place where they were positioned at the time the session
was saved.

In addition, if you save a session with the name “startup.sam” and place it into
the folder with the Samplitude program file (default installation would be
c\MAGIX\Samplitude ...), Samplitude will load that session the next time you
start the program.

Rename Project

This function allows you to rename a project file, rather than save it to a different
file. For RAM Wave Projects, only the internal names are changed (without
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being saved). In the case of HD Wave Projects, all corresponding files are
immediately renamed. RAM Wave Projects need to be saved after renaming
the project.

Delete Wave Project(s)

Wave Projects are deleted from the hard disk.
Use this command with caution, as all corresponding files are lost!!!
There is no undo for this function, and no recycle bin.

Note: If you want to delete a Wave Project from a file manager such as Windows
Explorer, you should also delete the related Samplitude files (i.e. *.hdp, *.ho, etc.)

Delete Virtual Project

This command deletes a VIP, and all Wave Projects used in it.
Fire seLEcTION: You can select the project file (.VIP) to delete.
ProjEcT LI1sT: You can choose from a list of the eight most recent projects.

FitE 1151: The file list shows the Wave Projects used in the selected .VIP. You
can specify - on an audio file by audio file basis — whether or not you wish to
keep the file (if used in other projects), or to delete it.

Convert Audio

This submenu contains various options for converting mono/stereo Wave
Project formats.

These conversions can be performed in Wave Editing mode, or by selecting a
VIP Object prior to performing the command. In both cases, the original file
is not changed — new files are created, and named, automatically by Samplitude.
Performing the command from within the VIP results in changes to the Object
which reflect the conversion. In other words, the Object will now refer to the
converted file(s).

Performing the command via Wave Editing (Destructive Editing) does not alter
the existing VIP — if the resulting file/s are needed in the VIP, this must be
done manually by opening the object editor (position/fades window) and
exchanging the underlying Wave Project.

Convert Audio = Import Audio

This provides the possibility to import all supported file formats explicitly as
Wave Projects. This is only necessary for file formats that cannot be opened
directly by Samplitude (Windows Media Files and certain MPEG files).
However, you can increase the performance of your computer if you import
compressed formats such as mp3 or Ogg instead of loading them in order to
avoid real-time decoding.

Unlike “Load Audio File” the audio file is converted to Wave when importing
and copied to the hard drive. You can also use the command if you have good

reasons to work in a copy of the file within the project. 21
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Key:  Ctrl+1

Convert Audio = Save In Format

This function only operates when working directly on a Wave Project, and
allows you to convert projects between the various Samplitude Wave Project
formats. Another option is the conversion to/from stereo/mono Wave Projects
and changing sample rate and bit resolution. Conversions into MP3 or AIFF
format is also possible.

RaNGE: Save the selected range or the whole file

SpeciAL OrrioNS: Show maximum amplitude: Enables display of the maximum
level after saving in dB for correct adjustment of the master level.

Save in new Format "TUTORO2.WAV" x|
—Range — Format
G . & Wiave
9 Dl el = g " FAM Projekt (RAF)
¢ Complete Project @ Steren « 8Bt
" Only Lefi Channel = 16 Bit
 Only Right Channel 24 Bit
" Mono Mixdown " 32 BitFloat
—Special Dations Sample rate: |441DD vl Cluality... |
I~ Show maximum Amplitude ' MP3
 AIFF

I=| Exclude Master Effects

Mo compression

Dithering Options Format Setings... |

e Cance! | Help |

Excrupe Master EFrecT: The master effects are not included during save.
Master effects are available for Wave Editing only in virtual Wave Editing mode
(refer to the “Wave Editing” chapter) when you open the mixer window for a
Wave Project.

DitHERING OrTIONS: When reducing bit resolution from 24bit or Float to
16bit, dithering takes place. You can choose the algorithm used in the according
dialog (see Options ->Program Preferences->Dithering Options).

Formar: This section allows you to choose the new format specification. Select
the desired format, and press OK to convert the audio file. You will be prompted
for a new file name. A new file will be created, leaving the original audio file
intact.
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Quatrty: Choose the quality of the used resampling algorithm (See Options -
>Program Preferences->Resampling Quality Options) when the sample rate
is changed.

Note: It is not possible to use the same name and overwrite the existing file, as the
file is actually open. (Samplitude will not overwrite an open file in this situation).
You will then be asked to specify a name and location for the new file.

Convert Audio = Stereo Wave = 2 Mono

A stereo Wave Project is copied and converted into a discrete left and right
mono Wave Project (i.e. the same sample is placed in each mono project).

Convert Audio = 2 Mono - Stereo/LR Wave

Two mono projects are linked to one L&R Wave or stereo project. This is a
convenient way of editing joined mono samples with the same operations.
After sending the command, a dialog opens which displays all loaded mono
files. “Load file“ allows you to load other files. Choose the right and left files
from opened Wave Projects using the " key. The <-> keys let you change the
channels. After clicking “Link Files”, name the new stereo file which will then
be created in the project directory.

Take note that mono files can only be joined with mono Wave Projects and
that only projects with the same bit resolution and sample rate can be joined.
The length of the two projects are then fit to each other; meaning, the longer
mono file determines the total length.

Convert Audio = LR Wave = 2 Mono

On occasion, it may be necessary to split a stereo project or two joined mono
projects (a so-called L&R Wave Project) into two independent mono projects.
This menu option terminates the static connection between the projects. If
you would like to re-join the projects, simply select ‘Convert Audio > 2 Mono
> Stereo’ from the same menu (see below).

Convert Audio = LR Wave = 1 Mono

A current L&R Wave Project is converted into mono. If it was previously a
stereo Project, both channels are mixed. The existing samples are initially added
with 100% of their image intact and are then divided by two. This prevents
clipping, and is equivalent to reducing the level by 6 dB.

Convert Audio - 1 Mono - LR Wave

The original mono Wave Project is duplicated, and converted into a single
L&R Wave Project, featuring the same sample in both channels.

Export Audio

The command “Export Audio” will let you export Wave Project files or VIP
files into various audio formats.
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A Note about exporting Wave Projects: Wave Projects can be directly loaded, or
imported, as .WAYV files by other audio applications. The Export Sample command
is only necessary if you wish to copy the audio file or convert it into different formats.
Keep in mind that capacity on your hard disk is required, and that the copy process
takes additional time.

You can also export Virtual Projects via this menu command. The dedicated
track bouncing command from the Tools menu offers much more control
about the details of the bouncing process including multi track bouncing,
exclusion of effects, bouncing a single track or Object of the track, for instance.
The following export formats are possible:

Wave, MP3, MP3 with external encoder, MPEG, Windows Media, Real Audio,
Ogg Vorbis, AIFF or AIFF with QuickTime, 32 Bit Float as 16/20/24 Bit and

dump files.
You can also export MIDI Objects as Standard MIDI Files.
2x]
Suchen in: IaAUd\D ﬂ - & Ev
MEW A Tutorisldema Realtime Tmestretching
Project Files CTutorisldemos_Elastic_Audio
Projekt Dateien CTutorialdemos_Surround_51_Roomsim_FX
Remix_Dema CaTutorialdemos_Surround_7 1_RoomSim

samplitude demo 2004
surround_Cemo_S51

Tutorial

Tutorialdemo Impulse Response Recording

Dateiname:

Dateityp: IWaveflIe [ wan) LI Abbrechen |

Fecent Dir.: I LI
—Range
Format: 44100 Hz, 16 Bit. Stereo ' Export marked range
Auclio Length:  00:01:16 ' Export complete project

Format Settings. s
& Create one file

! Eaeh CO-Track in 2 file

I~ Play exported file(s)

A

Options

The two radio buttons in this section allow you to export the entire file, or a
portion of the file, selected as a Range.

You can furthermore decide, if you want to save each CD track of a project as
a separate file or if you want to save the whole project as a single audio file. If
the tracks are saved separately, an additional list file (. m3u) will be created
besides the audio files. This file contains the names of the single audio files in
the correct order. The option is only available when any CD tracks are set in
the project.

To automatically play the exported file on completion of the process, check
(tick) “Play exported file”. The playback will be not be done by Samplitude but
by the default playback application for this file type.
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Format Settings button
Depending on the exported file format the button launches various format
settings dialogs.

Export Audio - Wave

The main reason for exporting Wave Projects is to compress the file into a
particular WAV format. Samplitude can use various Windows .WAV
compression codecs that are available in the system. Select your desired setting,
and click OK.

Export Audio - MP3

This dialog enables you to export files in the MP3 format, with various format
settings.

Export Audio = MP3 with external Encoder

You can invoke an external command line encoder, and can set several
parameters for the encoder in the dialog.

Export Audio - MPEG

This dialog allows you to export files in the MPEG2 format (*.mpg). Clicking
on the Format Settings button launches the Choose Bitrate dialog, shown below.
Samplitude offers MPEG2 Bit rates ranging from 64 kbit/sec to 384 kbit/sec.

Export Audio > Windows Media (*.wma)

This dialog allows you to export files in the Windows Media format (*.wma)
Clicking on the Format Settings button launches the Windows Media Export
Settings dialog, shown above.

Various MS Audio Bit rate settings are available, ranging from 6kbps for Voice
Audio to 128kBps for near CD Quality Audio. The dialog also allows you to
enter Title, Author, Description and Copyright details.

Redirector files (*.wvx) can be generated by following the directions in the
Redirector Files section.

Export Audio - 0GG Vorbis

Exports the project in OGG Vorbis format. Simply enter the filename in the
dialog. This format is an excellent alternative to the well-known MP3 format.
The Format Settings button opens a compression settings dialog. The
compression scale ranges from 46 kBit/s to 500 kBit/s (32 kBit/s to 320 kBit/
s for MP3). No only can compression be adjusted in relatively large steps (e.g.
64 kBit/s, 96 kbit/s, 128 kBit/s, 160 kBit/s) but also in steps of 2 (e.g. 148
kBit/s, 150 kBit/s, 152 kBit/s).

Export Audio - Real Audio (*.ra)

This dialog allows you to export files in the Real Audio format (*.ra)
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The initial dialog is identical to the Export Audio > Wave dialog.

Clicking on the Format Settings button launches the Real Media Export Settings
dialog, shown above.

Various Real Audio encoding algorithms are available via use of the appropriate
settings in the content settings and target menus.

Author, Title and Copyright information can also be entered.

Export Audio = AIFF File with QuickTime

This dialog allows you to export audio as Macintosh AIFF format (*.aif), through
use of QuickTime’s conversion algorithms.

The browser window, that opens after selecting the function from the menu,
allows you to name the file and select a target directory for it. QuickTime will
initially create temporary files in this directory as part of the conversion process.
The dropdown menu allows you to select various formats for the conversion
process.

Further variables are available by clicking on the Options button.

The Compression dropdown menu allows you to determine the bit reduction /
compression algorithm to use — this is, to some extent, dependent on the input
file format.

The Rate dropdown tab allows you to select the desired sample rate.

Export Audio = Aiff

This menu allows you to export audio material as AIFF files, at the selected bit
depth.

16 bit material can only be exported to 16 bit AIFF. To export 16 bit audio to
higher resolution formats, you must first convert the file to 32 bit Float format
with the File > Convert Audio > Save in Format function.

Export Audio - 32 Bit Float as 16 / 20 / 24 Bit
This menu item allows you to export 32 bit Float audio files in reduced bit
depth WAV formats.

Dithering is employed, providing the best possible quality at the lower bit
resolution.

Note: If Samplitude’s dithering functionality is deactivated, the sample will be rounded
mathematically during bit reduction. This is a better solution than pure truncation.

Export Audio = Export MIDI File

This menu item allows you to export all MIDI data from the project as standard
MIDI file (*.mid).

Export Audio - Export as Dump

This menu item allows you to export audio material as a dump file — only the
raw sample data is stored in the file. (i.e. no file headers, etc.)

You can choose between “Intel” and “Motorola” byte order. (So called Little- or
Big Endian.)
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Note: You must convert 32 bit Float files to 16 or & bit before using this command.
Only 16 bit audio files can be exported as Dumps.

Export video sound

You can load video files like audio files to work on the video soundtrack. This
is used, when you don’t want to edit the audio, and just want to process the
whole audio track with effects, like normalizing or noise reduction. If you
prefer a visual feedback, use the function Menu Options > Media Link instead.
After editing the video sound track, you can re-write sound track back into the
video file. You also have the possibility of replacing either the original video
sound track or of producing a new video file. a new time-consuming
compression of the video is not necessary. No matter what, you can change
the audio format, for example, into compressed formats such as ADPCM.
However, the appropriate compression codecs must be installed.

Export Video Sound il

—Wideo Source

| o

—Audio Length —Audio Format

Audio Length: 00:01:16
“ideo Length: 00:00:00 44100 Hz. 16 Bit, Stareo

Farmat Settings...

—Destination file

& Replace Audio in the ariginal A% file
i Save a new AY file ta:

OF CCancel Help |

CRrEATE AVI / Aubio Copy: This option performs a track bouncing of the current
VIP into an audio file. The AVI file is copied to a new file, which contains the
new audio track. This option keeps the original AVI.

REeprAcE Aupio IN Vipkio: This option performs a track bouncing of the current
VIP into an audio file. This file is merged into the selected AVI file, so the AVI
gets a new audio track.
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Note: If the length of the video file and the audio are different, a warning is given.
After exporting, the longer one is truncated, no automatic synchronization is done.
Ifyou obtain such a warning, try to resample your audio soundtrack to the appropriate

length.

Export to Video deLuxe pro

The Menu command calls the track bouncing dialog and opens the MAGIX
video deLuxe video editing program with the result.

Batch Processing

Batch processing automatically applies a single Wave Project task to any number

of other files (the “batch”) in exactly the same way — for large volumes, usually

overnight.

Each task (“job”) is entered in a job list that defines several batch jobs They can

define several batch jobs which are then implemented one after the other.

Possible jobs may include:

— normalization

— linear fading (in and out)

— real-time effects in the mixer master

— Format conversion: Bit resolution(16/24/32), Sample rate, stereo/mono/
left/right

— Storage in all available export formats

For example, you can normalize a whole list full of 24bit .WAV files to 96%,
apply 5 ms fades at the beginning and the end of each file, compress them
with the multi-band compressor, change them all to 16bit mono, resample
them on 22kHz and then saved them all as mp3s.

Batch Processing x|

—Jobs

Source Files | Effects | Destination Format | Destination Files |
Job List:

Add Joh

Remowve Joh

U Execute Jobs
A file: ‘ Ofile(s) Complete size: 0.0KB  Selected size: 0.0KB
Close
Add directory. | Save list. Remove Remowve all |
Help
Jobs

To the right edge of the batch processing window is the job list. New jobs are
created by activating the “Add job” button. When you select a job (with a mouse
click), the 4 settings tabs are displayed(source files, effects, target format, target
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files). “Remove job” removes the selected job. “Perform jobs” starts the batch
processing.

As long you don’t close down Samplitude, all the jobs remain saved until
execution, even if you close the batch processing window in the meantime.

Source files

Here you can create a list of the files to be edited by selecting “Add file”. Multiple
selection is possible. Select “Load directory” to add all of the audio files within
a directory (including all sub-lists). All importable audio formats are loadable
in Samplitude. “Save list” creates a Playlist (in the common *.m3u format) for
using your selection of files later. “Remove” deletes all selected list entries. “
Remove all” deletes the complete list.

Effects
Batch Processing il
Source Files ~ Effects | Destination Format | Destination Files | FoEe
Job List:
Freser: (I ~|  Sovo | tood | Deles
—Amplitucle —Effect Prasat- Mixer Master Channel
& Mo changes
IND Effect LI
" Normalize to:
1000 =] o 0.00 dB Load Preset. | EditPreset |
~
Change Wolume:  Effacs
Add Jok
+0.00 di [~ Time Stretching / Pitch Sh Setup -~ 1
Remowve Joh
i Fades atstartand end of project—————————————— I Remove clipping Setup
™ Fadeln Length 50 |ms ™ Remave DC Offsat Setup.. Execute Jobs
[~ FadeOuw  Length: 50 ms Close
Help

1. Normalization

You can normalize using percentages (%), decibels (dB) or manually by using
the levels. For more details, please read the Effects Menu chapter -> Amplitude/
Normalize

2. Master Effects

To avoid redundance in the batch processing dialog, effects settings have been
integrated with the mixer preset files.

{ bml buttons_mx_save_effect.bmp} In the Samplitude mixer, you can export
all mixer settings to the mixer preset (*.mix). Simply press the “Save mixer
preset” button in the mixer (see illustration).

By loading these *.mix files into the batch processor (“Load preset”), all master
channel effects settings are included (all other mixer preset data e.g. channel
properties, groups, etc. are ignored). “Edit preset” opens a special FX routing

dialog from which you have access to all effects parameters.
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For more details about the FX routing dialog, please read the “Effects” chapter.
Mixer presets are stored in the /fxpresets/batch directory and can be selected
directly from the listbox.
Besides mixer preset master effects, you can use the non-real-time effects
Resampling/Timestretching, DC removal and De-Clipping. Settings opens the
applicable effects dialog.

3. Fades at the start and end of projects
Linear fades of any given length can be added to your files.

Destination format

Batch Processing x|

—Jobs

Source Files | Efiects Destination Format | Destination Files |
Job List:

R ~|  -: | Lo |

—Samplerate

Presets Delets |

r— Bitresolution —File form

¥ Mo change [ Mo change

™ Mo change

8 Bit
£ BBt MP3 New Samplerste
£ 24 Bit MFEG =
32 Bit Flost "Windows Media
Feal Audio
- Steren/Mono AIFF Quallty of caleulation el daly
OGEG Vorhis Remowve Joh
¥ Mo change ClHlig
& Yeny high

Lol
BrEn, ! Ultra high 1 (slow)

30

) OnlyLefi Channel
) Only Bight Channel
. dane e

Mo compression
Format Settings..

Wltra high 2" (wernyslow - arly:
uzefulfar 32 bitfioat files)

Execute Jobs

Cloze

Help

All settings can be saved as a preset. For more details, please read Samplitude
Effects -> Saving Effects (Preset mechanism).
You may select the bit resolution(16/24/32 bit), the sample rate, stereo/mono/
left/right and format with the applicable format option.
For more about the sample rate: Effects menu -> modify sample rate .
For more about export formats: Effects menu -> export audio.
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Destination files

Batch Processing x|

—Johs

Source Files | Effects | Destination Format ~ Destination Files |
Job List

 Replace Source Files
" Save files with new name to the Source Directary

& Save files to this d\re[:tnryj

[cAMAGI) Zequaiatt Audio} =S
File Narne Prefix; e.g. "(PrefiTestway"
File Marne Suffix: .0 "Test{Suffix) waw" Add Job

Femove Joh

v Delete jols from list after processing

I~ Delete Source Files after processing Execute Jobs

" Create Sub Directories Llose

Help

There are several ways to-save edited files:

“Replace file”: Replaces the original file with the edited file. Should the file be
used in the VIP, the VIP first must be closed.

“Save and rename file in the source directory”.

“Save file in the following directory”.

“Delete source file after editing”.

“Save with source directory path“. The file is saved within the path to its source.

Connect to the Internet

Opens your default dialup connection to the Internet. All you need is a normal
internet-connection for your computer — using a Modem, ISDN or ADSL.

FTP Download

This option allows you to directly connect to any FTP-server on the internet, in
order to download audio material into Samplitude. The MAGIX server is the
“default”, which is not a bad thing, as you’ll always find new sound-material
there. Once again, the only requirement is a working internet connection.
Close Project

This menu command closes the active project window. If the project is changed,
but not saved, a warning message will pop up.

Exit

Closes Samplitude.
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“Edit” Menu

This menu contains all functions that are analogous to cutting/splicing etc.
tasks that you would perform on a tape machine.

Virtual Projects are “track-sensitive” — i.e. only the selected tracks are
manipulated. When working in a Virtual Project (VIP), you must first select a
Range before making use of the cut functions. The start and end points of the
selected Range determine the start and end points of a cut. The vertical position
indicates the tracks that are affected by the edit.

We recommend the use of the Auto-crossfade function for almost all situations,
in order to achieve smooth transitions between the edit points. This will
automatically create fades at the Object edges.

Please note that these functions affect both channels, when working with stereo
and L&R Wave projects. (If only one channel is to be edited, you will need to
convert the Wave Project into two mono Wave Projects. The two mono Wave
Projects can be merged, following individual processing).

Attention: To avoid inconsistencies between the Object modes (e.g. lock all
audio in time, link Objects until silence) and the common edit commands,
some VIP edit options work differently to those of former Samplitude versions.
General Rule: In VIPs, delete, cut and paste commands are dependent on the
current Object mode.

Explanation: There are several Object “modes” (link Objects one/all tracks,
link until silence), which “ripple”. To explain, this means that when you move
one Object in time, the following Objects are also moved, thus preserving
crossfades and relative distances between the Objects. In these “rippling” Object
modes, the edit command functionality is also affected. To give you an example,
when you cut one Object, the following Objects will be moved backwards in
time, to fill the gap. If you perform an insert, the following Objects are moved
forward, to avoid overlaps. This is the “standard” behavior of the delete, cut
and paste functions, as in former versions of Samplitude.

In other Object modes (normal, lock all audio), these commands will not
perform a “ripple”. In other words, temporal (time) movements of other areas
not directly involved in the cut, remain unaffected. This facility is especially
important when cutting time-synced audio, e.g. projects with .avi links. As an
example, in the “normal” Object mode, the delete command works like the
clear command, leaving a gap where the audio material was deleted.

The usual commands, which work independently from the selected Object
mode are accessible in the “more....” submenu. If you find this behavior
uncomfortable, remap your keyboard shortcuts to the old style.

Undo

Undo last command(s) (VIP). Samplitude offers a secure way of tracking your
changes in Virtual and Wave Projects. Up to 100 changes can be kept in the
memory, allowing you to retrace (and undo) all of these steps, if necessary.
Virtual processes and physical processes (such as Normalize, Reverb, Filter
with activated Create Copy option etc.) can be reversed (undone).
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Range and Marker manipulations can also be undone using this command.
When adding effects to audio material (Effects Menu), the Undo option only
works on effects that are applied directly to the VIP Objects — i.e. destructively
“printed” to the Object, as opposed to realtime effects. The ‘Create Copy’ option
must be enabled in the effect dialog, in order to “undo” destructive effects
processes.

Notes: The number of Undo steps (i.e. Undo depth) is defined in the Options >
Program Preferences > Undo Definitions Menu item.

Some commands, such as Tools > Remove Unused Samples or CD > Make CD, do
not allow Undo commands.

Shortcut: Alt + Back, Ctrl + z
Redo

Reverses (undoes) the most recent Undo command.
Shortcut: Ctrl+a

Undo History

UndoHistory T |

Button/Fader 20:54:43 i
Move Objects 20:54:21
Button/F ader 20:54:16

Edit Rubberbands 20:54:09 ﬂl
New Rubber 20:54:07

Edit Rubberbands 20:54:04

Displays a list of recent editing steps. To return the project to the desired state,
simply select the relevant Undo step. Note that it is easy to toggle between
various steps, to ensure that you select the correct state. Once you're sure of
your selection, click OK to complete the Undo.

Cut

Wave Projects:

The audio data (in the selected Range) are copied from the current Wave Project
into the Clip. The material which follows the removed Range is merged with
the material which preceded the removed Range, to close the gap. The complete
Wave Project becomes shorter.

Please keep in mind that the Clip contains the same attributes as the Wave
Project that the material was copied, or removed, from.

If you cut material from a mono Wave Project, the Clip becomes a mono Wave
Project. If material from a stereo Wave Project is cut or copied to the Clip, the
Clip becomes a stereo Wave Project. Another attribute adopted by the Clip is
the bit resolution and sample rate of the source Wave Project. The previous
contents of the Clip are deleted.
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Virtual Projects (VIP):

Object Mode: Normal, Lock all audio

Cut works without ripple, the range is filled with silence, not moving following
audio material backward.(=Command “Copy & Clear )

Object Mode: Link Objects one/all tracks

The material behind the removed range is appended to the material in front of
the removed range.

The VIP becomes shorter if the selected range covers all tracks. This way you
can shorten VIPs which contain empty space behind the last Object. (=
Command “Paste with Ripple”)

Use the function Edit->Paste/Insert to insert the Clip contents in Wave Projects
or VIPs.
Shortcuts: Shift + Delete, x, Ctrl + x

Delete

The command deletes all selected Objects, curve points or the selected Range
in the project. Curve points have priority over ranges, the Range has priority
over a selected Object.

When both an Object and a Range is selected, the Range will be deleted. That'’s
why if you want to remove an Object from the project with this command (by
using the Del key) a Range must not be selected.

A dedicated “Remove Object” command which works independently from a
Range selection can be found in the Object->Cut Objects menu)

In accordance with the selected Object mode in VIP’s, deleting a Range works
as follows:

Object Mode: Normal, Lock all audio

Delete works without ripple, and does not move the ensuing audio material
backwards (=Command “Clear”).

Object Mode: Link Objects one/all tracks and Wave Projects

The sample data that follows the deleted Range is added at the position the
deleted Range started (moved backward). The Project length becomes shorter
(=Command “Delete with ripple”). Using this ‘Delete’ command will only delete
the data from the current sample, leaving the VirtClip and its contents as they
were. If you want to preserve the deleted material, use the ‘Cut’ command.

Shortcuts: Delete

Copy

Copies the selected Range into the Clip. (VIP, Wave Projects)

The current Range is copied into the Clip, but is not deleted from the Project.
The sample length is unchanged. Please note that any previous Clip contents
are deleted.

Shortcuts: C, Ctrl + C, Ctrl + Insert
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Paste/Insert Clip

The contents of the Clip are inserted into the current Project, at the current
play cursor position, or at the start point of the currently selected Range.

Object Mode: Normal + Lock all audio
Paste works without ripple, and does not move the subsequent audio material
forward. This avoids overwriting/overlapping the material in the selected Range
(= Command “Overwrite with Clip”).

Object Mode: Link Objects one/all tracks and Wave projects

The data or Objects positioned after the insert point are removed to make
room for the Clip contents. The samples or audio tracks become longer. The
Clip remains unchanged during the procedure. (=Command “Paste with
Ripple”)

In Virtual Projects with selected Ranges, the Range start position, and relative
track position, are used as the insert point for the Clip contents. Right after the
insertion of the Clip, the program selects a Range over the inserted area. If you
next select Edit > Delete , the inserted contents are removed, and the project is
returned to its pre-paste state.

The following table indicates Samplitude’s response in cases where the Clip
and the Project have different channel numbers:

Clip > Project Clip Channel --> Project Channel
Mono Mono Channel 1 Channel 1
Stereo Stereo Channel 1 Channel 1
Channel 2 Channel 2
Mono Stereo Channel 1 Channel 1
Channel 1 Channel 2
Stereo Mono Channel 1 Channel 1
Shortcuts: V, Ctrl + V, Shift + Insert
Extract

Deletes sample data on both outsides of the selected Range.
This function is designed to be the counterpart of the Cut function.

HD Wave Projects:

The current Range remains unchanged — the sections on either side of the
selected Range are permanently deleted. The audio file becomes shorter. The
contents of the Clip are unchanged.

Virtual Projects (VIP):
The selected Range determines the material (from all VIP tracks) that remains
in the Project, after using the function. This is regardless of the selected Range

@
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spans all tracks. In other words, the function is not reliant on specific track
selection.

The Objects on either side of the selected Range are deleted from the Project.
The contents of the VirtClip remain unchanged.

Insert Silence

The ‘Insert Silence’ option will insert ‘blank’ data at the current play cursor
position, or at the start position of the currently selected Range.

You can enter the length of inserted silence in the displayed dialog, if a Range
is selected, it’s length is automatically used in the dialog as default value.
The “blank” space will actually contain data with a value of zero and will be
inserted before the selected Range. Any data which follows will be appended to
the end of the blank space. The defined Range is maintained, and the length of
the inserted space extends the overall sample length.

Strip Silence

This command removes the silent parts from all selected Objects in a VIP.
After application of the command, the Objects were split in a way, that the
silent parts of the Objects are separated from them. The new silent Objects are
all selected, so you can delete them all at once by pressing the DEL key. Or you
keep them and examine them first.

Strip silence
— Ophionz
Threzhold for silence detection [dB]: W
Threzhold for signal detection [dE]: IW

binirum length of silence: I 100 ms

V¥ Crossfades

LCancel |

Append Projects

This function allows a project to be appended to another project, i.e. the material

of one project is copied, and placed directly behind the material of the first.

You first need to select the Object you want to append, select the menu option,

and click on the project you want to add to the first.

This option is commonly used for ‘cleaning up’ VIP’s that contain numerous

Wave Projects. You can:

— append a VIP with a VIP. This is good for bigger projects, you can edit parts
of it in different files and finally put them together

— append a Wave Project with a Wave Project. A particular use of this option
is the ‘cleaning up’ of VIP’s that contain numerous physical samples.
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— append a Wave Project with a VIP. This is a smart method to transfer markers
from a Wave Project to the VIP. Normally, when a Wave Project is loaded
into a VIP, the markers stay inside the audio file as Audio Markers. Often it
is necessary to have these markers in the VIP. When you append a Wave
Project with the VIP, the Wave data will be inserted as an Object at the end
of the VIP at the active track and the markers from the Wave Project will be
inserted in the VIP.

More - Delete with Time/Ripple

This command deletes the marked Range. Material later than the end of the
Range will be preponed by the length of the Range.

Shortcuts: Ctrl + Delete

More - Clear

Replaces the selected Range with silence (VIP). This command is useful for
removing material without changing the length of the VIP track(s).

Note: This command will not save the deleted data to the Clip. If you want to preserve
the deleted data in the clipboard, use the Edit > Copy+Clear command.

Shortcut: Alt + Delete

More = Copy + Clear

Copies the selected VIP Range into the Clip, and clears it from the VIP Project.
The Project length is not changed. Please note that the previous Clip contents
are deleted.

This is a good way to remove a section of a VIP for use elsewhere, without
affecting the length of the track(s) that the material was removed from.

Shortcuts: Alt+ C
More - Cut with Ripple

The material behind the removed Range is appended to the material in front
of the removed Range.

In VIPs: The VIP becomes shorter if the selected Range did cover all tracks.
This way you can shorten VIPs which contain empty space behind the last
Object.

Shortcut: Ctrl+ X

More - Copy as...

Copies the selected Range into a new file. (HD Wave Projects only)
An Explorer-type file browser is launched, allowing you to name the new file,
and select a target location for it.

Shortcut: Shift + C
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More - Paste with Ripple

The samples or Objects that are located behind the insert position are postponed
to make room for the Clip contents. The samples or audio tracks become longer.
The Clip remains unchanged during the procedure.

Shortcut: Ctrl+V

More - Overwrite with Clip

Overwrites sample data with the contents of the Clip.
The current Range is replaced with the Clip contents. The overall project length
remains unchanged.

Note: In VIP’s, this command does not overwrite the actual audio data i.e. the HD
Wave Project does not change.

The Clip contents are not changed.
In Virtual Projects, the selected Range determines the target position and track
for the Clip contents.

Shortcut: Alt + V, Insert

More - Crossfade with Clip

The content of the Range is crossfaded with the content of the Clip. In this
case the position of the play cursor determines the end of the clip which is to
be used to crossfade the Wave Project. The length of the clip determines the
length of the crossfade.

Also here, the rules of channel ordering are observed between Project and Clip
in the same way as for the Paste function. The Clip remains unchanged.

More - Mix with Clip

This command allows you to mix sample data with the Clip. (HD Wave Projects
only)

The contents of the Range and the Clip are evenly mixed. Channel assignment(s)
between project and Clip follows the given pattern. The contents of the Clip
are not altered. As both components are combined with their full sample values,
make sure that no clipping occurs. The Mix with Clip function is performed
by addition, ensuring that the Project sample remains free of sudden volume
decreases.

Despite this, however, you may still need to modify the amplitude, before
performing the mix, in order to keep the resulting sample from clipping /
distorting. This can be done through use of the Effects > Amplitude/Normalize
menu item.

Append Projects

This function appends one project to another - i.e. the material of one project
is copied directly to the end of the first.




“Edit” Menu

You first need to select the project you want to append another to, select the

menu item, and click on the project you want to add to the first.

You can:

— append a VIP to a VIP. This is good for bigger projects, allowing you to edit
portions of it in different files, and join them together.

— append a Wave Project to a Wave Project. A common use of this option is
for “cleaning up” VIPs that contain numerous physical samples.

— append a Wave Project with a VIP. This is a “smart” method, used for the
transferal of markers from a Wave Project to a VIP. Normally, when an
Wave Project is loaded into a VIP, the markers stay inside the audio file as
Audio Markers. Often, it may be necessary to have these markers in the
VIP. When you append a Wave Project to a VIP, the wave data will be inserted
(as an Object) at the end of the active track in the VIP, and the Audio Markers
will be inserted into the VIP.

Auto Crossfade Active

If this option is active, all newly recorded or cut material in a VIP (or material
that is dragged from a Wave Project into a VIP track) has an automatic fade in/
out applied to it. If you perform a ”Split Object” command, the resulting Objects
are crossfaded, avoiding clicks at the beginning and end of the Objects.
Global settings for Fade In and Fade Out parameters are assigned to the Object.
These settings can be changed in the Edit > Crossfade Editor, which may prove
useful where the audio material is cleanly cut, and the fade impairs the attack
phase of the sample.

If two overlapping Objects have an automatic crossfade applied to them, a
real-time crossfade results. If an Object with an existing fade in is moved over
an Object that precedes it, a crossfade will be applied across the two Objects
(when auto crossfade is active).

The Auto Crossfade mode is an excellent aid when making linear cuts to a
spoken voice track, jingle, etc., which requires smooth segues - without those
unwanted pops or clicks. If needed, each crossfade can be edited in the editor,
or by manipulating the fade handles directly in the Objects.

See the “Crossfade Editor” chapter for more details.

Delete Curve Handles

The options offered by this command allow you to delete automation handles
from the active VIP, as follows:

Delete Curve Handles = Delete Volume Handle

This function deletes any selected Volume curve handles. Individual Volume
events can be deleted by selecting the Object in Curve Mouse Mode and then
double-clicking on a Volume curve event. When deleting several curve events,
the ‘Delete Volume Handle’ function is the best tool for the job. Use the Curve
Mucse Mode, and grab tool, to select multiple curve events.
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Delete Curve Handles = Delete Panorama Handle

This function deletes any selected panorama curve events. Individual events
can be deleted by selecting the Object in Curve mouse mode and then double-
clicking a Pan curve event. When deleting several curve events, the ‘Delete
Panorama Handle’ function is the best tool for the task. Use the Curve Mode
and Grab Tool, to select multiple curve events.

Delete Curve Handles = Delete Surround Handle

This function deletes any selected Surround curve events. Individual Surround
events can be deleted by selecting the Object in Curve Mouse Mode and then
double-clicking on a Surround curve event. When deleting several curve events,
the ‘Delete Surround Handle’ function is the best tool to use. Use the Curve
Mode and grab tool, to select multiple curve events.

Delete Undo Levels

Deletes all Undo steps (VIP). This feature will delete the Undo steps of a Virtual
Project. This is sometimes useful if Wave Projects are left in the Undo chain,
but no longer exist in the VIP. You won't be able to process or delete the Wave
Project if the undo chain still contains a reference, so you might as well get rid
of it. After deleting these "orphaned” Undo levels, these Wave Projects will,
once again, be available for use.
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The View Menu allows you to adjust various parameters that determine how
Samplitude displays project data. A wide variety of options are available,
ensuring that Samplitude’s display suits your preferred working methods, by
selection of view options appropriate to specific workflows.

Rebuild Graphic Data

Occasionally, you may encounter inaccuracies in Waveform displays (or other
project bitmaps), following extensive sample processing tasks. Such artifacts
can be caused by a number of factors, including inefficient display drivers.
Should this (rare) problem occur, simply use this Menu item to restore the
graphic display. The screen (window) is cleared, and completely redrawn by
this function.

Note: Corrupt graphic files can also result from abnormal program termination —
i.e. a crash / hang. Corrupt graphics files are usually not a problem for Samplitude,
as the graphics are not part of the audio data. Any corrupted graphics files will
automatically be rebuilt when Samplitude is restarted. The project is then reopened.

Sections

These Menu items allow you to take advantage of Samplitude’s ability to
simultaneously display up to 3 different "views” of the same project.

If you select ‘2’, Samplitude will display the project in two windows. Each
section can be handled separately. It is possible to represent the complete project
in one section, and a zoomed-in version of a certain Range in the other, for
example.

The screenshot above shows a VIP that uses 3 views simultaneously, enabling
various ways of looking at the first Object on track 1.

Note: You can return to the default, single view mode at any time by pressing the
“Shifti+B” keys.

The Sections > 3 mode is especially useful when adjusting loop points in Wave
Projects.

The whole sample can be shown in the upper section, while the section to the
lower left displays the beginning of the loop Range, and the section to the
lower right, the end of the Range. Use the split Range function for this purpose
(key “B”).

You can also drag Ranges across the section boundaries (i.e. from view to
view). Establish the start point of a Range by clicking, then keep the mouse
button pressed, and change over to another section. Samplitude will indicate
the size of the Range while dragging. Release the mouse button at the desired
location to define the end of the Range.
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Fix Vertically

Ranges can be dragged in Samplitude horizontally and vertically. If this option
seems too strange to you, you can fix the upper edge of a Range(s) to the
maximum value and the lower end to the minimum value. Thus, you get the
usual representation in Range marking. However, a trade-off is that you are
not able to define the vertical extension of a section by choosing the vertical
Range button.

In wave projects, a vertical area selection can be very useful in order to quickly
zoom in on the upper edge of the wave form (by means of the “Zoom into
Range” button on the position bar). Using the Grid, you can then more precisely
read peak values.

Hide Submix/AUX busses

Shows/Hides Busses (if present)

You can access the same function via the "Busses” button, in the top left corner
of the VIP window.

Please refer to the “Working with the Mixer” chapter, in the "Quick start/
User’s Guide” for more details.

Show Grid

The Grid display is designed to assist you with general timing information,
and precise placement of Objects and Ranges. The Grid shows you information
about your location (i.e. where you are) in the project window. It can be displayed
in several formats, assisting with easier identification, and a better overview,
depending on the task being performed.

In addition to identifying locations in the project, the Grid can help you to
structure your VIP song, aligned with bars and beats. Precise Object looping
is easy when using the Grid.

The Grid display consists of vertical lines that are displayed at specific intervals
in the VIP, or Wave Project window. The frequency of the line display is changed
by altering the units of measurement. As an example, if the Grid is displayed
in Bars & Beats, the vertical lines are very close to each other, indicating where
the individual beats occur.

If you zoom into a window, the resolution of the Grid display will also change.
As an example, if you wish to see the vertical lines of the Grid every second
(i-e. aline on every one second increment), you may need to zoom further into
the window.

The Show Grid Menu item is a switch that activates/deactivates the display of
the predefined Grid in the project window. The units of measurement defined
by View > Units of Measurement will appear in the upper sections of the Grid.
Decibel indicators will also be displayed at the right boundary of each Object.

Shortcuts: #
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Grid Lines
This provides 6 options for the graphical display of Grid Lines.

Grid Lines ‘} ...........................

<wonE>
Units Of Measurement
Nine options are available for defining the Units used in the Grid. The choice

of Unit will depend on the type of project you are working on, although you
can easily toggle between the various Unit options in any project.

Units of Measurement PN Samples
Miliseconds
v Hours/Min/Sec
SMPTE
SMPTEMilliseconds
Bars/Beats
CD MSF
Feet and Frames 16 mm {40 fpf)
Feet and Frames 35 mm {16 fpf)

The units are as follows: ‘Samples’, ‘Milliseconds’, ‘Hours/Mins/Secs’, three
SMPTE Frame options, the MSF format for red book CD’s (SMPTE at 75
frames), SMPTE + Milliseconds (instead frames) and ‘Bars’ for BPM display,
and feet and frames for 16/36 mm film.

Snap active

This function switches the Snap on and off. Time positions of Objects and
Range borders, changed by dragging with the mouse, are forced to distinct
values with Snap active, according to the selected “Snap to...” type.

There is a difference between the Object Snap and the other “Snap to...” types.
The Object Snap (the predefined “Snap to...” type) means that Objects and
Range borders can be shifted around until they reach the proximity of a reference
position. Then they jump exactly to the reference position. The proximity is
not a time value but an absolute screen pixels value and therefore independent
from the actual project zoom depth. The reference positions are the beginning,
the end or the hot spot of all other Objects and markers in the VIP.

If several Objects have been selected, the move is performed by lining up the
beginning (or the hot spot) of the last selected Object in the sequence with the
reference point. All selected Objects remain in their position relative to each
other.

This option can be used to easily rearrange Objects with their audio patterns
and gain sample-exact connections.
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The other snap types (Snap to Range, Grid/Bars, Grid/Frames) have no
proximity rule. If activated, Objects and Range borders always snap to their
according positions.

Shortcuts: Ctrl + ~

Snap and Grid Setup

This Menu item launches the project Options dialog. The dialog provides a
number of variables that determine the Snap and Grid settings used in different
types of projects.

Project Options il
["Project Sample Rate / Volume Damping ~ Recording —— | Bar/BPM — |
I
Sample Rete (H2) 44100 = Lock recorded Objects B P—
¥ Group objects after multirecard
Volume: & 0dB — Editing Denominatar |4
C 6dB ¥ | Besiuclive fude BEM 120.000
C-12dB I Auto Crosstade Mode
= 96
© -18dB ™ CD Anangement Mode B=

[ Snap/Grid [ AutoSave Mode
™ Snepto; & Ohbjects (ohjects snap to edges of other ohjects) I~ active
 Range Gl et ent rand efarshiap) | Save Interval "I[I— Minutes
© Grid/Bars GetEPW o clrent anae |
" Grid{Frames The selected © Save on original File

range is Beats: |4 Partitions: |1
Bus it CHpiolEE e & Save a5 Backup File (*_bak VIP)

0 smpt Use cutrent position for offset | ¢ Bave max 10 Backup Files

(*_bakd¥IP)
¥ Show grid Samples = r Use Snap_nﬂset
also for grid
Befine EaindiEsie: | Farmat | T Cancel Help |

Snap To: When this box is checked (ticked), the Snap feature is turned on.
OsgjEecTs: This option activates the Object Snap.

RANGE : activates the Range Snap and enables you to use the currently marked
Range as a Snap basis by selecting Get current Range for snap. This can be
used as a simplified form of the Grid/Bar snap. The principle is the same, the
Range borders will become snap reference points and these points are continued
in both direction in equal distances according to the Range length. Mark a
Range with the smallest time fraction (e.g. 1/16 note) and you've got a 1/16
snap. Use this option, when you want to snap to distinct time positions without
changing the project tempo.

GRriD/Bars: Activates a Snap based on measures. You can enter the tempo in
BPM and additional measure attributes in the Bar/BPM area. The tempo can
also be detected from the current Range selection via “Get BPM from Current
Range”. You can define the number of beats to which the current area selection
corresponds to - e.g. 4, if a complete 4/4 measure has been marked. The
program now automatically displays the tempo (bpm) for the marked area.
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PartiTIONS are used to define the number of Snap positions per beat, i.e. a
value of 4 = 1/16 notes in a 4/4 measure.

GrID |/ FraMEs: Activates the snap based on frame length. The exact frame
length is dependent from the selected SMPTE format (Options >
Synchronization Settings).

BAR/BEAT: Here you set the meter (numerator/denominator), the tempo in
beats per minute (bpm), and the timer resolution in peaks per quarter (clicks/
pulses per quarter note — often shown as PPQN).

SNAP OFFSET TO PROJECT START: Lets you define a starting point for the snap
and grid.

UsEe SNaP OFFSET ALso FOR GRID: When this box is checked (ticked), the Snap
Offset (if set) is applied to the Grid.

Shortcut:

VIP Display Mode

The VIP Display Mode preferences help you to define the two possible
alternative display modes, when working with Virtual projects.

Ctrl+ Shift + “”

activate this drawmode (use Tab to
switch drawmodes in program)

=
E
z
o
z
L«

" Standard ¥ Buttons/Slider

¥ Draw Samples

v Scale with Fades/Curves = Ervelope only v Peak Meters

I Halve " Transparent v Show Border

¥ Separate Stereo & Interleaved [V Arrangement Text

Midi I Drave Envelope [~ “ertical Auto Zoom

¥ Gray out muted ohjects/tracks

L

Metroname

house B

forrm Colors

& Default color settings ¥ Change Mouse Cursors
" Red/Blue alternation
" Comparisonics colors
* Group colors

[v Draw while Move

™ Lock VIP size against ZoomOut

2nd click for object movement
[ {protection against unintentional
mowverment)

¥ ObjectName

[~ Background

™ Large Object Handles I” Froject Mame

v hove Thrash. 200 | ms

v Object Properties ™ Group Mumber
v Object Lock Button I Original position v “IP Border Scrall
v Highlight Crossfades I Audio Marker
[~ Handle far OffsetRatio
Colors 2
Comparisonics Audio 7
segrr?entswze‘ 50 ms i Ok Cancel Help
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You will usually choose mode 1, as it provides detailed overviews of samples
(with all information displayed). Mode 2 employs a quick drawing method,
without graphics. Perhaps you may prefer using mode 1 to display half mono
waveforms, and mode 2 to display full waveforms, in dual stereo. Switching
between the two modes is via the Tas key.

You can also toggle between Mode 1 and Mode 2 by selecting the appropriate
mode from the Menu item. The Modes are defined by selecting the Draw
Mode dialog, which opens the following window:

As shown above, the two Draw Modes have identical options - which are listed
side by side for easy comparison. The active mode is set by selecting the
appropriate radio button at the bottom of the dialog window.

Waveform Display

Draw Sampies: The audio sample representation is switched on. Usually you’ll
leave this on, but it can be advantageous to deactivate sample representations,
when you wish to see volume and pan curves more clearly.

Note: If drawing mode 2 (see above) is activated, the waveform display in the default
setting is switched off. You can, of course, change this at any time.

Scari wiTH FADES/CURVES: In this default representation mode, the waveform
overview is scaled in accordance with the settings of the Fade In/Out, or Volume
curves. This makes the decay of the sound during a Fade Out, or Volume
Curve changes, more visible. This mode also offers good visibility of the audio
material..

Harve: The graphical representation of the audio material can be displayed as
a whole waveform, or half, for higher definition. Checking this box will display
the waveform with half its information.

This mode is recommended, because the Grid (key #) and vertical Zoom
functions (Ctrl + cursor up/down) are perfectly adapted to this draw mode.
The display of Volume Curve results on the signal is also improved in this
mode.

SEPARATE STEREO: If this option is active, stereo tracks in VIPs are displayed as
a two-channel waveform. This allows you to expand the display to both channels,
rather than showing a single composite channel.

Draw EnverorEe: With this option on, an outline is drawn around the envelope
of the waveform. In most cases, this provides easier viewing of the waveform.

In the second column you can set the representation of the crossfade.
StaNDARD: The waveform of the second Object is drawn over the waveform of
the first one

ExviLoPE oNLY: When this radio button is selected, only the waveform outline
(envelope) is drawn. Both Objects are well visible in crossfades.
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TraNSPARENT: When this radio button is selected, the colors of both crossfade
waveforms are overlapped. This works best in front of a dark background
(default). We recommend that you combine this, and the Draw Mode option
(Waveform Colors > Red/Blue alternation), to optimize the display of crossfaded
areas.

INTERLEAVED: When this radio button is selected, a sample of the left Object,
and a sample of the right Object, are drawn Alternatively within a crossfade.
You can then visually assess the fade area - a task made especially easy if the
adjacent Objects are of different colors.

Waveform Colors
DEFAULT cOLOR SETTINGS: All Color Settings are set to their defaults (Options >
Program Preferences > Color setup)

RED/BLUE ALTERNATION: This mode alternates the waveform color of adjacent
Objects between red and blue. This improves the visibility of crossfades in the
transparent and interleaved drawing modes (see above).

CompraRIsONICS coLoRrs: This mode uses an algorithm patented by
Comparisonics to depict sonic material in different colors. Dependent on
the pitch, and additional parameters, a specific color (hue) is computed and
displayed for each segment of audio material.

Low pitches are blue in shade, whereas high pitches are green/yellow/red.
Tonal sonic material is clearly shaded in color, while noise and atonal audio is
gray in color. This makes it possible to visually recognize the different pitches
of a lead saxophone, or to visually detect inconsistencies which would be
unrecognizable, if a purely graphic envelope representation was used.

The size of the audio segment, used for the computation of color, can be defined
in the Comparisonics Audio Segment Size (see the lower-right of the Draw
Mode dialog) field. We recommend sizes of 50 ms or larger, to ensure that
sufficient audio material is available for the color computation.

A completely unique audio search method is provided within Wave Projects,
based on the Comparisonics colors. This is accessed via the Range >
Comparisonics Audio Search Menu Option, and allows you to quickly and
conveniently find identical, or similar, audio material in the Wave Project.
Please refer to the Menu Items — Range chapter for more details.

Note: For further information on the Comparisonics algorithm, refer to
WWW.Comparisonics.com.

Group corors When Objects are grouped, they will automatically be given a
new color. So you can quickly identify the Objects groups in the VIP
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VIP
Activate/ deactivate Several VIP components ( Buttons/Slider, Peak Meter,
Border and Arrangement Text) here.

Butrons/StipEr: This is the Track Box including all Mixer Control elements
like Volume Fader, Mute, Solo.... If you work with the mixer window always
open next to the VIP, you can remove all the identical functions. This is also
the case for the peak-meter.

Szow BorpEiRr: This option determines if a border is drawn between tracks in
a VIP. Switch it off to save space within VIP’s (with lots of tracks on small
displays — e.g. laptops). Attention: If you deactivate the track borders, you lose
also the selected track highlighting.

ARrRRaNGEMENT TExT: The arrangement text serves to distinguish the two editing
areas in Universal mode (area/Object) and is also displayed in this mode.

Objects

BackGrouND: Each Object in the VIP track can be assigned it’s own color. The
color is displayed if this option is checked. If unchecked, the track background
color is used. Object color schemes can be assigned via the Object Menu or in
the Object Editor.

OgjEcT NaME: Objects in VIP windows can have their own name. If this option
is checked, the Object name is displayed. Object names can be assigned via
the Object Menu.

LArRGE OBjECT HaNDLES: When selected, larger handles for Objects and volume
/ panorama curves will be displayed. This option simply provides better
visibility.

Project NaME: Samplitude also allows you to display the audio file name in
each Object. This is especially useful if you quickly want to identify the Wave
Project used in an Object. Checking this option will display the audio file name
in the Object.

OsjecT PropERrTIES: This shows you which Object-related effects are applied
to the Object, e.g. EQ for equalizers, DYN for dynamics etc....

Grour NuMBER: Objects in VIP windows can be grouped together. When
grouping Objects, it is helpful to have the group number displayed in the
Object. This option allows you to display group information in the Object.

OsjecT Lock Butron: When locked, an Object cannot be moved. Activation of
this option allows you to change the lock/unlock status of an Object, by clicking
on the key icon in the lower region of the Object. The key is not displayed if the
Object length is too short to allow it’s display.
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Red key: Object is locked

Yellow key: Object can be moved

OriGINAL rosITION: The original recording time position of the Object start in
the selected time format.

HicHricHT CrossraDEs: This setting applies an alternate Object background
color to crossfade to increase its visibility

Mouse Behavior

CHANGE Mouse Cursors: This option causes the mouse pointer to change,
when moving it over certain areas. As an example, when moving the mouse
pointer over an Object handle, the mouse pointer changes into a directional
pointer. This option is useful for mouse modes that combine several functions.

Draw wHILE MOVE: To increase graphic performance, disable this option. When
deactivated, only the Object outline is drawn while moving/dragging Objects
with the mouse button depressed.

Lock VIP s1zE AGAINST ZooM Our: If the VIP is Zoomed out beyond its size
(from the start of the first Object to the end of the last Object), it will usually be
extended automatically. This behavior can be switched on/off here.

2ND Crick FOR OBJECT MOVEMENT: This option allows you to move Objects
with your second, rather than first, click. The first click simply selects the
Object, avoiding accidental replacements/moves.

Move THRESH: You can adjust the Object move threshold value, in milliseconds.
This prevents Objects and Markers from being moved accidentally, as soon as
you click on them.

VIP BorpEr Scroir: This mode allows you to scroll through the VIP when
selecting a Range, and extending it beyond the current window borders.

Shortcut: Shift + Tab

Store Position and Zoom Level

This Menu item stores positions and zoom factors. Once stored, they can be
recalled with the 8 buttons to the bottom-left of the VIP, the View > Get Position
and Zoom Factor” Menu item, or the NUM pad (to the right of the cursor
keys). To delete stored positions/zooms, right-click on the desired button(s),
or overwrite with a new setting.

Store position and zoom level > 1 Ctrl+Numeric Pad 1
Ctrl+Mumeric Pad 2
3 Ctrl+MNumeric Pad 3

4
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The keyboard Shortcuts used to store these settings are shown in the screenshot
above.

Note: Remember that right-click = delete setting. Take care, or you may unwittingly
delete a favorite setting!

Store Zoom Level

Store zoom level » 1 Ctrl+Mumeric Pad 4
% 2 Ctrl+Mumeric Pad S
3 Ctrl+MNumeric Pad 6

4

This Menu item stores Zoom factors. They can be recalled with the 4 Zoom
buttons to the bottom-left of the VIP, the View > Get Zoom Factor Menu item,
or the NUM pad (to the right of the cursor keys). To delete stored zoom settings,
right-click on the buttons, or overwrite with a new setting.

The keyboard Shortcuts used to store these settings are shown in the screenshot
above.

Note: Remember that right-click = delete setting. Take care, or you may unwittingly
delete a favorite setting!

Get Position and Zoom Level

Get position and zoom level » 1 Mumeric Pad 1
2 Mumeric Pad 2
3 MNumeric Pad 3
4

This Menu item loads one of the 4 possible setups for position and zoom
factor (assuming that they have been stored via View > Store Position and Zoom
Factor). They can also be recalled with the 8 buttons to the bottom- left of the
VIP and the NUM pad (to the right of the cursor keys). To delete stored
positions/zooms, right-click on the buttons, or overwrite with a new setting.
The keyboard Shortcuts used to store these settings are shown in the screenshot
above.

Note: Remember that right-click = delete setting. Take care, or you may unwittingly
delete a favorite setting!

Get Zoom Level

Get zoom level 4 1 Mumeric Pad 4
% 2 MNumeric Pad 5
3 MNumeric Pad 6

4
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This Menu item loads one of the 4 possible setups for Zoom levels (previously
stored via View > Store Zoom Factor). They can also be recalled using the 4
buttons to the bottom-left of the VIP, and the NUM pad (to the right of the
cursor keys). To delete stored zoom settings, right-click on the buttons, or
overwrite with a new setting.

The keyboard Shortcuts used to store these settings are shown in the screenshot
above.

Note: Remember that right-click = delete setting. Take care, or you may unwittingly
delete a favorite setting!

Horizontal

This Menu item contains all functions of the horizontal (red) position toolbar,
plus other horizontal view options.

Horizontal » |\ Section to Beginning
vection Left
Half Section Left
Half Section Right
Section Right
Section to End
Section to Play Cursor/fLast Stop Position

Objectborder Left
Objectborder Right

Marker Left F2

Marker Right F3

Zoom In Ctrl+Cursor Left
Zoom Out Ctrl+Cursor Right
Show All

Zoom to Range
1 Pixel = 1 Sample

Zoom Level 1s
Zoom Level 10s
Zoom Level 60's
Zoom Level 10 min

Definable Zoom Level S1
Definable Zoom Level 52
Definable Zoom Level S3
Definable Zoom Level S4

Vertical

This Menu item contains all functions of the vertical (blue) position toolbar,
plus other vertical view options.

Vertical » Section to Upper End
% Section Up
Half Section Up Cursor Up
Half Section Down  Cursor Down
Section Down
Section to Lower End

Zoom In Track
Zoom Out Track

Show All

Range to Section

1 Pixel = 1 Bit

Zoom Out Wave Ctrl+Cursor Down
Zoom In Wave Ctrl+Cursor Up
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The various options are self explanatory. We suggest that you experiment with
the various vertical viewing options by changing the Menu items, toolbars and
Shortcuts. This will help you to establish the options which best suit your
working methods.

A little persistence and patience goes a long way — time spent developing your
favorite viewing method/system will be repaid tenfold by the speed benefits
you will enjoy in future Samplitude projects!
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This Menu allows you to make various changes to track layouts within a VIP.

Insert new Tracks -> Add one Track
Expands the Virtual Project by one track, at the bottom of the VIP track list.

Insert new Tracks = Add several Tracks

The Virtual Project is expanded by multiple empty tracks.
The number of tracks must be entered into a small dialog box before they are
appended to the project.

Insert new Tracks = Insert empty track

The Virtual Project is expanded by one empty track, which is inserted below
the selected track.

Insert new Tracks = New Submix Bus

The Virtual Project is expanded by one SubMix Bus track, which is inserted
below the selected track.

A Submix bus is a track with all capabilities of a normal track, e.g. EQ, FX,
plug-ins. The difference is that it allows you to route the Outputs of all lower-
numbered tracks into it - i.e. the SubMix Bus. Once a SubMix bus is created, it
appears in the output device list of all lower-numbered tracks.

Please refer to the Mixer chapter for details!

Insert new Tracks = New AUX Bus

The Virtual Project is expanded by one AUX Bus track, which is inserted below
the selected track.

An Aux bus is a track, which has all capabilities of a normal track, e.g. EQ, FX,
plug-ins. The difference is that it allows you to route the Outputs of all lower-
numbered tracks into it - i.e. the Aux Bus - by using the aux send sliders in the
Mixer. Once an Aux bus is created, it appears in the output device list of all
lower-numbered tracks.

You can also send Objects to the Auxes, a great feature for automating Aux
effects.

Please refer to the Mixer chapter for details!

Insert new Tracks = New Surround Bus

You can also mix your project as a surround version later. Use this command
to create a surround bus. All tracks that are to be routed to a surround bus
have the Surround Panorama Module instead of the normal panorama fader
for setting the output level of the track. As soon as a surround bus is available,
the output signal of each individual Object can also be routed to this bus and
positioned in the surround panorama independent of the track panorama
settings. (Object-Surround)
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The surround master is created simultaneously when a surround bus is created;
the individual channels are routed to the different output devices (more details
in the help on Project Surround Setup).

Insert new Tracks = New Surround AUX Bus

This command lets you create a new Surround Bus.

Aux busses are generally used for implementing send effects. The function of
a surround AUX bus is the same, and is enhanced by the possibility to include
surround effects. It can be fed from a normal track (refer to Stereo and mono
signal processing in surround projects) or a lower surround bus (according to
the track number). The AUX bus itself can again feed a surround bus of a
higher track number.

Cut Track(s)

All tracks in the VIP which are covered by a marked Range are cut and copied
into the VirtClip
If no Range is marked, the selected track is cut.

Copy Trackl(s)

All tracks in the VIP which are covered by a marked Range are copied into the
VirtClip
If no Range is marked, the selected track is cut.

Insert Trackl(s)

All tracks in the VirtClip are inserted into the current VIP above the actual
selected track or Range.

Delete Track(s)

All tracks in the VIP which are covered by a marked Range are removed from
the VIP
If no Range is marked, the selected track is removed.

Track Properties

This submenu allows access to all track properties (this can also be done by
clicking the corresponding button in the track box of the corresponding track
in the VIP window). The main purpose of the menu is to remap keyboard
shortcuts to Samplitude functions. This allows you to operate Samplitude
with the keyboard.

In addition, the menu also allows you to switch the track type, enabling it’s
use as an Aux or SubMix bus

All menu options affect the selected track (i.e. the one outlined in yellow).

Command Description Shortcut

Mute Mutes the track Alt + M

Mute inactive  Mutes, and deactivates the track
(this increases performance, because no caching nor FX
processing of this track is necessary)
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Solo Mutes all other tracks, except those

that are already “soloed” Ctrl + Alt + S
Solo exclusive  Mutes all other tracks Alt+S
Record Arm track for recording Alt+R

Record Type  Setthe recording type for the track to audio or MIDI recording
and for audio recording to Stereo, Mono or Mono mixdown

Monitoring switch manual monitoring for the track
(See Menu Play/Rec > Monitoring for details)
Lock Lock track. No Object moves or length changes are allowed.

Volume Curve active Shows / Hides Volume curve
Pan Curve active Shows / Hides Panorama curve
Edit Volume  Open the numeric input field for Volume

Edit Pan Open the numeric input field for Panorama
SubMix Bus track acts as SubMix Bus
Aux Bus track acts as Aux Bus

Mute Bus Inputs Mutes the Input of a Bus, the output of the bus is
still active
Global Mute/Global SoloEnable/Disable all mute/ solo states of the tracks

Track FX

This option allows (as with the mixer channels) the application of real-time
effects to the selected track in Samplitude. More information about effects can
be found in the “Effects” chapter.

Track Effects = Track Routing Dialog

Opens the track FX routing dialog .

In many circumstances, you would use the FX button in the track Properties
box (left of the track), rather than using this Menu item (both perform the
same function). Use of the Menu item can be more convenient in some
situations, such as when the project track count is high, and the screen view is
zoomed out (the Plug-ins button is not always visible).

For details regarding the FX routing dialog, read the “Effects in Samplitude”
chapter in the manual.

Track Effects = Copy/Paste Track Effects Settings

This command allows you to copy the complete effects settings of the active
track into the clipboard (in order to paste them to another track). This includes
the order, and parameter adjustments, of all internal effects (EQ, Dynamics,
Delay/Reverb...) plus those of (used) plug-ins.

You can also perform this function with the Copy/Paste buttons in the FX
routing dialog of the track.

Track Effects © Reset Track Effects settings

Reset all track effects settings to default values - i.e. no effects are applied. You
can also perform this function with the “Reset” buttons in the FX routing

dialog of the track.
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Track FX = Aux Sends

Opens the AUX Sends routing dialog for the track. Please refer to the Mixer

chapter of the manual for details!

Track Effects - Track Dynamics/Distortion/Delay/Reverb/EQ/
Plug-ins/Dehisser/FFT Filter/Multi-band Dynamics/Advanced

Dynamics/Multi-band Enhancer/Amp Simulation/Room
simulation

Please refer to the Menu Effects chapter, for further details.

Pan/Surround Editor

The command opens the Surround Panorama dialog. If you are working in
normal Stereo Master mode, then the panorama settings for stereo tracks are
shown. Further information about the Surround Panorama module can be

found in the “Surround“ chapter.

Track Information
Opens the track Properties dialog, with the following options:

+ Track Info - Mixer Track 2 il
—Audio
Record: |Rea\tekACB? Audio LI All Tracks Track/Dev+ |—1 I~ 2-Channel-Surround active
+
Qutput: All Tracks Track/Dev + |——
Track Type: [T SubmixBus = A% Bus Effects/Routing
—MIDI
Record Dev: [\4pLRDT =] ANTecks | VEThsmmeniEdior | GlobalMDIOptions.. |
Playback Dev: [MPuU-401 ~|  AllTracks Bars/Beats (Projed)
™ Record contraller curves while Playing Automation/Controller ...
Playback/Thru parameters:

In Chan QutChan.  Transp.  Program Bank: High Lo

Iall LI Ial\ LI 0 Inu change j All Tracks

| DI T ative
—Recard

File: [TUTOR01023iAY 1| Al Tracks. Audio Options: & Stereq [~ Record only to
FAh
" Mono
 Audio S
DI Moo (Mix)

V Max Track name: IS: 2 <« »> oK Cancel

Audio

Outrut (Aupio DEvicE): A drop-down list selects the audio card (or specific

stereo output for cards with multiple outputs) used to play back the track.

RecorD (Aupio DEevice): A drop-down list selects the audio card (or specific

5s stereo input for cards with multiple inputs) used to record the track.
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You can customize the device names listed here as well as disable devices (like
the PCs onboard sound system) you never use in the Options > System >
Playback or Record devices dialog. Audio devices are organized always as Stereo
pairs.

Arr TrAcks: This button (just to the right of the two drop-down lists) allows
you to quickly assign ALL audio tracks to playback or record through the selected
audio card (or stereo output).

Track/DEv +: By clicking on this button, you switch to the next track and
assign the next audio playback or recording device to it at the same time. If a
track is armed for recording and you click this button for the recording device,
this state is also taken over to the next track. The + key between the two keys
sets both playback and recording device.

Track TypE: Here is indicated if the track is a aux/submix bus. You can change
the track type in the Menu track- Track Properties menu item.

2 CHANNEL SURROUND ON: Check this box to apply a 2-Channel-Surround
Sound to the track. Read more about this in the Surround chapter

ErrecTts/RouTiNG: Opens the FX routing dialog for the FX-Routing settings
for the track

MIDI
PrayBack DEv: Selects the MIDI playback device for the track.

Recorp DEv.: Selects the MIDI record device for the track.
Arr Tracks: Sets the MIDI record / play device for all tracks.
Global MIDI Ortions: Opens the MIDI Options dialog.

BAR /BEeats (PrOJECT): Opens the Bar Definitions dialog.

AvutomatrioN/CoNTROLLER: Opens the MIDI Controller / VST automation
Curves Settings dialog.

Recorp ConTROLLER CURVES: Enables recording of MIDI controller curves
from MIDI devices.

PrayBack/THRU PARAMETERS: The data received at MIDI IN is output via MIDI
OUT. MIDI events are received on all or on a specific channel, which you
control by the In Chan. Setting. The events can be transmitted on their original
channel or on a different channel (set by Out Chan.). In addition a Transpose
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(Transp.), Program Change and a Bank Switch command can be transmitted.
Transpose affects all MIDI Objects in the track.

MIDI THRrU AcTIVE: Enables MIDI through for the track.

Record

Recorp FiLE: You can enter the name for the audio file you are about to record,
in this field. Click on the yellow folder button to open the standard Windows
file naming / browser dialog. Normally these files are named after the VIP
name with a suffix number for the track number and created in the VIP
subdirectory. When you edit your whole recording project in the VIP as it is
intended by the concept of Samplitude’s virtual working, there’s no need to
change something here. Nevertheless you can: by clicking on the folder button
you may enter a new name for the audio file or select a new location.

RecorDp To RAM: Check (enable) this option to record to your system’s RAM
(RAP recording) rather than the hard drive (HDP recording). You should only
use this option for very short recordings! Be careful not to overtax your system’s
RAM, or the system will become sluggish and unstable.

Ar1 Tracks: With this button you can name/rename quickly the recording
files for all tracks. Several different naming conventions are possible to construct
the name from the track number, track name, project name or the given file
name from the file name edit field.

SterEO: Click on (enable) this option to record in from a stereo input device
into a stereo Wave Project.

Mono: Click on (enable) this option to record into a mono Wave Project. If
you select this option, the audio recording device selector changes to mono
devices, actually the left or right channel of a stereo input pair. Make sure you
select the right one (Left or Right channel)

Mono (MixpowN): Click on (enable) this option to record from a stereo input
device into a mono Wave Project by adding the contents of both channels and
applying a -6 dB attenuation.

Recorp Mobk: These two radio buttons allow you to select either audio or
MIDI recording. Although you can use a track for a mixed audio/MIDI playback
you cannot record both type of data at the same time on one track.

Track Name

You can type a name for the track here. When you open the Mixer window,
this name will be used to identify the track’s mixer channel. Use the << [/ >>
buttons to rapidly switch between the tracks, allowing you to set up all your
track settings with no need to close and reopen this dialog.
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MIDI Controllers/VST Automation/VST Instrument Editor
Please refer to the “Working with MIDI in Samplitude” chapter.

Track Visualization

The visualization from the menu window can be set as Master display or track
display. For further information about different views please refer to the “Menu
Window” chapter.

Hide Track

Hides the selected track from the VIP display. It continues to be visible in the
mixer and is also played back.

An overview of all tracks including their status of visibility is included in the
track Manager. (“Tools” menu > Manager > Track Manager or “Ctrl+Shift+S”
keyboard shortcut). This also lets you hide a track in the mixer window.
Minimize Track / Maximize Track / Minimize none

Minimize TRACK: This Option minimizes the selected track. This can also be
done with the + button in the Track Box in the VIP Window

Maximize Track: This Option minimizes all tracks except the selected track.
The selected track will be zoomed vertical to the maximum possible level

Minimize none: This Option un-minimizes all tracks.

Track Freeze/Edit Track Freeze/Track Unfreeze

Please refer to the “Freeze” chapter for further details!

Activate next

Moves the track selection up/down.
Alternatively, you can use the Alt+ cursor up/down keys.

Activate previous

Moves the track selection up/down.
Alternatively, you can use the Alt+ cursor up/down keys.
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Contrary to the menu Edit all functions in this menu exclusively manipulate
selected Objects in Virtual Projects. Ranges are used to define the insertion
points, or cut positions, of Objects. When inserting material into a Virtual
Project, the Range start point performs much the same function as the Play
Cursor — i.e. the material is inserted at the Range start point.

Splitting, and splicing, are two of the most commonly performed Object editing
tasks. The beauty of Samplitude, for these duties, lies in the fact that Objects
are virtual — i.e. no changes are actually made to the physical audio files. This
allows for very fast editing and flexibility.

The Object Editor is also a fundamental Samplitude feature, providing powerful,
and individual processing for each Object.

New Object

Use this command to create a new virtual Object. Before doing so, you must
first select a Range in the Wave Project that you wish to reference. The current
Range in the Wave Project will be inserted into the Virtual Project, at the Play
Cursor position. It will automatically become the currently selected Object.
The results of this procedure are the same as the Drag & Drop method of
importing Wave projects into VIP tracks.

Note: The Object will be inserted at the actual Range position in the VIP. If a Range
is not marked in the VIP, the Object will be inserted in track 1, at the current Play
Cursor position.

Cut Objects - Cut Objects

The currently selected Object(s) is replaced with empty space, and copied to
the VirtClip. The length of the current project is unchanged, and all non-selected
Objects remain in their original positions. The previous contents of the VirtClip
are replaced with the Cut Object.

Cut Objects = Copy Objects

Select this option to place a copy of the (currently selected) Object(s) into the
VirtClip. The contents of the VirtClip can then be inserted into the project
with the Cutting Objects > Insert Objects option (see below). The previous contents
of the VirtClip are replaced.

Note: You can also Copy/Paste Objects by click-dragging, with the Ctrl key depressed.

Cut Objects = Insert Objects

Objects in the VirtClip can be inserted at the current Play Cursor position of
the project. The other Objects in the project maintain their positions. Please
note that the newly-inserted Object may cover portions of existing Objects.
Simply drag the new Object to a different set of tracks, or reposition the Object
on the same tracks.
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Cut Objects - Delete Object

The selected Objects are deleted from the current project. The length of the
current project, however, remains the same. Unselected Objects maintain their
positions. The contents of the VirtClip remain unchanged.

Cut Objects = Extract Object

Effectively the inverse of Delete Object. All unselected Objects are deleted. Please
note that this function is similar to the Edit > Extract Menu item. Where the
two differ is that the Edit Menu function requires that a Range be selected,
prior to it’s use.

Cut Objects - Duplicate Objects (in place)

All selected Objects are duplicated, and pasted to the same position as the
original Objects. The original Objects are overlaid with the copied Objects.
The duplicated Objects can easily be shifted to any desired position with the
mouse. If several Objects are selected before duplication, press the shift key
before moving them, to ensure that all Objects remain selected, and are moved
together.

This option does not make use of the VirtClip, so any existing VirtClip contents
remain unchanged.

This function is also available through use of your mouse. Press-hold the Ctrl-
key, click on the Object you wish to duplicate, and drag the Copy to a new
position in the project.

Another option is to use the Drag & Drop functionality for the Object, or the
Universal Mouse Mode:

If multiple Objects are selected, press the Ctrl key and drag the selected Objects
to the new position. This allows you to duplicate the selected Objects easily,
without using the VirtClip.

Cut Objects = Duplicate Objects

All selected Objects are duplicated, i.e. a copy is created and placed behind the
old Object (depending on the grid).

This command is also available in the MIDI Editor.

Duplication is also possible via drag & drop (in Object or in universal mode):
If several Objects have been selected before duplication, the Ctrl key should be
pressed before subsequent moving so that all Objects remain selected and are
moved together.

This way, Objects can be reproduced directly via VirtClip.

Shortcut: Ctrl+D

Cut Objects = Duplicate Objects multiple....

This function duplicates multiple Objects, and places them in sequence.
Another dialog is displayed (see the following screenshot), which allows you to

determine; the number of copies (of the selected Objects), the distance between &1
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the duplicated Objects, and the overall length of the duplication. This is an
excellent method for quickly building loop-based projects.

Multiple Object Cop;
Number of Objects: [10

Cancel
Help
Delta Time————— ~ Duration

Samples: W Samples: Im
Milsec:  [47%5ms | | Milisec:  [47.952ms
SMPTE:  [00:00:042 | | SMPTE:  [00:00:47:2
Bars/Beats: lm Bars/Beats: Im'

[V Group created Objects

NuMBER oF OBJECTS: Determines the number of Objects that are created.

GrouP crEATED OBjEcTs: When checked, all created Objects are grouped
together.

Derta TiMmEe: This determines the relative position of each created Object, to
the next (from the beginning of one Object to the beginning of the next). The
default setting is the length of the selected Object. At the default setting, the
duplicated Objects are adjacent to one another, creating a seamless Loop.

DuraTiON: As an alternative, the duration can be specified, thus combining
the time difference, and the number of duplicated Objects.

Cut Objects = Split Object On Marker Positions

The Object is split into several Objects at all VIP Marker positions that lie
within the Object borders.

The new Objects have the same Object properties (FX, Object volume, color...all
set in the Object Editor).

Cut Objects = Split Object On Track Marker Position

The Object is split into several Objects at all CD Track Marker positions that
lie within the Object borders.

The new Objects have the same Object properties (FX, Object volume, color...all
set in the Object Editor).

Split Objects

This function splits or separates selected Objects so that individual Object
sections can be further manipulated. All selected Objects are separated at the
current play cursor position, which results in two independent Objects.

If a Range is selected, the cut occurs on both Range borders. It is not necessary
to select Objects prior to choosing the Range and calling the Split Objects
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function. All Objects affected by the Range are split in this case. If an underlying
Object is separated, the newly created Object covers the original underlying
Object.

The two new Objects have the same Object properties (FX, Object volume,
color...all set in the Object Editor).

If the command is performed while playback, the split position is defined by
the actual play cursor position at the moment you perform the command.

Shortcut: T

Trim Objects

This function trims the borders of the selected Object(s) to the currently selected
Range borders. The selected Range needs to be located inside the borders of
the Object you want to trim.

Shortcut: Ctrl+ T

Heal/Unsplit Objects

With this command you can join Objects which were split into pieces (e.g. by
accident). The Objects have to border each other in the VIP as well as its referred
audio data has to fit. That means, the have to refer to distinct, but bordering
wave data of the same Wave Project. If this conditions are not fulfilled, the
command is grayed out. All Object settings (fades, effects etc.) of the second
Object are removed, the resulting Object carries the settings from the first
one.

Glue Objects

The option discussed in this section is related to the freeze function. The new
audio data is copied to the freeze directory and remains there for as long as the
grouping state is maintained.

The “Group Objects...” command—found in the Object menu and Object context
menu—Ileads to a destructive bouncing operation, whereby a new Object is
created through combining several individual Objects, including effects, time-
stretching settings and crossfades. The new Object has no effects. Fades remain
unchanged. Object aux sends of the first Object are applied to the new Object.
By calling the Unfreeze function, the original state of the Objects is re-
established.

By using the “Edit Object Freeze” command, grouped Objects can be recalled
and edited as a Freeze Project in the state they were in when the grouping
command was executed. All changes performed here are automatically applied
to the grouped Objects.

Object Freeze

This function renders each individual Object to a new audio file which then
replaces the original Object in the VIP. This is advantageous if, for example,
you want to activate very system-draining real-time plug-ins. The original Object
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always remains preserved and can be re-edited using the “Edit Object Freeze”
or can be recalled using “Object Unfreeze”.

If more than one Object is selected, the function will be applied to each
individual Object. Fade-in, Fade-out and Object volume are not calculated, as
these properties are taken over by every new Object.

Note: To make a single Object out of a many Objects, select the appropriate Objects
in the track and use the “Glue Objects” function.

Object Freeze - Edit Object Freeze

Opens the root VIP of the frozen Object. This VIP contains tracks with the
original Object(s).

In the case of “Glue Objects“ the root VIP contains more than one Object,
whereas for “Object Freeze” it contains only one.

Warning: The length of the root VIP can not be changed, as the length is set by the
Object to which the “Freeze or “Glue” function was applied.

Object Freeze - Object Unfreeze

The function can only be used on Objects which were created by “Glue Objects”
or “Freeze Objects”.

It recalls the Object(s) stored in the root VIP. Changes made in the root VIP
will be included.

Tip: If tracks are added to the root VIP, it is not possible to use “Unfreeze Object”.
The root VIP is the project which was created by freezing a track or Object.

Lock Objects - Lock Objects

To protect Objects from unintended editing use this option. First, select the
Objects you want to “lock” and activate the lock function. Locked Objects are
marked by turning the little key symbol red.

You can define which the forbidden editing actions (moving, duration change
...) in the Object Lock definitions dialog (see below).

You can also lock/unlock a single Object by clicking its lock symbol directly.
Locking a track means activate Object Lock for all Objects on this track.

Lock Objects = Unlock Objects
Any selected (and locked) Objects will be unlocked

Lock Objects - Lock Definitions

Selects options for Object locking (as shown in the screenshot). Only “moving”
is locked, by default. Locking a track means activate Object lock for all Objects
on this track.

DisaBLE MovinG: Disables moves of selected Objects (default). This is useful
in multi-track projects, when performing quick editing.
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Di1saBLE VoLUME CHANGES: The volume handles are disabled for the selected
Object/s.

DisaBLE FADE-IN/OuT: The fade handles are disabled for the selected Object/s.

DisaBrE LENGTH CHANGES: The length handles are disabled for the selected
Object/s.

DisaBLE DELETING: This option prevents deletions of locked Objects. This option
only affects the deletion of selected Objects by pressing “Del” (or the “Delete
Object(s) from the Object > Cutting Objects menu). It will not prevent the
deletion of an Object when the Range that encompasses the Object is deleted.

Move/Edit Objects

This Menu branch contains a wide variety of options for fine-tuning Object
position, especially when crossfading.

Move/Edit Objects > Move Objects

This function allows you to move an Object to a precisely specified position.

Move Dbjects to...
— New Start Position

Samples:  [1.088.710

Milisec.:  [24.007 ms %

SMPTE: |00:00:24:DD
Bars: |U1 3:01:001

The dialog shown above is opened, enabling you to select the new position in
samples, milliseconds, or SMPTE time.

Move/Edit Objects - Object/Fade Step Settings

Samplitude contains a complete function set for editing Object fades and
crossfades. To edit the crossfade, select two overlapping Objects. To edit a
single Object, select only one Object.

Step Width for Object Move Gommands
Step Width1————— - Step Width 2

Samples: IW Samples: IW :

Milsec. [100ms | | Milisec: [200ms ﬂl
SMPTE:  [00:00:00:03 | | SMPTE: [00:00:00:05
Bars: IW Bars: lm
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All of these functions can be adjusted incrementally, allowing for very precise
Object movements. The settings can be defined via the Object->Object/Fade
Step Setting menu.

Move/Edit Objects - Object Move Step 1 and Step 2

These Menu items are primarily used for fine-tuning crossfades. You can move
all handles of one or two selected Objects, with these menu functions.

Edit Objects . Object Move Step 1 »  Move Object Left Ctrl+1
Move right Object Left Ale+1
Move Object Right Ctrl+2
Object Move Step 2 | 4 Move Object Left Ctrl+Shft+1 Move right Object Right Alt+2
Move right Object Left Alt+Shft+1
Move Object Right Ctrl+Shft+2 Move Object Start Left Ctrl+3
Move right Object Right Alt+Shft+2 Move Object Start Right Ctrl+4
Move Object Start Left Ctrk+Shit+3 Move Oblect EndLefy 6B
Move Object Start Right Ctbeshieg | Move Object End Right pad
Move Object End Left Alb+Shft+3 Move Crossfade Left Chrl+Alt+3
Move Object End Right Alb+Shft+4 Move Crossfade Right Crl+al+4
Move Crossfade Left Crl+Ale+Shft+3 | poye Object Start Offset Left Ctrl+S
Move Crossfade Right Ctrl+Alt+Shft+4 Move Object Start Offset Right  Ctrl+6
Move Object Start Offset Left  Ctrl+Shft+5 Move Object End Offset Left Alt+S
Move Object Start Offset Right ~ Ctrl+Shft+6 Move Object End Offset Right  Alt+6
Move Object End Offset Left Alt+Shft+5
Move Object End Offset Right  Alt+Shft+6 lncrease Laft Youme Satts
Decrease Left Yolume Chrl+7
Increase Left Volume Ctrl+Shft+8 Increase Right Yolume Ale+8
Decrease Left Yolume Ctrl+Shft+7 Decrease Right Volume Alt+7
Increase Right Yolume Alt+5hft+8
Decrease Right Yolume Alt+Shft+7 Move Object Content Left Ctrl+9
Move Object Content Right Ctrl+0
Move Object Content Left Ctrl+Shft+9 Move right Object Content Left  Alt+9
Move Object Content Right Ctrl+Shft+0

Move right Object Content Right ~ Alt+0
Move right Object Content Left  Alt+Shft+9

Move right Object Content Right ~ Alt+Shft+0

Please note that although these functions can be executed from the Menu item, it is
far quicker to use the associated keyboard commands to execute the functions.

In combination with the “Activate next/previous track” (Alt +cursor up/down)
and the “Select next/previous Object” (ctrl+alt+cursor left/right) allows you to
complete project edits, without using the mouse at all!

The basic principle of manipulating the Object is as follows: The Ctrr key
selects the left Object, the Arr key the right Object. The increment length
(Step length 1 or 2) is determined with the SuiFT key.

The NUMBER KEYS (0-9) select one of the following functions for the selected
Object:

1...move Object left

2...move Object right

Quite self-explanatory

3...move Object start/end left

4...move Object start/end right

With two selected Objects, the ctrl and alt keys select either; the end of the
first, or start of the second Object. Ctrl + Alt moves the whole crossfade. When
only one Object is selected, the modifier keys select the start and end points of
this Object.
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5...extend fade time

6...reduce (shorten) fade time

As above: With two Objects selected, it affects the fade out of the first, or fade
in of the second Object. As long as you don’t have asymmetric crossfades
enabled (please see the Crossfade Editor chapter), you'll notice that Alt + 5/6
have no effect, because the fade in/out times of the crossfade are linked. When
only one Object is selected, the modifier keys refer to the fade in and out
points of the Object.

7...increase Object volume
8...reduce Object volume
This is the equivalent of moving the Object volume handles up and down.

9...move Object content left

o...move Object content right

This is a very special facility, that can only be accessed in this way or via the
Object Editor. You can move the Object’s underlying audio material. This is
the equivalent of: moving the Object’s start point, moving the whole Object in
the opposite direction, and the Object’s endpoint by exactly the same amount.
To illustrate, just open the Wave Project window of an Object (Wave Editing),
and use the keys. You'll see the effect as you move the Range in the Wave
Project, which addresses the audio data for the Object.

To perform all of these manipulations with a Step length of 2, simply use the
Shift key, prior to selecting the numeric value (i.e. Alt + Shift + o = move
content of the second Object right by Step length 2 ).

Move/Edit Objects = Object To Play Cursor Position

Moves the selected Object to the current play cursor position. If multiple Objects
are selected, the selected Object with the smallest track number is moved to
the play cursor, all other selected Objects are moved relative to it (in
consideration of the Object modes).

Move/Edit Objects - Object To Original Time Position

This command moves the selected Object to the original time position of the
material’s recording/creation. This can be helpful if an Object is accidentally
moved, and you don’t notice the change until a few edits later, or even a later
session.

Note: The command only reverts to the time position — if an Object has been moved
to another track, it will be placed at it’s original location on that track, not at the
location of the track it was originally recorded /created on.

If an Object has been moved between tracks, the only current method of reverting to
earlier position/s on other tracks is via Undo, or the use of VIP backups!
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Move/Edit Objects - Set Original Time Position

This Menu item sets a new time position for the ‘Original Position’ attribute
of the selected Object.

Note: The command only sets a new original time position — if an Object is
subsequently moved to another track, it will be placed at the new time position on
that track, not at the location of the track it was originally recorded / created on.

Move/Edit Objects > Arrange Objects

You can arrange all selected Objects in a way that each Object is separated
from the next by a given distance (time). This is useful when you prepare a CD
master.

You can also select Objects across several tracks, the arrangement of the Objects
will happen individually for each track. The first-selected Object in each track
will always remain in its original position.

Mute Objects

Playback of the selected Object/s will be muted — i.e. silent. The waveform will
remain visible.

The letters MuL + MuR will appear in muted Objects, indicating that both left
and right channel is muted. You can mute left and right separately in the
Object Editor.

Shortcut: Ctrl+M

Build Loop Object

With this function, a Loop can be defined within an Object. A Range, which
indicates the Loop length, must first be selected in the Object. If there is no
Range, the whole Object is looped (Loop start/end = Object start/end)

The Object then turns to a “Loop Object”. This means that the number of
Loops can simply be raised with the ‘Object length handles.

To put it simply, drag a Range over the section to be Looped, select Object >
Build Loop Object, then click and drag the right edge of the Object to the right.
The Loop section will be repeated.

You can edit the loop start/length/stop times, and disable the loop “attribute”
of an Object in the Object Editor - on the pitchshift/timestretch tab.

Loop Objects are ideal for generating long drum sequences from a single drum
loop! Loop Objects also help to save memory, as only one Object is handled
rather than multiple Objects, or copies of the same material or very long
samples!

If you split a Loop Object at any given point, and disable the loop attribute on
the (new) second Object, the second Object plays back seamlessly from the
loop end point in the audio. This allows you to loop a drum hit, creating a
Drum Roll, for example. Just select the Range over the hit you want to make
“roll”, pull the length handle, and split the Object after the last drum hit you
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want to hear. Disable the loop flag on the second Object, and the last hit will
continue with its natural reverb tail.
Set Hotspot

The current Play Cursor position is turned into a reference point for the Snap
function. Once defined, the hotspot is used for snapping the Object to the
grid, rather than using the Object’s start point.

Dashed vertical lines illustrate hot spots. Hot spots may be positioned outside
the boundaries of an Object (to the left or right of an Object).

This function is very useful where you wish to synchronize a portion of an
Object, which is not aligned with it’s beginning.

Select Objects - Select Objects

This Menu item will select all Objects located partially, or entirely, in the selected
Range, or Objects beneath the current Play Cursor position (if no Range is
selected).

Select Objects = Select All Objects
All Objects of the project will be selected.
Select Objects = Switch Selection

This Menu item performs the reverse of the command above. All selected
Objects are deselected, and all unselected Objects are selected.

Select Objects - Deselect Objects

No Object in the project will be selected. This is useful when you wish to
delete a Range with the “DEL” key, because the key gives priority to selected
Objects, over selected Ranges.

Select Objects - Select next Object

Selects the next Object on the selected track. If no Object is selected, the
command selects the Object nearest to the play cursor.

Shortcut: “” CIRL+ ALT+ W

This command, in conjunction with “Select next/previous track” (cursor up/
down), allows you to navigate through the Objects by keyboard only!

Select Objects = Select previous Object

Selects the previous Object on the selected track. If no Object is selected, the
command selects the Object nearest to the play cursor.

Shortcut: “<”, CTRL + ALT +Q

This command, in conjunction with “Select next/previous track” (cursor up/
down), allows you to navigate through the Objects by keyboard only!
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Select Objects - Object-Lasso

The normal way to select several Objects at once would be to click on the free
space on the right of the Object in the lower area of the track and to drag a
frame around the selected Objects.

Sometimes, however, there is not enough space between the Objects. The
Object Lasso solves this problem.

Once activated, you can click on an Object and pull up a selection frame, without
moving the Object you clicked on (which would be the case in the standard
mode).

Once you selected your Objects the mouse returns to the standard mode, that
means that you will have to reactivate the Object lasso each and every time you
want to use it.

Shortcut: Ctrl + Alt+ L

Group Objects

Multiple selected Objects are grouped together. All operations are applied to
the whole group.

Shortcut: Ctrl + G
Ungroup Objects

Selected Objects are ungrouped. Individual Objects can now be processed
independently.

Shortcut: Ctrl+ U

Object Color/Name - Object Background Color

[Color

Basic colors:

[y |
Jo
[y |
.
4y )

Custom colors:

W rrrrr
Hue [208°  Red 232
murrrr- R 2E

Define Custom Colors >> | ColorlSolid Lum: [120 Blue: I13El

0K I Cancel I I édd to Custom Colors i

Samplitude allows you to specify different colors for selected Objects. The
dialog shown above allows you to apply virtually any color to Objects, dependent
on your computer’s display settings.
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Object Color/Name - Object Foreground Color

Samplitude will also allow you to apply virtually any color to selected Object
foregrounds. The dialog is identical to the previous dialog (see above).

Object Color/Name = Object Name

Another way to distinguish certain Objects is to give them a different name.
Samplitude allows you to specify a name (such as ‘Svennevig Shuffle’) with
this option.
Please note that the name will be only be visible if you enabled the View > VIP
Display Mode > Definition Menu item, or by pressing Shifi+ Tab when selecting
the Object.

Shortcut: Ctrl+ N
Object Editor

This Menu item launches Samplitude‘s Object Editor window.
The Object Editor is covered in detail in the Object Editor chapter. Please refer
to this chapter for further information.

Object Manager

See “Tools” Menu

Take Manager

See “Tools” Menu

Wave Editing

Samplitude is primarily a non-linear, non-destructive multi-track audio editor.
This means that most of your work is usually completed in the virtual domain
(VIP), without making changes to the original audio. There are, however, some
jobs which are best completed by working directly on a Wave Project, as if you
were using a conventional audio editor.

Samplitude can also function as a conventional audio editor, but now offers
two alternatives, namely: Destructive Editing, or Wave Editing. Samplitude’s
development team designed a way to circumvent the disk space, and time
inefficiencies associated with Destructive Editing/Wave Editing. When working
directly on Wave Projects, the powerful options offered by the Wave Editing
system place Samplitude a “cut” above other conventional audio editors!
Read the Virtual Wave Editing section for an introduction to the new Wave
Editing mode, and also take a look at the Glossary for a rundown on Wave
Editing basics.

There are some differences between the “Destructive” and “Wave Editing”
modes, when working on Wave Projects:
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Rendering edit operations on saving

A1 EDITS: cut, paste, delete and insert, are virtual. The edit positions are marked
by dotted lines. There is no undo file creation. All edit operations are RAM
resident and applied to the Wave Project when you save it.

MasTER SECTION: You can use the Mixer, while working in a Wave Project.
This allows you to apply real-time FX manipulations as you would in the normal
VIP Master section. These effects will be applied to the Wave Project when
you save it.

For more information on the Mixer Master section, read the “Working with
the Mixer” chapter, in the “Quick start/User ’s Guide”!

MENU Fire Save 1N FORMAT: This will open the track bouncing dialog (format
conversions are possible). (Tools > Track bouncing)

Auto CrossraDpe: The Auto Crossfade option (Edit Menu) works in Wave
Projects, too. Default crossfades are applied to every cut or insert operation,
when auto crossfade is active. You can use the Crossfade Editor to fine-tune/
edit crossfades.

New Fire wiTH DRAG AND DrOP: You can mark a Range in the Wave Project,
and drag this Range to an empty space on the program desktop. A new Wave
Project (untitled.wav) will appear. This method allows you to easily make copies
of the entire (or parts of the) Wave Project.

Edit a copy of Wave Content

This opens the Wave Project referred by an Object for Wave Editing. But in
unlike the normal “Wave Editing” command it copies the wave data of the
Object at the end of the Wave Project and adjusts the Object in a way, that it
points on these audio data.

This has the advantage, that the operation creates an undo step in the VIP, so
you can undo the Wave Editing without opening the Wave Project again. The
disadvantage is, that you change the length of the Wave Project, which is not
desired in all cases (when using the audio data in a loop, for instance).

Edit Root VIP

The root project is a special option closely related to the Freeze option. It can
be used, for example, for editing bounced Objects in their original state for a
mastering project.

Every Object created in Samplitude through bouncing can be edited in this
primary project in its pre-bouncing state, as long as its original audio data and
primary project (=root VIP) are still available.

This option, in which, basically, a complete project with all its options can
hide behind any Object, enables complex audio productions and a convenient
recall of the previous working state prior to the bouncing operation.
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Operation

This opens a copy of the root project in the state it was last saved in. If it was
recalled and edited after the bouncing procedure it may, of course, differ from
the previously created audio file.

After editing the root VIP and applying the “save project” function, you are
requested to confirm whether the Object that was originally created is to be
updated by means of a track-bouncing procedure. All track-bouncing options
(format, dithering settings etc.) do apply for this operation. If no other section
or a different section exists, the original length of the audio file is valid for this
process.

However, the automatic update request only ensues if the original VIP is also
called up with the “Edit root VIP” command. A project called up in the usual
way using “Open project” has no effect.
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”Real-time Effects” Menu

This menu entry permits fast access to the relevant real-time effects at Object
level. Correspondingly, menu entries are provided here which can be controlled
via the Object Editor.

For more details on these effects please read the relevant articles in the chapter
entitled “’Offline Effects’ Menu”.

Object Switch Channels

With this function you can switch left and right stereo channel. This is useful
to correct recordings with switched channels.

Object Multi-band Enhancer

The Multi-Band Stereo Enhancer allows you to perform detailed modifications
and corrections to the stereo image in three independent frequency bands.
The signal is separated into the three frequency bands and the separate bands
are processed individually.

The assembling of the independent bands is 100% frequency neutral thanks
to the FIR complement Filter technique — no discoloration of the frequency
response is introduced.

For More Information about the Effects parameters refer to the “Offline Effects”
Menu

Invert Phase

The sample data within the selected Range is inverted along the amplitude
axis. This phase inversion means that negative values become positive and
vice versa.

The “Invert” function permits samples with different phases to be matched.
Along with the available mixing functions (which are, from a mathematical
viewpoint, adding functions) you can actually subtract samples by applying
this function to the selected sample.

Object EQ

This dialog contains a 4-band parametric equalizer. You can activate filters on
four freely selectable frequency ranges to adjust the sound of a sample. You
can produce wide-band frequency adjustments for both high and low pass
ranges as well as small-band corrections of specific frequency ranges.

For More Information about the Effects parameters refer to the “Offline Effects”
Menu

Object FFT Filter

The FFT filter for real-time application in the Object Editor, in the track and/
or stereo-mix master allows the precise linear phrasing filtration of signals
and is thus very suitable for mastering. It contains 1024 frequency-bands,
each of which can be raised by up to +30 dB and reduced by around —-8o dB.
The FFT filter for real-time application is a “minor” option with a huge number
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of possible setting, analyses and function modes for destructive editing of the
audio material (“Offline Effects” menu). The filter-curve can be edited by plotting
a curve with the mouse.

Object Dynamics / Object Advanced Dynamics /Object Multi-band
Dynamics

Opens the corresponding dynamics dialog for the Object. For More Information
about the Effects parameters refer to the “Offline Effects” Menu and the “Effects
Chapter” in the manual.

Object Dehisser

The Dehisser complements the Noise Reduction DSP. It can be used to remove
constant low-level White Noise. This is typically found in material recorded
through MIC pre-amps or analog sound cards.

The Dehisser does not need a noise-print sample, as is necessary with the
Noise Reduction DSP.

For More Information about the Effects parameters refer to the “Offline Effects”
Menu

Object Distortion

This effect allows you to distort audio material by using a non-linear
characteristics line; the signal becomes louder and overtones are added. By
adjusting the starting point of the distortion (Threshold), a soft, analog sounding
distortion (i.e. Threshold at —40 dB) can be created (Overdrive). A harsh, digital
sounding distortion can be created with a Threshold setting of o dB. The Ratio
setting determines the strength of the distortion.

Object Amp Simulation

The Amp Simulation is a real-time effect that simulates tube amp sound
properties. It is especially suitable for guitar sounds, but also for the organ or
recordings of vocals.

For More Information about the Effects parameters refer to the “Offline Effects”
Menu

Object Vocoder

The Vocoder in brief: A carrier material (e.g. a string pad or a Synth chord) are
affected by a modulator (e.g. language or singing, or even drum loops) to give
the impression that the audio material is “speaking” or “singing”.

For More Information about the Effects parameters refer to the “Offline Effects”
Menu

Object Room Simulator

This command opens the Room Simulator for the Object. Please make sure,
that the Object volume is placed before the Room Simulator effect to avoid
fade out of the reverb tail. For More Information about the Effects parameters
refer to the “Offline Effects” Menu
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Object Resampling/Timestretching

This command opens the dialog for an Object’s assigned resampling or
pichshifting algorithm. For example:

Resampling / Time Stretching / Pitch Shifting - Object Editor ll

Time factor. Pitch Time units:
(et ] Old Length MNew Length:

L L \ 002:01.057 0021057 £
% % BPM values

0ld BPM New BPM:
|120 |120.uuu

™ Anti Aliasing Filter (High Quality Resampling) 1.00000 0.00000 Gl i (Aaeisy | IR |

Play / Stop Play Original Ok | Cancel | Help |

For More Information about the Effects parameters refer to the “Offline Effects”
Menu and the Chapter “Elastic Audio“.

Elastic Audio

Opens the Elastic Audio Editor. There is a detailed description of the Editor in
the first Manual part in the Chapter of same name.

Shortcut: Ctrl + Shift + E
Object DirectX / VST Plug-Ins

This function allows you to use Microsoft DirectX and VST 2.0 compatible
plug-ins and with Samplitude. This complements the already existing effects
with an unlimited number of 3rd-party effects.

For More Information about the Effects parameters refer to the “Offline Effects”
Menu
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The options available in the Effects menu are processed directly to Hard Disk
Projects (HDP), RAM Projects (RAP), or selected Objects in the VIP window.
With the exception of the Normalize Object (Virtual) option, the effects are
processed destructively. In other words, the original audio file will be overwritten
with the processed file. If you enable the Create Copy option (in each Effect’s
window), the processed audio will be appended to the end of the original (dry)
audio file.

When processing selected Objects in the VIP window, having this copy allows
you to undo the process, and restore the original (dry) Object. The appended
audio is retained in the project (even though it may no longer be referenced by
the VIP) unless deliberately deleted, either manually or with the Tools > Remove
Unused Samples function.

Note: If you process a selected Object which appears elsewhere in the project (e.g. a
loop-based project) and you do NOT have the Create Copy option checked, you will
affect ALL copies of that Object in the project, as the original HD Wave file has been
destructively processed. This will not occur if Create Copy is checked, as the processed
Object will now reference the appended audio section (see previous paragraph).

We recommend that the Create Copy option is always checked when applying
effects via the Effects menu. Even though this results in the project requiring
additional hard disk space, you can always be certain that you have an undo (or
the original file) if you need it. You can never be “too” sure that you no longer
need the original file!

If the Create Copy function is not checked, you will not have an Undo for the
processing, regardless of whether undos for HD Wave Projects are enabled in
the Options > Program Preferences > Undo Definitions dialog. Your only option
will be to restore a backup of the entire project. (We don’t need to remind you
that regular backup of all referenced files is essential.) This applies to VIP and
HD Wave Projects.

Dialogs in the Effects menu that don’t offer a Create Copy function (such as
the Fade In/Out dialog), will automatically create an Undo file, provided that
the Undo is enabled for HD Wave Projects (Options > Program Preferences >
Undo Definitions dialog). These Undo files are temporary, and are deleted
when the project is closed.

Tip: If the Create Copy option was used (when applying Effects to a Selected Object
in the VIP window), you can use the Take Manager to switch between any appended
(processed) copies, and the original (dry) audio file!
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Extended Options for destructive effects
Here you can set some options for the application of destructive effects.

Destructive effect calculation in VIP Objects

In the upper part of the dialog you can choose between three ways of storing

the calculated effect audio from applying destructive effects on VIP Objects.

This data will be stored for “Undo” operations, when the checkbox “Create

copy” in the dialog of the chosen effect is set.

Hint: Disable this checkbox only if you are really sure that you won'’t need to

undo the calculation and you want to spare the time and disk space for creating

the additional wave data.

1. “Append effect at original file.” This was the usual way in earlier program
versions. You obtain fewer different files and can quickly access the effect
calculations according to a specific file. There are some disadvantages: when
you are working with a 16bit-depth file, the effect is also stored in this
resolution, which is undesirable when you want to benefit from the internal
32bit calculation depth. Furthermore, the file length is changed, which will
cause problems when you use the Wave Project as a loop or in different
VIPs.

2. “Write effect to an FX file (..._fx.wav)” The results of all effect calculations
are stored in one separate file, named like the original Wave Project with
the suffix “_fx”. So the original Wave Project remains untouched. Additionally
you've got the possibility to store the effect calculation in 32bit float format
to remain the highest quality of the effect.

3. Finally, you can “Generate a new fx file for each effect”. Then all destructive
effects are stored in separate files with a running-number-suffix. Alternatively
these files can also have detailed names.

Destructive effect calculation for Wave Projects

When calling a destructive effect from within a Wave Project, the above options
are obsolete and the effect results are always inserted in the Wave Project.
Nevertheless temporary files for undo actions are created, when “Undo” for
Wave Projects and “Create Copy” are enabled.

When applying an effect on a Range in the Wave Project, it is possible to add a
crossfade at the beginning and the end of the processed audio data between
the original and effect audio. To do this, activate the according checkbox in the
effect dialog “Create Crossfade”. The length of the crossfades are also adjusted
here.

Amplitude/Normalize - Normalize

This function modifies the sample’s overall amplitude.

The data is altered so that the maximum amplitude occurring in a specified
Range is set to 100% (or any other value between 1-400%). Samplitude will
first attempt to detect the maximum value, and relate it to the chosen percentage.
All other values are then weighted with the new factor.

The Normalize function is designed to fully-modulate, or over-modulate,
samples. It is often performed before converting a higher resolution sample to
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a lower resolution. As the dynamic range of the low resolution file is reduced,
it can still be fully-utilized by applying the Normalize function.

If you are working with sounds from a single instrument, you should set the
factor to 100%.

If, however, your audio material features background percussion, for example,
you will be able to over-modulate the sample to a range between 120% and
200%. This will only cut off the new percussion peaks. The same method
allows you to alter the sound of natural instruments by over-modulating them.
As preparation for further physical processing, such as filtering, reverb, dynamic
compression, etc., a level reduction of 50-70% is suggested. This should avoid
clipping during post processing.

An important point to note: If the volume level is relatively low during recording,
and the material is later normalized, the result will not be of the same quality as a
full-range recording. As an example, if the volume level was only set to 50% of the
possible range, the audio material will be in 15bit quality. Even normalizing the
material to 100% will not change this aspect.

Normalization m
400 % Waorking Mode Quick access
Nomalize to 100.00 % J 200% & Virual
0.00 cB - " Destructive Set
1 100% | Parameters
% 35% Multiple obiect selection
Peaak Maximum, 0.00 dB |

Get
B0% ¢ independent normalization Paramstars
Peak change +0.00 dB

@ unified normalization

Play { Stop [0]8 | Cancel | Help |

NormALIZE TO: Allows you to set the target level for normalization. This can
be done by typing the desired value into the data fields, adjusting the fader, or
pressing the preset buttons for 50, 95, 100 or 200%. The value is displayed as
a percentage and in dB. odB=100% (full Range). Normalizing to a value over
odB results in digital distortion.

Peaxk MmaxiMuM: displays the highest detected peak in the selected Range/Object.

PEak cHANGE: displays the level change in dB, in accordance with the selected
normalize level and the detected peak maximum

Working Mode

Virtuar: This function will perform real-time normalizing on the selected
Objects. This is different than the destructive normalizing process, which
restructures the audio file.

The real-time normalizing function looks for peaks in the Object, and adjusts
the Object volume, so that the highest peaks precisely match the selected
normalize level. You can return the Object to its original volume setting by
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selecting “Reset”, located below the volume fader in the Object Editor.
This option is not available when working with Wave Projects (Wave Editing)

Destructive: The audio material in the Wave Project is physically altered.
Undo is only available when Undo is enabled, and the “create copy” flag is set.

Multiple selection
When multiple Objects are selected, there are two different techniques to
normalize the Objects.

INDEPENDENT NORMALIZATION: Each Object is normalized according to its own
maximum (peak) level.

UNIFIED NORMALIZATION: The maximum level is detected from all Objects,
and each Object is normalized according to that value. This is the default
behavior.

Quick Access

Set parameters: These buttons allow you to set a normalize value (e.g. 99%),
and the normalize method for multiple selected Objects, when you access the
Normalize function via the Quick Access dialog.

GET PARAMETERS: To reload these parameters in the dialog.

Shortcuts:
Key: Shift + “N”

Amplitude/Normalize - Normalize (quick access)

Quickly normalize a selected Range (Wave Projects), or selected Objects, (VIP)
to a fixed value. This value can be defined in the Normalize dialog.
Normalization modes are always applied in accordance with the project type -
i.e. Wave Projects in destructive editing mode are normalized "destructively”
and Wave Projects in virtual Wave Editing mode (and VIP Objects) are
normalized “virtually”.

Key: “N”

Amplitude/Normalize - Fade In/Out

This option opens the Fade In/Out window. You can destructively apply fades
(both in and out) to Wave Projects from this window.

Important note: Using this dialog, fades (both in and out) can be destructively
applied to Wave Projects only. If you wish to destructively apply a fade to an Object
in the VIP window, right-click on the Object and select Wave Editing. This will open
the Wave Project that the Object refers to.
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If you prefer to fade non-destructively, you can use the Volume Curves or
Object Handle options in the VIP.

FADE StarT IN %: This parameter sets the level at the beginning of the fade as
a percentage of the original level. To create a simple fade in, set this parameter
to a value of o. To create a simple fade out, set this parameter to a value of 100.

Note: You can adjust this parameter by clicking on one of the three “preset” percentage
buttons (o, 50, 100), moving the slider, or by typing the value in the box.

Tip: Fade ins don’t have to start at a level of o, and end at a level of 100. Fade outs
don’t have to start at a level of 100, and end at a level of o. The levels can be set
anywhere between o and 200. Use the graphic display to help “visualize” the curve
you are applying.

Fape END 1IN %: This parameter sets the level at the end of the fade as a
percentage of the original level. To create a simple fade in, set this parameter
to a value of 100. To create a simple fade out, set this parameter to a value of o.

Note: You can adjust this parameter by clicking on one of the three “preset” percentage
buttons (o, 50, 100), moving the slider, or by typing the value in the box.

Tip: Fade ins don’t have to start at a level of o, and end at a level of 100. Fade outs
don’t have to start at a level of 100, and end at a level of o. The levels can be set
anywhere between o and 200. Use the graphic display to help “visualize” the curve
you are applying.

Fape Curve: This parameter allows you to choose the type of curve used for
the fade.

EXP.: Click on this button to select an exponential curve. The taper of the
curve can be set with the slider.

Prasets
’]Unga\/ed Flug-in Configuration =] Sawe Load B R |

vt |

Active Plug-ins Installed Plug-ins

Pre————————— InterVideo Audio Effects
Post

Mute | Sola Move. A~ v
Edit Remove
I~ Force Latency (Samples)

sem I” Force Mono Processing
s | I Bypass

[ Play/Sip ] oK Cancel Help
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LINEAR: Click on this button to select a linear curve. The taper of the curve
can be set with the slider.

LOG.: Click on this button to select a logarithmic curve. The taper of the curve
can be set with the slider.

Tip: By selecting the opposite number for a curve’s taper, you can invert the curve.

Fape In: Click on this button to quickly set up a “simple” fade in. The fade’s
level will start at o and end at 100.

Fape Our: Click on this button to quickly set up a “simple” fade out. The
fade’s level will start at 100 and end at o.

Important note: Whenever possible, it is recommended that you perform fades non-
destructively within the VIP window by using the volume curves or Object handles.
If you prefer to fade destructively, note that the Fade dialog does not have a Create
Copy option. Don’t panic, the Fade function is one of the Effects menu items which
automatically creates an Undo if the Options > Program Preferences > Undo
Definitions dialog has Undo enabled, for HD Wave Projects.

Shortcut: “F”

Amplitude/Normalize - Set Zero

Sample data values in a selected Range are set to zero (no data), eliminating
noise and imperfections in a sample.

Example

In between sentences in a spoken recording, there are inevitably background
noises (e.g. pages ruffling). By marking this area and then overwriting it with
silence (to zero), you can clean up your recording.

Switch Channels

This option allows you to switch the left and right channels of a stereo Wave
Project.
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Stereo Enhancer

This option opens the Multi-Band Stereo Enhancer window. In this window,
you can expand or collapse the stereo image (in up to three separate frequency
bands) of Wave Projects, or selected Objects in the VIP window.

Multiband Stereo Enhancer - destructive x|
Preset: | Parameters from Mizer or from Object Edior | N c
Filter Settings Bass Mid High
Stereo: Stereo: Stereo:
View dB: > lin.
0.0z 007
0.z hbno Exp. | | Mono Exp. | | Mono Ep
1000 |« 1000 |« 00 |
Pan: Pan: Pan:
o o o o o 0
L R L R L R
Gain: Gain: Gain:
0o {de 00 |ae TR
Split-Freq 1: - kHz  Split-Freq2:
Mode: Multi Band Band Separation: hd Bypass
Direction Pan Phaseg Correlator I [ Reset
= =
Play / Stop Ext. Options... [®] Create Copy Cancel
= =

Note: This option can only be applied to stereo audio files.

The Multi-Band Stereo Enhancer allows you to perform detailed modifications
and corrections to the stereo image in three independent frequency bands.
The signal is separated into the three frequency bands and the separate bands
are processed individually.

The reassembly of the independent bands is 100% phase-neutral, thanks to
the FIR Complement Filter technique — no discoloration of the frequency
response is introduced. This method is superior to that of many other stereo
enhancers, which work by destroying phase coherency.

Using multiple bands to affect the stereo image has many important advantages
over image enhancers that destroy phase coherency - increasing the width of
the mid-range, for example, prevents the "typical” problems of muddy highs
and lows when using such enhancers. These issues often show up due to
phase cancellations. In addition, the decline of mono compatibility caused by
an increase of the base width is limited to the treatment of a specific band.

Some Important Multi-Band Stereo Enhancer Applications

1. Reduction or expansion of the stereo base width.

2. "Punchy” bass - through reduction of the base width in the bass range.

3. Control and correction of problems in the stereo image of a completed mix.
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4. Relocation of the mono portion of a stereo recording within the panorama
field (directional mixing). This can also be used to move a centered vocal
track to the left or right in a stereo image.

5. Damping or removing mono signals in the mid-frequency range in order to
create “room” in tracks or drum loops. This allows the addition of further
instruments or vocals.

In the upper left hand section of the dialog is the Filter section. The graphic
display shows the approximate frequency response of the individual bands.
The left axis shows the damping in —dB, the upper labeling the frequency in
kHz. You can switch the according scales into linear or logarithmic mode.
With the two sliders in Multiband mode you can adjust the split frequencies
between the lower and middle (1) and the middle and high (2) band.

In the upper middle are the parameters for the stereo manipulation. To the
right are the standard control options, radio buttons, and checkboxes for the
different modes and the A/B/C switch for quick comparison of three dialog
configurations.

Multi Band Mode

The algorithm works with three frequency bands if this option is checked.
The Multi Band mode is not automatically active when using the Enhancer in
the Mixer Master section. This reduces the initial load on the CPU when selected
in the Master section.

Band Separation

This setting determines the characteristics of the filter segment, and is used to

increase separation.

Higher settings will produce the following:

1. The attack level of the filter curves is increased — the transition between two
bands is smaller.

2. The absorption in the cross section increases: Setting Low: approx. 25-35
dB, Normal: approx. 35-45 dB, High: approx. 55-75 dB.

3. The coarseness of the frequency response of the individual bands is reduced.
This is usually not a problem, as the coarseness of the individual filter bands
is cancelled out, due to the complementary filter technique. The output
signal is always reproduced without any coarseness.

4. The CPU load increases.

Direction Pan Mode

This switches between two panorama control modes.

If the option is checked, only the mono portion (the center signal) is considered
when changing the panorama setting. The panorama control functions as a
directional mix controller. This allows you to move previously centered vocals
to the left or right channel. Any portion of the remaining audio signal that is
not centered is unaltered.

Otherwise, all panorama controls operate conventionally — the complete stereo
signal is changed (mono and the remaining left and right portions).
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Stereo (Base Width)

The width value is set between o and 200. A setting of 0 means “Mono”, 100
= “No Change” or “Stereo”, and 200 = “Maximum Width” (Difference Signal).
Depending on the correlation between left and right, a level boost can occur if
the value of the fader setting is reduced. In extreme cases, a level boost of +3
dB may be introduced. This is the case if the left and right channels are identical
(this corresponds to maximum correlation), and when setting the base width
to o (Mono).

Increasing the base width to values above 100 decreases mono compatibility.
If the base width is reduced, mono compatibility is maintained.

Gain
You can adjust the gain of each single band by +/- 6dB here.

Pan

The panorama for each of the bands is controlled with this knob (or horizontal
slider). Damping values are shown in dB.

If the Direction Pan mode option is active, the Pan control functions as a
directional controller. Only the mono portion (center signal) is considered.
This allows you to isolate centered vocals, and change their position within the
stereo field. Any material outside the center remains unchanged.

Solo Mode

Selecting the Solo mode buttons allows previewing of individual frequency
bands. This greatly simplifies the process of changing filter parameter settings.
As an example, you can isolate a specific frequency range of a mix, and change
the aspect of the stereo image for the range.

A/B/C

To compare different dialog configurations, select a different radio button.
Can also be used as a bypass function, if one of the configurations is left at the
default setting.

Phase Correlator

Opens the Phase Correlation Display. This is especially useful in Solo mode.
The base width and panorama setting for each frequency band can be visually
checked.

Playback

Click on this button to hear a real-time audition of the processed audio.

Save, Load, Delete Setup
This allows you to save, load, and delete configuration settings for the dialog.
The default file extension is *.ste.
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OK
The algorithm is applied to the selected Range or VIP Object.

Cancel
The dialog is closed without applying any changes.

Invert Phase

The sample data within the selected Range is inverted along the amplitude
axis. This phase inversion means that negative values become positive, and
vice versa. This function is reversed by simply reusing the command.

The “Invert” function allows samples with different phases to be matched.
Along with the available mixing functions (which are, from a mathematical
viewpoint, adding functions), you can actually subtract samples by applying
this function to the selected sample.

Parametric Equalizer....

This dialog contains a 4-band parametric equalizer. You can activate filters in
four, freely-selectable frequency ranges, in order to adjust the sound of a sample.
You can make broad (wide-band) frequency adjustments for both high and
low pass ranges, plus fine (narrow-band) corrections of specific frequency
ranges.

Note that the Mixer window (Shortcut: “M”) also offers one equalizer processor
per channel. This processor will operate in real time and the audio material
will not be altered. (Non-destructive editing.)

+ Parametric Equalizer - destructive il
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1..4 The EQ bands are arranged in groups of buttons, controlling frequency,
bandwidth (Q) and gain (volume). Each of these parameters can be adjusted by




"Offline Effects” Menu

moving the corresponding knob, or thru numerical input in the data fields.
The EQ can also be adjusted in the frequency response curve above. Drag the
according ball for an EQ band to form the curve.

TypE: For the first and fourth EQ band (typically used for the lowest and highest
frequency bands), you can select a lowpass, shelving or bandpass filter curve.

FreQ.: The frequency of the individual filters can be adjusted between 10 Hz
and 24 kHz. As each frequency is selectable, several filters can also be set to
the same values, to achieve a more pronounced effect.

Q: The bandwidth of each individual filter can be adjusted between 10 Hz and
10 kHz. Once again, overlapping filter frequencies are possible.

GaIN DB: These knobs determine the amount that the filter level (volume) is
increased or decreased (+/- 20 dB). A setting of o deactivates the filter, and
does not consume processing power.

VoruME: You can adjust the output gain (volume) with this fader. Your filtering
results in a low volume (i.e. makeup gain).

IN/Out METERS: These meters indicate the levels of the audio input and output.
RESET: Resets the meters, in cases where clipping has occurred. (Turns off the
red clip indicator)

A, B, C: You can choose between three different settings with these checkboxes.
This is especially helpful if you want to experiment with settings, and compare
them. To switch between setups, simply select another radio button and adjust
settings to your taste, then select another radio button a.s.o. The settings will
be stored with the project and can be saved as a group with the Save button.

Bypass: This option bypasses the EQ entirely, allowing an easy comparison
between the processed and unprocessed signal.

CreaTE Cory: As with most of the other Effects menu items, this important
option determines whether an Undo will be created - prior to processing the
file. As always, we strongly recommend that you leave this option enabled.

Pray/Stop: This button activates the real-time preview, allowing you to audition
the EQ settings, prior to applying the process.
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FFT Filter/Analyzer...

Choose this option to open the FFT Analyzer/Filter window. This window
allows you to destructively apply FFT Filtering to Wave Projects or to selected
Objects in the VIP window. The FFT Filter is one of Samplitude’s most powerful
tools, offering unique draw options that allow you to easily redraw the frequency
response of the selected Range. This can be invaluable when dealing with
equalization issues, for repairing audio, or for precision mastering.

FFT Filter / Spectrum Analyser - destructive .’i]
Presets
ﬁmsavea Parameters (Offine Editing) =] Save Load Delste | Anatyse Al |

685 22043 Hz

Invert Filter

Prevent Glipp.

Reset

& Static

 Dynarmic Start
l ‘  DynamicEnd

& Filtar
" Direct{ Match

Zoom Al : | & | Mex| = T3 )
Drawrnode: & HzfMNates & 0 Freglinflog © @ dBlin/log © & Seftings ... | 0.0
f I¥ Create G
[ Play/Siop | Prevew | PlayOiginal Extended options S ok | Concel | Help

So...what is it?

The FFT Filter/Analyzer combines a FFT (Fast Fourier Transform) spectrum
analyzer with a FFT Filter. In other words, a Spectrum Analyzer to view the
frequency response of the audio, and a graphic EQ that allows you to draw the
desired changes into the frequency response graphic.

What can I do with it?

There are literally a million and one possible uses for this processor. In fact, a

manual as thick as the one you have in your hand could easily be written on

this subject alone! With that in mind, we’ll cover some of the more common,

practical uses.

This manual assumes that you, the reader, have reasonable knowledge of the

principles and terminology of audio spectrum analysis.

1. View the frequency response of a mix, and make desired adjustments

2. Sub-bass enhancement or reduction (of rumble or plosives)

3. Adjust the amplitude of an individual instrument or note

4. Capture the frequency response from a recording, and apply it to another
recording (convolution)
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5. Crossfade between two separate filter curves

Tip: If you wish to delve further into the theory behind the FFT-Filter/Analyzer, we
suggest you find an advanced text, specific to FFT.

Curve Display

Three different curves (each a separate color) can be displayed by the graph. A
total of nine curves (three groups of three) are available for use.

The first group of three curves (yellow, red, blue) is used in the Static mode,
the second group is used for the start point of the dynamic filtering (Dynamic
Start), and the third is used for the end point of the dynamic filtering (Dynamic
End).

Bruk: The blue curve represents the original frequency response - UNTIL
changes have been made. Once changes to the frequency response curve have
been made, the blue curve represents the resulting frequency response. When
using the Direct/Match Edit mode, you can re-draw this curve, in order to
make absolute changes to the frequency response. In other words, the curve
you draw IS the new frequency response curve.

Yerrow: When making changes to the frequency response curve, the yellow
curve will appear, indicating the original frequency response. The yellow curve
only appears when using the Direct/Match Edit mode, or when using the Filter
Edit mode - with curve numbers set to 3 (under the Settings > Draw Settings >
Curve Number option).

ReD: The red curve is centered (flat) at odB, and indicates relative changes (i.e.
the gain changes made, to achieve the desired response) to the frequency
response curve. You can re-draw this curve in order to make relative changes
to the frequency response.

Faders

LEFT (LARGE) FADER: Use this fader to adjust the amplitude scale of the blue
and yellow curves. The amplitude is shown (in dB units) to the right of the
fader.

RiGHT (UPPER) FADER: Use this fader to adjust the amplitude scale of the red
curve. The amplitude is shown (in dB units) to the left of the fader.

RigHT (LowER) FADER: Use this fader to adjust the overall level of the FFT
Filter, without altering the frequency response curve. The amplitude change
is shown (in dB units) beneath the fader.

Zoom

Atrx: Click on this button to quickly zoom out all the way. If you click on the
button a second time, the graphic display will return to the previous zoom
level.
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Ourt: Click on this button to zoom out by 1 level (there are 10 zoom levels).
In: Click on this button to zoom in by 1 level (there are 10 zoom levels).

Max: Click on this button to quickly zoom in all the way. If you click on the
button a second time, the graphic display will return to the previous zoom
level.

There are a total of 10 zoom levels available.

Note: Once zoomed-in, you can use the scroll bar (beneath the graphic display) to
scroll the display. The current frequency range is shown (in Hz) above the graphic
display.

Draw Mode (below the zoom buttons)

In the first mode (left radio button), the frequency response is displayed as
individual “partials” (useful for editing the low end of the frequency response).
In the second mode (right radio button), the frequency response is displayed
as a curve.

Hz/Notes (to the right of Draw mode)

This option allows you to display the graphic in Hz (frequency) or musical
notes. Frequency can only be displayed as musical notes when the Freq lin/log
parameter is set to log.

Freq lin/log (to the right of Hz/Notes)

Linear display of frequency provides a more detailed view of the higher end.
Logarithmic display of frequency provides a more detailed view of the lower
end.

dB lin/log (to the right of Freq lin/log)

Linear display of amplitude provides a more detailed view of the higher end.
Logarithmic display of amplitude provides a more detailed view of the lower
end.

Filter Mode

Static: Select this mode to affect the entire Wave Project or selected Object.
You should always use this mode, unless you intend on crossfading between
two frequency response curves.

DyNaMmIc sTART: When a crossfade between two frequency response curves is
desired, use this mode to adjust the first (start) curve. The FFT Filter will start
with this curve, and perform a crossfade until it ends on the second (end)
curve.

Dynamic END: When a crossfade between two frequency response curves is
desired, use this mode to adjust the second (end) curve. The FFT Filter will
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start with the first (start) curve, and perform a crossfade until it ends on this
curve.

Edit Mode
FirTer: Select this mode to re-draw the red curve — i.e. use this mode to make
relative adjustments to the frequency response curve.

Direct/MatcH: Select this mode to re-draw the blue curve - i.e. use this mode
to make absolute adjustments to the frequency response curve. The curve you
draw IS the new frequency response curve.

Analyze all

Click on this button to have the FFT Spectrum Analyzer calculate the frequency
response of the Wave Project or selected Object. Note that this option only
applies when the Filter mode is set to ”Static”.

Reset
Click on this button to reset all curves to their default (odB) position.

Analyze > Filter

Click on this button to transfer the frequency response curve (of the current
Wave Project, or selected Object) to the red curve. This allows you to quickly
apply the frequency response of one recording to another.

Invert Filter
Click on this button to invert the frequency response curve.

Prevent Clip.
If the audio distorts or clips after adjustment of the frequency response curve,
click on this button to instantly readjust the curve (in a way that prevents

clipping).

Create Copy

As with most of the other Effects menu items, this important option determines
whether an undo will be created prior to processing the file. As always, we
strongly recommend that you leave this option enabled!

Play/Stop

Click on this button to hear a real-time stereo preview of the filtered audio.

Preview

Click on this button to hear a calculated (processed) preview of the filtered
audio. This option should be used if your machine isn’t fast enough to allow
real-time playback.
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Tip: You can determine the length of the preview by pressing the “Y” key, and entering
the desired number of seconds in the Program Options > Preview Time parameter
box (middle of the window).

Play original

When using the Test/Preview audition functions, click on this button to play
the original (dry) audio. This allows you to quickly compare processed vs.
unprocessed audio.

Settings

Click on this button to open the Advanced Settings window.

This dialog allows you to adjust the factors used in calculating the analysis of
the audio. In most cases, the default values are fine for most work, but you
may wish to experiment with the settings, should you have projects or work
which require(s) greater accuracy.

To improve accuracy in the lower frequency ranges, a higher resolution is
needed (starting at 8192). The accuracy of the analysis (in Hz, at a sample rate
of 44.1 kHz) is listed in the table below:

Resolution Accuracy in Hz
256 172

512 86

1024 43

2048 21.5

4096 10.7

8192 5.3

16384 2.7

32768 1.35

High resolutions (8192) are only needed for low frequency ranges, or specific
(fading) harmonics. Generally, values of 1024 or 2048 are ideal. Values below
1024 rarely yield useful results.

Two important suggestions:

1. If you have drawn very detailed filter curves, it is imperative that you save
the curve parameters. When switching modes or parameters, the curves
will appear to be closely matched but will not maintain the same details.

2. When previewing the filter settings, and working with high resolutions in
real time, please ensure that the Test Buffer setting (File > Options > System)
is the same as, or slightly higher than, the Resolution setting (in the Advanced
Setting dialog of the FFT Analyzer). Real-time previews are not possible
unless this is correctly set.

If the Test audio is breaking up/popping/crackling, this is probably an indication
that you need to adjust the buffer or resolution settings.
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Settings > Analysis Parameters

ANarysis PrecisioN HicH: When analyzed, the audio is separated into
individual blocks. This mode overlaps the blocks by a 50% ratio, providing a
more accurate representation of short sounds (percussion, etc.). Calculation
time is doubled when this setting is selected.

Anarysis PrecisioN Normar: When analyzed, the audio is separated into
individual blocks. This mode appends the blocks, without overlapping them.

Anarysis Accuracy Noise: This is the preferred option for analyzing audio
that has a less distinct pitch (e.g. percussion or cymbals)

Anarysis Accuracy ToNes: This is the preferred option for analyzing audio
that has a more distinct pitch (e.g. guitar or flute)

When working with completed songs (i.e. a file which has already been mixed),
the choice of setting used here will depend on the type of material. You will
need to use your own judgment in such cases.

CuaNNELs LErT: When working with stereo files, select this option to limit
analysis to the left channel.

CHANNELS RicHT: When working with stereo files, select this option to limit
analysis to the right channel.

CHANNELS BorH: When working with stereo files, select this option to analyze
both channels.

Anarysis TiME(s): This parameter allows you to define the number of seconds
that the audio will be analyzed by the FFT Analyzer/Filter.
This setting only affects the display of frequency response in ”Static” mode.

Note: Every time an analysis parameter, or the resolution is changed, the frequency
response is re-calculated. For instance, if you have previously used the “Analyze All”
button to calculate the response for the complete Range, you will need to reuse the
function. This is because the re-calculation (due to the aforementioned changes)
will overwrite the previous analysis results. In this situation, the “Analyze All” button
is re-enabled.

Settings > Filter Parameters

Precision: This parameter allows you to specify the quality level that the FFT
Filter will use when processing the audio file. Low, Normal, and High are the
choices; High offering the best quality, but also taking the longest time for
processing.

PrecisioN Rear TimE: This parameter allows you to specify the quality level
used for real-time previewing of the FFT Filter. Test, Low, Normal, and High

93




"Offline Effects” Menu

94

are the four choices; with High offering the best quality, but also requiring the
most computing resources.

Tip: If your machine isn’t fast enough to allow a real-time preview at the High
setting, try one of the lower settings. The quality of the preview will be slightly lower,
but that won't affect the quality level of FFT Filtering on the audio file.

Max RANGE (DB): This parameter sets the maximum amplification range for
the red curve.

MiN RaNGE (DB): This parameter sets the minimum amplification range for
the red curve. If frequencies are to be completely faded out, set the Min Range
parameter to a low value (e.g. —120dB).

Note: The fader to the right of the graphic display can be used for fine tuning.

TrRESHOLD: When re-drawing the blue curve (Direct/Match Edit mode), only
frequencies that were originally louder than this threshold setting will be
changed. This makes adjusting the levels of partials easier (when using the
“Partial” Draw mode).

Note: The fader to the right of the graphic display can be used for fine tuning.

Settings > Draw Settings
These settings affect the way the frequency response curves are displayed.

Draw Grip: This parameter allows you to toggle the Grid On and Off for the
graphic display.

Curve NuMBERs: This parameter allows you to determine the number of curves
shown in the graphic display. The choices are 1, 2, or 3.

Settings > Dynamic Filter Mode
Three different modes are available when using dynamic filtering.

Direct: A simple crossfade between the two curves is performed.

Circre/DirecT: A crossfade is performed between the two curves, and the
start curve is moved towards the higher or lower frequencies. If you selected a
band pass filter as the start curve, the middle frequencies are changed in time
(filter sweep). The highest value of the start and end curves are determined,
and a range for the "sweep” is set.

Note: If in the Filter Edit mode, you will first need to edit the red curve. If the
complete filter curve is at o dB, no highest value is available for calculation.

Circre: The start curve is moved in this mode. The highest and lowest values
of the start and end curves determine the "sweep” range. The second curve is
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only used to determine the end of the sweep, and otherwise, has no influence
on the end result.

Note: If in the Filter Edit mode, you will first need to edit the red curve. If the
complete filter curve is at o dB, no highest value is available for calculation.

Tip: Use a broadband (noise) signal to experiment with the different settings for the
Dynamic Filter mode. This will allow you to easily hear how the dynamic filter
works.

Settings > Resolution

This parameter determines the number of individual filter bands used when
calculating the filter curves. The actual number of filter bands used is one half
of the value specified here.

Note: Resolutions above 8192 are only needed when performing detailed work with
low frequency Ranges, or for fading individual “partials”. For all other uses, a value
of 2048 or 4096 is usually sufficient.

Settings > Save Setup
Click on this button to save the current parameter settings and filter curves.

Settings > Load Setup
Click on this button to load a previously-saved set of parameters and filter
curves.

Note: Once you have selected the settings, you can close the Advanced Settings window.
The settings will be kept for the remainder of your current Samplitude session, even
if you haven’t saved the settings via the “Save Setup” button. When you restart
Samplitude, the default settings will be loaded when the FFT Filter is opened if the
settings were not saved as a preset.

To view the frequency response of a mix and make desired

adjustments:

1. If the FFT Analyzer/Filter is to be applied directly to a Wave Project, ensure
that it is the currently active window. If the FFT Analyzer/Filter is to be
applied to an Object in the VIP window, ensure that the Object is selected.
(Click on the Object, in the lower half of the track, to select it.)

2. If the FFT Analyzer/Filter is to be applied directly to a Wave Project, mark a
Range in the Wave Project window. If the FFT Analyzer/Filter is to be applied
to a selected Object in the VIP window, proceed to step 3.

3. Select the Effects > FFT Filter/Analyzer menu option, and the FFT Analyzer/
Filter window will open.

4. In the lower-left corner of the window (for Draw mode), select the second
“Curve” mode. The frequency response will be displayed as a curve.

5. Click on (i.e. enable) the Direct/Match option (on the right side of the window
- Edit mode).
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6. Click on the “Analyze All” button. The entire marked Range, or selected
Object, will now be analyzed for frequency content. When the analysis has
finished, the frequency content will be displayed as a blue curve.

7. You can now use the mouse to re-draw any section of the blue curve - i.e. if
the graph shows a tall “spike” at toooHz (and the audio sounds a bit harsh),
use the mouse to re-draw the spike (make it shorter). The FFT Analyzer/
Filter is perfect for taming strident frequencies.

8. Click on one of the Test buttons to hear a real-time preview of your frequency
curve changes.

9. Repeat steps 6 and 7, until you are satisfied with the results. If you’d like to
start the re-draw process over again, click on the “Reset” button, and the
curve will return to its original analyzed state.

10. Click on the OK button to "write” the FFT Filter process to the Wave Project
or selected Object, and to close the FFT Analyzer/Filter window.

Enhancing or reducing sub-bass:

1. If the FFT Analyzer/Filter is to be applied directly to a Wave Project, ensure
thatis the currently active window. If the FFT Analyzer/Filter is to be applied
to an Object in the VIP window, ensure that the Object is selected. (Click on
the Object, in the lower half of the track, to select it.)

2. If the FFT Analyzer/Filter is to be applied directly to a Wave Project, mark a
Range in the Wave Project window. If the FFT Analyzer/Filter is to be applied
to a selected Object in the VIP window, proceed to step 3.

3. Select the Effects > FFT Filter/Analyzer menu option, and the FFT Analyzer/
Filter window will open.

4. In the lower-left corner of the window (for Draw mode), select the first
“Partial” option.

5. Click on (i.e. enable) the Direct/Match option (on the right side of the window
- Edit mode).

6. Click on the Settings button to open the Advanced Settings window. In the
upper-right corner of the window, set the resolution to 16384. Close the
Advanced Settings window.

7. Click on the “Analyze All” button. The entire marked Range, or selected
Object, will now be analyzed for frequency content. When the analysis has
finished, the frequency Content will be displayed as a blue curve.

8. You can now use the mouse to increase or decrease the level of each partial
between 10Hz and 50Hz. Warning: You can potentially damage your monitors
when excessively boosting sub-bass frequencies. Keep your monitor levels low when
experimenting! Click the mouse just to the right of each "partial’, in order to
adjust its level.

9. Click on one of the Test buttons to hear a real-time preview of your frequency
curve changes.

10. Repeat steps 8 and ¢ until you are satisfied with the results. If you'd like to
start the re-draw process over again, click on the “Reset” button, and the
curve will return to its original analyzed state.

11. Click on the OK button to "write” the FFT Filter process to the Wave Project
or selected Object, and to close the FFT Analyzer/Filter window.
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Adjusting the amplitude of an individual instrument or note:

1. If the FFT Analyzer/Filter is to be applied directly to a Wave Project, ensure
that it is the currently active window. If the FFT Analyzer/Filter is to be
applied to an Object in the VIP window, ensure that the Object is selected.
(Click on the Object, in the lower half of the track, to select it.)

2. If the FFT Analyzer/Filter is to be applied directly to a Wave Project, mark a
Range in the Wave Project window. If the FFT Analyzer/Filter is to be applied
to a selected Object in the VIP window, proceed to step 3.

3. Select the Effects > FFT Filter/Analyzer menu option, and the FFT Analyzer/
Filter window will open.

4. In the lower-left corner of the window (for Draw mode), select the first
“Partial” option.

5. Click on (i.e. enable) the Direct/Match option (on the right side of the window
- Edit mode).

6. Click on the “Analyze All” button. The entire marked Range, or selected
Object, will now be analyzed for frequency content. When the analysis has
finished, the frequency content will be displayed as a blue curve.

7. Click on the “Max Zoom” button to zoom the graphic display all the way in.

8. If you wish to adjust the amplitude of an instrument, select the first ‘Hz’
option for the Hz/Notes parameter. Frequency will be displayed in Hertz
(Hz). If you wish to adjust the amplitude of a note, select the second “Note”
option for the Hz/Notes parameter. Frequency will be displayed as musical
pitches (notes).

9. To adjust the amplitude of an instrument, find its fundamental (strongest)
frequency range, and re-draw the “partials” in that area (higher — to increase
amplitude, or lower — to decrease amplitude). To adjust the amplitude of a
note, find the partials in the note’s frequency range and re-draw them (higher
— to increase amplitude, or lower — to decrease amplitude).

10. Click on one of the Test buttons, to hear a real-time preview of your frequency
curve changes.

11. Repeat steps 9 and 10, until you are satisfied with the results. If you’d like
to start the re-draw process over again, click on the Reset button, and the
curve will return to its original analyzed state.

12. Click on the OK button to "write” the FFT Filter process to the Wave Project
or selected Object, and to close the FFT Analyzer/Filter window.

Capturing the frequency response from a recording and applying it to

another recording:

1. If the FFT Analyzer/Filter is to be applied directly to a Wave Project, ensure
that it is the currently active window. If the FFT Analyzer/Filter is to be
applied to an Object in the VIP window, ensure that the Object is selected.
(Click on the Object, in the lower half of the track, to select it.)

2. If the FFT Analyzer/Filter is to be applied directly to a Wave Project, mark a
Range in the Wave Project window. If the FFT Analyzer/Filter is to be applied
to a selected Object in the VIP window, proceed to step 3.
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3. Select the Effects > FFT Filter/Analyzer menu option, and the FFT Analyzer/
Filter window will open.

4. Click on (i.e. enable) the Direct/Match option (on the right side of the window
- Edit mode).

5. Click on the “Analyze All” button. The entire marked Range, or selected
Object, will now be analyzed for frequency content. When the analysis has
finished, the frequency content will be displayed as a blue curve.

6. Click on the Analyzer > Filter button, and the analyzed frequency response
curve will be transferred to the red curve. Click on (i.e. enable) the Filter
option (Edit mode). The red curve (representing the analyzed audio’s
frequency response) is now visible.

7. Click on Cancel to close the FFT Analyzer/Filter window.

8. If the red (analyzed) frequency response curve is to be applied directly to a
Wave Project, ensure that it is the currently active window. If the red
(analyzed) frequency response curve is to be applied to an Object in the VIP
window, ensure that the Object is selected. (Click on the Object, in the lower
half of the track, to select it.)

9. If the red (analyzed) frequency response curve is to be applied directly to an
Wave Project, mark a Range in the appropriate Wave Project window. If the
FFT Analyzer/Filter is to be applied to a selected Object in the VIP window,
proceed to step 10.

10. Select the Effects > FFT Filter/Analyzer menu option, and the FFT Analyzer/
Filter window will open.

11. Click on one of the Play buttons, to hear a real-time preview.

12. Click on the OK button to "write” the FFT Filter process to the Wave Project
or selected Object, and to close the FFT Analyzer/Filter window.

Crossfading between two filter curves:

1. If the FFT Analyzer/Filter is to be applied directly to a Wave Project, ensure
that it is the currently active window. If the FFT Analyzer/Filter is to be
applied to an Object in the VIP window, ensure that the Object is selected.
(Click on the Object, in the lower half of the track, to select it.)

2. If the FFT Analyzer/Filter is to be applied directly to a Wave Project, mark a
Range in the Wave Project window. (Click and drag in the appropriate Wave
Project window to mark a Range.) If the FFT Analyzer/Filter is to be applied
to a selected Object in the VIP window, proceed to step 3.

3. Select the Effects > FFT Filter/Analyzer menu option. The FFT Analyzer/Filter
window will open.

4. In the lower left corner of the window (for Draw mode), select the second
“Curve” mode. The frequency response will be displayed as a curve.

5. Click on (enable) the Filter option.

6. Click on (enable) the Dynamic Start option.

7. The currently displayed blue curve represents the frequency response at the
beginning of the audio file. On the right side of the window under Filter
mode, click on (i.e. enable) the Dynamic End option.

8. Re-draw the red curve (currently centered at odB) to make some relative
changes to the frequency response.
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9. Click on one of the Test buttons, to hear a real-time preview of the filter
curve crossfade.

10. Repeat steps 8 and ¢ until you are satisfied with the results. If you'd like to
start the re-draw process over again, click on the Reset button, and the curve
will return to its original analyzed state.

11. Click on the OK button to "write” the FFT Filter process to the Wave Project
or selected Object, and to close the FFT Analyzer/Filter window.

Problems and Solutions regarding the FFT Filter Analyzer

1. Slight tremolo or rough sounding audio, delay effects:

This can happen when the "Test1” setting is selected in the Precision section
of the Advanced Settings dialog. Use a different Precision setting.

2. Modulation Effects when using extreme filter settings for low frequency ranges:
This is also caused by the "Test1” setting, in the Precision section of the
Advanced Settings dialog. Selecting a different setting may solve this problem.

3. Problems with the real-time preview when using higher resolutions:

Ensure that the File > Preferences > System > Real Time buffer setting is
either the same as, or higher than that of, the Resolution setting found in the
Advanced Setting dialog of the FFT Filter.

4. You are unable to completely eliminate specific ranges of a spectrum:
Ensure that you are using the Filter Edit mode, and reduce the dB Min setting
to a value between —100 to —120 dB.

5. Differences between filtering and analysis:

If filter processing has occurred, and the frequency response of the edited
Range is analyzed a second time, the new analytical process does not coincide
with the corrected frequency response (the blue curve) before processing. Why
not? The responses will closely resemble each other if the Analyze All, and the
Analyze Precision “High” settings are used prior to the filtering process, and
for the new analysis.

6. Unexpected resonance-like artifacts are introduced when filtering with broad
band-passes:

Reduce the angle of the curves by omitting vertical lines when drawing the
curves.

7. The morphing results for the dynamic filtering are uneven when using the Dynamic
Start or End filter mode:

Use the highest Filter Precision setting.

The Direct dynamic filter mode reduces this problem when using smaller
Resolution values. You may need to experiment with different settings for the
other dynamic filter modes.
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8. The results of the calculation (OK), or the non-real-time preview function (Preview)
are somewhat different to the real-time previewing (Test):

If different settings are used in the Filter Precision and Filter Precision Real
Time options (in the Settings dialog), this may result in slight differences in
processing. Take note of these settings when working with the FFT.

Finally, when working with the FFT Filter, work carefully and patiently. Remember
to keep track of all settings to avoid any confusion or inaccuracies, and remember to
make sure that your Undo options are enabled!

Dynamics (Overview)

Overview concerning dynamic manipulation
Three modules are available for dynamic processing:

Dynamics: A simple, quick dynamic module, offering a compressor, expander,
gate and limiter. This module uses an extremely efficient algorithm, making it
very light on CPU resources.

Apvancep Dynamics: The Advanced Dynamics module is a more extensive
tool, which combines a classic dynamic module (compressor/expander/gate),
and an approximating limiter. The output from this module is an unbiased,
optimally-modulated signal with defined volume.

As opposed to the mode of operation used by the Dynamics module, the
Advanced Dynamics module is controlled by the characteristic line, rather than
setups. This approach allows free combinations of operating modes.
Parameter adjustments are possible through direct input, or graphic adjustment
of the characteristic line.

Level detection is performed in (selectable) PEAK, RMS or "fast” modes. In
”fast” mode, computer processing requirements are minimal, but the mode of
operation differs from ”"classic” dynamic modules. The RMS mode mirrors
the dynamic behavior of analog dynamic modules. A more lively sound is
achieved in PEAK mode.

MurriBanDp Dynamics: The most extensive dynamic processing options are
afforded by the Multiband Dynamics module. The primary advantage of
dynamic manipulation in several frequency bands (compared with a standard
dynamics processor) is that "pumping”, and other undesirable side effects, are
drastically reduced. As an example, a level peak in the treble won’t force the
entire signal down in the bass Range, allowing you to focus on the processing
of individual frequency Ranges.

Which module should be used, and when?

Which dynamic module should be used, and when, depends on how focused
the change needs to be. A "Dynamics” module is incorporated into each mixer
channel, and offers extremely light CPU use and simplicity of operation. Its
inclusion on each channel makes the adjustment of overall track dynamics
quick and efficient.
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The sound of an Object, on the other hand, must often be modified very
specifically. For example, the dynamics of an instrument can differ, due to the
change in playing style between the verse and refrain. This is usually desirable,
but can be smoothed or emphasized through precise use of compression. The
use of the Advanced Dynamics module is advisable for precise changes to the
dynamic behavior of the source material, as in our example.

The Multiband Dynamics module is generally used to balance the entire mix,
in the master channel. One problem which may occur is clipping, resulting
from the volume increase of the multiband compressor. To avoid this issue,
it’s often necessary to insert a limiter which will then smooth all overly-hot
levels to the limiter threshold. If using multiband dynamics during CD
mastering, it’s usually better to use the processor in the Object Editor. This
allows you to adjust the processor to suit each song (i.e. each Object, in this
situation, would point to a file that was a full stereo mix of a song).

It should be noted that experienced mastering engineers are often cautious
about using multiband dynamics. Actually, let’s shorten that sentence:
experienced mastering engineers are often cautious, or to put it another way -
"there are no old bold mastering engineers”. Are you starting to see where this is
heading? Multiband dynamics processors have not always been readily available,
although a variant known as side chain dynamics processing (e.g. de-essing)
has been popular since the dawn of compression and EQ. Mastering engineers
are conservative by nature, generally using as little compression as possible.
(There are, of course, always exceptions!). Early multiband compressors were
not phase coherent, resulting in coloration of the phase response. In some
cases, the costs outweighed the benefits.

Over recent years, advances in DSP algorithms and computing power have
resulted in a proliferation of powerful multiband dynamics processors. These
are capable of rectifying mastering problems which were previously difficult
to control. Samplitude’s phase-coherent multiband dynamics processor
represents the pinnacle of this new technology, but is capable of destruction if
used incorrectly or excessively. Some of the world’s most famous mastering
engineers blame the current "inappropriate hyper compression” trend (where
every CD is mastered as loud as possible) on the advent of software/hardware
”Finalizers” and multiband compressors. While this claim may be at least
partly true, the processors are not to blame - the person who controls the
processor determines the product.

Note: Sometimes it is very difficult to avoid hyper compression, as the person who
pays your engineering wages may be demanding the “loudest CD on the radio!”.
Don’t worry, we understand. Just do your best to keep the dynamics as vibrant as
possible.

Samplitude’s multiband dynamics processor is exceptionally powerful, and
although very capable in any situation, it should only be used when actually
needed. If multiband compression is required when working on a multi-track
mixdown, you should first see if the audio can be isolated to one or two tracks.

If so, try using the Multiband dynamics within the Object Editor for those 101
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tracks/ODbjects, rather than inserting the processor over the entire mix. When
mastering, carefully consider the reason for inserting the Multiband Dynamics
module. Be patient when adjusting the parameters, and be sure that your chosen
settings actually "enhance” your mix.

In some cases, you may find that the advanced dynamics processor is more
appropriate for the project. In a mastering situation, this would be termed
"bus compression”, as the processor is inserted over the stereo output buss.
Put simply, the entire frequency spectrum is processed.

The advanced dynamics processor emulates the wonderful sound of vintage
bus compressor/limiters, which shaped the sound of many famous recordings.
On the other side of the coin, you can also use this processor to seriously
mangle your audio into new, unexpected shapes. (Multimedia creators and
sound designers take note!). It’s really a matter of knowing what your audio
needs, then patiently adjusting the parameters until you strike gold.

When using multiband dynamics, it may be beneficial to insert the Advanced
Dynamics module (set as a limiter) after the multiband. If you're close to
running out of DSP power (CPU resources), try using the standard Dynamics
module (set as a limiter) instead.

When CD mastering, it’s recommended that multiband dynamics be used on
a per-Object (CD track) basis. This allows precise control over the individual
CD tracks, with each having different

multiband dynamic settings.

The following table indicates where the various dynamic modules are available:

Dynamics (Compressor/Expander....)

Choose this option to open the Compressor/Expander/Noise Gate/Limiter
window. This window allows you to destructively apply dynamics processing
to Wave Projects, or selected Objects in the VIP window.

: Compressor / Expander / Noise Gate / Limiter - destructive il
Preset: | Paremeters from Mixer or from Object Editor ~|

Compressor) Expander Gain In Out

dB Input 60 50 -40 30 20 0 0
o 25 Attack Release Ratio Thresh.

LI

111}

I:I 50

20 6.0 1.00 -0.2 0o

ms ms dB dB dB

R

Sate Mode: Limiter = s

Ll -100 | 48 # Look ahead 12000 samples

=
Play / Stop . Options... [® Create Copy Cancel
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The Compressor processes the dynamics of an audio sample. The dynamics
algorithms ”look ahead” to eliminate peak distortions, or other artifacts. The
graphics display always indicates the actual dynamics curve. The additional
alternative uses as an expander, noise gate and limiter are variations on the
compression algorithm.

Note: The Mixer (shortcut — “M”) and the Object Editor also contain a compressor
for each channel or Object. These compressors operate in real time within the virtual
environment — the audio material on the hard disk is not altered (i.e. non-destructive
processing).

Mode

The track’s dynamics processor can function as a compressor, limiter, expander,
gate, or distortion device. Select the appropriate mode in the Mode listbox to
apply the specified type of dynamics processing.

Note: Proper use of dynamics processing is an art form in itself — it is beyond the
scope of this manual to go into great detail about the use of dynamics processing in
your Samplitude projects. Great care should be taken when using compressors, as
the effect of removing dynamics from your audio can result in the loss of all excitement
and life from perfectly good recordings! We have assumed that the you have a general
familiarity with dynamics processing, and the terms/methods associated with such
processes.

The dynamics algorithm is similar to that of a “classic” compressor.

The dynamic of a frequency band is limited, loud sections are reduced (i.e.
compressed), and soft audio sections maintain their level. This setting is used
if the compression is to result in a coloration of the audio material without
causing the volume to rise.

The compression ratio is configured with the ratio control, the threshold with
the threshold setting, and the envelope is controlled with the Attack and Release
settings.

Comp Max: This mode is exactly the same as the compressor, but the output is
normalized to odB.The dynamics of a frequency band are limited, loud passages
stay loud, and soft audio sections become louder. This setting is often used to
add "presence” to audio material, making it more prevalent, or to increase
loudness. Other terms for this type of processing are “Maximizer” or “Loudness
Enhancer”.

LimITER: This mode limits the dynamics of audio to a predefined threshold.
Loud sections (i.e. above the threshold) will be reduced, but soft sections (below
the threshold) are unaffected.

The ratio is automatically set to infinity when in this mode.

LiMITER 100: This mode is exactly the same as the limiter, but the output is
normalized to odB.
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The ratio is automatically set to infinity when in this mode.

ExpaNDER: The dynamics of a piece are increased, loud passages stay loud,
soft passages (i.e. below threshold level) become even softer. Dynamic expansion
is often used for voice-overs that have a high distortion level. Through
expansion, the spoken voice is lifted above the noise level, which is in turn,
suppressed.

Expansion can also be used to restore dynamic range to old recordings, LPs
and cassettes, for transfer to CD.

When using expansion, a certain reserve of level must exist in order to avoid

clipping!

Gare: This mode suppresses audio that is below the predefined gate threshold.
Audio above the gate level will pass through unaffected. Very soft passages
(below the threshold level) are zeroed. Please note that the gate function is also
part of all other modes. Using the dedicated Gate mode reduces processor load
if you don’t want to apply any other dynamics processing at this stage.

Ratio/Threshold

This section controls the ratio and threshold parameters. You can use the sliders
to modify current settings, or type the desired settings directly into the boxes.
Notice that the visual display (left of the window) changes to reflect the current
ratio and threshold settings.

Note: Click on the “Linear” button to quickly reset the ratio parameter to a 1 to 1
setting (Compressor or Expander disabled).

Attack/Release

This section controls the Attack and Release parameters. You can use the sliders
to modify current settings, or type the desired settings directly into the
numerical data fields.

Gain
Shifts overall output level to compensate level cut

Gate

This section controls the Level parameter (threshold) of the gate. You can use
the slider to modify the current setting, or type the desired setting directly into
the numerical data field. Notice that the visual display changes to reflect the
current gate level (threshold).

Tip: The gate can be used in any mode by setting the threshold with this parameter.

Play/Stop

Click on this button to audition your dynamics processor changes in real time,
without leaving the Compressor/Expander/Noise Gate/Limiter window. All
tracks in the VIP will play back, allowing you to make dynamics processor
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adjustments in the context of the entire production. You can also solo the
processed audio by selecting the solo button in the VIP.

OK
Click on this button to accept the current dynamics processor settings, and
close the Compressor/Expander/Noise Gate/Limiter window.

Cancel
Click on this button to close the Compressor/Expander/Noise Gate/Limiter
window, without accepting changes to the dynamics processor settings.

Create Copy

As with most of the other Effects menu items, this important option determines
whether an Undo will be created prior to processing the file. As always, we
strongly recommend that you leave this option enabled!

Bypass

Click on (enable) this option to bypass the dynamics processor. This allows
you to quickly toggle the dynamics processing on and off, allowing comparisons
between the processed and unprocessed audio.

Presets

Save: Click on the “Save” button to save the current dynamics processor settings
as a preset. A standard Windows "Name File” dialog will appear. Name the
preset and click OK, and the preset will be saved.

Loab: Click on the “Load” button to load a previously saved dynamics processor
preset. A standard Windows "Open File” dialog will appear. Select (i.e. click
on) the preset you want to load, and click OK. The preset will be loaded.

Deiete: Click on the “Delete” button to delete a previously saved dynamics
processor preset. A dialog will appear, asking if you are sure that you want to
delete the preset. Click “Yes” to delete the preset. Click “Cancel” to cancel the
delete. You can use the preset drop-down list (upper-left side of the window) to
quickly load any previously saved dynamics processor presets. Simply click on
the menu, and select the desired preset.
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Advanced Dynamics

Advanced Dynamics - destructive D x|
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Envelope Compressor 1 Compressor 2

Attack Release Ratio Thresh. Ratio Thresh. ch
-F
mla -
= = 10
= = (i 20
5 = = = a0
= i =| -0
50
50
20.0 500 | | 100 | | 200 | | 100 -40.0 | oo
me ms 5 B db a8
- .
Sete (5). Limitec(d), Mode: Compressor 2 - #l Look ahead | 12000 Bypass
Level: | <96 | dp Thresh.: ‘ 01 dp |l Hard = femeter

Reaction: @ Peak < RMS @ Fast

= =
Play / Stop Ext. Options.. [ Create Copy Cancel
L =

General controls and presets

Harp: When active (i.e. with the switch pressed), the output signal is limited
to the defined value. This means that no sample will be louder than the limiter
level. Signals are not simply cut off at the limit, as the algorithm attempts to
“move” the signals to this limit as gently as possible, without changing the
original sound. If the switch is not depressed, the algorithm regulates levels in
accordance with the defined transmission characteristic, and behaves like an
analogue limiter.

SoFr — KNEE: This indicates the rounding off of the characteristic lines. Value
Range is 1 to 10, where 1.0 means no rounding off. “Rounding off” is practical
when the constant change between compressed, and uncompressed, signals is
clearly apparent - i.e. the signal level fluctuates around the knee. Knee is used
to achieve a soft transition.

DyNaMIc scoPE: Visualizes the input and output of the signal during dynamic
processing.

RepucTioN pispray: Displays the mean level difference between output and
input.

INpUT Dispray: Displays the input level in dB.
Outrut pispray: Displays the output level in dB.

REsEeT: Resets reduction, input and output displays.
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MobE: Modes are typical applications of Advanced Dynamics. They constitute
default settings, that makes the graphical editing of the characteristics line
easier. For this, the number of editable parameters are reduced according to
the selected Mode, e.g. by selecting Limiter mode, compressor 1 and 2 are
hidden, because they are not needed.

PreseTs: Saving, loading, deleting: This is where all parameters can be saved,
loaded and deleted. The default file extension is *.dy2.

In addition, all Dynamics presets (*.dyn) can be loaded. The parameters are
converted to those available in the Advanced Dynamics module. If saved from
within the Advanced Dynamics processor, the preset will be saved with the
*.dy2 extension.

OK: The parameters are accepted.
CanceL: The parameters will not be accepted.
Herp: Opens online Help.

Processing the characteristic lines (graphically)

In order to graphically process the static transmission characteristic, click on
one of the nodes in the black grid to the left of the window. A tool tip (which
matches the color of the selected node) will appear, indicating the name and
value of the parameter. If you move the mouse, with the button depressed,
you will change the value. It should be noted that moving a characteristic node
may also have an effect on the parameter values of the other nodes, under
certain conditions.

To directly position a node in the characteristic field, click on it with the right
mouse button. A small dialog field will appear, allowing you to directly enter
input and output values.

In order to achieve greater clarity, the different sections are divided into different
colors. The color of the tool tips, nodes, and parameter tabs indicate which
parameter is being edited.

If you have switched on the Hard Limiter option, and a value lower than o dB
is selected, a red “LIMITED ZONE” will appear in the characteristic field. The
level of samples cannot “enter” this zone, and are kept to a level which is
smaller than/equal to the defined limiter level.

In order to hide a node, move the applicable threshold slider to o dB. In order
to make it visible again, the threshold must be below the limiter threshold.

Processing the characteristic lines (parametrically)
TuresHoLD: This is the input threshold value (in dB). levels above this value

cause the respective component to process the audio.

Rartio: Defines the ratio of input level to output level.
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LiMITER LEVEL: level (in dB) determines the maximum level at the output.
Please note the HARD setting.

GartE LEVEL: level (in dB) determines the minimum level at the input. All signals
below this level will have an output signal level of o dB.

Maxke up: Raises the entire static characteristic (in dB), without affecting the
limiter and gate settings.

All changes of these parameters have a direct effect on the static transmission
characteristic, and on each other. As an example, a gate will render all
subordinate level changes ineffective.

All threshold and level settings remain as set. ratio settings can be modified
through make-up and Soft. By changing make-up, only the geometric ratio
between the output and input level (from the view of the threshold points) is
retained. The actual ratio of input to output level is the ratio setting + make-

up.

Dynamic parameters
Level measurement methods: The time function determines how the
compressor reacts to source material.

PEAK: Allows the dynamic module to react in a more lively fashion, but can
tend to be a bit “sharp”.

RMS (Root MEAN SQuark): Corresponds to the operating mode of an analogue
dynamic module; sounds relatively round and balanced, less lively. The time
constant for signal detection (in order to obtain the control signal) is based
solely on the setting of the Attack regulator. Both time constants are also
evaluated here, for signal smoothing (with signal dynamics manipulation).

Fast: The strength of this process is low processor utilization. This setting can
be favorably used to offset peak levels. Use “fast” mode when working at the
limits of your CPU, and the dynamics of Objects require minimal adjustment.
The maximum level at the output is never higher than the limiter level.

The time constants regulate the sound characteristic substantially, time
constants that are too short can lead to distortion effects, while those that are
too long can result in “pumping”.

Atrtack: Time constant for the increase of the signal level (in ms). That is, how
fast the dynamic processing follows an input level peak.

Rerease: Time constant for the drop of the signal level (in ms). That is, how
fast the dynamics processing reacts on an input level decay.

Preview: If this switch is inactive, the dynamic section does not operate in
preview mode. This may result in artifacts (pumping) and over-modulation.
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On the flipside, steep attack phases of the wave forms are not smoothed without
preview activated — and the sound character therefore tends towards being
“brisk and lively”. You should disable preview if trying to emulate the behavior
of analogue dynamic modules.

The Dynamic Scope

This scope appears when the Play/Stop button is pressed. A “snow cloud”
appears in the characteristic field. Each individual point in the snow cloud
represents the difference of output values, above the respective input values
(in dB).

The use the Dynamic Scope can be easily explained with the following example:
Select preset o - “NULL” - and press PLAY. You'll see that the “snow cloud” is
not visible, as all sample levels are on the gray straight line — i.e. all output
values are equal to the input values.

If you slide the make-up fader upwards, you can see that the “snow cloud”
follows the characteristic. If you select very high time constants, this takes
place relatively slowly.

Selecting a relatively small Attack time (10 ms), a long Release time (400 ms)
and a severely arched characteristic can move the effect towards “pumping” —
give it a try! The “restlessness” of the cloud graphically reflects “pumping”.
By selecting very small time constants, you can visualize the operating mode
of a simple harmonic generator.

Tips and hints for the Advanced Dynamics module

In addition to its sonic characteristics, the strength of the Advanced Dynamics
effect is in the visually-supported processing of the characteristic. Quick success
comes from the selection of one of the supplied presets, and making small
adjustments to the characteristic, dependent on the source material. This is
very simple, as you can accurately separate the individual signal components
with the help of the Dynamic Scope.

If the “snow cloud” moves jerkily, this is probably due to an inappropriate
time constant setting. Check and adjust, this setting to suit your tastes/needs.
Save your own presets.

In order to couple “analogue” limiting with the hard limiter algorithm, define
the Limiter level at the maximum desired sample level. Once set, you can
simulate an “analogue” limiter by using an extreme ratio setting (compressor
10.0 or expander 0.1).
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Multi -band Dynamics
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The multi -band dynamics processor allows you to edit the dynamics, in up to
four independent bandwidths (frequency bands). The complete signal, including
the control signal, is separated into individual frequency bands, and each band
is individually processed by a dynamics processor.

Once processed, the individual bands are reassembled, without any phase
shifting, or alteration of the frequency response. Responsible for the high quality
process is the FIR filter technique employed during the processing.

If no dynamics processing takes place, and the separated frequency bands are
reassembled, the audio material returns to it’s original state, without any quality
loss.

The biggest advantage of the multi -band compressor (over the standard
compressor) is the fact that problem issues such as; obvious “pumping”, or
other unwanted side-effects are drastically reduced. As an example, a peak in
the bass bandwidth would normally “pull down” the rest of the signal, during
processing. This issue can be side-stepped with a multi -band processor, set to
only compress the peaking bass frequencies. The multi -band compressor allows
specific treatment of individual frequency ranges.

Characteristics

The upper-left-side graphic display shows the dynamics reference line. It
represents the relationship between the input level (upper label, in dB) and
the output level (left-hand label, in dB).

The reference lines always shows the dynamics settings for all frequency bands
in the Filter section, each line in its corresponding color. You can move one
band on top of the set of curves for a better visibility by selecting one of the
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bands edit controls or clicking its according band number (1..4).

Cory To ArL: Click on this button to Copy the selected band’s Dynamics
Processing. The settings of this band will also be applied to ALL currently used
bands.

Filter Settings

The upper section of the dialog contains the settings for the Filter. The graphic
display indicates the approximate frequency responses of the individual bands.
Each band has its own colored line. The left axis label displays the absorption
(reduction) in dB. The upper numbers show the frequencies in kHz.

This section controls the frequencies of the different bands, and their overlap.

1..3: These sliders adjusts the Cutoff frequency of the Filters. The Cutoff
frequency of the fourth Filter is determined automatically by the frequency
(and bandwidth, for bandpass Filters) of the adjacent Filter.

You can switch the frequency and dB (amplitude) axes between Lin (linear) and
Log (logarithmic) curves. (Log. provides more resolution in lower Ranges, Lin.
provides more resolution in higher Ranges.) Use this display to help visualize the
different bands.

Gain Enhancement/Reduction
The top-left grid shows the frequency bandwidth, while the display underneath shows
the gain reduction being applied to each band.

Setup

Bands

The multi -band Dynamics Processor can function as a broadband, 2-band, 3-
band, or 4-band Dynamics Processor. Select the desired number of bands in
the list box:

Tip: As you make changes to these settings, notice that the frequency Display updates
to reflect the current settings.

BAND SEPARATION: Select the amount of the Separation between bands (how
much the filters will overlap) in this menu.

Look AHEAD: If this option is checked, the dynamics section will perform a
look-ahead preview. When unchecked, “pumping” or distortion may be
introduced. Note that unchecking this option will not automatically “level”
steep attack phases of the waveform, which may result in “sharper” audio
material. The setting affects all bands.

Link BanDs: Click on (enable) this option to link all bands of the dynamics
processor. Any changes made to a band will be applied to ALL currently used
bands.

111




"Offline Effects” Menu

112

Byprass pyN.: During audio playback, click on (enable) this option to bypass the
currently selected (red) band.

Byprass arr: During audio playback, click on (enable) this option to bypass all
multi -band Dynamics Processing.

Note: If Link bands is active, it does not guarantee that the settings for all bands are
set to the same values. Only parameters that were changed after the Link bands
option was activated will match. If all parameters of the bands are to be set to the
same values, use the Copy To All option.

Band 1.4

The parameters for the Dynamics section are located to the lower half of the
dialog. The controls for each of the four dynamics bands are functionally
identical.

Gain

This section controls the make-up gain parameter for the band. This parameter
is not available when the selected band is using the Comp Max or Limiter 100
setting.

Rartro: Defines the ratio of input level to output level.

TuresHoLD: This is the input threshold value (in dB). levels above this value
cause the respective component to process the audio.

Attack: Time constant for the increase of the signal level (in ms). This is, how
fast the dynamic processing follows an input level peak.

Rerease: Time constant for the drop of the signal level (in ms). This is, how
fast the dynamics processing reacts on an input level decay.

Gate

This section controls the level parameter (Threshold) of the Gate. You can use
the slider to modify the current setting, or type the desired setting directly into
the numerical data field. Notice that the visual display changes to reflect the
current Gate level (Threshold).

Mode

Each band’s Dynamics Processor can function as a compressor, Limiter,
Expander, or Gate. Select the specific type of Dynamics Processing to be applied
in the Menu. The functions of the controls (in the Dynamics section) are
generally similar to that of the standard dynamics section (Compressor, Limiter,
Expander, and Gate). For detailed Information Refer to the “Dynamics” Chapter.
In short: The compressor, Expander and Limiter algorithm is similar to that of
a “classic” compressor, Expander or Limiter, the Comp Max and Limiter 100
settings will automatically apply maximum make-up gain, by normalizing the
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output of the band to odB. The Gate is available in all other modes too, as a
dedicated mode it saves computing power for that band.

Soro: During audio playback, click on (enable) this option to Solo the currently
selected (red) band. This is a very useful feature.

Out (All)

This section controls the output volume (makeup gain) parameter, for the
combined (summed) output of all bands. This control is especially useful for
getting an idea of what the process sounds like, without adding the volume
amplification of the dynamics process. The fader can easily be set to a level
that is similar to that of the input signal.

Limiter On (Only in the Mixer Master section)

This option is not available when using the multiband compressor via the
Effects menu. When using the multiband compressor in the Mixer Master
section, you can switch to, and edit, the Peak Limiter directly from the multiband
Dynamics Section. This Peak Limiter provides level limiting when using the
multiband Dynamics, increasing the loudness of your mix.

CREATE copy: As per most of the Effects Menu items, this important option
determines whether an Undo will be created prior to processing the file. We
recommend that you leave this option enabled!

Play/Stop

Click on this button to audition your Dynamics Processor changes in real-
time, without leaving the compressor/Expander/Noise Gate/Limiter window.
All tracks in the VIP will play back, allowing you to make Dynamics Processor
adjustments - in the context of the entire production. You can also solo the
processed audio by selecting the solo button in the VIP.

OK
Click on this button to accept the current Dynamics Processor settings, and
close the compressor/Expander/Noise Gate/Limiter window.

Cancel
Click on this button to close the compressor/Expander/Noise Gate/Limiter
window, without accepting changes to the Dynamics Processor settings.

Presets

Save: Click on the Save button to save the current multiband Dynamics
Processor settings as a preset. A standard Windows “Name File” dialog will
appear. Name the preset, and click OK.

Loap: Click on the load button to load a previously saved multiband Dynamics
Processor preset. A standard Windows “Open File” dialog will appear. Select
(click on) the preset you want to load, and click OK.
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DeireTE: Click on the Delete button to delete a previously saved multiband
Dynamics Processor preset. A dialog will appear, asking if you're sure that you
want to delete the preset. Click Yes to delete the preset. Click Cancel to cancel
the Delete.

Tip: You can use the preset drop-down list to quickly load any previously saved
maultiband Dynamics Processor preset. Simply click on the menu, and select the
desired preset.

Strategies to Cope with the Flood of Parameters

A multi -band dynamics processor (naturally) contains many parameters —
which can be confusing for inexperienced users. The following strategies may
help with editing, using all bands.

If you need to alter all bands, rather than one individual band, the following
steps may be useful. The frequency settings are based on the standard
configuration:

Step 1: Making Global Preparations for all bands

1. Select the Dynamics Setup that is closest to your desired results. As an
example, if you need to add loudness to your audio material, use the
compressor Max setting. Use compressor if presence needs to be added, or
recorded speech needs become more transparent. This setting will not
increase the overall loudness, and is perfect for clarifying muddy recordings,
adding a “kicking” bass for pop music etc. The setup only affects the currently
selected band (white filter curve). Click on Copy To All to transfer the current
setting to the other bands.

2. Activate Link bands. Any changes you perform in the current band are
automatically mirrored on the other bands.

3. Change the configuration of all bands, until the audio sounds right to your
ears.

Step 2: Fine-tuning of Individual bands

1. Turn off Link bands, and select a band.

2. Activate the Solo mode. Individual bands can be isolated (heard
independently) in this mode, making the task of optimizing settings for
each band easier. Ideal settings for the higher frequency bands are “small”,
as the waveforms are shorter.

3. If you can’t find satisfying settings for some of the bands, try to change the
split frequency setting for the selected band. A narrow band setting may
help prevent “pumping” artifacts in the sound.

If you only wish to edit a specific, and critical frequency range, a different
approach can be taken:

1. make sure that Link bands is turned off. Activate the Play Solo option, and
select the band you wish to edit. If you don’t know the exact frequency
Range, simply work progressively through some of the bands.
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2. Change the split frequencies of the selected band, in order to “filter out” the
critical range.

Now you're ready to perform some dynamics editing. First up, select an

appropriate Dynamics Setup.

— To limit critical frequencies, for tasks such as de-essing, Limiter or
compressor Setups can be used.

— Use the Bypass Dyn. checkbox to compare the processed and unprocessed
bands.

— Turn the Play Solo option off, and compare the original signal with the
processed signal. To do so, make use of either; Bypass Dyn. or Bypass All.

A third option is to compare the default presets. Some may provide a great
starting point. In most cases, good results can be achieved by starting out with
one of the presets, and some judicious tweaking.

The presets, however, will only get you so far. Dynamics processing belongs to
the family of algorithms that are entirely dependent on optimal settings, and
on the type of audio material being processed.

Different types of audio material will also have a big impact on the type of
settings. The original dynamics, the volume level, and the source material are
all equally important. Other aspects to consider include; the frequency response
of the audio source, and the proposed use of the processed audio.

Comparing at constant volume levels

If the task is to compare the sound differences, without allowing the dynamics

processing to alter the volume levels, this method can be used to accomplish

the task.

— Use the output All control to adjust the volume until the audio signal level
matches that of the bypassed level - i.e. when the Bypass All option is used.

— Compare the levels by repeatedly checking the bypass option, and adjusting
the output levels.

If the multi -band compressor is used in the Mixer window’s Master section,
the peak meters can be visually used to assist with this task.

Reducing the CPU load

The multiband compressor’s algorithm causes a high CPU load, which is
influenced by the settings in the filter section. The CPU load increases with
the use of the following settings:

— Low Split frequencies

— Increased number of bands

— Larger settings for the Separation parameter

Should the real-time use (in the Mixer or when using Test for playback) lead to
a CPU overload, you may need to attempt matching the results by using settings
that are less processor intensive:
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1. A high setting for Separation (Normal, High) is only needed in a few special
cases. As an example, individual bands may need to be precisely separated
from the other bands, for treatment of a very specific frequency area.
Typically, this would involve specific bands that are exposed to extreme
dynamics manipulations.

Dynamics treatment of the low bass range often benefits from a high Separation
setting. This smoothes the frequency response of the source signal, even
for lower settings.

2. The values in the lower split frequencies should not be set to a value that is
smaller than necessary.

3. Only use as many bands as are really needed. Three bands are often enough
for standard use. As an example, if it’s only the bass range that needs to be
treated, two bands are sufficient.

Finally, when using the multiband Dynamics Processor, always take care not
to overdo the processing. This subtlety is only learnt through experience, but a
good general rule to follow is “less is more”....

Careful checking of each band (by using the Play Solo option) will help in this
respect.

De-clipping

This unique Samplitude function removes digital or analog clipping. Anybody
who records audio has encountered this problem at some point.

Declipping - destructive il

- Presets
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3
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1
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Samplitude uses high-grade algorithms to interpolate the “clipped” passages,
using the material that precedes/follows the clipped portion as a reference
point. Once processed, the total volume level for the material can be further
reduced to prevent any additional clipping.

The de-clipping algorithm is especially useful on material that contains obvious
but not heavily distorted clipping, such as a piano or voice recording. It does,
however, have limits — heavily distorted material cannot generally be repaired,
although you may be able to significantly improve the damaged audio.
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Clipping Definition

MiN NUMBER OF CLIPPED SAMPLES (> I): This parameter defines the minimum
number of consecutive clipped samples that must occur before Samplitude’s
de-clipping algorithm will repair the distortion. A value of three works well in
most instances.

MIN LEVEL OF CLIPPED SAMPLES (< odB): This parameter defines the volume
level at which Samplitude’s de-clipping algorithm assumes that the audio is
distorted (In other words a Threshold level, like that found in a compressor).
Start with a value of -0.5dB. If clipping persists, reduce this value until the
clipped audio is repaired.

A number of sound cards exhibit different clipping behavior, so adjustments
to this setting can be an important issue. Some DAT recorders have an analog
protection mechanism that prevents the incoming level from reaching the digital
maximum signal. For such devices, a setting of —o.5 dB (or lower) makes sense.
By entering a value of -6 dB, all samples above half of the digital maximum
are considered “distorted”, and are recalibrated. Even distorted analog material
can be improved with this algorithm.

Note: Once again, it helps if you are patient, and careful, when repairing audio in
this manner. If at all possible, take the time to repair the clipped samples sequentially
(i.e. one “clipped section” at a time), rather than processing the entire file in one
pass.

GeT LEVEL FROM HEIGHT: Click on this button, and the height of the marked
Range will be used to define the Min. level of clipped samples (< odB) parameter.
Maybe you’ll have to switch “Fix vertically” in the View menu into “off” state
to define vertical ranges. This function is very useful when correcting clipped
samples sequentially i.e. one “clip” at a time (see above)

NUMBER OF STEADY SAMPLES AFTER CLIP (I....I0): This parameter defines the
number of “steady” samples used to determine the end of the distorted segment.
In other words, a number of samples that follow the distorted section, that
remain at a constant level. A number of lower-end audio cards (e.g.
SoundBlaster, and others) produce chaotic values during a clipped segment.
For such devices, the only way Samplitude can determine the endpoint of the
distorted segment is to increase this parameter value to a setting between 5
and 10. If your audio card is less erratic when playing a clipped segment, you
can reduce this parameter to a value of 1.

De-clipping Mode

Adjust maximum level to odB — (Recommended for 16 bit recordings, or when
in 16 Bit Integer Internal Precision mode) Click on (enable) this option to
Normalize the audio, after the de-clipping process. This is recommended if
you work with 16-bit material, as there would be no “volume reserve”
(headroom) available for the correction of the distortion. When working with
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floating point material (24-bit Wave Project), this option can be disregarded,
given that the floating point format offers an unlimited dynamic range.

Load Setup
Click on this button to load a previously saved de-clipping preset.

Save Setup
Click on this button to save the current de-clipping parameters as a preset.

Create Copy

As per most of the other Effects menu items, this important option determines
whether or not an Undo will be created, prior to processing the file. As always,
we strongly recommend that you leave this option enabled!

Preview

Click on this button to audition a (processed) preview of your current de-clipping
settings. The duration of the preview is determined by the preview Time setting
in the Options > System (Shortcut -Y) menu.

OK
Click on this button to write the current de-clipping settings to the audio file,
and close the de-clipping window.

Cancel
Click on this button to close the de-clipping window, without applying any
processing.

Remove DC Offset

Choose this option to remove DC-offset from a Wave Project, or selected Objects
in the VIP window. DC-offset occurs when the audio waveform is not (vertically)
centered at the Zero amplitude Line. In other words, the waveform is centered
either above or below the Zero amplitude Line. DC-offset can cause clicks,
glitches or other inaccuracies, and should always be removed before applying
processing.

Tip: Some audio cards are responsible for the DC-offset while recording, and others
are not. To check for DC-offset, Zoom-In on a waveform, and see if it is (vertically)
centered at the Zero amplitude Line. If the waveform is not centered at the Zero
amplitude Line, use the Remove DC-offset option to fix the problem.

The effect performs in two stages, first it analyses the audio data and then it
removes the DC offset. You can set a minimum dB threshold. If the analyzed
DC offset is below this value, no removal takes place. This will become useful
in batch processing to spare calculation time.
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Get noise sample

Use this to get a sample of the noise used in the noise reduction function.
For general information on noise reduction read the according manual chapter.
This function is the first step in the noise reduction process.

The noise reduction function can be used to effectively remove annoying noisy
material from the audio, with minimal discoloration or other artifacts. In order
to achieve this, the algorithm first needs a sample (noise print) of the noise
that you wish to remove. This is most effective with constant noises such as; a
ground loop, air conditioner hum, tape hiss or feedback.

Before using noise reduction, you must first make a noise print (of the noise
you wish to remove).

To do so, mark a Range in the Wave Project or selected Object that contains
ONLY the noise. Then, select this option to take the actual “Noise print”.
Note: If the “Noise print” contains audio (as well as the noise), it will also be
removed. So....be sure that the “Noise print” ONLY contains noise!

The duration of the noise print should not be too short — Samplitude will
display a dialog if a longer sample is required.

Noise reduction

(Please refer to previous Item — get noise sample before proceeding)

This option opens the noise reduction window. This window allows you to
apply graphic “Noise print” style noise reduction to Wave Project, or selected
Objects in the VIP window.

Noise Reduction - destructive il
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Important note: You must first use the get noise sample option to take a “Noise
print” (of the noise to be removed) before using noise reduction. (see previous Item)
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Here is a quick overview of the steps involved:

1. Select a noise sample as explained above.

2. Next, select the section in the Wave Project (or select the VIP Object) that
requires the removal of the noise signal.

3. Open the noise reduction dialog via the Effects menu.

4. In the noise sample box, select the noise sample setting. This file contains
the noise print.

5. You may wish to preview the changes before committing them to the audio
material. To do so, click on the preview button.

6. make all desired changes in the dialog, or load a preset and click on OK to
process the sample.

Noise sample
The “Noise print” created with the get noise sample option will automatically
be displayed (selected) in this drop-down list.

Tip: Any loaded Wave Project can be selected from this drop-down list, and used as
a “Noise print”. As an example, say you've recorded several guitar tracks through
an amplifier that generates a significant amount of 6o cycle hum.

Rather than taking a “Noise print” for each individual Track, you can mark a
Range in one Track (containing the hum - in isolation) and copy that “Noise print”
to a new sound file (Wave Project). You can then use this sound file (“Noise print”)
to remove Go cycle hum from ALL guitar tracks recorded through the noisy amplifier.
In other words, you can create an archive of commonly used “Noise prints” to speed
up repetitive noise reduction tasks.

Play

Click on this button to listen to the “Noise print”. Check for evidence of audio
you may not want to remove from the file. If you can hear audio you don’t
want removed, create a new noise print.

Draw Mode
In the first mode, the frequency response is displayed as a solid curve. In the
second mode, the frequency response is displayed as a line.

Freq lin / log

Linear display of frequency provides a more detailed view of the higher end.
Logarithmic display of frequency provides a more detailed view of the lower
end.

dB lin / log

Linear display of amplitude provides a more detailed view of the higher end.
Logarithmic display of amplitude provides a more detailed view of the lower
end.
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Presets

(TypE oF) Noisk: To make the noise reduction process quicker/easier, you can
select presets that specify the type of noise (to be removed. Samplitude will
adjust the noise reduction parameters accordingly.

MEep1uM TONAL NOISE (E.G.: HUM): Use this preset for reducing 60 cycle hum,
and other tonal noise.

HARrD ToNAL NOISE (E.G.: HUM): Use this preset for reducing louder 6o cycle
hum, and other louder tonal noise.

Low BROADBAND NOISE (E.G.: HISS): Use this preset for reducing low-level
hiss, and other low-level broadband noise.

MEDIUM BROADBAND NOISE (E.G.: HISs): Use this preset for reducing louder
hiss, and other louder broadband noise.

HARD BROADBAND NOISE (E.G.: HIss): Use this preset for reducing severe hiss,
and other severe broadband noise.

GRAMOPHONE I MEDIUM (E.G.: VINYL): Use this preset for reducing vinyl noise.

GRAMOPHONE 2 HARD (E.G.: viNYL): Use this preset for reducing louder vinyl
noise.

(TypE oF) Aubpio MateriaL: To make the noise reduction process quicker/
easier, you can also select presets that specify the type of audio (from which
the noise will be removed). Samplitude will adjust the noise reduction
parameters accordingly.

SPEAKING Voice: Use this preset when applying noise reduction to Speech.

SINGING Voick: Use this preset when applying noise reduction to Vocals.

Fast Beats / pERcUssION: Use this preset when applying noise reduction to
percussion or other short “choppy” audio.

Songs: Use this preset when applying noise reduction to complete mixes.

ORCHESTRAL INSTRUMENTS: Use this preset when applying noise reduction to
individual instruments.

Tip: Use these presets. They’ll enable you quickly “dial in” noise reduction settings
that produce the desired result, and minimize potential side-effects.
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Algorithm’s Internal Parameters

Resorution: This parameter allows you to set the resolution (Low, Medium,
or High) used by the noise reduction algorithm. The higher the resolution, the
longer the algorithm will take to process. You may wish to experiment with
this parameter because a higher resolution does not always guarantee the best
results. As an example, Low resolution often works best when applying noise
reduction to short percussive sounds, and speech.

Precision: This parameter allows you to choose the quality level that will be
used to for noise reduction. Low, Normal, and High are the three choices, with
High offering the best quality, but taking the longest to process.

PrecisioN Rear-TiME: This parameter allows you to choose the quality level
used for real-time previewing of noise reduction. Test, Low, Normal, and High
are the four choices, with High offering the best quality, but requiring the
most processing (CPU) resources.

Tip: If your machine isn’t fast enough to provide a real-time preview at the High
setting, try one of the lower settings. The quality of the preview will be slightly lower,
but this won't affect the quality of the actual noise reduction process on your audio

file.

Absorption

This parameter determines the intensity (Low, Medium, or High) of the noise
reduction algorithm. You can use the Fader to fine-tune the setting.

The low, medium and high settings determine the effectiveness of the
algorithm. The fader allows fine-tuning of the setting, which always operates
in the selected setting range. This parameter sets the level of the noise print
sample absorption (or amplification). This is visible in the graphic display.
The yellow curve indicates the original spectrum of the noise print sample,
and the blue curve represents the corrected spectrum. The latter is used to
remove the noise from the audio.

Tip: In most cases, you will want to adjust the Absorption parameter to be just
aggressive enough to reduce the noise. Extreme settings are likely to cause artifacts.

Mix (Reduction)
This parameter determines the amount (in dB units) that the noise is reduced.

Tip: Quite often it is actually beneficial to leave a little noise in the audio. Removing
all of the noise is usually impossible without damaging the remaining audio. Such
damage can include artifacts such as; strange flanging sounds and whistles. Think
of the process in terms of reduction, not 100% elimination. As always, be patient,
try a number of settings, and select the ones that deliver optimal results.
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Artifact Suppression

When trying to reduce high levels of noise, artifacts can often occur (see above).
This isn’t a limitation of Samplitude, but rather a universal by-product of current
noise reduction techniques. If you encounter artifacts when applying noise
reduction, the following three parameters may prove useful (in addition to
reducing settings such as Absorption and Mix).

SmootrH Atrack: This parameter controls the Attack when applying noise
reduction. A higher value will reduce artifacts, but alters the response time of
the audio. Generally speaking, this parameter is most effective for diminishing
artifacts in musical tracks.

SmoorH RELEASE: This parameter controls the Release when applying noise
reduction. A higher value will reduce artifacts, but alters the decay of the audio.
Generally speaking, this parameter is most effective for diminishing artifacts
in percussive (instruments with short decay) tracks.

Static Firter SmootH: This parameter “levels” the Spectrum of the noise
sample. (To better understand what this parameter does, look at the blue curve
in the graphic display.) This “leveled” Spectrum is then used to calculate the
noise reduction. Generally speaking, this parameter is most effective for
diminishing artifacts in vocal, or other “smooth”, tracks.

Create Copy

As per most of the other Effects menu items, this important option determines
whether or not an Undo will be created, prior to processing the file. As always,
we strongly recommend that you leave this option enabled!

Play/Stop

Click on this button to audition the noise reduction in stereo.

Preview

Click on this button to hear a calculated (processed) preview of the noise
reduction. This option should be used if your machine isn’t fast enough to
provide a real-time preview. The duration of the preview is determined by the
preview Time setting in the Options > System (Shortcut -Y) menu.

Play Orig

When using the Review functions, click on this button to play the original
(dry) audio. This allows you to quickly compare processed vs. unprocessed
audio.

OK
Click on this button to write the current noise reduction to the file, and close
the noise reduction window.
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Cancel
Click on this button to close the noise reduction window, without applying
any processing.

Load Setup
Click on this button to load a previously saved set of noise reduction parameters.

Save Setup
Click on this button to save the current noise reduction settings.

To use noise reduction:

1. If noise reduction is to be applied directly to an HD Wav or RAP file, ensure
that it (Wave Project) is the current active window. If noise Reduction is to
be applied to an Object in the VIP window, ensure that the Object is selected.
(Click on the Object in the lower half of the Track to select it.)

2. For this example, we will remove 50/60 cycle hum from a guitar Track.
First, mark a Range (in he Wave Project or selected Object) that ONLY
contains 50/60 cycle hum.

Tip: Click and drag in the Wave Project window to mark a Range. Click and drag
(starting in the upper half of the Track) to mark a Range in the VIP window.

3. Select Effects > get noise sample to obtain a ,Noise print” of the 50/60 cycle
hum.

4. If noise reduction is to be applied directly to an Wave Project file, mark the
desired Range in the Wave Project window. (Click and drag in the Wave
Project window to mark a Range.) If noise reduction is to be applied to a
selected Object in the VIP window, proceed to step 5.

4. Open the noise reduction window from the Destructive Effects menu.

. Under the preset section, select Medium Tonal noise for the Noise parameter,
and select either Songs or Orchestral Instruments for the Audio Material
parameter.

6. Click on one of the Play button to hear a real-time audition of the noise
reduction. If your machine isn’t fast enough to keep up with the load of a
real-time preview, click on the preview button and Samplitude will process
a calculated preview.

7. If you are satisfied with the results, click on OK to write the noise reduction
to the audio file. If you are not satisfied with the results, adjust the resolution,
Absorption, and Artifact Suppression parameters, and repeat steps 6 and 7.

V1

Noise reduction Tips

To identify optimal settings please follow the steps below:

1. While familiarizing yourself with the noise reduction processor, always begin
by selecting preset parameters which are appropriate for the type of audio
material that needs correction, and the type of noise.

2. Experiment with the Absorption parameter. Never over-do this setting! Your
audio could lose all of it’s ambience if this setting is too high.
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3. To reduce potential artifacts, increase the Attack and/or Static Smoothing
values. The selected method depends on the audio material that needs
treatment.

4. Always be aware that the Artifact Suppression parameters are affected by
the Absorption parameter, and vice versa. Always search for the optimal
relationship - which balances artifacts against removed noise.

5. It is good practice to check files for DC Offset and remove it (if there) prior
to using noise reduction. (Effects > Remove DC offset)

6. Discoloration of the original audio material can be reduced by repeated use
(i-e. multiple passes) of the noise reduction algorithm. A low Absorption
level should be chosen. Once the first attempt has been executed, the
remaining noise signal in very low volume sections should be used as the
noise print for the next attempt.

7. High level broadband noise can be difficult to remove. It is therefore
suggested that you treat the material - prior to using noise reduction - with
a filter. The Equalizer can be used to cut frequencies that are not used by
the original (desired) audio. As an example, a female voice doesn’t use
frequencies below 200 Hz, and above 8000 Hz, so these can safely be
reduced (but ONLY if necessary!).

For instruments - everything below the lowest note can be reduced. As an
example, if the lowest note played is an A=440Hz then everything below
440 Hz can be cut. This may result in the loss of some harmonics, but
audio repair always involves some trade-offs. The FFT Spectrum Analyze
Filter (Effects > FFT Filter/Analyzer) is best suited for this task.

8. Whether or not artifacts are audible, is particularly dependent on the volume
of the end result, and the frequency response of the audio playback system.
If you know where the audio will be reproduced (movie theatre, TV, radio,
etc.) it may be helpful to repair the audio in similar conditions.

9. For sound designers: The algorithm can be used to achieve interesting
discoloration of the original material, especially if the noise sample contains
material other than that of the noise signals.

10. The algorithm is useful for the removal of incorrectly played notes, if the
notes/tones contain a spectrum with overtones. To accomplish this, a sample
that only contains the wrong note is required. This wrong note can then be
captured as a noise sample.

Once again, the “less is more” approach applies to effective noise reduction.
As the audio engineer, the noise will be far more noticeable to you than most
listeners. On the flipside, most listeners quickly notice processing artifacts
such as flanging/whistling, particularly on vocals. As such, a little remaining
noise is preferable to having weird artifacts in the audio.
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De-hissing

This option opens the de-hisser window, allowing you to apply de-hissing to
Hard Disk (HD Wave) and RAM Projects (RAP), or selected Objects in the VIP
window.

The de-hisser complements the noise reduction DSP. It can be used to remove
constant low-level white noise. This is typically found in material recorded
through low quality pre-amps, or low quality analog sound cards.

The de-hisser does not require a noise-print sample, as is necessary with the
noise reduction DSP. This makes the de-hisser ideal for real-time use in the
Mixer window’s Master section.

The dialog of the de-hisser (when using it in real-time) differs from the dialog
used for off-line processing (‘Effects’ menu).

The de-hisser was combined with a simple FFT (Fast Fourier Transform) filter,
for use in the Master section of the Mixer window. As the de-hisser algorithms
make use of FFT functions, the audio is only processed once, for both DSP
steps.

When using the off-line version of the de-hisser (Effects > de-hissing), additional
control options are available.

Dehisser - destructive il
— Presets
IUnsa\/ed Parameters (Offline Editing) ﬂ Save Load Delete I
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I” Bypass
-114
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I G Ci
Elay / Stop | Freview | Extended options | 4 (et OK | Cancel | Help |
Graphic Display Curves

Three different Curves (each a separate color) are displayed by the graph.

LicuT BruE: The light blue Curve represents the frequency response that results
from the de-hissing process.

Yerrow: The yellow Curve represents the original frequency response (before
applying de-hissing).

DArk Bruk: The dark blue Curve (flat line) represents the “threshold” of the
de-hissing algorithm (defined by the Absorption parameter value).
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Draw mode
In the first mode, the frequency response is displayed as a solid Curve. In the
second mode, the frequency response is displayed as a line.

Freq. lin / log

Linear display of frequency provides a more detailed view of the higher end.
Logarithmic display of frequency provides a more detailed view of the lower
end.

dB lin / log

Linear display of amplitude provides a more detailed view of the higher end.
Logarithmic display of amplitude provides a more detailed view of the lower
end.

Absorption

This parameter determines the intensity of the de-hissing algorithm. You can
use the fader to modify the current setting, or you may type the desired setting
directly into the box.

This parameter determines the threshold between the noise and audio signals.
Finding the correct settings for this parameter is of utmost importance. Unlike
noise reduction, where a useful Absorption value is automatically entered, the
value in the de-hisser dialog needs to be manually defined, as it is highly
dependent on the type of audio material.

Low settings can lead to incomplete removal of noise, or may introduce artifacts.
High settings may discolor the audio material. The louder the volume of the
noise print, the more attention you need to pay to the settings in this dialog

Tip: In most cases, you'll want to adjust the Absorption parameter to be just aggressive
enough to reduce the hiss. Extreme settings will, in all likelihood, cause artifacts.

Reduction

This parameter determines the amount (in dB units) of hiss reduction. You
can use the fader to modify the current setting, or you may type the desired
setting directly into the box.

The highest setting is —30 dB. If the reduction value is low, side effects from
the algorithm (artifacts) remain low. These artifacts can be introduced in
situations where the noise print is relatively loud, or the Absorption settings
are not optimal.

Extremely low volume sections (such as the Fade Out of an instrument sound)
are often critical, as the actual noise print level can exceed that of the audio
signal. These situations may necessitate the use of smaller values for the
reduction parameter (-10 to —15 dB). This may reduce the introduction of
artifacts, and could prove to be a good compromise.
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Resolution

This parameter allows you to set the resolution (Low, Normal, or High) used
by the de-hissing algorithm. The higher the resolution, the longer the algorithm
will take to process. You may wish to experiment with this parameter, as a
higher resolution does not always guarantee the best results. As an example,
Low resolution often works best when applying noise reduction to short
percussive sounds, and speech.

Overlap
This parameter selects the type of “overlap” used by the de-hissing algorithm
(Smooth, Normal or High).

SmootH: Generally speaking, this setting is most effective when applying de-
hissing to musical tracks (or audio with slower attack).

Normar: Generally speaking, this setting is most effective when applying de-
hissing to percussive (instruments with short decay) tracks.

HicH: Generally speaking, this setting is most effective when applying de-
hissing to mixed (multiple instruments) tracks.

Bypass
During audio playback, click on (enable) this option to bypass the de-hisser.

Inverse de-hissing

When using the de-hisser, click on (enable) this option to limit what you hear
to the hiss that is being removed. This is a great way of ensuring that you
aren’t causing side effects by using the de-hisser. If you hear any significant
amount of signal (besides the hiss), you should probably readjust the Absorption
and reduction parameters.

Note: You will find this option to be an essential part of your de-hissing routine.

Create Copy

As per most of the other Effects menu items, this important option determines
whether or not an Undo will be created, prior to processing the file. As always,
we strongly recommend that you leave this option enabled!

When this box is checked, Samplitude will create a copy of the selected Range
into the same audio file as the original material. This allows you to compare
your results with the original material. Please consider the length of the selected
Range, and the available hard disk space or RAM memory.

Play/Stop

Click on this button to hear a real-time Stereo audition of the de-hissing process.
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Preview

Click on this button to hear a calculated (processed) preview of the de-hissing.
This option should be used if your machine isn’t fast enough to provide a real-
time audition.

Tip: You can determine the length of the preview by pressing the Y key (to open the
System window — Program options) and entering the desired number of seconds in
the preview Time parameter box (center of the window).

Bypass.
Click on this button to play the original (dry) audio, when using the Playback
functions. This allows you to quickly compare processed vs. unprocessed audio.

Save Setup
Click on this button to save a set of de-hisser parameters.

Load Setup
Click on this button to load a previously saved set of de-hisser parameters.

OK
Click on this button to apply de-hissing, and to close the de-hisser window.

Cancel
Click on this button to close the de-hisser window, without applying any
processing.

To apply de-hissing:

1. If de-hissing is to be applied directly to an Wave Project file, ensure that it
(Wave Project) is the currently active window. If de-hissing is to be applied
to an Object in the VIP window, ensure that the Object is selected. (Click on
the Object in the lower half of the Track to Select it.)

2. If de-hissing is to be applied directly to an Wave Project file, mark a Range
in the desired Wave Project window. (Click and drag in the Wave Project
window to mark a Range.) If de-hissing is to be applied to a selected Object
in the VIP window, proceed to step 3.

3. Select Effects > de-hissing, and the de-hisser window will open.

4. Enter a value of 40 for the Absorption parameter.

5. Enter a value of 12 for the reduction parameter.

6. Click on the Play/Stop button and Samplitude will process a calculated
preview.

7. 1f you are satisfied with the results, click on OK to write the de-hissing
process to the audio file.

If you are not satisfied with the results, adjust the Absorption parameter so
that it is just high enough to reduce the hiss (without producing artifacts).
You should also readjust the reduction parameter. You may also wish to
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experiment with the resolution and Overlap parameters. Once your setting
have been made, repeat steps 6 and 7.

Tip: As previously mentioned, it’s a good idea to click on (enable) the inverse de-
hissing option (to verify that you aren’t removing too much of the desired signal)
before applying your de-hisser settings.

Suggested steps for finding the optimal Absorption parameter setting:

1. For preview purposes, locate a “critical” section in your audio material. Critical
sections comprise portions of your audio material that contain low level
music or speech. Other such sections are those that contain a relatively
high level of noise when compared to the audio signal, or audio that is
similar to particular types of noise signals. As an example, the “breath”
sound of a saxophone tone may have similar characteristics to a noise signal.
Another example is the sibilance of spoken words. It is easier for the
algorithm to distinguish sounds with overtones, or consonants, from noise
signals.

2. Set the reduction setting to the highest value (-30 dB).

3. Slowly increase the value of the Absorption setting. This can be performed
during playback of the real-time preview.

Adjustments to the Absorption setting causes the audio to go through four
possible stages:

Stage 1: If the value is small, no noise is removed.

Stage 2: The noise is partially removed. Dependent on the level of the noise
signal, a small number of artifacts may be introduced, if the noise is not
completely removed.

Stage 3: The noise is completely removed.

Stage 4: If the value is high, the algorithm not only removes the noise signal,
but also portions of the audio signal. (Use the inverse option to verify the
material that is removed. If portions of the audio signal are included in the
audible signal, the Absorption value is too high.) The audio material loses
definition and sounds dull. This is due to the removal of ambient characteristics.
The task is to reach Stage 3.

Tip: When auditioning the changes, it often helps to use a high monitoring level. It
may also help to tweak the high EQ on your mixing console or amp, but be sure to
return it to it’s “neutral” position before finally accepting the setting! We also
recommend the use of a system with a good signal-to-noise ratio.

4. If the noise signal can not be removed without discoloring the music or
speech, reduce the reduction value until a compromise is reached between
noise reduction/minimal discoloration.

If you destructively reduce the noise of individual audio tracks in a multi-
track VIP, the de-hisser settings become less critical than when using the
de-hisser, in the Mixer Master section, for the complete mix. For higher
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noise levels, you should therefore use the “Effects” menu version of the de-
hisser, and remove the noise from the tracks individually.

Note: When working in multi-track projects, if the hiss is limited to one or two
tracks, you will almost certainly achieve better results by de-hissing the individual
tracks, as opposed to inserting the de-hisser in the Mix Master channel in real-time.
It is far better to only change the tracks affected by hiss.

Once again, the “less is more” approach is often the most suitable for effective
de-hissing. As the audio engineer, the noise will be far more noticeable to you,
than to most listeners. Most listeners will, however, quickly notice processing
artifacts such as flanging/whistling, particularly on vocals. As such, a small
amount of noise is preferable to having weird artifacts in the audio, in most
cases.

Note: When using the real-time de-hisser in the Mixer Master channel, Samplitude
currently requires a VIP Buffer setting of at least 16000. This can be set in the
Options > System dialog (Shortcut — Y). If the buffer is not set to this value (or
higher), the de-hisser will not function. In fact, it will refuse to display.

Manual de-clicker

This dialog enables the destructive de-clicking of individual objects. It contains
the de-clicker, a button for direct Wave Editing as well as Algorithmix
reNOVAtor support.

Manual Declicker - destructive il

Fresets
’]Standard LI Sawve Load welete |

Frojectfile: Declick - |
CAMAGISequoiadAudio\ TutorialiutorD] WAy BCCKer setings

Destructive Declicking | el | P | Editwane project |

Ontylet | oOniyRight | | j

Prewview | Presdiew Time: |2.D SEC.

Settings can be loaded and saved. Self-created settings saved in the FX_presets-
directory are displayed in the preset list.

Spectral Editor - Algorithmix reNOVAtor

Samplitude provides a demo version of the Algorythmix reNOVAtor. This high-
quality effect is most suitable for eliminating coughs, whispers or other
interference.
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By marking the interference in the visible spectrum, the interference is “erased”
with the help of a sophisticated Algorithm. The “Algorythmix reNOVAtor”
must also be unlocked.

Read more about applying this effect in the Algorithmix reNOVAtor Quick
Start manual.

Convolution

Choose this option to open the Convolution window. This window allows you
to (destructively) apply the “characteristics” of an audio segment to other Wave
Project, or selected Objects in the VIP window. It might help to think of this
processor as a “simplified” version of the Room Simulator (they are both
Convolution Filters).

When convolving two samples, the original sample will be amalgamated (by a
complicated filtration method) with the convolution sample. Common
overtones will be amplified, different overtones will be reduced, and a number
of ambient characteristics will be transferred.

Convolution - destructive il
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Note: A similar technique is available in the FFT Analyze Filter - if a sample is
filtered with the saved frequency response from another sample. This method, however,
only considers the frequency responses of the two samples.

Convolution can result in innovative reverb, delay, filter, or morph-effects
between the two samples. Unexpected results can take your Project in new
directions!

The basics of this method are the same as those of the Room Simulator. In
this case, an exact mathematical convolution function is used, whereas the
convolution function is optimized for calculating reverb responses in the Room
Simulator. The maximum length of the Convolution sample is double that of
the Room Simulator.
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Convolution sample

Use this Drop-Down List to select the audio segment that you wish to use for
the “characteristics” to be applied to the current Wave Project or selected Object
in the VIP window. When using files longer than 1048576 samples, only the
first 1048576 samples will be used.

Important note: The segment of audio (Convolution sample) must first be loaded
into Samplitude (as an Wave Project) before it can be selected from this list.

Mix
ORIGINAL (%): This parameter allows you to adjust the level of the original

(dry) audio. The data can be entered numerically (via keyboard) in the adjacent
data field.

Resurr (pB): This parameter allows you to adjust the level of the resultant
(wet) audio produced by the Convolution process. The data can be entered
numerically in the adjacent data field. Values above -10 dB can sometimes
produce distortion or clipping, so it may be advisable to use small values initially.

Create Copy

As per most of the other Effects menu items, this important option determines
whether or not an Undo will be created, prior to processing the file. As always,
we strongly recommend that you leave this option enabled!

Save Setup
Click on this button to save the current Convolution parameters as a preset.

Load Setup
Click on this button to load a previously saved Convolution preset.

Preview

Click on this button to audition your current Convolution settings. The duration
of the preview is determined by the preview Time setting in the Options >
System (Shortcut -Y) menu.

OK
Click on this button to write the current Convolution settings to the audio file,
and close the Convolution window.

Cancel
Closes the Convolution window, without applying any processing.
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Distortion

This effect allows you to distort audio material by using a non-linear transfer
reference line; the signal becomes louder, and overtones are added.

By adjusting the starting point of the distortion (Threshold), a soft, analog-
sounding distortion (i.e. Threshold at —40 dB) can be created (Overdrive). A
harsh, digital sounding distortion can be created with a Threshold setting of o
dB. The ratio setting determines the strength of the distortion.

+ Distortion - destructive x|
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Amp simulation

The Amp simulator is a real-time effect that simulates tube amp sound
properties. It is especially suitable for guitar sounds, but also for the organ or
recordings of vocals.

Ampsimulation - destructive il
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Amr MobpEL: Here you can select from a range of amplifiers whose sound can
be simulated.

SPEAKER MoDEL: Here you can select from a range of speakers whose sound
can be simulated.

EQ-SectioN: A 3 band equalizer for setting the bass, mid-tones and treble.

BrigHT: The Bright button is for a particularly sharp sound display, that can
be jarring when used with the following automatic controllers:

DistortioN: Creates distortion in typical analog amplifier fashion.

VoruMme: Controls the entire volume of the amplifier module.

Vocoder

The Vocoder in brief: Carrier material (e.g. a string instrument pad or a Synth
chord) are affected by a modulator (e.g. language or singing, or even drum
loops) to give the impression that the material is “speaking” or “singing”.
This is done by transmitting the modulator’s frequency characteristics to the
carrier. The modulator signal is divided into a number of frequency bands and
apportioned positions at regular intervals in the respective frequency bands.
These measurements control a filter for the carrier that correspond to the same
frequency bands.

X
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Strictly speaking, a Vocoder has two inputs and an output. Since Samplitude
effects have only one input, the carrier is either “won” from within the effect,
which can then be mixed precisely with white noise or any WAV file. Or you
can use the Vocoder as a mono effect whereby one input channel is used as
carrier and the other one as the modulator.

There is a Real-time FFT filter within the Vocoder for editing Vocoder signals.

Vocoder control elements

FirTer curves: The yellow line represents the frequency properties of the
modulator. The light blue line represents the frequency properties of the carrier.
The red line is a freely plottable FFT Filter. Any frequency property can thus
be drawn in to optimize the results of the Vocoder. The blue line is the resulting
filter curve of the Vocoder. For more about zooming and filter graph display
options, please read the FFT filter help files.

RESET FILTER: resets the red filter curve to its initial state.

Dynamic filter parameters
ResponsE TIME (RELEASE): Affects the speed of adjusting the dynamic filter to
the modulator spectrum. The greater the value, the slower the Vocoder follows
the modulator and softer the sound changes in the carrier. Give the parameters
a low value for better results.

DyNamic REpUCTION: Affects the dynamics of the modulator signal for reducing
the modulation depth of the dynamic filter.

This prevents two modulation side effects: Firstly, modulator signal volume
adjustment is transferred to the output signal in a less complex form. This
improves the Vocoder voice in the mix. Secondly, low-level portions of the
modulator signal are ignored so as to avoid a modulation of the carrier by
breathing sounds or signal interference.

This parameter is useful only if the modulator signal is fully controlled.
Instead of using dynamic reduction within the Vocoder, you can adjust the
modulator’s signal dynamics (or the results) with the dynamic tools integrated
in the program.

REsoruTioN (NUMBER OF FILTER BANDS): Dynamic filter resolution
(approximately dependant upon the number of filter bands). The best results
occur with medium to high resolution.

PrrcH (Firter sHIFT): The dynamic filter of the Vocoder shifts the frequency
up or down to create certain pitch effects. For the best results, don’t change
these parameter.

ForMANT: Tosses or stretches the dynamic filter curves to manipulate the
formants, thus changing the characteristics of the Vocoder voice.
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SMOOTH/NORMAL OVERLAPPING: Internal parameter that changes the
overlapping time window (which calculates the modulator signal spectrum).
In the “Smooth” mode, the Vocoder sounds are softer and more tuneful, but
quality may suffer.

Carrier signals

SAMPLE SELECTION LIST: Carrier samples are selected here. All opened Wave
Projects are listed along with some special carrier samples loaded automatically
from the Vocoder directory. Carrier samples prefer materials with even
frequencies e.g. orchestral chords, broad synthesizer surfaces, wind noises
etc.

SAMPLE (DB): Sets the number of carrier samples.

Noisg(pB): Automatic controller that mixes white noise into the carrier. This
is above all useful if the carrier material can’t be modulated well or sounds too
uneven. Whispering voices can also be produced in this fashion. It’s also good
for filling in drum loops between beats that are too far apart.

MoDpUIATOR/EXCHANGE CARRIERS: Exchanges modulator and carrier signals.
This is particularly useful if the “stereo channel as carrier” option is used.

STEREO CHANNEL As CARRIER: If this option is active, as carrier signal no more
sample from the selection list used, but a stereo channel of the input signal,
the other channel serves as modulator. The advantage is the resulting accurate
synchronization between carrier and modulator signal - the result is always
independent of the play start.

Here are some short instructions:

Create 2 tracks which each include a modulator and carrier. Then create a
submix track including the Vocoder as an effect with the “Stereo channel as
carrier” option. Route the outputs of the modulator and carrier tracks (“Track”
menul) to this submix track and then set the modulator pan to the left and the
carrier pan to the right. Instead of using audio files you can also use VST
instruments, or you can combine audio files with VST instruments.

VoruME: Adjusts the Vocoder output level.
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Room Simulator
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General Information

This function simulates the reverb patterns of any room reverb signal. The
process calculates the impulse response of the reverb and applies it to the
audio material in the selected range of the object in the VIP track. A room
impulse response is the natural decay of a sharp, high-impact like sound such
as a gunshot or similar. It contains all necessary information to exactly replicate
the room reverb. The impulse response can be influenced with the dialog
parameters. The reverb characteristics are accessible for easy editing. In
addition, the reverb character can be determined by selecting the type of impulse
response. A graphic display of the impulse response and additional fade-curves
allow you to get a visual overview of the impulse response manipulation via
the Room Simulator dialog. In Samplitude professional, the Room Simulator
is available as a real-time effect in objects, tracks, AUX busses and master
channels

General operating elements
Bank
For selecting a bank directory into which the impulse response list is transferred.

Presets (Impulse Response and Parameters)

When loading a preset, the Room Simulator loads parameters of the dialog
and the impulse response associated with the settings. The impulse response
can be any sample that is saved to the hard disk as a WAV, HDP, or RAP file.
If the file was moved or deleted, the Room Simulator displays an error message.
A special *.imp file is created for standard impulses.

When saving a preset, only the file path to the selected impulse response saved,
and not the impulse itself.
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Load/Save/Delete presets (Impulse Response and Parameters)

The presets can be saved, loaded, or deleted. The load function is only needed
if the preset files are located in a different folder than the “RoomSim” folder.
(Presets that are located in this folder are automatically loaded and displayed
in the selection list of the dialog.) The presets have the extension *.rms.

File (Impulse response)

Here you can select an impulse response from the “RoomSim” and Bank
directories as well as any currently opened Wave Project. If the Wave Project
does not contain an impulse response, no reverb effect will be produced.

If you deactivated the “Install Impulse Responses” option when loading the
program, the directory remains empty. If you skipped this part of the installation
you may always go back and install just this part of the Samplitude installation.

Load (Impulse response)
The impulse response can be any sample that is saved to the hard disk as a
WAV, HDP, or RAP file.

Play (Impulse response)

To verify the impulse response, it is played after this button is activated. IMR
file impulse responses are only played with 16 bits, even if the impulse response
has a 32 bit float format..

Graphics

dB lin

The graphic display will follow the usual sample display based on the linear
amplitude scaling applied to the graphic.

dB log

The scaling of the amplitude display follows a logarithmic pattern. This
coincides with the way the human ear perceives volume changes.

Zoom options: All, In, Out, Max, Position.

Curves:
ReD: Impulse response timeline

LIGHT BLUE: 2 segment envelope curve to suppress early reflection and post-
reverb.

Yerrow: Freely plottable envelope curves

Parameters

Parameter presets

This section lets you save, load, and delete the parameters o the dialog only
(response curve, frequency response, mix). This function is most useful when

testing different settings without changing the impulse response. 139
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Save/Load/Delete Parameter presets

The load function is only needed if you want to load preset files from different
folders than the default folder “FX-preset”. The presets for the Parameter that
are located in the “FX-preset” sub-folder are automatically loaded and listed in
the drop-down menu.

The Parameter presets have the extension *.rsp.

Parameters for editing reverb response times

PLOTTABLE ENVELOPE CURVES: The impulse response scale can be manipulated
with a yellow freehand envelope curve. Typically, it is used to suppress or
delete early reflections. Using the zoom options will help greatly.

RESET FREEHAND ENVELOPE: reinstates the curve’s original status.

Pre-DELAY: Delays the entire impulse response to a selectable time interval
from 1..100 ms.

Impulse L.R.
Eariy ReFLECT: This parameter allows you to set the amount of the early
reflection. It raises or lowers the first part of the impulse response.

Late ReveERrB: The later reverb portions can be amplified or decreased. This
parameter uses the final part of the impulse response.

LencTH: This setting will shorten the length of the reverb effect to up to 5% of
the original length by shortening the impulse response pattern. Please keep in
mind that the reverb can end rather abrupt, which may lead to unnatural decay
patterns. You can compensate by applying a lower Late Reverb setting to fade
the impulse response with the 2 segment envelope curve. The graphic display
will assist you in allowing a quick optical check of the envelope.

Env. TiME: Sets the duration of the first envelope curve segment.

Parameters for editing reverb frequencies
HicHh: This setting allows dampening of high frequency portions of the reverb
effect.

Low: This setting suppresses low frequencies of the reverb effect.

FFT-EQ: The reverb percentage can be re-worked with an additional FFT filter.
The real-time spectrum diagram of the reverb percentage in the FFT filter
permits optical control of room frequencies by recording the impulse response.
Undesired resonance can, for example, be identified and eliminated rapidly.
The FFT filter is unavailable with parameter latency settings of less than 4096
samples because it causes greater latency due to its linear phasing function.
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Mix
Dry.: Sets the original signal in dB

WET: Sets the amplitude of the reverb effect in dB
Our: Sets the output level in dB
Byrass: The input is switched directly to the output for comparison.

Performance Options

Quatrty: In the two normal modes, room simulation is calculated at half the
sample rate. This is perfectly sufficient in most cases, since natural or digital
impulse responses typically possess components of less than 10 kHz. (you can
check this in the integrated FFT filter’s spectral editor). Many older reverb
devices at half the sample rate — computation above the frequency range that
is inefficient use of the CPU.

Both normal modi differ only in the quality of the resample used for sample
rate decrease. The “normal” resampling quality is nevertheless quite high.
Only in exceptional cases should normal plus mode be used (and in which
arithmetic performance increases slightly).

HicH mode calculates the entire frequency range, doubling the load on the
CPU when compared with normal mode.

RETRIEVE, SET: Saves and set the quality options globally. Different settings
are recommended for use in objects, tracks, etc.

LaTeNCY: Parameter for block length defaults upon which the folding operation
is calculated internally.

Short block length increases the number of arithmetic operations required.
This increases the load on the CPU. Large block length leads to irregular CPU
load. The optimum for real-time processing tends to be about 32,768 samples.
For use in the AUX, track or master, (where lower latency is desired) a setting
of 40% is recommended when operating on fast systems.

The quality of the result is independent of this setting.

With latencies of less than or equal to 40%, the FFT filter can no longer be
employed. Impulse responses that you have created yourself may apply the
FFT filter to the impulse response before destructive room simulation.

The parameter used during room simulation set high by default, since lower
latency would increase CPU load unnecessarily.

SET / GET SETTINGS: with the get button you can reset these options to its
defaults, with the Set button you can define new ones.
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Overview: impulse response and parameter tendencies

Quality
“High Quality” setting Double (Factor 2:1)

Latency
Lower latency (2048 samples):  approx. increase of 50% (factor 1.5)
Very low latency (128 samples): approx. increase of 150 — 200 % (factor 3 -

4)

Impulse response duration

If the length of the sample used as an impulse response exceeds a power-of-
two, the CPU load doubles (factor 2,1).

The performance required subsequently doubles whenever the following
impulse response lengths are exceeded:

11.88 s
5-:944 S
2.97 8
1.48 s
0,74 8

0.378
etc.

Make sure that your own impulse responses are shorter than the next value —
particularly if the impulse responses are longer than 1 second, because the
length of these “continuous CPU load intervals” increases exponentially with
each increase in length.

Impulse response sample rates
The CPU load increases proportionally to the sample rate.

Impulse response resolution
The CPU load is independent of it since the computation is carried out with
float precision in each case.

Room Simulation: Tips and Tricks

The Room Simulator can be used to recreate the characteristics of a multitude

of room reverbs. By editing the impulse response pattern itself a number of

different effects can be achieved. Here are a few suggestions:

Use the Reverse function on the impulse response to create a reverse reverb.

By using the Timestretching function the size of the room can be altered

without affecting the resonance behavior of the room itself.

Use the Draw function in the Wave window to remove early reflections of

the room or add others to it.

— You may want to experiment with short samples of your own audio material
by creating a Fade Out in the sample. You can use the sample as the impulse
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response. Interesting and sometimes amazing effects can be created this
way.

— You can also get interesting reverbs by using the impact on a percussion
instrument as an impulse response.

Problems and Remedies

The reverb is too harsh.

The Late Reverb parameter can be used to fade out the impulse response to
zero. Use the graphic display to test the parameter’s effect on the response.
Especially when using the dB log setting for the display, the response can be
monitored to see whether the amplitude effectively fades to a zero value.

Resulting file has a large DC offset.
The impulse response must not contain a DC offset. Please remove it by using
the menu Effects-> Remove DC Offset.

Heavy hard disk activity or an error message concerning insufficient memory was
received.

The algorithm needs an immense amount of storage, especially with long
impulse response patterns. All background processes should be terminated
and all RAM Wave Projects that are not needed should be closed.

The CPU load is too high.

— Check the latency parameter settings according to the advice given in the
parameter description.

— Select “Normal quality”.

— Reduce the length of the impulse response (while remembering the advice
given regarding continuous CPU load intervals).

Problems with very long impulse responses.

When used in real-time, impulse responses of up to 11.88 seconds (with 44,1
kHz sample rate) can be used on up-to-date computers (2002)).

The length is limited only by the CPU capacity.

With destructive computations, the upper limit is 380.4 seconds (with 44,1
kHz sample rate).

If this upper limit is exceeded, the following samples are ignored.

Impulse responses of this length are, however not suitable for room simulation.
If you want to experiment with extremely long impulse responses (longer than
1 minute), you should note that the algorithm will require a lot of main memory
(over 500 MB).

When loading long Wave Projects as impulse responses, a warning appears
offering the chance to abort the operation to prevent a long wait for loading.
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Echo/Delay/Reverb

Choose this option to open the Echo / Delay / Reverb Effect window, allowing
you to destructively apply delay effects to Wave Projects.

i+ Echo / Delay / Reverb - destructive il

Preset: | Unsaved Parameters (Offline Editing) ~| Save ][ Load |[__Delete |

Mix Balance in %

Dy wet

11K}
11K}

100 100

Link

Mode: Echo Delay / Rev. Time Decay
@ 1 ety Large
@ Feedback
@ Multi Tap
@ Hall 250.00 ms | 30 = Ping Pong
E =
BPA: 240.00 Small

— —
Play / Stop Ext. Options... [®] Create Copy o] Cancel
= —

Note: If this function is used via the Destructive Effects menu, processing is destructive.
The same processor is also available for real-time use within the VIP window. To
make use of the real-time version, open the Mixer (key M) and right-click on the
Delay/Reverb button (on each channel).

Mode
Mode determines the parameters available in the dialog.

1 DErAY: This mode sets the processor to function as a single repeat delay.

FeepBack: This mode sets the processor to function as a delay that repeats, as
it decays to silence. The “echo” events are repeated in accordance with the
interval specified in the Echo Delay (Millisec.) settings. Echo decay is applied
to the repeated events — as a percentage of the previous event - depending on
the settings.

Murrrrar: This mode sets the processor to function as a multi-tap delay. The
multi Tap delay repeats portions of the delay event, between the major delay
events determined by the Echo Delay settings. This allows for a variety of delay
events, that are repeated and multiply, while the decay “fades” earlier events.

Track DE1ay: This mode delays the entire Track by a set amount. This can be
useful for correcting audio delays in recordings.
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Revers: This mode sets the processor to function as a reverb. Although this
mode is not intended to create a world class reverb, the algorithm uses very
little CPU power and offers sufficient fidelity for most simple reverb
applications.

Echo Delay / Rev. Time

In this field the delay between the individual echoes and/or the original signal
and the first delay is displayed in the set measurement unit. The measurement
unit is configured by clicking on it and selecting from the menu.

In Reverb mode it controls the Reverb time.

Decay

You can adjust the decay of the delay/multi tap delay effect here. The slider
actually controls the amount of feedback from o until 100 %, depending from
this the delay fades out faster or slower.

Ping-Pong: This applies a Stereo effect to the delay by swapping the channels
of the feedback path. To hear this effect, the input signal must

Reverb Properties
Roowm Sizk: This fader adjusts the overall size of the reverb chamber. You can
also enter the size numerically (with your keyboard) in the adjacent data box.

DARk / BrigHT: This fader adjusts the overall tonal color (light / dark) of the
reverb chamber. You can also enter the tonal color numerically (with your
keyboard) in the adjacent data box.

Link: The wet and dry levels are linked to maintain a nearly constant overall
signal level when moving one of the faders.

Mix Balance in %
Dry: This fader controls the original signal level.

Wer: This fader controls the level of the Delay’s decay (expressed as a percentage
of the original audio’s level). You can use the Fade to modify the current setting,
or type the desired setting directly into the box. Notice that the visual display
(lower half of the window) changes to reflect the current level of the Delay’s
Decay.

Create Copy

As per most of the other Effects menu items, this important option determines
whether or not an Undo will be created, prior to processing the file. As always,
we strongly recommend that you leave this option enabled.

When this box is checked, Samplitude will create a copy of the selected Range
in the audio file that contains the original material. This allows you to compare
the results with the original material. Please consider the length of the selected
Range, and the available hard disk space or RAM memory.
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Load Setup
Click on this button to load a previously saved set of Echo / Delay / Reverb
Effect settings.

Save Setup
Click on this button to save the current Echo / Delay / Reverb Effect settings.

Test
This button auditions the processed audio file.

OK
Click on this button to write the Delay/Reverb Effect to the audio file, and
close the Echo/Delay/Reverb Effect window.

Cancel
Click on this button to close the Echo / Delay Effect window, without applying
any processing.

Resample / Timestretching

Note: If you only want to change the sample rate of an audio file, use the Adjust
Sample Rate option from the Effects Menu.

All algorithms in this dialog use the time factor parameter and pitch as input
parameter.

The time factor calculation (from the original length/original speed and the
length required / speed required) can be comfortably activated on the right
side of the dialog.

Resampling / Time Stretching / Pitch Shifting - destructive

Algorithm actol Time Factor Calculation

Time factor. Pitch Time units
(RltiiErge) Old Length hlew Length

L l \ 002:01.057 00201057 5
% |% BPM values:

0ld BPM New BPM
|12u |1 20,000

I Anti Aliasing Filter (High Guality Resampling) 1.00000 0.00000 Caiculota Time Festor | Reset |

Play  Stop | Flay Original Ext Options. | oK | Cancel | Help |

Resampling

Samplers and PCM Synthesizers transpose samples using this procedure. Time
factor and pitch are dependent upon each other: the shorter the audio material,
the higher the pitch. The effect is comparable with changing the playing speed
of record players or tape recorders.
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The effect is relatively loss-free, the sound loss is smaller than with all
Timestretching/Pitchshifting procedures. If a pitch change is justified by
changing the speed (and vice versa), use this algorithm.

When increasing the length of the audio material by resampling, very small
alias effects may occur. the anti- alias filter helps in this regard. Alternatively,
since this filter requires additional CPU load, it can be activated for the
computation and the real-time preview by checking “High Quality Resampling”.
The filter is also available for the other algorithms that use resampling internally
when pitchshifting.

Pitch-Shifting/Timestretching

With all other algorithms, pitch and length variation are independently
adjustable. These algorithms produce artefacts, and depending upon the audio
material, specific algorithms may produce better results. The algorithm used
for Timestretching/Pitchshifting as a default Object Effect can be stored for a
Wave Project with the timestretch patcher.

Algorithms for Pitchshifting / Timestretching

Standard

An algorithm is used that usually produces very good results. It uses factors
(from 0.9 to 1.1) and fixed phases, which maintains the impression of space
for stereo signals. For drum loops or other “beat-like” material, this algorithm
is only occasionally suitable because it can change the groove and - in rare
cases - doubles or erases beats.

Time compression (shorter sample length) usually works better with this as
timestretching. When combining two samples, reduce the longer sample rather
than the other way around.

Use recommended when:
— working with complex material (Mix)
— the other algorithms fail

Load on the CPU: light

Smoothed

This is a substantially more complex algorithm, which demands more
computing time. The material can now be processed even with very large factors
(0.2... 50) without creating large artefacts. That’s because the material is
“smoothed”, which creates a softer sound and changes phase position. This
smoothing is hardly audible in recordings of speech, singing or solo
instruments. With more complex spectra — mixed sounds from different
instruments or fixed mixes — problems may arise. This algorithm is not suitable
for drum loops and other material with pronounced transience. The groove
remains, but the phase shift alters the ‘attacks’. With small Corrections (factor
approx. 0.9 - 1.1), a smallest possible Smooth degree often does the trick. You
can adjust the smooth degree in five steps.
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Use recommended for:

— orchestral instruments

— speech recordings with background noise (e.g. video recordings)
— Synth surfaces, guitars...

Use not suitable for:
— Stereo mix
— Drum loops, percussion

Load on the CPU: very heavy

Beat marker-based slicing

This mode was primarily conceived for adjusting drum loops, but can also be
used for other material such as monophonic bass lines or sequencer lines. The
algorithm divides the material into individual components — individual notes
or beats marked by beat markers.

The beat is then reconstructed using this “snippets”. Individual beats are
overlaid when the tempo is increased. Small pauses appear between beats when
the tempo is decreased.

If you are able to use this algorithm, do so. It allows you to change the tempo
without loss of quality and with minimum CPU load.

Use recommended for:
— Samples to be cut into individual notes or bars (beats)
— Drum loops, but only when beats don’t overlap and there is little reverb

Use certainly not suitable for:
— Anything else

Load on the CPU: very light

Beat marker-based stretching

This algorithm works like the standard algorithm, but synchronizes the
stretched material with the beat markers. The groove is consequently altered
somewhat, and beats may be duplicated or deleted. In contrast to the beat
marker-based slicing algorithm (which may produce missing or incorrectly
positioned markers), this algorithm’s disadvantage lies in decreased
synchronization performance. In practice, the automatic generation of markers
almost always produces good results. One should avoid placing beat markers
too close to each (< 1000 samples.)

»LONG oVERLAP”: With this option active, the sounds are less “roughened up”,
but echoes can appear instead. This is especially suitable for drum loops with
very little time changes.

Use recommended for:
— All types of rhythmic samples that can’t be cut into individual notes or
measures (beats)
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— Complex overlapping drum loops
— For when beat marker-based slicing can’t be employed or when it’s too much
bother to find the perfect beat marker position.

Load on the CPU: light

Beat marker-based slicing and beat marker stretching — Setting and
evaluating beat markers

If there are no “patched” (see below) beat markers inside the Wave Project,
these are determined automatically in real time. If there are beat markers, you
can determine by the option “patched” if they are used or not.

In the offline-effect dialog for timestretching you can temporarily create such
markers for offline processing. To save beat markers permanently into the
Wave Project and for more comfortably editing, use the Timestretching patcher
(menu Tools)

Generating beat markers — Options:
FinD BEAT MARKER: The algorithm searches for and marks out beats in the
audio material.

BEAT RECOGNITION THRESHOLD: Sets the threshold for beat recognition. When
the Wave Project is being displayed, you can follow the placement of beats.
This also works with Objects if the Wave Project is kept open simultaneously.

REeSeT BEAT MARKERS: All beat markers are removed.

Beat markers can be re-positioned, copied, deleted etc. by activating the
applicable marker commands.

When new markers are created, the marker name must be assigned “Beat
Marker”. Before editing, we advise that you set the beat recognition threshold
to a high value and then delete the redundant markers. It is quicker than adding
markers manually.

You can only edit markers while the dialog is open by using the Timestretching-
Patcher. There you can edit the beat markers without closing the timestretching
dialog (non-modal window).This allows you to check the results without having
to close the dialog.

Furthermore you can save the tempo (BPM) and the preferred method for
Object-based timestretching directly to the Wave Project.

Monophonic Voice

This is Timestretching and Pitchshifting for solo vocals, speech or solo
instruments. The material must not contain background noises and should be
free of reverb. With suitable source material, the audio quality is very high.
The “Use formant correction” option secures the formants when pitchshifting
so that the “Mickey Mouse effect” doesn’t occur. You can therefore “compose”
a background chorus from just one solo voice. Formants can also be shifted
across + - 12 half tones to create voice distortion.
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Typical uses are:

— Intonation correction (imprecisely pitched notes should be removed as
Objects and worked on separately if not working with ElasticAudio)

— Harmonizer effects: an Object with singing can be copied and shifted
downwards. If the pitch is then changed, a second voice is generated, etc.

— Creating background vocals from existing vocal samples

— Timestretching

— Speech sample distortion

Use recommended for:
solo vocals, speech or solo instruments without overlapping, little or no reverb
or background noises.

Use certainly not suitable for:
Anything else

Load on the CPU: heavy
Change Sample Rate

This option opens the Change Sample Rate window, allowing you to convert
the sample rate of Wave Project. As an example, this is where you convert
audio from 48kHZ to 44.1kHz, in preparation for CD burning. This process
will create a new copy of the Wave Project file, and apply the Sample Rate
Conversion to the copy. In other words, you don’t have to worry about destroying
the original audio file.

Change Sample Rate il

—MNew Sample Rate—  — Cuality el

aelp |

|441 ]| " Standard (fast)

" High
" 96 kHz
S @ .

£ 48 kHz Very high

= 441 kHz = Ulira high 1 {slow)

" 32kHz Ultra high 2 {very slow - only

" 2205 kHz useful for 32 bit float files) cancel |

Important note: You can only convert the sample rate(s) of Wave Project files! If
you wish to convert the sample rate of an Object in the VIP window, right-click on
the Object and select Wave Editing. This will open the Wave Project file that is
referred to by the Object.
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New Sample Rate

This parameter determines the new sample rate for the copy (Wave Project).
You can use the radio buttons to select from the most common sample rates,
or you can type the sample rate into the box. Your audio card MUST support the
new sample rate, or you will not be able to play the converted Wave Project!

Quality

This parameter determines the degree of Anti-Alias filters and interpolation
used when converting sample rates. The higher the quality, the longer the
sample rate conversion takes to process.

The available conversion algorithms range from Standard to Ultra High 2,
offering a suitable quality for all needs:

Standard

An interpolation algorithm is used, which is also applied during realtime
resampling. This setting is appropriate for work where high quality is not
necessary, but speed is important.

High

This adds a filter to dampen the alias frequencies or to improve the
reconstruction (interpolation). When using extreme conversion ratios, such as
converting from a 48 kHz signal to a 22 kHz signal, this setting may improve
the results.

Very High

This setting uses a new algorithm, which utilizes a higher sample rate internally.
The input and output sample rates are divisible by this internal sample rate.
(As an example, the conversion from 48 to 44.1 kHz uses an internal sample
rate off 7.056 MHz). This ensures the highest possible quality. This method is
also used during CD-Bouncing, if the sample rate of the Project is not 44.1
kHz.

Ultra High 1
Similar to Very High, but with a higher internal filter order. CPU load increases
dramatically.

Ultra High 2

Similar to Very High, but with a super high-quality internal filter order. CPU
load increases sharply. This algorithm is only useful for non 16Bit files, as the
maximum level possible for artefacts is lower than -96 dB.

Note: Reducing the sample rate will result in a loss of high frequency content, i.e
When converting from 48k Hz to 44.1kHz, this loss is negligible and above the range
of human hearing. When converting from 44.1kHz to 22.05kHz, however, you will
definitely notice the difference. The highest frequency that can be represented by the
audio is equal to half the sample rate. In other words, if the sample rate is 22.05k Hz,

the highest frequency that the audio can reproduce is 11.025kHz. 151
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OK
Click on this button to convert the sample rate of the audio file (using the
current settings), and close the Change Sample Rate window

Cancel
Click on this button to close the Change Sample Rate window, without applying
sample rate conversion.

Some Notes On Sample Rate Conversion (SRC):

Sample Rate Conversion (SRC) is often misunderstood by newcomers to digital

audio. Some people become confused about the difference between SRC and

Bit Depth (16/24/32 Bit). Here are a few quick notes which broadly summarize

the important issues:

1. Sample Rates are principally related (by the Nyquist Theory) to frequency
response, while bit depth is principally related to Dynamic Range. In other
words, sample rates have no effect on Dynamic Range.

2. Anti Alias Filters are used when performing SRC to reduce Alias Distortion,
while dithering is used when reducing bit depth to reduce (mask)
quantization distortion, caused by truncation (removing bits from the word
length i.e. 24 bit truncated to 16 bit).

3. A simple chart: sample rate > Frequency Response > Anti Alias. Resolution=Bit
Depth > Dynamic Range > Quantization > Dithering.

4. Due to the complicated mathematics involved in SRC, the quality of the
conversion was - at best - a compromise in the past. Poor interpolation
algorithms, combined with the steep filters required for the removal of alias
distortion, often resulted in noticeable quality differences between the
original and the resampled audio. In recent years, advances in algorithm
quality have dramatically reduced such artifacts. The algorithms in
Samplitude (particularly the Ultra settings) offer extremely high quality SRC
results. We are sure that even the most pedantic of audio engineers will be
very impressed with Samplitude’s SRC capabilities!

5. In the past, some audio engineers would perform SRC by re-recording the
audio, in the analog domain at the new sample rate, to avoid the problems
of poor SRC. As an example, a 48kHz mix needs to be converted to 44.1
kHz for CD Mastering. The engineer would play the mix at 48kHz through
the analog converters, while re-recording the analog audio at 44.1 kHz onto
another recording device.

By using this method, digital SRC is avoided and therefore Alias distortion is
avoided (although the filters in AD/DA converters also create some distortion
around the Nyquist frequency).

This is still a legitimate method of performing SRC, particularly if your AD/
DA converters are of the highest standard. If you're one of the engineers who
employ this method, we urge you to try Samplitude’s high quality settings,
and carefully compare results. You will be pleasantly surprised at the excellent
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SRC Samplitude offers — and will save a LOT of time when converting your
projects.

Sample Manipulation
Sample Manipulation - Sample Data /2

Every second sample is removed, and the entire sample is reduced to half its
length. The audible pitch is doubled, i.e. raised by one octave. When halving
the sampling rate, you will notice that the corresponding upper harmonics are
missing. This option is only available when working in Destructive Editing
mode - i.e. directly on an HD Wave file.

The frequency Range is divided (i.e. 0-22.05 kHz @ 44.1 kHz sample rate — >
o-11.025 kHz @ 22.05 kHz).

Sample Manipulation - Sample Data *2

This function inserts a new value between two neighboring sample values. It
is the average of the two sampling values.

The entire sample is doubled in length, and the resulting pitch of the sample
is halved. You must then double the playback rate to achieve the former pitch.
You should note that the higher sample rate does not lead to new upper
harmonics — the frequency range of the audio material remains the same.
This option is only available when working in Destructive Editing mode - i.e.
directly on an HD Wave file.

Sample Manipulation = Reverse

The sample data in the selected Range is reversed along the time axis - i.e. the
file will play backwards, with the (former) end position now placed at the
(former) start position, and vice-versa. This allows for very interesting effects,
not to mention ‘backward masking’ hidden messages, frequently rumored to
be in various songs....

This function is reversible: if you do not select a new Range, reuse of the
function restores the original material.

The option is only available when working in Destructive Editing mode - i.e.
directly on an HD Wave file.

Build Physical Loop

This function features a complex loop optimization algorithm, for use in Wave
Projects. It is useful when samples are to be used for instrumental sounds, or
for Wavetable synthesis. Sample loops which feature strings, drones, pads
and ambient effects (all usually difficult to transparently loop) can easily be
created with this option!

Prior to processing a sample, you will need to select a Range that defines the
approximate boundaries (edges) of the sample loop. To do this, you must be in
Destructive Editing mode - i.e. working directly on the HD Wave Project. (Object
> Destructive Editing when working in a VIP)

Remember that you can shift and vary a Range during playback, in order to find the
best loop position. A good shortcut technique for fine-tuning loops positions is provided
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by activating the split Range mode (Shortcut — B). The sample will now be displayed
in 3 sections.

To ensure a smooth, glitch-free loop, the outer limits of the Range will be set
to zero amplitude. By applying a crossfade to the material at the loop endpoint
(containing the sample data in front of the loop’s start point), Samplitude will
create a transparent transition between the loop end and start points.

When a marker is placed before the selected Range, the Range between the
marker and the loop start point will be used for the crossfade. This offers you
a feature found in professional hardware samplers. To achieve a short crossfade,
set the marker closer to the loop start point. To achieve a longer crossfade,
position the marker further away from the loop start point.

Note: The distance between the marker and start point of the loop Range needs to be
smaller than the loop Range itself, in order to make a crossfade possible.

Direct X / VST Plug ins

This function allows you to use Microsoft DirectX and VST 2.2 compatible
plug-ins with Samplitude. This complements the already existing superb effects
with an unlimited number of 3rd-party effects.

The Mixer and the Object Editors in Samplitude are also compatible with plug-
ins, which can be used as real-time effects. However, the plug-ins have to be
able to process the audio data blocks immediately and completely, without
changing the length of the material.

This is the case for most plug-ins. Other algorithms will fail, such as time
stretching plug-ins, since they are based on changing the length of the material.
The menu Effects does not pose these limitations. All available plug-ins should
work, even if they change the length of the audio material or temporarily off-
load the data blocks.

Working with the Plug-Ins

After opening the plug-in dialog, a list of installed plug-ins is visible. Double
clicking on a specific plug-in moves the plug-in to the left side of the dialog.
The left side shows the active plug-ins. At the same time the plug-in is moved
into the active plug-in list, the dialog for the chosen plug-in is displayed. The
Plug-in dialog allows you to make further settings for the effect. Additional
double clicks on entries in the right-side list add other plug-ins to the active
plug-in list on the left side. Please make sure that the chosen plug-ins are
compatible with each other. For example, mono and stereo plug-ins cannot be
used simultaneously — an error message is displayed. In this case you can
“force mono processing”.

Pre/Post section (Mixer only)

In the Mixer, the list of the active plug-ins is divided in two sections, pre and
post. In the FX routing page of the track or the master section there are four
corresponding entries, DirectX plug-in Pre and Post and VST Plug-in pre and
post. So you can use a plug-in (or more as one) at two different places of the
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effects chain. All plug-ins loaded below the pre line in the list are inserted in
the effects chain at the pre position, all below the post line at the postposition.

Note: By technical reason it is not possible to put DirectX Plug-ins after VST Plug-
ins, if they are used together in pre or in postposition. To achieve this, put the VST
Plug-in pre and the DirectX Plug-in post.

Dire.ctx / VST Plugins (destructive) - destructive Ll

r Presets

IUnsaved Plug-in Configuration LI Save Load et | EI

vst |

Active Plugins Installed Plugins

ACH

MAGIX D

aper
W Patcher
FCM Silence Suppressor

Mute Salo Mowe: ~ ~ |

Edit Remove |
I~ Force Latency (Samples) 0

Options

Setup

Flay / Stop I Praview | Extended options

¥ Create Copy ok Cancal Help

Dialog Elements

Pray/Stor: This button activates the real-time preview of the active plug-in
listed on the left side of the display. This function is ideal for testing of the
chosen plug-in settings if the real-time calculation operates sufficiently.

PreviEw (oNLY IN EFrects MENU): This function calculates a short segment
of the audio material with the active plug-in settings and plays back the audio
segment.. Use this option if your system does not seem to be able to sustain
the real-time preview (“Play/Stop’ button). The length of the off-line preview
can be determined with the setting System (shortcut: y) — Test buffers.

CreaTE Copy (oNLy IN ErrEcts MENU): This decides whether Samplitude
creates a copy of the original material. If the option is checked, the copy is
appended to the end of the audio file and the effect is processed over the copy
instead of the original. This function allows the Undo option to return the
Object to the original state. It is therefore recommended to always use this
option!

Soro: Only the selected Plug-In will be used. 155
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MurtE: The selected Plug-In will be muted (bypass function). You can also
bypass a plug-in by unchecking the preceding checkbox.

Remove: the selected plug-in will be removed from the effects chain.
Arrows: moves the plug-in up / down in the effects chain

PLuG-IN IATENCY: Shows the reported latency of a Plug-in. With Force Latency
you can override this value, in case a wrong latency was reported from the
Plug-in.

Setup
WriTE DIRECTX 10G FILE: For trouble shooting problems with a special plug-
in you can activate logging here.

START ALL OBJECT RELATED PLUG-INS AT PLAYBACK START: This option is only
needed when using Plug-Ins with the Object Editor. Some Plug-Ins causes
playback errors if they are started independently. The errors occur when the
Object with the assigned Plug-In is played back. You can prevent this by
choosing this option. At the other hand, the performance will significantly
slow down, because Samplitude has to calculate all plug-ins, no matter if the
Object which uses it is actually playing.

DisaBLE DirecTX wWHILE SCRUBBING/JoGGING: This is checked by default,
because some popular plug-ins cause problems while scrubbing.

Presets

SAVING AND Loaping: These two buttons in the upper left-hand section of the
dialog allow you to save and load Plug-In presets. A previously saved preset,
which is saved in the standard FX-preset folder will be listed in the selection
box. A Plug-In Setup contains the information of utilized plug-ins, all the
parameters, and the order in which the plug-ins are set.

This allows you to easily transfer custom settings between several instances
and projects in Samplitude (Mixer, Object Editor, Offline Wave editing in the
Effects menu).

Copry/pasTE: With the copy/paste button in the top right corner you can even
quicker transfer plug-in settings between different instances of a plug-in chain.

Some Tips for Working With Plug-ins in the Effects Menu

1. When using plug-ins which require mono file input (e.g. Antares Autotune)
on a stereo file, you must convert the file to mono before using the plug-in.
(File > Save In Format) After converting to either a single, or two mono
tracks (a piano recorded in stereo, for example), you can then open the mono
file/s, process it/them with the plug-in, and re-import the processed file
into the project (usually by click-dragging the selected file into a track).




"Offline Effects” Menu

Note: This is slightly different when using DirectX in the VIP (i.e. in realtime). In
this scenario, the Force Mono Processing box must also be checked.

2. It is unnecessary to leave plug-in windows open, once you're happy with a
setting. As an example, if applying multiple plug-in effects to a file, you
could end up with plug-in windows all over the screen. To avoid this situation,
simply close each DirectX plug-in dialog once you’'ve made your settings.
Samplitude will retain the settings. You can reopen these dialogs at any
time, for further adjustment, by double-clicking on the appropriate entry in
“the left-hand column of Samplitude’s plug-in dialog. Once all settings are
to your taste, click the OK button.

Process only left/right stereo channel

Only the right/left channel of a stereo Wave Project will be affected by effects,
when "Left/Right processing only” is used. This option is only available when
in Wave/Destructive Editing mode.

The L/R buttons (in the lower left corner of the Wave Project window) have
the same effect.
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“Range” Menu

The Range menu contains functions which enable you to select sections
(Ranges) of a project in various ways. Ranges work in VIP tracks, and when
working directly on Wave Projects.

Many of Samplitude’s processing options require you to select a Range prior
to their use. Spending some time learning the many ways you can select Ranges
in Samplitude, will dramatically increase your editing speed.

Note: When selecting a Range for playback (when looping a particular section for
overdub rehearsal, for example), it is unnecessary to drag the Range vertically down
over all of the tracks. Selecting one track will still result in the playback of all tracks.

Range all

Choose this option to quickly mark a Range over the entire Project (Wave
project or VIP).

Shortcut: A

Move play cursor - to Beginning

Choose this option to position the play cursor at the beginning of the project
(Wave Project or VIP).

Shortcut: Home

Move play cursor - to end

Choose this option to position the play cursor at the end of the project (Wave
project or VIP).

Shortcut: End

Move play cursor - to Range start

Choose this option to position the play cursor at the beginning of the currently
marked Range.

Move play cursor - to Range end

Choose this option to position the play cursor at the end of the currently marked
Range.

Move play cursor - to Section start

Sets the start position of the play cursor to the beginning of the screen section.

Move play cursor - Left/Right Move in Page/Scroll mode

With this command you move the play cursor left and right. In Page mode the
project window is scrolled page-wise. When the play cursor arrives at the project
window border, the section is shifted, the play cursor runs into the new section
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from the opposite side. In Scroll mode the Playcursor stays constant, the project
is moved under the playcursor.

If there is a Range selected, moving the play cursor in Page mode moves also
the Range start.

Shortcut: Left Move in Page mode Left arrow
Left Move in Scroll mode Alt + Left arrow
Right Move in Page mode Right arrow
Right Move in Scroll mode Alt + Right arrow

Note: The above functions work best when using the keyboard shortcuts.

Move play cursor - Object border left/right

This option moves the play cursor to the left (right) border of the selected
Object.

Shortcut: Object border left Ctrl+ Q
Object border right Ctrl+ W

Move play cursor = Marker left

This option moves the play cursor to the next marker to the left (previous
marker).

Shortcut: F2, At + Q

Move play cursor = Marker right

This option moves the play cursor to the next marker to the right (next marker).

Shortcut: F3, Alt + W

Edit Range - Move Range start left

Moves the start of the Range one pixel to the left in the current VIP window.
The distance moved is determined by the zoom factor. The greater the zoom
factor, the shorter the distance.

If the playback is not running, the command is the same as Move play cursor Left/
Right. Use this command especially while playback is running to move the Range
start without affecting the current play cursor position!

Shortcut: Alt + “/” (Num pad)
Edit Range - Move Range start right

Moves the start of the Range one pixel to the right in the current VIP window.
The distance moved is determined by the zoom factor. The greater the zoom
factor, the shorter the distance.
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If the playback is not running, the command is the same as Move play cursor Left/
Right. Use this command especially while playback is running to move the Range
start without affecting the actual play cursor position!

Shortcut: Alt + “*” (Num pad)
Edit Range - Move Range end left

Moves the end of the Range one pixel to the left in the current VIP window.
The distance moved is determined by the zoom factor. The greater the zoom
factor, the shorter the distance.

Shortcut: Alt + “” (Num pad); Shift + <- (Cursor left)
Edit Range - Move Range end right

Moves the end of the Range one pixel to the right in the current VIP window.
The distance moved is determined by the zoom factor. The greater the zoom
factor, the shorter the distance.

Shortcut: Alt + “+” (Num pad); Shift + -> (Cursor right)
Edit Range - Range to beginning

Choose this option to extend the currently marked Range to the beginning of
the project (Wave Project or VIP).

Edit Range - Range to end

Choose this option to extend the currently marked Range to the end of the
project (Wave Project or VIP).

Edit Range = Flip Range Left

Choose this option to flip the currently marked Range to the left. (What used
to be the start of the marked Range is now the end of the marked Range.)

Shortcut: Ctrl + Shift + Left arrow

Edit Range - Flip Range Right
Choose this option to flip the currently marked Range to the right. (What used
to be the end of the marked Range is now the beginning of the marked Range.)

Shortcut: Ctrl + Shift + Right arrow
Edit Range - Beginning of Range - 0

Choose this option to move the beginning of the currently marked Range to
the next zero amplitude crossing.

Tip: Editing Cuts should be made at zero amplitude crossings, to prevent clicks.
Samplitude’s auto crossfade features will usually prevent this problem from being
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an issue when editing. If you are cutting audio for use in another software application,
however, ensure that you place your cuts at zero amplitude crossings.

Shortcut: Ctrl+Page Up
Edit Range - End of Range = 0

Choose this option to move the end of the currently marked Range to the next
zero amplitude crossing.

“Zero” is the next sample value with zero value or the boundary between a
positive and a negative sample value (or vice versa).

In VIPs this works too, but Objects have to be present somewhere in the VIP
in the selected Range.

Tip: Editing Cuts should be made at zero amplitude crossings, to prevent clicks.
Samplitude’s Auto Crossfade features will usually prevent this problem from being
an issue when editing. If you are cutting audio for use in another software application,
however, ensure that you place your cuts at zero amplitude crossings.

Shortcut: Ctrl+Page Down

Edit Range - Beginning of Range < 0

Choose this option to move the beginning of the currently marked Range to
the previous zero amplitude crossing.

“Zero” is the next sample value with zero value or the boundary between a
positive and a negative sample value (or vice versa).

In VIPs this works too, but Objects have to be present somewhere in the VIP
in the selected Range.

Tip: Editing or Cuts should be made at zero amplitude crossings, to prevent clicks.
Samplitude’s Auto Crossfade features will usually prevent this problem from being
an issue when editing. If you are cutting audio for use in another software application,
however, ensure that you place your cuts at zero amplitude crossings.

Shortcut: Shift + Page Up
Edit Range = End of Range & 0

Choose this option to move the end of the currently marked Range to the
previous zero amplitude crossing.

“Zero” is the next sample value with zero value or the boundary between a
positive and a negative sample value (or vice versa).

In VIPs this works too, but Objects have to be present somewhere in the VIP
in the selected Range.

Tip: Editing or Cuts should be made at zero amplitude crossings, to prevent clicks.
Samplitude’s Auto Crossfade features will usually prevent this problem from being
an issue when editing. If you are cutting audio for use in another software application,
however, ensure that you place your cuts at zero amplitude crossings.
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Shortcut: Shift + Page Down
Edit Range - 0 - Range <0

Choose this option to move the beginning of the currently marked Range to
the next zero amplitude crossing, and to move the end of the currently marked
Range to the previous (left) zero amplitude crossing.

Shortcut: Clear

Note: If you do not have a Clear key on your keyboard, it is easy to assign your own
shortcut, for this option. A possible suggestion is Ctrl+Shifi+ Up arrow, as this is not
used by default. To change the shortcut key, open the Options > Program Preferences
> Edit Keyboard commands window.

Edit Range - Range start to left marker

Choose this option to extend the Range to the next marker on the left.

Shortcut: Shift + F2

Edit Range - Range start to left Object border
Choose this option to extend the Range to the left border of the next Object.

Edit Range - Range end to right marker
Choose this option to extend the Range to the next right marker.

Shortcut: Shift + F3
Edit Range - Range end to right Object border

Choose this option to extend the Range to the right border of the next Object.
Edit Range - Range over all selected Objects
Choose this option to extend the Range over all selected Objects.

Range length to

The following options allow you to adjust the length of a marked Range to a
precise number of beats.

Note: To define the length of a bar; select View > snap and grid setup.... You can
now enter the time signature, tempo (in beats per minute), and pulse per quarter
note resolution.

1- 16 BEAT(s): Choose this option to adjust the length of the currently marked
Range to a duration of 1, 2, 4, 8 or 16 beats.

Tip: The grid option (under the View menu) can display bars and beats, and the
snap function can be set to “snap to bars”.
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Split Range

Choose this option to display the current project (Wave Project or VIP) in
three independent views. The top view shows the entire project (Wave Project
or VIP), the lower left view shows the audio near the beginning of the currently
marked Range, and the lower right view shows the audio near the end of the
currently marked Range. Each view has its own independent zoom controls,
and can be used to manipulate the currently marked Range.

Note: To return the screen to a normal view, press Shift + B.

Tip: This option is very useful when trying to create loops! In the lower views, you
can zoom-in (independently) at the beginning and end of the currently marked
Range. This allows very detailed adjustments to the Range borders, without having
to constantly zoom in and out.

Shortcut: B

Split Range for Video

This option is nearly identical to the Split Range option above, but is intended
for use with AVI (video) files.

Note: To return the screen to a normal view, press Shift + B.

Store Range

In Samplitude you can define and store different Ranges for future retrieval.
An unlimited number of Ranges can be defined. You can for example specify
different loops and compare them while you recall their Ranges.

All Ranges of a project can be seen in menu Tools-> Manager->Range Manager.
There all Ranges can be renamed or played.

When selecting this menu option, the selected Range needs to be stored by
entering a numerical value the Range is associated with.

Shortcuts:
Keys:  ALT + F2 ... F10

Other....
You can define more Ranges by using the submenu “other”. You will need to
specify a name for the Range selected.

Shortcut: Alt + F11

Note: Ranges stored under specific names can only be recalled with the Range Manager
(Tools menu).

Get Range

By selecting this option, you can choose one of the stored Ranges as the current
Range.
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Samplitude even lets you set a Range while playing. The specified Range
becomes the current one and is audible. Using this method, you can change
between two Ranges comparing them with each other.

Ranges can also be named and recalled with the Range Manager (Tools->
Managers menu).

Shortcuts: Ctrl+F2 ... F10

Get Range length

The following options are similar to the Get Range options, but in this case
only the stored Range’s length is recalled (not the Range itself). This Range
length is then used to mark a new Range starting from the current play cursor
position.

Shortcuts: Ctrl + Shift + F2....F10

Store marker

The following options allow markers to be placed, and their location stored
(for later recall and positioning of the cursor).

Other....
Choose this option to place a marker (and store its position) under a specific
name.

Note: The position of markers stored under specific names can only be recalled with
the marker/CD Track Manager (Tools menu).

Shortcut: Key “?”

Auto Number
Choose this option to place an automatically named marker (and store its
position).

Shortcut Key «”

Marker on Record Position

With this option, which is enabled by default, you can set markers while
recording at the current recording position. You can disable this behavior here,
then also while recording the markers are set at the current play cursor position.
Keep in mind, that Playback and recording are independent functions, that
means you can play back the beginning of a just recorded Object while still
recording it!

I-1I0
Choose this option to place a marker (and store its position for later recall) to
the 1....10 key.
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Shortcuts: Shift + 1....0
Note: all markers can be placed in real-time during playback!

Defined markers can be seen above the sample data section of the project
window in the marker bar and can be moved with the mouse. Right-click on a
marker to open a context menu with the most important menu entries
concerning markers. Double click between two markers on the marker bar
marks a Range between the markers.

Get marker

The following options allow marker positions to be recalled in real-time. You
can also recall marker positions using the marker/CD Track Manager or the
Audio marker Manager (Tools menu).

I-1I0
Choose this option to recall the marker position stored to the 1...0 key. The
cursor will be placed at that position.

Shortcuts: 1....0

Marker on Range Borders

Choose this option to place markers at the start and end points of the currently
marked Range. The markers will be labeled S (start) and E (end).

Set markers on silence....

This option opens the Set Markers on Silence.... window. This allows you to
have Samplitude automatically detect silence, and create/place a marker each
time silence is encountered. The “silence threshold” can be defined. When
working in a VIP, you can set Samplitude to split selected Objects wherever
silence is encountered.

Set Markers on Silence... il
il Tl Threshald dB Start number: |D | .................... e
*00 :I -0 :I Erefic I Cancel

Help

_I Add Time (ms): ID

_| Delete matching Markers | I™ SplitVIP Objects

LI LI Delete all Markers | Test |

Important Tip: Only audio to the right of the play cursor, or audio within a marked
Range will be searched! If you wish to search the entire audio file, press the HOME
key to place the play cursor at the beginning of the file.
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Min. TiME (Ms): This parameter determines the minimum length of silence
that must be encountered before the algorithm will actually consider it “Silent”,
and create/place a marker.

TurEsHOLD (DB): This parameter determines the level at which the audio is
considered silence.

Tip: To quickly see all locations that are below a certain level, use this parameter in
conjunction with the Test button (see below).

StarT NuMBER: This parameter defines the starting number used when placing
the markers. As an example, if this parameter is set to 5, the first marker will
be labeled 5, the next marker labeled 6, etc.

Prerix: This parameter allows you to enter a prefix that will appear before
each marker number. As an example, if you enter “low” for this parameter
(and 5 for the start Number parameter), the first marker placed will be labeled
lows, the next marker labeled low0, etc.

App TiMmE: After finding silence the marker will be moved through, adding a
positive or negative time in ms.

DEeLETE MATCHING MARKERS: Click on this button to delete all markers that
meet the criteria set by the min. Time and threshold parameters. As an example,
let’s say markers were placed by a previous search. If you enter the same criteria
(set by the min. time and threshold parameters) and click on this button, these
markers will be deleted.

DELETE ALL MARKERS: Click on this button to delete all markers in the window,
or currently marked Range.

OK: Click on this button to perform the search, place the markers, and close
the dialog.

Cancer: Click on this button to close the dialog without performing a search
and creating/placing markers.

SpriT VIP OBjEcTs: When working in a VIP, select this option to have
Samplitude split the selected Object(s) wherever a silence marker is placed.

Test: Click this button to preview the results of the function, prior to completing
the command. This is useful for checking that the threshold settings are suitable
for your needs. Once you are happy that the threshold settings are right, click
the OK button to commit the changes.

Note: Split Objects are not shown until you commit to the changes.
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Marker Tips: You can click and drag a marker to move it. You can also set and
adjust various markers via the markers button, at the top of the Track Properties
section (see screen shot below), or by right-clicking on a marker.

Comparisonics Audio Search

This function uses the patented Comparisonics algorithm. This allows you to

find the same, or similar sounding, regions in an audio file very quickly — a

revolutionary feature!

The function has a variety of uses including:

— quickly finding particular, repeated, sounds in a recording.

— forensic audio work.

— finding repeated animal (or other) noises on lengthy field recordings.

— finding instances of a particular instrument in a classical recording (e.g. a
cymbal)

— finding examples of repeated Foley, or other distinctive sounds, when editing
pre-mixed audio for film/video.

It is assumed that a HD Wave Project is already open. If not, select an Object
in the track you wish to search, then select Object > Wave Editing.

Prior to selecting the command via the menu, you must first select a Range (to
be used as the basis for finding other ”similar” Ranges), and copy it into the
clipboard (Key “C”). The Range can be of any duration, but sms — 5 secs will
provide the best results, depending on the dominant frequency of the audio
you are searching for.

Note: The waveform display does NOT need to be set to Comparisonics Colors (View
> VIP Display mode > Definitions) for this function to work. In fact, with the
Comparisonics Colors displayed. you would rarely need to use this function, as similar
areas can be identified by color!

Once you have selected the Range and copied it to the clipboard, launch the
dialog from the Range > Comparisonics Audio Search menu.

The dialog allows you to change the sensitivity for the algorithm. During the
adjustment of the sensitivity level, Samplitude displays “Match markers” at
positions identified as a match for the material in the clipboard.

In the example above, the algorithm has found 4 locations which contain audio
similar to that of the clip (which, in this case, contained a wide frequency
spectrum including bass guitar, kick drum and crash cymbal). note that the
original Range area has been correctly identified by the algorithm. The
sensitivity fader is used to adjust the threshold of the algorithm, thus
determining the relative similarity to the audio in the clipboard. You may need
to experiment a little with this setting to determine the appropriate position.

In the example shown above, the algorithm correctly identified the complex
frequency spectrum of the clipboard audio, and the four times the particular
section of audio appeared in the file (a four bar sample of a rhythm section).
Other areas of the file were not significantly different (the file is four bars of
bass guitar and drums), yet the algorithm managed to select the correct sections.
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Note: The audio copied to the clipboard can also be used as the sample for finding
similar sections of audio in other Wave Projects. Simply open the other file(s) you
wish to search, and use the function.

Copying audio marker to VIP marker

Creates copies of all available audio markers of the selected Object in the VIP.
The Audio Markers of the relevant Wave Project are adopted only within the
Object boundaries.

Copying VIP marker to audio marker

Copies the markers in the VIP to the corresponding position of the Object
within the Wave Project. Adoption of the VIP Markers occurs within the Object
boundaries only.

Delete marker

This function deletes the currently selected marker. To select a marker, either;
use one of the “Get marker” commands, or position the mouse cursor over the
marker until the bi-directional arrow cursor appears. Once visible, click on the
marker.

Note: When using the mouse to select the marker, the quickest deletion method is to
select the marker as shown above, then press delete on the keyboard. You can also
right-click on the selected marker and use the delete marker command.

Delete all markers

This function deletes all markers in the active project. The command does not
simultaneously delete markers from the VIP and all Wave Projects referenced
by the VIP Object(s) — the command must be applied separately to each Wave
Project. In other words, deleting markers from the VIP does not delete markers
from Wave Projects.

Recall last Range

Choose this option to recall the last Range that was marked in a Wave Project
or VIP window. As an example, if you’ve mistakenly removed a marked Range,
selecting this option will restore it.

Shortcuts: Shift + Backspace
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Range Editor

Range Editor

—Range Start

Samples: IW
Millisec.: W
SMPTE: W
Bar: IW

—Range Length

Samples: IE?.EB?
Millisec.: |62E ms
SMFTE: IDEI:DD:EID:15
Bar: IDDD:D1:DE4

—Range End

Samples: IW
Millisec: W
SMPTE: W
Bar: IW

x|

Cancel |

Choose this option to open the Range Editor window.

This window allows you to specify the currently marked Range’s start and end
positions, and length (in Samples, Milliseconds, SMPTE, or Bar formats).

If you change any of the values in the “Range start”, “Range length” or “Range
end” sections, all other values will automatically be updated, with the following
exceptions:

Change the Range start value — the end point will be retained.

Change the Range end value — the start point will be retained.

Change the Range length value — the start point will be retained.

Please note the format of the “Bar” dialog box. The format is displayed in 4/4
time, with a resolution of 96 clicks per quarter note. Bar, beat, and clicks are
displayed.

The number of beats per minute (BPM) can be set in the BPM dialog box,
accessible via the View > Grid Setup option.

Range Manager
Please refer to the chapter “The Managers”

Object Lasso

The normal way to select several Objects at once would be to click on the free
space on the right of the Object in the lower area of the track and to pull a
frame around the selected Objects.

Sometimes, however, there is not enough space between the Objects. The
Object lasso solves this problem.

Once activated, you can click on an Object and pull up a selection frame, without
moving the Object you clicked on (which would be the case in the standard
mode). Once you release the mouse left-click, the mouse returns to the selected
mouse mode.

Edit Time Display

Shows or hides the time display window.
This window always shows the current time position in the current format.

You can change this format with the menu “Units of Measurement”. We 169
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recommend the SMPTE format: hours:minutes:seconds:frames. The colors
and the font for the display can be changed in the File->Preferences. You can
zoom the window to any size and position it anywhere on the screen.

Click the right mouse button on the Time Display to display a pop-up menu
that lets you choose the preferences for the Time Display.

This popup menu contains several shortcuts for program options to customize
the font as well as the colors for foreground and background of the display.
You can also select the time unit here, it is the same unit as defined in the
View menu.

You can set up from one to five rows with “Number of Rows”. Each of the
rows can display one of the following values, which you can select in the
“Current field menu” by right-clicking in the according row.

St. - Position/Range start
This line shows the current Range start position or the current real-time cursor
position.

Len - Range length
If a Range is selected, this line displays the length of the Range.

End - Range end Position
If a Range is selected, this line displays the Range end position.

CD Positions

This shows several CD related time positions, including CDS: position from
CD start (first set Track Marker), CDE: position to CD end (distance to CD End
Marker), CDT: position inside the actual CD track or TrE: position from actual
CD track end.

Act - Current Mouse Position
This line shows the current mouse position (not editable).

Mix — Latest Mixer Position
This line shows the value of the recently selected mixer control (not editable).

Rec- Current recording position
This line shows the current recording position (not editable).

RSp- Remaining disc space for recording
This line shows the remaining recording space.

In the same way you can configure the time fields at the lower edge of the VIP
window

There you have the possibility to edit the values manually by double clicking in
the corresponding field. You can also use relative values in this fields, when
you enter e.g. “+2:00” in the time fields, you increase the value of the field by
2 (seconds, beats...depending on the used unit of measurement).
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You can also access this function by the keyboard shortcuts alt+ numpad 1..5
or with the corresponding menu items “menu Range-> - edit time display>->
field 1..5".

1. By double-clicking in the relevant box.

2. By selecting the box via the Range > Edit Time display menu.

3. By using the shortcut keys (Alt+Num pad 1-5).
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“CD/DVD” Menu

The options found in this menu are geared toward preparing and burning
CD’s.
If your computer is powerful (and well-tuned), you will easily be able to Burn
Red Book Master CD’s in real-time, as you mix a song or master another mixed
track.

Note: As new CD/DVD writing hardware is constantly appearing, MAGIX cannot
guarantee that your hardware is currently supported by Samplitude’s existing CD/
DVD writer *.dll files. In addition, some CD/DVD writers have various hardware
or firmware limitations. Therefore, prior to purchasing a CD/DVD writer for use
with Samplitude, please download the most recent CD Burner DLL patch from the
Samplitude/Samplitude Support Area (www.samplitude.com, navigate to
“Support”). After installing it, you'll find a document CDR_Readme.txt in the
installer folder, which is describing all compatibility-tested devices.

If you have already purchased your CD/DVD writer, please do the following

before using it with Samplitude:

1. Ensure you have installed the latest firmware update from the hardware
manufacturer.

2. Download and install the latest CD writer *.dlls from www.magix.com

Samplitude allows you to create audio CDs directly from Virtual Projects and
any stereo Wave Project, regardless of the number of tracks in the VIP.

32Bit Float/24bit Objects are dithered, and converted to 16bit, during the
burning of the CD or the CD track bouncing function. The only requirement
is that the project be at a sample rate of 44.1kHz.

When selecting the special "CD Arrange mode”, regardless of the selected
Range, Wave Projects are loaded by automatically inserting a pre-determined
space between the songs, or Objects. The duration of this gap can be adjusted
with the CD > Set Pause Time menu item.

If a completed, multi-track, VIP is destined for use as a single track on a (multi
track) CD, use the Track Bouncing function to turn the multiple tracks into a
single Wave Project.

Load Audio CD Trackl(s)

Import entire audio CDs or single CD tracks in a project. However, as opposed

to normal data, Audio CDs have to be read first (grabbed or ripped). The data

import is digital, so there are no losses in the sound quality.

If you want to import audio CD tracks, just follow these easy steps:

1. Insert an audio CD into your CD-ROM-drive and select “Load CD audio
track” from the CD menu. A dialog with a list of the CD tracks will appear.
If you have more than one CD-drive (or for example an additional CD-writer)
you will first have to choose the drive from which the CD is loaded. You can
do this in the CD-drive options
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2. Select the desired title(s) (pressing Shift + mouse button or Alt + arrow
keys).

3. Click on “Copy selected track(s)...”

4. The “Project import” dialog will appear. Here you can choose a file name
and the target directory.

5. Now, the audio material will be copied from the CD-drive to the hard disk. A
state display informs you of the current transfer state.

6. Once the audio data has been transferred, all dialogs will be closed and the
tracks will be added to your master track as single Objects.

The Track List Dialog

CD Track List [ ]
Tile| Stait Ti.. | Length | ISAC | Name Artist I T |
01 | ORODO0 034730 DEARSOT30401 | Booly Rock

02 | 0347.30 (M0655 DEABSDIZ040Z Ridess on the stoim
03 | 035470 043518 DEABIDI30403 | NISSE ANALODG Most Flay | Stop |
04 132928 045542 DEASI0N 30404 Fonk da world
05 182470 055461 DEABS0IZ0405 | Anbme anywhers Passe |  Resume |
05 | 241356 (25316 DEABADT30406 Rock it
07 | 271272 042352 DEABIDIZ0407 | Amirack Tracks selected 0
02 | 34249 033522 DEARIIA 20408 Freedom jazz dance Cluration: 000
03 | 31771 044767 DEABIDIZM0S | Le sunset Memary: 0 Bytes
10 | 4B05E3  04:4605 DEABIDIZI4I0  Whatsup
11 | 4451:68 030665 DEABSOI30411 | From Stockhokn to Bejing Salact all Tracks
12 | 4758568 035638 DEABSDIS0M1Z  New moming
12 515521 061666 DEASS0130413 Calvados Unzelect all Tracks

Read ISAC |
| TOSHIBA DVD-ROM SD-R1202
{402 =] |Burst Copy If =]

4] | | o himva b |
UPC/EAN: -

LD Mame FOMK D& WORLD Wiite text fie. .

CD Autisk: Misze Landgren Funk Unit P

: Hep | Close
CD ingested

All CD tracks are shown including start time and length. In the name column
the track name is shown, this is derived from the CD Text information, if the
CD provides this information and the CD drive is able to read it. Select a track
by clicking it with the left mouse button, select a Range of tracks with SHIFT
+ mouse click, select several tracks with CTRL + mouse click.

Copry SELECTED TRACK(s): This button starts the audio copy process. For each
track, a new Object and the corresponding Track Marker will be created in the
arrangement.

TRANSPORT CONTROL: Use is like the transport buttons on a real CD player,
start, pause and stop playback and skip forward and back between the tracks.
Below this, information about the total length and memory demands of the
selected tracks is displayed.
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SELECT ALL TRACKS: all audio tracks are selected (for example, if you want to
copy all tracks of a CD). Pressing Ctrl and clicking on the mouse button you
can select more than one track.

ReaD ISRC: reads the ISRC code (if provided) of the tracks.

Temro MODE: In the right selection box you may choose the reading speed, in
the left selection box the selection mode (see “The CD drive configuration
dialog”)

CD-prIVE oprTIONS: Here you can adjust some of the settings of the CD drive
settings you are using and choose the drive for “ripping” CDs if you have more
than one CD-drive installed in your system (see The CD-drive dialog)

WrITE TEXT FILE: Creates a text file with the retrieved CD information as
displayed in the CD track list

The “Import project” dialog

The “Import project” dialog appears after selecting the “Copy selected tracks”
option. Type in a name and a target directory for the new audio files. The
audio files will receive a number in addition to the name you chose (“name” -
> name_I.wav, name_I.wav...).

The preset format for audio tracks (CDA files) is the WAV format. You are
however free to convert them into a compressed format, like MP3 while still
reading the data. Just choose your audio format in the “Import project” dialog
and click on the “Format settings” button to make your changes (More
information concerning the audio formats see Import Sample)

The CD-drive dialog

Choose and configure your CD-drive. The CD manager permits the import of
audio data using most SCSI- and ATAPI-CD-ROM drives and CD/DVD writers.
In case of doubt, ask our technical support which drives are compatible. If you
experience problems while reading audio tracks, you can choose between several
reading processes in the Configuration dialog, which differ in the way the data
is read or “ripped”.

[SCYI CD-ROM Drive List |

Drive Hoszt  Target LUM Uze as
Mame Adapter [[]

Configuration...

Reszet

Help

i

Add Drive Delete Load Setup Save Setup | ok
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ConricuratioN: This button opens the Config dialog, in which you can set
different special features, SCSI-IDs etc.

RESET: Restores the initial drive configuration.

ApD DRIVE: Adds a new entry to the drive list. However, you will have to adjust
the specific settings.

DEeLETE: deletes a selected drive from the list.

SAVE SETUP: Saves the current drive list with all configuration-data in a *.cfg
file.

Loap seTUP: Loads the current drive list and all configuration-data from a *.cfg
file.

CD-Drive Configuration

5C$1 CD-ROM Configuration

COvD-ROM SD-6125

Drive NaME: Lets you edit the name of the drive in the list. This is useful if
you create more than one entry accessing the same physical drive.

Host AparTER NUMBER: Lets you specify the number of your SCSI adapter -
normally o.

SCSI-ID: Lets you set the ID of your CD ROM drive. Be sure to set the correct
ID, there is no error checking!
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SCSI-LUN: Select the SCSI LUN parameter, normally o.
At1as: Lets you select the manufacturer type of your CD ROM drive.
Cory moDE NorMmar: Copies the audio data without any software correction.

Cory MODE SECTOR SYNCHRONIZATION: Copies the audio data using a software
correction algorithm. This is useful, because some CD ROM drives cannot
seek exactly to the same position between two read accesses but Samplitude
can correct these differences using this algorithm.

Cory MoODE Burst: Optimizes the speed of the copy process, no software
correction is done.

SecTors PER READ: Defines the number of audio sectors per read cycle, the
higher the number the faster the copy process will be. Not all SCSI adapters
support more than 27 sectors!

Sync Secrors: Defines the number of audio sectors used for the Sector
Synchronization. A higher number results in a better synchronization but also
in a slower copying process.

Set CD Track Index

Choose this option to place a Track Marker at the current play cursor position.
all subsequent Track Markers will be re-numbered.

Important note: Each audio track on the CD MUST have a Track Marker! Track
Markers are placed at the beginning of each audio track (slightly before the audio
starts). The Track Markers allow CD players to cue to each individual audio track.
Tip: This option is also available from the toolbar.

Set CD Sub index

Choose this option to place a Sub Index Marker at the current play cursor
position. all subsequent Sub Index Markers will be re-numbered.

Note: Sub Index Markers are not required, but they allow CD players to cue to
specific points within an audio track. Sample CD’s containing dozens or hundreds
of loops, broken into components, often use sub indexes.

Tip: This option is also available from the toolbar.

Set CD Pause index

Choose this option to place a Pause Marker at the current play cursor position.

Note: Pause markers allow CD players to switch their output to absolute silence
until the next Track Marker.
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Set CD end index

Marks the end of the CD. This is important for burning a CD, when the project
still produces audio after the endpoint of the last Object(s) e.g. a reverb tail. To
prevent Samplitude from cutting this section of audio, you can place the CD
End Marker an appropriate distance after the last Object. Another use of the
CD End Marker is to partially burn a project to CD. CD Burning always starts
from the first Track Marker, and ends with the End Marker. all you need to do
is delete all Track Markers that precede the first track you want to burn. All
audio before the first Track Marker will not be burned to the CD. Burning
stops with the CD End Marker, allowing you to place the CD End Marker
inside the project.

Set Track Indices on Silence

This function sets Track Markers on silent passages of a selected Object.
As an example, this is useful for setting markers between each title, after
recording an entire DAT tape.

Set Track Indices on Object Edges

Choose this option to automatically place a Track Marker at the beginning of
each Object (in track 1). In many situations, this option provides the quickest
way to set Track Markers for your CD.

Prior to using the function, execute the “Remove all indices” command, to
delete any redundant Track Markers.

If there are multiple Objects that make up a single track or title, you may want
to first use the bouncing function (to combine the Objects), to ensure proper
track assignments.

Tip: This option is also available from the toolbar.

Set track indices on Object edges - Options

Set Pause indices on Object ends
This option automatically generates Pause markers on Object ends.

Time Offset for indices on Object Edges
This option allows you to set an offset for the generated Track Markers.

No indices on Object Crossfades

This option prevents track indices from being placed between two overlapping
Objects, which segue via a crossfade. This makes it possible to use the automatic
Track Marker generation functions, even if crossfades are used inside each
track.

Remove index

Choose this option to delete a Track Marker or Sub Index Marker. First, click
on the marker, then select this option to delete it.
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Tip: After clicking on a Track Marker or Sub Index Marker, you can press the delete
key to remove it.
Remove all indices

Choose this option to delete all Track Markers and Sub Index Markers. This
can be helpful before use of the “Set track indices on Object edges” function.

Make CD...
—Mode

¢~ Bum "On The Fiy". &1 Fx are calculated in raal time: [non destructive)
" Generate a complete new file for the whole CD (hon destuctive)
& Start CO-R Buming Module [e.q. fior creating MP3 CD)

— TOC Farmat
Uze Uni Code for TOC
[Samplitude internal and cdaudio 32 Bit)

I Usge ASCI Code for TOC File -
[only far cdaudio 16 Bit) Print TOC | Export DDP |

[~ Call ext. cdaudio Software Show TOC | Export TOC |

Dithering |
Are there any problems Trauble-
while CO-Burming? shoating. ..

LCancel | Help |

This dialog starts the CD writing process. Samplitude contains high-grade CD
creation routines that are constantly updated. The software code is licensed
from Point Software & Systems.

If you want to find out which CD-R drives are supported, please read the file
“CDR_Readme.txt” in the installation folder or visit our web sites at
www.samplitude.com.

Samplitude creates a TOC (Table of Contents) file prior to starting the CD
creation. The name of the current VIP is used and the extension *.tcx is added
to the file. The TOC file is located in the same folder as the current VIP. It is
therefore important to save the VIP to the hard disk prior to starting the burning
process.

BurN "ON THE Fry”: This mode will burn the CD directly from the VIP window.
All real-time processing will be calculated (included) during the burning process,
so there is no need to create an Image File. This saves a great deal of time and
hard disk space!

The following real-time tasks are calculated during the process:

— Object effects, volume and panorama settings

Fades and crossfades

Mixing of tracks

— Mixer track effects

Mixer master section effects
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— 32bit float to 16bit conversion and dithering

To get a good idea whether your system is able to sustain the real-time

processing needed for this functionality, try this:

Play back the VIP sections that contain the largest number of tracks and/or

where the most real-time effects are used. Watch the DSP meter (bottom left-

hand). Below are the expected performances at the different DSP values:

— Below 25%: CD creation with up to 4x mode

— Below 50%: CD creation with up to 2x mode

— Below 90%: CD creation with up to 1x mode

— Above 90%: Real-time creation is not possible, use the second mode
(Bouncing)

GENERATE A COMPLETE NEW FILE: Use this option if your system is not fast
enough to sustain the real-time creation of the CD (see above). This mode
calculates all WAV files, including fades, crossfades, and volume automation
into a new audio file. Any other real-time processing is also part of the newly
created audio file. Make sure that you have sufficient hard disk space prior to
starting the process (approx. 700 MB for a complete CD).

The original WAV files used in the VIP remain unchanged. This makes this
procedure non-destructive!

Use UN1 Copke ror TOC: This is the default setting and is used for the internal
CD creation process as well as the 32bit version of Point CDAudio.

Use ASCII Copg For TOC: This format should only be chosen when using
the 16bit version of Point CDAudio.

Carr exTERNAL CDAuDIO SorFTwARE: This lets you determine whether you
want to automatically start the CD creation application “CDAudio”. The current
TOC information is passed to the application, so that the CD creation in the
external program can be immediately started. all Samplitude projects are closed
and the application itself is closed down to prevent any type of file access
conflicts.

If CD-Audio is installed in any other folder than “C:\CDAUDIO” you will
need to enter the location of the application.

Only use this option if you do not want to use Samplitude’s internal audio CD
creation and purposely want to use an external program.

StarT CD-R BURNING MODULE: starts the MAGIX CD burning utility to burn
any data files, e.g. mp3 files on CD.

PrinT TOC: This starts the external TOC Printer application. This convenient
tool allows you to print the contents information of the current CD. You may
choose between a text style format to print the production documentation and
a formatted printout for the CD jewel case. Please refer to the on-line help for
the TOC printer for more specific information.
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Szow TOC: This button opens a text window, which shows the contents of the
current TOC. The “Copy” function can be used to copy the contents to the
Windows clipboard for use with other text editing applications.

Export TOC: This function allows you to save a TOC file (*.TOC, *.TCX). A
track-bounced Wave Project is also created from the VIP, which is referred by
the TOC file.

TROUBLESHOOTING: Opens the CD Burning Profiler, which checks the system
for incompatible drivers of your CD-Recording hardware.

Create DVD-Audio

Introduction

Samplitude can burn DVD-Audio Discs using any type of DVD writer. You
can burn the following disc formats: +R/-R/+RW/-RW.

DVD-Audio discs can only be played back on DVD-Audio enabled players!
DVD-Audio-enabled players are identified by the DVD-Audio logo on the device.
The player requires up to six individual analog outputs for multi-channel
playback.

Samplitude currently burns so-called “Black Discs”, DVDs without a graphic
menu but merely including Track Markers which can be controlled like an
Audio CD. However, to create DVD audio/video with menus, videos and
slideshows, the video cutting and DVD authoring program “MAGIX movie
edit pro” will soon be available which can be integrated into Samplitude.
You can save 16 and 24 bit audio on a DVD-Audio; sample rates of 44.1 and
48kHz as well as double and fourfold amounts of these rates are possible. Up
to 6 audio channels are supported in 5.1. surround as well as other
configurations (stereo, 4.0, etc).

The only limitation is that the maximum allowed bandwidth for hardware
players of approx. 1oMbit/s must not be exceeded. Therefore, only sample
rates of 48kHz are available for 5.1 surround sound. The 10Mbit limit would
be exceeded at 9GkHz.

For example, the following playback times would result for the available storage
capacity of a single-layer DVD-R (at 44.1kHz sample rate):

Stereo 16 Bit: approx. 7h

Stereo 24 Bit: approx. 4.5h

5.1 surround and 24 Bit: approx. 1.5h

Creating a DVD-Audio disc

In the VIP, Track Markers are placed in the same manner as for a CD. An
Audio CD and a DVD-A can be subsequently burned from the same project.
{bmc dvda_button.bmp} start DVD-Audio creation via the “DVD-Audio” button
in the CD toolbar.

The “Trackbouncing” dialog is displayed. You can choose between 16bit and
24bit audio. The initial setting is 24bit. The “Create DVD-Audio” box must be
activated.
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An external program is opened for burning the DVD-Audio. The path to this
program is predefined but can be changed if necessary.

Alternatively, “Movie Edit Pro” can also be opened here, which enables advanced
DVD authoring (menus).

“OK?” starts the bouncing process. The DVD-A burning application is launched
and the files are handed over automatically.

Note: Double storage space of a DVD is required on the hard drive, as the VIP
is bounced first and the DVD image is then created from the complete audio
data, which is then burned.

The track list is displayed in the DVD audio tool. Further tracks can be added
manually, and the surround format can be changed (stereo, 4.0, 5.0, 5.1).
The “Burn” button opens the burning window where the burner and burning
speed are selected.

The DVD image is first created after pressing the “Start” button. This is then
followed by the burning process.

Show CDR drive Information....

Choose this option to display information about your CD-R drive. A CD must
be in the drive for this option to work.

Among the information displayed is the manufacturer, drive name, hardware
revision, cache size, and the features supported by the drive mechanism.
The “Disc At Once” feature is extremely important, as it is needed for Red
Book-compatible Audio CD production. CDs burned in this way are accepted
as Masters by CD Manufacturing facilities.

Show CDR Disc Information...

Choose this option to display information about the CD currently in the CD-R
drive.

The most important information is the maximum length. This cannot be
exceeded during the production (i.e. 74 minutes and 5 seconds).

CD Track/Index Manager

In this dialog, all the CD tracks and sub-indices in the current VIP are displayed
in a list.
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Marker / CD Index Manager il
karker | Source kMarker | In/Ciut Foint |
Filt
" [ CDTmck | CDSubndex | CDPouss
Empl
Elay tarker Stop Advanced »>
Flay Loop CD Text.. Help | Close

All currently saved markers of the active project are shown with their name
and position in this dialog. Select markers with the mouse, then you can change
its position Normally in the time entry field below the list. You can also name
and rename it there. Play marker starts playback up from the selected marker,
Play loop plays a one second loop around the marker. Stop stops the playback.
CD Text opens a separate dialog for entering CD Text information.

The play cursor is moved to the respective marker position by double-clicking
on the desired marker.

With Filter you can select, which of the marker types to display.

Create: with the according buttons, you can create markers, CD tracks, CD
Sub indices or CD Pause markers at certain time positions. You have to enter
the time position in the time field below the marker list.

Other settings such as Preemphasis, Copy Protection, and Second Generation
Protection Flags can be set for each of the tracks.
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The button Apply to all allows you to use the current flags to set all tracks to
the chosen settings.
Other settings are the ISRC Codes for every CD track.

CD Text/MP3 ID Editor

Here you can input the CD text information for the CD. The CD track names
are copied from the CD Track Marker names in the VIP. all information here
is contained also in the VIP, but in addition to that you have the possibility to
save and load all entries made here in a separate file (*.cdt).

This function allows you to supply data regarding a song or CD content — such
as album, artist etc.

MP3 files do not only transport audio data, but also information about the
coded music piece through so-called “ID3 tags”. These are file appendages
into which an encoder can write standardized information. The ID3 tags are
recognized by the decoders and displayed as music data by the MP3 player.

CD Disc Options....

This option opens the CD Disk Options window, allowing you to configure
several parameters for the CD.

CD Dizc Options
+CD Tije

JNumhcs 1in LK

~ UPC/EAN Code

prostce:

— Mumber of first CD Track = I
1 Cancel

[+ Allow Borws Tracks before Track 1 Help

CD TrriEe: This line allows you to enter a Title for the CD. The Title is written
to the CD, and is used when printing the TOC.

UPC/EAN Conbe: This line allows you to enter a UPC/EAN Code for the CD.
The UPC/EAN Code is written to the CD, and can be requested by special CD
players.

NumBER OF FIRST CD Track: Under certain circumstances (e.g. Track-At-Once
burning), the number of the first track can be determined with this setting. As
Samplitude burns Red Book Audio CD’s in one pass (Disc At Once), you will
probably never need to adjust this setting. (It has no bearing when Burning
Disk at Once.)

Arrow BoNus TrACks BEFORE TRACK I: This option allows you to insert “hidden”
or bonus tracks before Track 1.
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Set Pause Time....

Choose this option to set the default Pause Time between tracks. The amount
of time can be entered in Samples, Milliseconds, SMPTE, or bars:Beats:Pulse
formats.

The Pause length is required for the grid function, allowing sample Objects to
”snap” to the edges of other Objects + the Pause time. A Pause time of 2
seconds is normally used.

Note: The SMPTE frame rate can be set in the View > Units Of Measurement
menu. The bars/Beats format can be defined by the View > snap and grid setup >
Bar Definitions options.

Set start Pause Time....

Choose this option to set the default Pause Time at the start of the CD. The
amount of time can be entered in CD frames (75 frames =1 second). Important!!!
This setting must be set to a value of 150 frames (2 seconds) to meet Red Book audio
CD requirements! It is recommended that you set this parameter to 150 frames
(two seconds) and leave it there.

CD Arrange mode

When you activate this menu item, Samplitude rearranges newly inserted

Objects, and inserts pauses (conforming to the Red Book Standard) between

the Objects.

We recommend the following procedure:

— Open a new VIP which contains 4 tracks so you will be able to mix down
later, if required.

— Activate the Special CD Arrange mode via the CD menu.

Open a new VIP.

Load audio files, audio tracks, or make a recording using a microphone.

You will see gaps between the individual Objects in the VIP — these are the
inserted pauses. The length of the inserted Pause(s) can be defined in the "Set
Pause Time” dialog.
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Track Bouncing....
This option opens the Track bouncing dialog.

Trackbouncing m
—Bouncing Range — Format
© Only marked range & Wave

& From VIP Startto last Object End

S 32 Bit (Eloa) fi it
¢ Complgte Project [~ Sevein it (Float) forma

I Onlythe active track @ Stereo

£ Only Left Channel
—Generating Options ¢ Only Right Channel

 hono Mixdown

& Only a Wave Project

 MNew separate Object in actual VIP  MP3

" Replace Ohjects in actual YIP

€ NewIP Mo compression

Format Settings

5.1 Surround Trackbouncing

= | Active
i Special Option
& Eenerate b one Tracks B i
1 GEnerEte 4 Steren rEE.e I~ Calculate maximurm Amplitude
= | CalllA27 Encader Path | I~ Exclude Master Effects from Bouncing

Cancel | Help |

This window allows you to “Track bounce” a Virtual Project (VIP) to one or
several Stereo audio files. This is essentially the same as exporting the VIP via
the Export Project command in the File menu, but offers many more
possibilities. You can also export single or multiple Objects or tracks, restrict
the export process to Ranges and exclude Track and Master Effects. The resulting
file can then automatically be opened in a new VIP or replace the Objects in
the current one. All tracks and all real-time processing (fades, effects, volume
and pan automation, Object effects, etc.) will be included in the bounce. If you
are bouncing to 32 float format, no distortion can occur.

It makes sense to use the master normalizer function of the mixer to create a
file with exact attenuation.

Trackbouncing Settings

Source:

ONLY MARKED RaNGE: Choose this option to limit the bounce to the left and
right boundaries of the currently marked Range.

Bouncing is performed from the project beginning to the end of the final
Object with reverb decay (refer to Program Options).

ComprieTE ProjeEcT: Choose this option to bounce the entire project.

Note: When selecting this option, ensure that no (or little) blank space exists at the
end of the VIP (i.e. after the endpoint of the last Object). Blank space will be included
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in the bounce! This can result in very long bounce processing times. You can easily
delete the blank space by selecting it as a Range, and pressing the delete key.

Bounce seLEcTED OBjECTS: all selected Objects are bounced, i.e. all Object
effects are applied and Wave Projects are created, one for each single Object.
The Objects are replaced by those referring to the new Wave Projects. This
permits quick export of a large number of single Objects to separate files (e.g.
for sample archives).

GruEt seLeCTED: All selected Objects of a track are included in a new file with
all Object effects.

These options has the same function as the “Glue Objects” function of the
“Object” menu; you can enter a custom file name, but there is no “Freeze/
Unfreeze” mechanism.

Options

PROCESS ONLY MARKED TRACKS: Only the selected track is bounced. If “Only
marked Range” is also activated, the marked Range is only bounced in the
marked tracks.

If the selected track is a submix bus, all tracks that are routed to this bus are
also bounced. This also works recursively, i.e. if these tracks are busses. This
permits fast mixing of groups.

MULTI-TRACK BOUNCING: bounces each track (including auxes) to a separate
file, for further processing in an external multitrack environment.

Suow MaxiMuM AmPLITUDE: Click on (enable) this option and (when the
bounce process has finished) Samplitude will display the maximum amplitude
reached by the “bounced” audio file.

Effects:
ExcLuDE MASTER EFrecTs FROM BouNciNG: The master effects are not included
during bouncing.

Excrupe Track EFrFecTs oF THE TARGET Track: The track effects of the target
track (if not identical with a source track) are not included.

These options are important in combination with “New separate Object in
current VIP/Replace Objects in current VIP” so that the track effects are not
applied twice. They are automatically adjusted when selecting a different
“Generating” option.

Generating
ONLy A Wave ProjecT: The bounced file is saved as a Wave Project. No new
VIP will be generated for the bounced file.
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NEw SEPARATE OBJECT IN CURRENT VIP: The bounced file is saved as a Wave
Project, and a new Object which references this file is created on a separate
track in the active VIP.

REr1ACE OBJECTS IN CURRENT VIP: The bounced file is saved as a Wave Project,
and a new Object which references this file is created by replacing the original
Object(s) in the active VIP.

New VIP: The bounced file is saved as a Wave Project, and a new Object which
references this file is created and placed in a new VIP.

Note: In all cases, the original Wave Projects are not changed. That said, however,
as some of the options result in changes to the VIP, we recommend that you save
and backup the VIP before using the command.

Format

The target format can be set flexibly. WAV and AIFF formats are supported in
8/16/24/32 bit mono/stereo at variable sample rates, mp3 at variable bit rates,
and WAV with any installed ACM codecs.

Note: All tracks that are the result of a trackbounce are opened (even if merely the
“Only a Wave Project” Generating option has been selected). This means:

1. You cannot bounce the same project twice in a row if it is still opened as a
result of the first bouncing process. It must be closed first. If you often
bounce and no longer require special options (as for mastering), you will be
faster if you select aa Export Audio from the “File” menu instead of using
the trackbouncing window.

2. All formats that cannot be directly opened by Samplitude cannot be created
in the trackbouncing window. For example, to bounce into Real or WMA
format you should also use File aa Export Audio.

Presets
You can save all settings in this dialog into presets. So you can restore your
special settings for, e.g. generating mp3 preview, Multi Track Bouncing or
Object.

Surround Track Bouncing:

This enables the surround trackbounce functionality. The other options in
this section will not be available until the “Active” box is checked. This is only
possible if the Project is set up for a surround mix. Read the according section
about Surround Trackbouncing in the Surround chapter.

OK
Click on this button to start the Track Bouncing process.
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Cancel
Click on this button to close the Track Bouncing window, without performing
a bounce.

Bouncing Sub Mix Busses

You can also bounce a Sub Mix bus. Every track routed to the Sub Mix bus will
be included in the bouncing process, even if the track sending to the bus is a
bus itself.

This is handy when you want to mixdown all tracks sent to a specific bus
(grouped strings, a drum kit etc.).

If you bounce several tracks, or just the active track (Option: only marked
tracks/active track) with the “New Object in actual VIP” or “Replace Objects”
functions - and this selection includes a Sub Mix bus - then it is possible that
the resulting Object will be placed at just this Sub Mix bus. It’s actually pretty
likely, in fact, because busses usually don’t contain Objects (although they
can), and the Object will be placed in the first empty track it finds. In this
situation, the track FX (including pan/volume automation) of the Sub Mix bus
will be excluded from the bouncing process. This prevents the effects from
being applied twice (once by the bounce, and once from the real-time track
FX).

You cannot bounce aux busses in this way. You need to include the tracks
being sent to these busses, in order to obtain the desired result.

Range Bouncing

Use this function to convert the Objects within a selected Range to a new
WAV file. The selected Objects in the VIP are replaced with the track-bounced
version. This is very useful to combine multiple Objects into a single Object so
that the function to create Track Markers automatically can be used.

If the VIP contains 24bit or 32bit Objects, a dialog box will ask you whether
the new file will be created as a 32bit float or 16bit file.

Remove unused Samples

This function removes all material from Wave Projects belonging to the current
VIP that is not used by any of the VIP Objects. The Objects in the VIP will
point to the proper audio Ranges in the linked audio files. This leaves the VIP
itself unchanged.

This function physically deletes data and has no undo capability, so use it with
caution!

If multiple VIPs use the same Wave Project, all VIPs accessing this projects
have to be open to avoid data loss.

Using this function can conserve a lot of storage space. However, the downside
of using this option is that after performing this function, Objects can only be
made shorter, but they cannot be extended any more, because all audio data
outside the Object’s borders was removed. For this reason you can also define
a security Range in samples. This amount of samples will be left in the Wave
Project before and after the according Object border to have some reserve when
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you want to change a fade in/out of the referring Object. The default value is
22050 (= 500ms at 44.1 kHz sample rate).

The dialog lists all Wave Projects referenced by the VIP and the amount of
storage space, which the Wave Project consume in total and how much of it
are actually unused in the VIP. Every file has a checkbox, to include it in the
process or not. Only files with unused samples are checked by default, you can
uncheck any Wave Projects you want to keep completely.

Note that the list also contains files not actually referenced by the VIP, but referenced
by the VIP’s undo chain. These files are 100% unused and will be deleted completely
when checked!

This can be right (when you have a recording session rejected), but there are
also cases, when you just imported audio material from other sessions or your
private sample library and decided later, rather not to use it.

Tip: If you need the complete contents of the audio files for other production projects,
it is recommended to archive the finished project in the following way. Save the
complete project to a new folder (File->Save Complete Project to). The VIP is now
located with the complete contents, in other words all the audio files, in an unaltered
form (WAV, RAP, etc.) in the same folder that the VIP was saved to. Next, use the
command Remove Unused Samples. The same folder will now only contain the
audio data or samples that are actually used by the archived VIP. The contents can
be easily back up to any backup medium such as CD-R, Data DAT, and others.

Delete Freeze Data

Please refer to the chapter “Freeze”

Collect Project Files

If a project uses audio data from different sources, sample CDs or audio data
from other projects these files often reside in different directories. It is wise to
collect all project-relevant files into the project directory to make sure nothing
is missing when you backup the project.

You can copy or move the file. When moving, make sure the file is not used by
another project.

Waveform Generator
Wwavoform Generator ]

— Format new Yyave Project —Waweform——— —Lenght —————————— Wavetorm Parameters —

Type: Samples: Frequency (Hz):
CMono  C RAM Bectangle | 441000 1000.0

* Staren * HD

Triangle | Millisec.: Level (dB):

Fesolution:  Sample Rate Sine 10.000 ms -6

COEEH ¢ 4k I

Saw [up)
~3zEr O ARk 00:00:10:00 oK
Float 96 kHz

Saw (clown)

Use Propetties from | 1
I= active ifawe Praject Witz [tz Help...
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The generated waveform shares the properties of the opened Wave Project. As
an option, the test tone can be automatically loaded into the active VIP.

Format new Wave Project
These options allow you to select the type, resolution and sample rate of the
new Wave Project that will contain the generated tone.

Waveform
Six waveform varieties can be selected — square, pulse, triangle, sine, saw up,
saw down and white noise.

Length
Use these boxes to enter the desired length of the generated tone.

Waveform Parameters
Use these boxes to set the frequency and amplitude of the generated tone.

SMPTE Generator

x
SMPTE Frames SMPTE Start Lenght Sarnple Rate

24 Frames/s Hours: IUU Samples: 44100
* 25Frames/s 26.460.000 Cancel
2997 Frames/s Minutes: ) & 441 kHz =

Millisec.
" 2997 Frames/s drop 48 kHz
® TS Seconds: IUU 600,000 ms 96 kHz Help
¢~ 30 Frames//s drop SHWPTE

H
ames |00 [or- 100000

This dialog allows you to create audio files containing SMPTE time code. These
files can then be placed into VIP tracks, and routed through any audio output
of your PC. This ensures extremely stable SMPTE time code output, which is
sample-locked to the audio material in your VIP.

New Manager-...

This command opens a further Manager window. The Manager key on the key
bar shows/hides all managers.

The Manager window has several different views that represent the different
managers.

Please refer to the chapter “The Managers”

Manager - File Browser/Object Manager/Track Manager/
Marker Manager/Range Manager

Please refer to the chapter “The Managers”

Take Manager...

Opens the Take Manager window. The Take Manager is specifically designed
for users who work with large numbers of different recording takes.
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Samplitude registers the VIP position of the recorded audio material. This
“time stamp” is stored in the HD or RAM Wave Project, and offers the option
to return the recorded Object to its original position.

Take Manager x|
MName | PDsiticml Length| File | Fecorded
Dl Al | Allgrouped abjects (Multittach Fecarding
[™ Samefile only
[~ Same track only Feplace | Statistic (verbose) | Play [ Stop | QK |
v hdatch t
S i e Statistic (brief) | Help | Cancel |
Display Filter

SAME FILE oNLY: Only takes that belong to the same audio file as the selected
Object are displayed.

SaME TrAck oNLy: Only takes that are positioned in the same audio track as
the selected Object are displayed.

Matcu TiMmE: Only takes that match the original time position of the selected
Object are displayed.

Play
Starts playback. Please set the play cursor to the desired playback position,
before opening the Take Manager.

Replace!
This replaces the selected Object with the take(s) currently selected in the Take
List.

Statistic (verbose)

Creates a new VIP with the currently visible takes in the Take List. Every take
is listed in a new track. The VIP can be used to audition the individual takes,
by making use of the solo and mute functions of each track. This facility can
be useful in situations where takes are confusingly named, during high pressure
(fast) sessions.
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Statistic (brief)

Creates a new VIP, with the currently selected takes in the Take List. All takes
are aligned on the same track.

This facility can be useful for burning a CD of the takes for later listening, or
general archiving purposes.

Take List

The Take List shows the Objects, allowing you to search and match other Objects
with the selected Object. The list shows the take name, time position, the
Wave Project associated with the take, and the date/time stamp.

Note: You will thank yourself later if you spend the time in appropriately naming
takes and Wave Projects, during recording sessions. We understand that the creative
flow occasionally dictates that this is not possible, but the more you practice, the
faster you will become.

Using the Take Manager

For this example, lets assume you have an Object in the VIP that was processed

(non-destructively — “make copy” option enabled) with the Room-Simulator.

In this situation, the processed (wet) signal was appended to the end of the

original (dry) recording. After some critical listening, you decide that the Object

sounded better dry, and now wish to swap the wet Object, for the original dry
take (Object).

Here’s how it’s done:

1. Select the Object that you’d like to replace (swap) by clicking on it (in the

lower half of the track).

2. Mark a Range that encompasses the currently selected Object. This is to

ensure that playback occurs in the desired area, while auditioning changes.

3. Open the Take Manager window (Tools > Take Manager, or Object > Take

Manager)

4. In the lower left corner of the Take Manager window (under Display Filter),

ensure that ”Same Track only” is the ONLY enabled option.

5. Look at the Take List, you should now see two takes. The take featuring the

red “O” is the currently selected Object.

6. Click on the name of the original (dry) take (the one not marked with a red
”0”), and press the Replace! Button. Samplitude will now replace the wet
Object (take) with the original dry Object (take).

. Click on the PLAY button to audition the change made in step 6.

. Click on the PLAY button a second time to stop playback.

9. Click on the OK button to accept the change you've made, and to close the

Take Manager.

oo NI

Note: Samplitude "Time Stamps” each Wave Project it records. This allows the
Object (representing the Wave Project) to be returned to its original start position, if
accidentally moved.
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The first step in working with the Take Manager is to select an Object. This
could be the most recently created Object, following a punch-in recording, for
example. This (selected) Object is identified with a colored “O” in the Take list.

Note: The Take Manager window will not work on Objects that were not recorded by
Samplitude! As an example, .\WAYV files imported via the File > Import Sample
option, or CD tracks loaded via the CD > Load Audio CD Track(s) option. If you
select an Object that was not recorded in Samplitude, and choose the Object > Set
new original position option, Samplitude will time stamp the Object, allowing it to
be used in the Take Manager.

Some examples of Take Manager use may be:

— Selection of the best Take, following several Loop-punch recording passes.

— Locating the best material between bars 32 and 34, from 12 Takes of a classical
production.

— A clear overview of all available Takes at a specific SMPTE time index (e.g.
30:00 t0 35:00).

Start Windows Explorer

This opens the Windows Explorer. If you position the Explorer window to the
left or right of the Samplitude window, you can easily drag & drop WAV files
into the Samplitude projects. This allows easy management of numerous files
(such as sound effects). This even works with dragging of multiple files.

Any file type with the WAV, OBJ (for Objects), HDP, and RAP extension can
be dragged into the VIP.

It also works during playback.

This is an obsolete command left in Samplitude for those who are used to use
it. You can browse your hard disc much more comfortably with the file browser
from the Managers. It includes a text search function and favorite directories.

Timestretch/Pitchshift Patcher

Overview

This tool enables audio files used in Samplitude and other MAGIX programs
(e.g. MAGIX music maker) to be patched with certain meta data that contain
information about time and pitch of audio ranges. Additional information and
settings are written into the Wave Project thus ensuring better timestretching
or pitchshifting results.

The following can be patched:

— Algorithms for Timestretching/Pitchshifting

— BPMs

— Beat markers

Algorithms for Timestretching/Pitchshifting

Different algorithms (besides the standard algorithm) can be used for real-
time timestretching and/or Pitchshifting for better results. Check Resampling/
Timestretching/Pitchshifting for more details. With the patcher you can store
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the best timestretching algorithm in the Wave Project. This ensures that the
“correct” algorithm is used automatically when Timestretching/Pitchshifting
is used on these projects as Object effects (e.g. with the Timestretch mouse
mode).

Beat marker

Beat markers are also saved in the Wave Project when using beat marker-
based algorithms.

In contrast to the Timestretching dialog, the patcher is non-modal, meaning
that if the patcher is open, you can move beat markers in a Wave Project while
checking out the Timestretching result.

BPM value

Patches the BPM value (beats per minute). This is useful for when the
Timestretching factor must be determined later in order to adapt the Wave
Project to the tempo of an existing arrangement.

Patches in brief

Patches only work if you have opened the Wave Project in destructive Wave
Editing mode and if it is not open in a VIP simultaneously.

On the right of the dialog (Patch) you can select the algorithm to be used and
specify the audio file tempo. On the left side (Test) is the control element from
the Timestretching/Pitchshifting Dialog.

It allows you to test the selected algorithm in connection with the Play/Stop
and Play original buttons. Patch saves the information in the wave file.
Samples from the MAGIX music maker product range Soundpool contain the
patch information as of version MAGIX music maker 2003.

Remix Agent
Please refer to the chapter “Effects and effect plug-ins”!

Impulse response extraction

The “chirp” method for extraction of impulse responses is more efficiently
than other known methods. It distinguishes itself, besides other advantages,
by a very high robustness against long-time disturbances and non-linear
distortion.

Impulse responses are used in the room simulator for the creation of ultra-
realistic, natural sounding reverb.
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Impuise Response Extraction x|

Impulse nza Extraction

Original chirp Resoluion: |32 Bit Flast S
= Sample rate: 44100 Hz -
| = Length: 1048576 Samples x| 23

Chirp Generation

Rewverbed chirgp

Frequency range (Hz)

Decay cutoff threshold (dB) -90.0

Win 500 e 15000.0
[~ Adaptlength to power of 2 Breview,
" Create Wave Project anly  Create Wawve Project only
@ Insertin current'vIP & Insertin current WIP
 Batch processing in current VIR Ciznzraiz  Insertin new VIP G

Close | Help |
General workflow

1.  Generating a chirp.

2. Capturing of the room’s “answer” to the chirp. Usually, that is playing
the chirp in an environment which is intended to be “cloned” with a
suitable PA speaker system and simultaneously recording the resulting
sound of the room with a good microphone. But that can also be achieved
by processing the chirp in an effect unit.

3. Calculation of the impulse response from the original and the reverberated
or otherwise processed chirp.

Step 1 Generating a chirp

Open the “Impulse response extraction” dialog from the “Tools” menu. on the
right side of the dialog there are the parameters for impulse creation.

A chirp is a sine wave with a continuously changing pitch.

Parameters:
ResorutioN: Choose between 16 bits and 32 bits float. 32 bit is recommended.

LencTH: Set the length of the chirp in samples. (always a 2™ number)

The longer the chirp is, the better the results are. The influence of continuous
disturbances like hiss or traffic noise or non-linear distortion lowers with a
rising chirp length. At the other hand the amount of calculations rises
exponentially. Attention! The chirp should be at least as long as the reverb
length!

SAMPLE RATE: Set the sample rate here. The sample rate of the original chirp,
the reverberated chirp and the VIP (if it is used) have to be equal!

If you are working with 96 kHz sample rate and intend to extract natural
impulse responses of room, so keep in mind that the speakers used for playback
have to be able to reproduce very high frequencies in order to include the (very
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small) ultrasonic components of the impulse response. Frequency Range: Set
the start and end frequency of the chirp.

The frequency range should be adjusted according to the abilities of the used
speaker. Avoid sub- base frequencies if the used speaker is not capable of
reproducing these frequencies.

Options
ONLY CREATE FILE: The chirp is just written into a new Wave Project.

INSERT IN CURRENT PROJECT: The Wave Project with the chirp is inserted into
the current VIP.

INSERT IN NEW PROJECT: The Wave Project with the chirp is inserted into a
new VIP. So you can play back the chirp and record the room response from
this VIP at the same time.

GENERATE: Make the chirp!

Step 2: Reverberation of the chirp

Natural rooms

The chirp is played back monophonic with a speaker or speaker combination
in a room. The speaker should be set up at that place where usually the acoustic
sources (instruments, singers) in the room are situated - in a theater building
that is the stage, for instance.

Speakers have a different directional behavior as typical natural acoustic sources,
they send less sonic energy to the back. That’s why the application of speaker
combinations is recommended.

An often used speaker combination is to use one speaker in front direction
and a second one in back direction.

Digital reverberation units

Reverberate (process) the chirp signal with the reverb unit.

The “Dry” part of the output signal should always be zero, otherwise the result
will become unusable.

Important: The reverb tail has to be recorded until its very end! Avoid any impulse-
like disturbances as well while the reverb fades out.

Hints for playback while recording the chirps in Samplitude (for recent version 7.0)
— In the dialog recording options (Key R) please choose “Playback while
recording” and the Monitoring mode “Peakmeter Monitoring” because
“Software Monitoring” can lead to acoustic feedback.

— In the dialog: activate “Monitor” and “Visualization”.

— Start a test recording with “Record” and play back the complete chirp to
adjust the recording level to an appropriate value. Avoid clipping by all means!
Reject the recording and repeat the procedure until you find the optimal
level.
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— Open another visualization window with a spectrogram view and a level
range from -go dB to check the reverberated chirp for non-linear distortion,
disturbing impulses or aliasing (details see below).

Step 3: Calculation of the impulse response from the original and the
reverberated chirp

SOURCE OF CHIRP PARAMETERS: Choose the Wave Project or Object which
contains the original (un-reverberated) chirp.

If the original chirp is not available anymore, you can manually adjust the
chirp parameters on the right side of the dialog. Keep in mind that you have to
set it exactly to the same values used for creating the reverberated chirp or it
will not work at all.

REVERBERATED SIGNAL: Choose the Wave Project or Object which contains the
reverberated chirp. When working in a VIP (see below) this field is filled
automatically.

DEecAY cuTorF THRESHOLD: If the signal level falls below this value (in dB), it
will be cut off.

ADAPT LENGTH TO POWER OF Two: Fade out the impulse response in a way that
the length of the sample is almost a power of two (in samples). Use this to
optimize the performance of the room simulator using this impulse response.

OrtiON “ONLY CREATE FILE”: The resulting sample will be only written into a
Wave Project.

OprtION “INSERT INTO ACTUAL VIP”: An Object with the impulse response will
be created in the current VIP.

OPTION “BATCH PROCESSING IN CURRENT VIP”: This works only when the
reverberated chirps are all Objects in the actual VIP (read details below). With
this option activated, impulse responses are calculated from all Objects in the
list of reverberated chirps (supposed you use the same chirp for all). According
to the list entries, new Objects with impulse responses appear behind the
Objects with the reverberated chirps.

Use the Mute buttons to exclude single Objects from the impulse response
calculation.

HEear: The impulse response is being calculated and played back.

Save: The impulse response is being calculated and saved.

Processing impulse responses automatically in a VIP

A typical and recommended workflow would be to place Objects containing

different reverberated chirps below the original chirp’s Object (typically on
track 1) track by track.
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Arranged this way, these Objects now appear in the list of reverberated chirps.
The track number supplements the Object name for a better orientation.
With the mute and solo buttons of the tracks you can exclude single Objects
from appearing in the list.

Some important hints

Digital Reverbs

— If available, use digital Ins and outs.

— If only analog Ins/Outs are available, use 24bits sound cards for recording.

— Too low signal level worsens SNR.

— Absolutely avoid digital clipping!

— Keep dry/wet ratio at zero! (only wet signals should be recorded)

— Record the complete reverb tail of the chirp.

— Avoid recording clicks from switching gear on or off !

— The chirp length normally shouldn’t exceed one minute! (Except when any
chirp-remains appear. Details for this: see below.)

Natural rooms

— Light distortion of the speakers is OK for longer chirps.

— Avoid digital clipping of the AD/DA converters!

— The louder the chirps are reproduced, the better the SNR is.

— The longer the chirps are, the better continuous disturbing noises (e.g. traffic
noise or hiss) disappear from the result. The SNR of the final impulse
response improves significantly in comparison to the SNR of the reverberated
chirp if the used chirp is longer than one minute!

— You can also use longer chirps to obtain good results with a lower playback
volume. That keeps speakers, ears and nerves much healthier!

— Absolutely avoid impulse-like disturbances while recording, like coughs,
moving chairs or falling objects. Otherwise it will result in remains of the
chirp in the impulse response.

— The frequency characteristics of the microphone, amplifier and speaker are
transferred to the result. So use high-end gear, if possible. The speaker
normally is the weakest link.

Problems and solutions

Chirp remains in the impulse response

In some cases there are remains of the chirp in the calculated impulse response.
Two typical causes and its solutions follow:

Cause 1: Aliasing

When using older digital reverb units, which are working with a low internal
sample rate, aliasing can happen. In a spectrogram visualization of the
reverberated chirp you can see the disturbing chirp, which is mirrored in the
frequency domain when adjusting the visualization’s range to - 9o dB.
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Solution

Experiment with different sample rates or try to use digital Ins/Outs to reduce
the aliasing component.

Apart from that the only solution is to use a very long chirp. The remaining
chirp in the impulse response should now be running through a very narrow
frequency range (e.g. from 12000 to 12100 Hz) and can be removed with a
steep band pass. Very suitable for this purpose is the FFT-Filter.

Cause 2: Erroneous impulses from the recording, reverberation or signal transmission

Impulses or impulse-like acoustic noises also result in chirp remains in the

calculated impulse response. The procedure reacts very sensible to such

disturbances. Impulses with a level of near

-50dB will already result in unwanted disturbances.

Typical sources are:

— Chirp playback or recording glitches caused by buffer or driver problems

— Cracks from starting: The chirp has to be played from the very beginning,
otherwise the playback starts with a non-zero value, which always results in
a crack.

— Crack by stopping the recording too early. Same thing as above: The last
played sample is not zero. After stopping the output is zero which results in
a crack.

— Impulse-like disturbances such as coughs, moving chairs, doors or falling
objects

"~ And last but not least: defective cables and plugs!

Solution

To find the cause of the disturbing impulses, listen carefully to the reverberated
chirp! If the cracks are reverberated too, the problem is at the playback side. If
they are dry, it is a recording problem. In the spectrogram view of the
visualization you can realize impulses as vertical lines.

Performance problems when calculating impulse responses from long chirps (longer
than 1 minute)

The calculation of the impulse response from longer reverberated chirps is
extremely performance consuming. Also the memory need is high. For chirps
with a length of six minutes (44.1 kHz), an amount of about 700 Mbytes is
needed.

Solution

Make sure that there is enough memory available. If necessary, increase virtual
memory. If virtual memory is used, the calculation time will rise significantly
(swapping!).

The calculation of a six minutes chirp on a P4 2.4 GHz with 512 MB RAM will
last about ten minutes.

The progress indicator of the calculation behaves non-linear — it will become
slower and slower, because the amount of necessary operations increases at
the end of calculation.
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It is recommended to perform the calculations via batch processing (e.g.
overnight).

Limitations of the impulse response procedure when simulating digital reverb units
With the impulse response procedure you can only simulate so-called linear
and time-invariant systems.

Effects such as chorus or flanger change are frequency response time-
dependent. They behave time-variantly and so it is not possible to simulate
them. This applies also to modulated effects (e.g. by an LFO).

Distortion and compressors have a non-linear behavior and cannot be simulated
as well.

The reverb presets from multi-effect units often use other effects besides the
reverb effect, for instance chorus, in order to “camouflage” the unwanted
resonance frequencies, which are typical for digital reverb algorithms. In these
cases an exact reproduction of the reverb preset is not possible.

The genuine strength of the procedure is the simulation of natural rooms in a very
high quality!
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Play Once

This option plays the current project (Wave Project or VIP) one time. Playback
will start at the current play cursor position.

Shortcut: Spacebar

Play Loop

Plays the current project (Wave Project or VIP) as a continuous loop. Playback
will start at the current play cursor position.

Shortcut: Spacebar

Play With Preload

If you require playback to start instantly, choose this option to preload the
audio buffers, then click OK to start playback. This function is useful when
you want to synchronize something ‘manually’ and an accurate playstart is
required

Shortcut: Shift + Spacebar

Play In Range / Loop

This option will start playback at the beginning of the audio tracks, or the
current song position, and continues until the end of a selected Range is reached.
Once the end of the Range is reached, playback then continues from the
beginning of the Range. This is also a quick way of testing sample loops.

Shortcut: Shift + P

Play only selected Objects

Only selected Objects will be played. All unselected Objects will be muted
temporarily. If the play cursor is not located on the first selected Object’s time
position, it will be moved to this position.

Shortcut: Ctrl + Space

Play cut > Play to Cut start (InPoint)

The range up to the beginning of the marked Range will be played. The duration
of this cut can be specified using Options > Program Preferences > Set Preroll
Time or in the pre-settings in the Crossfade Editor. The settings are consistent.

Shortcut: Fs
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Play Cut - Play from Cut start (InPoint)

When simulating a cut using a marked Range, choose this option to play back
a short segment of audio, starting from the beginning of the marked Range
(Cut Start). The duration of the playback is defined by Options-> Program
Preferences->Set Preroll Time or in the pre-settings in the Crossfade Editor.
The settings are consistent.

Shortcut: F6

Play Cut - Play to Cut end (OutPoint)

Choose this option to play back a short segment of audio that stops at the end
of the marked Range (Cut End). The duration of the playback is defined by
Options-> Program Preferences->Set Preroll Time or in the pre-settings in the
Crossfade Editor. The settings are consistent.

Shortcut: Fy

Play Cut - Play from Cut end (OutPoint)

Choose this option to play back a short segment of audio that starts at the end
of the marked Range (Cut End). The duration of the playback is defined by
Options-> Program Preferences->Set Preroll Time or in the pre-settings in the
Crossfade Editor. The settings are consistent.

Shortcut: F8

Play Cut - Play over Cut/Crossfade

VIP: A cut is simulated. Playback will start slightly before the marked Range,
then will skip the marked Range (Cut), and end just after the Range. The
duration of the playback is defined by Options-> Program Preferences->Set
Preroll Time or in the pre-settings in the Crossfade Editor. The settings are
consistent.

Shortcut: F4

Stop

Choose this option to stop playback (or recording). The playback cursor will
return to the point at which playback commenced. This point can be set using
the playback parameters (P).

Shortcut: Space

Stop and Go to Current Position

Choose this option to stop playback (or recording), and have the cursor remain
at the point the stop command was issued.

Shortcut: “” or “decimal” (Num Pad)
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Restart Play

Choose this option to restart playback from the original play cursor position.
Tip: You can select this option while audio is playing.

Shortcut: Backspace
Playback Options
Choose this option to launch the play parameter window.

Play Parameter =]

—Samplerate Autoscroll—————— ~Varipitch—————————————— Vol ——
[44100 =] || & o Pitch 1
[" active for Zoom <15

= soft & Page

Halftones

Int. Rate 44100

—Scrubhbing (humeric 0)

AT

 Absolute BPFM Orig

* Two speed IU.125 = 7
* Jogging BPHM Out = —
[ active - -

" Stop st position
Device: |Realtek AC37 Audio LI Cptions: 7 |

Sample Rate

The sample rate at which a project is played back can be changed here, provided
that the soundcard supports this rate. Use this if you want to play back a
project that has a sample rate that your sound card doesn’t support. You can
change the playback sample rate here and then compensate the tempo change
with the varipitch function.

Options

Opens a properties screen, which displays which playback features (sample
rate, resolution, hardware pitching ...) the selected driver supports. There is
also a button to open the Windows multimedia mixer in playback mode (if
your soundcard provides one) to quickly adjust the output level.

Device

This allows you to define the device used for playback of Wave Projects and
the stereo master device for VIPs. Devices that show up in this list are set up
in the Options Menu -> System/Audio settings
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Autoscroll

The ‘Autoscroll’ section activates the autoscroll feature, which is especially
useful when working with long disk files. The Wave Project window will follow
(scroll) the play cursor during playback.

When working in ‘2’ or ‘3’ section display mode, the autoscroll feature causes
the individual sections to follow the play cursor. If you have zoomed into any
of the sections, the play cursor will move through the section faster, resulting
in additional screen redraws.

There are two autoscrolling options:

Sort: The ‘Soft’” option smoothly scrolls the entire wave form, with the play
cursor remaining centered in the display. This mode requires a fast graphics
card, as the entire screen is scrolled between the marker steps.

Pace: The ‘Page’ option performs a page by page scrolling.

Please note that autoscrolling processing power requirements are based on your CPU,
graphics card and display resolution. Given these requirements, you may encounter
small interruptions to audio playback. Should this occur, simply disable the autoscroll
feature, or increase the buffer size (select ‘Setup > System’).

You can switch on/off auto scroll mode via the “AutoScroll” (“Scroll” key)
menu option. The “AutoScroll Soft” (Shift + “Scroll” key) menu option toggles
between “page” and “soft” mode.

Scrubbing

You can "scrub” audio by pressing + holding the o key, on the numeric keypad
(with Numlock active), and moving the mouse left<->right. Playback starts at a
very low speed, with the mouse position — relative to the play cursor —
responsible for controlling the scrubbing speed.

There are three scrubbing modes available via this dialog:

Joccing: The distance between the play cursor and the mouse determines the
playback speed.

Two SpeED: Scrubbing takes place at two speeds. Normal playback speed occurs
when you drag the mouse quickly over the project. When you drag it slowly,
the alternate (second) speed is used. You can specify a playback speed factor
(for the second speed) in the numeric field. The default is o.125, i.e. 1/8th of
normal speed.

Assorutk: The position of the mouse in the window determines the playback
speed. At the left window border, playback speed is 200% backward, at the
right border — 200 % forward, in the middle of the window, the speed is o.
Realtime resampling is performed when changing the playback rate. This occurs
without changing the sample rate of the sound card. For best performance,
use small play buffer sizes and a fast processor.
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Note: When working with smaller buffer sizes (4000, 2000 samples), scrolling becomes
‘softer’. Please verify the performance of your computer system at smaller buffer sizes
to avoid any interruptions to playback. You may need to experiment with several of
these small settings, to ensure error-free playback.

Varipitch

Samplitude supports smooth changes to pitch during playback, even in multi-
track projects.

Activate the varispeed mode (with the ‘active’ button). This will allow you to
adjust the playback speed in the following ways:

VERTICAL SLIDER: Changes the playback speed from -200% to +200%
Prrcu Factor: Lets you manually specify a pitch factor

HarrroNEs: Lets you specify a value for halftones. Playback will be transposed
by the user defined number of halftones.

INTERNAL RaTE: This setting defines the sample rate used for the varipitch
calculation. If you wish to play a 48 kHz WAV file, but your sound card only
supports rates up to 44.1 KHz, simply set the internal rate to “48”, and activate
varispeed. The audible results are identical to those you would hear if you
were playing back via 48 KHz hardware.

This function is also very useful for digital playback to DAT, at 44.1 KHz, and
vice-versa.

BPM: Use these two boxes to enter the original BPM value of your material,
and a destination BPM value. The destination BPM value is then achieved via
the varipitch function.

Shortcut: P
Playback Mode - Loop Mode

Playback is performed in Loop Mode, which means the playback continues
from the beginning of a range after reaching the end of a Range or the project.
This menu item is mainly present to map a keyboard shortcut on it. You can
also switch the loop mode on/off via the LOOP button on the transport control.
Playback Mode - Change Playback Direction

Choose this option to change the direction of playback (i.e. reverse).

Playback Mode - 0-Tone Mode

The O-Tone Mode is a special live playback mode that fulfils the requirements
of radio editors, but is also useful in other situations.
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When o-tone mode is activated, the Objects on the first track of the VIP will be
played back sequentially. When playback is started, an area comprised (precisely)
of the first track object will be marked and played back.

When playback stops, the next Object will be marked. When playback is
restarted, the next Object will be played back as well. Following playback of the
last Object, the first Object will be marked again.

This facility allows separate audio Objects positioned on the Track (and
separated by pauses) to be played back one after another, at the push of a
button.

You can also play back multi-track projects in O-Tone Mode - e.g. surround
sound for theaters, or other live projects. Only Objects on the first track will be
used for the start/stop markers, so please ensure that the desired Objects are
placed on the first track.

O-Tone Mode can also be used when the Object Manager is activated. In this
scenario, the Object list can be used for quick selection of the next Object you
wish to play.

This is perfect for mixing live speech with pre-recorded material (the ‘original
tone’).

Playback Mode - Auto scroll

Switch Autoscroll on/off. For more information on auto scroll, please read the
“Autoscroll” section, in the playback parameters chapter.

Shortcut: Scroll

Playback Mode - Autoscroll soft

Switch Auto scroll between “page” and “soft” modes. For more information
on auto scroll, please read the “Autoscroll” section in the playback parameters
chapter.

Shortcut: Shift + Scroll

Scrubbing active

Switch scrubbing on/off. For more information on scrubbing, please read the
“Scrubbing” section, in the Playback Parameters chapter.

Shortcut: Alt + Shift + Arrow down
Jog/Two Speed/Shuttle

Switch between the three scrubbing modes. These menu items are mainly for
mapping keyboard shortcuts. For more information on scrubbing, please read
the “Scrubbing” section, in the Playback Parameters chapter.

Scrub left /right
To scrub left or right with the keyboard.

Shortcut: Scrub left Alt + Shift + Arrow left
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Shortcut: Scrub right Alt + Shift + Arrow right

Record

This menu item starts recording, immediately.

A note about multi-track recording: Samplitude can simultaneously record as many
files (tracks) as your sound card/s and system can deliver.

Before starting recording, you need to select the appropriate input device for each
track. This can be done via the Track Info dialog, or by right-clicking on the ‘R’
button in the VIP track.

Select the tracks you wish to record to with a mouse click.

Recording then occurs as per stereo/mono recording.

Shortcut: R

Record Options

This menu option opens the Record window. All recording settings can be
made here. Once set, you don’t need to reopen the dialog, and can start recording
by pressing the Record button on the transport control, or by clicking the toolbar
icon.

Record Parameter - O tracks active il
—Format—————— ~Record Mod —Sample Rat —Options
lh' @~ 18 Bit PRI Manitaring Mode:
ave ha -
. E!‘ IPeakmeterMommrmg LI Monitor
E Opti o ) " Besamp. ta 44.1
B EIPTERS oo ¢ 5 I™ Playback while Recording
- i W Create ¥IF Object
Infar Mano
© Mona (Mi) ¥ Update object during recording
No compression I Read CD/DAT Marker
(editakle)
I Preload Record Offset (Samples) 0
Fecord Start Fecord Length
’7 1200 ® [ active ’7 3.600.000 smet [~ active Extended aptions
—FRecord Device and File Path —Record infarmation
IREaItekACB? Audio ﬂ Info Fecord Time:  00:00:00:00 Wisualizer
Femain. Times:  12:40:62:07
‘C YWWMAGESequoiaitAudiol Tutorialy TUTORDTOT M MAW (| Disk space G 30414802 m‘
Take + | [Takes
‘ Becord | Stop EBecaord Pauze | ‘ Markar 1 | I
Track 1 << | 3% Close I Help |

Recording and playing are two independent threads that can take place independently.
This allows you to close the recording dialog, after recording has commenced. When
live updating of the recorded Object is enabled, you will see your recorded audio
material appear in the VIP, in real-time. You can freely play and edit your project,
while recording is taking place!

Attention: As you can start/stop the playback of the VIP, independent of recording
in the background, you cannot stop recording by pressing the space bar! To do so,
you must click the Record button /icon again, or re-open the Record dialog and click

«Stop »! 207
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Shortcut: Shift +R
The settings for most Recording tasks can be made here.

Record Format

You can specify the format to record in. This allows you to record directly in
mp3 or AIFF format, for example. The Format options dialog allows you to
select the data format you wish to save in - e.g. bit rates or sampling resolution.
Some Internet formats (e.g. Real audio) can only be recorded as is - i.e. they
are “non-editable”. Normally you won’t use these non-editable formats in
projects, and will record audio in the wave format, and export it to the
compressed format, after the fact. By recording in a compressed format (e.g.
“.wma”), you avoid the extra conversion step. It is not possible to record in
compressed audio formats during multi-track recording.

Record Mode

The radio buttons in this section are used to select either stereo or mono,
whether you want to record the audio into a RAM Wave Project or as a Wave
Project, and whether you want to record in 32-bit float, 24-bit or 16-bit format.

16 Brt: Select this option to record in 16-bit format.
24 BiT: Select this option to record in 24-bit format.
Froart: Select this option to record in 32-bit Floating Point format (IEEE).

SterEO: Click on (enable) this option to record from a stereo input device into
a stereo Wave Project.

Mono: Click on (enable) this option to record into a mono Wave Project. If
you select this option, the audio recording device selector changes to mono
devices, actually the left or right channel of a stereo input pair. Make sure you
select the right one (Left or Right channel)

Mono (MixpowN): Click on (enable) this option to record from a stereo input
device into a mono Wave Project by adding the contents of both channels and
applying a -6 dB attenuation.

PRELoaD: Click on (enable) this option to load all buffers before recording
begins. This enables you to instantly start recording when the Record button is
clicked. If disabled, there will be a short pause (depending on the size of the
Buffers) before recording actually begins.
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Sample Rate

This option allows you to select the sample rate of the recording. The most
common sample rates are selectable as (radio button) presets. You can also
type the desired sample rate directly into the box.

Important note: Your audio card MUST support the selected sample rate or recording
will not work.

Resamp. To 44.1: Select this option, and Samplitude will perform a real-time
Sample Rate Conversion to 44.1 kHz. — i.e. if you have a DAT tape that was
recorded at 48 kHz, and plan to master its contents to a Red Book audio CD,
this option can be used to convert the sample rate to 44.1 kHz while Recording
the DAT into Samplitude.

Note: Real-time resampling is not always the best option.

It should also be noted that higher quality Sample Rate Conversion algorithms are
available in Samplitude. These are performed off-line, after the file is recorded (the
highest quality algorithms are too taxing for real-time processing during recording).

Record Start Time/Length

This box enables selection of a specific duration for recording in hours, minutes,
seconds and milliseconds. The recording take will automatically disengage when
the specified duration is reached. To enable this function, check (tick) the active
box, and enter the desired take length in the numeric box. Note that Remain.
Time is also activated (see above)

Record Device and File path

Input DEvICE: Select the desired input device in this field. Multiple sound
card inputs will be displayed here. By clicking on the “Info” button you can
check on the record capabilities of the selected sound card. It shows you
information on the sound card driver and it’s capabilities.{bmc
RightW.bmp}Record Device Dialog. You can customize the device names or
disable devices you never in the System/Audio dialog, Record Tab.

Note: If you do not see your audio card listed in the drop-down list, go to the System/
Audio Settings (key y) and check, if the right driver Model is used and the device is
enabled at all. It also can help to press the RESET button there!

Fire Partn: This dialog allows the user to determine the name and hard disk
destination of the Wave Project. The path to the left of the button indicates the
destination of the audio file to be recorded. If you click on the yellow folder
button, you may enter a new name or location for the audio file. This is an easy
way to redefine a target directory or hard disk as the destination for the new
audio file. If you create a new name, a new Wave Project with that name will
be initialized. Usually, you don’t have to change this because you can define
auto-naming rules in the Track Information dialog.

209




“Play/Rec” Menu

210

Info (Recording Device Capabilities Dialog)
This dialog allows you to determine the recording capabilities of the selected
recording device.

SampLE RaTE/REsoLuTION: Boxes for supported sample rates/resolutions are
checked. For WDM drivers, the reported capabilities depend on whether or
not WDM compatibility mode is set (in the System options - Shortcut: y).

ZERO LATENCY MONITORING (ZLM): Pressing “test ZLM support” will indicate
whether or not your device supports Zero Latency Monitoring. You can activate
Zero Latency Monitoring in the Recording Options section of the Recording
Parameters dialog.

Device INFo: Indicates the system name of the recording device. Also allows
you to change the name (used by Samplitude) of the recording device, listed in
the track information/mixer panels. (“System/Global audio options” dialog -
Shortcut: y). Driver version and information is also displayed.

OprEN WINDoOws MIxER: Opens the recording mode of the Windows Multimedia
mixer panel (if your soundcard provides one), allowing you to quickly adjust
the input level.

Monitoring Mode / Monitor

Most sound cards allow you to preview the audio signal you are about to record,
and (depending on the features of the sound card) you will be able to monitor
the recorded signal during recording. For more Information about monitoring,
read the appropriate chapter below (Menu Play/Rec ->Monitoring)

Playback while Recording
Check (tick) this box to record the Wave Project while listening to previously
recorded tracks.

Record Offset

If you have a record offset enabled, Samplitude will automatically compensate
for the offset. The numeric box, record offset (samples), allows you to specify
an offset which is calculated in samples.

In some rare cases and on some systems it is necessary to compensate for any
delays caused by processing speed and other factors, such as your sound card’s
ability to switch between Playback and Recording mode. Delays can occur
between the recording and playback of audio when the Playback while Recording
feature is turned on. This option allows adjustments if this occurs. Good values
to start with are in the 20-2000 sample range — experiment to see which setting
best suits your device/system.

Create Vip Object
Check (tick) this option to automatically create an Object (in the VIP), after
Recording a new Wave Project. If you check this box, a new Object is created
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for every recording take and inserted at the cursor location/in the Track(s)
enabled for the recording. If the box is unchecked, Samplitude will not create
an Object.

Update Object while recording:
Enable real-time updating of the recorded Object in the VIP. If disabled, the
object will be created after the recording stops.

Read CD/DAT Marker

If your audio device supports the input of CD or DAT markers, Samplitude
will note the position of these markers in the recorded project. Check (tick)
this box, to enable the capturing of CD/DAT markers.

Record Options = Extended Options

Several additional options can be reached by opening the “Extended record
options”:

Extended record options i|

[ Show small record window during recording

[ Show small record window during Punch In recaording

[~ Each Fecord Take in a new file

Set cursor to record end position - next recording starts at this
position

[ Record Button in Record Options can stop Recording

¥ Show confirmation dialog (0K, Delete) after record

Resampling Quality ...

Cancel | Help...

“Show small record window during recording/punch in recording”
You can display a small non-modal recording window with the main recording
controls while recording. Deactivate the option if you don’t want this (V6
behavior).

“Each take in a new file”

You can decide if you want Samplitude to create a new file for each take. These
auto-created Wave Projects are named with the original Wave Project’s name
and a suffix “_Txxx”, where XXX is the take name.
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Set cursor to record end position

After finishing a recording, the play cursor is replaced to the recording’s end
position. So the next recording will start at this position. This simulates
recording on a tape machine.

Record button in Record Options can stop recording
Disable this option when you experience problems by accidentally clicking the
record button twice.

Show confirmation dialog (OK, delete) after record
You can disable the confirmation dialog (Use the recording or not?) by
unchecking the box if it should annoy you.

Resampling Options

Quick access to the resampling quality settings, might be necessary when
performing real-time resampling, e.g. recording from DAT into a 44.1kHz
VIP.

Visualizer

Click on this button to open the Visualization window. (see Window Menu
chapter for a detailed description)

To minimize system requirements, you may wish to disable the Monitor
function, if it is not crucial to the recording. This may be necessary if you are
pushing the limits of your system.

During recording, the meters will be slightly delayed in their reaction, due to
the priority level change. The most important task is to keep your recording(s)
error free. As such, the updating of VU meters is a lower priority task. This is
to avoid overloading the computer. The levels are still shown at their correct
values. If you use lower buffer settings, the meters are updated at shorter
intervals (i.e. they are faster).

Tip: Adjust the Input signal’s level so that the loudest peak doesn’t quite reach odB.
The Input level of the signal must be adjusted at the source or with a mixer. Some
audio cards also allow you to adjust the input signal.

As with all digital audio, any levels above odB are clipped, resulting in ugly
distortions. If a red line is displayed at the up, we suggest that you lower the
input signal level. If this happens during recording, you will probably need to
re-record the take. If the take has been completed, however, we suggest listening
to the file before deciding to discard it — the clipped section may not be
significantly damaged.

Note: Samplitude offers a de-clipping feature in the Effects menu. This allows for
audio repair in cases where re-recording is not possible. This should only be used as
a last resort — it is always better to avoid clipping during recording, if possible!
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Reset Peak
Click on this button to reset the LED Peak-Meters to the off position.

Record Information
This display contains 3 numerical counters which show the following data for
recording:

Recorp TimEe: This counter indicates the length of the current recording in
hours, minutes, seconds, and milliseconds.

RemaIN. TiME: This counter shows the remaining space on the hard disc in
terms of time units. This counter is updated in real-time during recording.

Disk Srace: This counter displays the remaining space available for recording
on the specified partition in hours, minutes, seconds and milliseconds.

Take

A “take name” (Object name) can be set for the Object, prior to starting
recording. This can be done by entering a name in the text box to the immediate
left of the “TaxEe ” button. Each take is named with this name and an ascending
take number. When the TAKE button to the right of the text box is clicked, the
take number is increased by one.

Marker

You can drop markers into the project during recording. The current cursor
position is used to insert markers at positions you may wish to select later, for
clean-ups, or similar tasks.

Each marker can be named (if you have timel) by entering a name into the
adjacent text box.

Record button
Start recording by activating this button.

Record Pause
Pauses recording until pressed again.

Stop

Stops the recording process. Samplitude will ask you whether you wish to
keep or delete the recording.

Should the computer become overloaded due to data swapping or hard disk
access issues, for example, simply interrupt the recording with a right-click or
the Spacebar.

Track
You can switch between the tracks and so adjust the recording parameters for
all tracks in one go.
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Close
Close the recording options dialog. You can open and close this dialog without
affecting an actual recording!

Record Mode/Punch In = Record without Playbck / Playback
while Recording

Switch between recording with or without playback of the other tracks (not
armed for recording).

This menu item is mainly intended for mapping a keyboard shortcut on it.
You can also switch the record mode via the Audio menu on the Transport
control.

Record Mode/Punch In=> Punch In Mode

This option activates the Punch mode. Punching In and Out allows real-time
or automatic commencement and suspension of recording at specific points
in the timeline.

Once the Punch mode is active, Punch-In record can be used to record audio
segments without stopping playback.

The ability to predetermine and automate this process is very useful for
musicians or composers who work alone. In addition, Punch In and Out points
can be determined at a single sample level, allowing accurate positioning of
entry and exit points.

The Punch In mode toolbar (shown below) is very useful when working in
Punch In mode.

Punch In mode requires one or more tracks to be armed for recording. The
tracks need to be configured in the same way as for multi-track recording —i.e.
each track requires a specific device selection. Right-click on the ‘R’ button of
each track to make your input device selection(s).

Punch recording can be done in two ways:

Punch-In/Out ‘On-The-Fly’

This allows you to start the recording (punch in) at any time during playback.
Once recording commences, it can be stopped at any time (punch out) with
playback continuing.

This is very similar to tape based multi-track recorders, which allow you to
correct mistakes made during previous recording passes by overwriting
segments of the tape.

Activate Punch-in mode. Simply start playback with the Spacebar. Punch-in
recording can be started by clicking on the punch record button on the toolbar.
The same button punches out of record mode with playback continuing. To
stop playback, press the space bar.

(The same function is obtained by clicking the dedicated Punch-In Record
button, which is obsolete now but left for convenience)

Punch-In/Out with Markers
The second method involves punching in/out of Record mode through use of
special markers. This is a more automated way of dealing with punch-in/out
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recording, and is very useful for musicians or composers who work alone.
By predetermining In/Out points, this method also eliminates the risks attached
to misplaced manual “punches”. Punching In and Out with markers allows
you to specify (down to single-sample level) the exact points where the recording
is to start and stop.

As you are working in a non-linear, non-destructive environment, any mistake
or unwanted take can be removed or undone without problems. Any existing
material in the track will still be there.

To operate in this mode, it is helpful if a Range (that defines the beginning
and end of the recording), is selected. This instructs Samplitude to stop playback
at the end of the Range. (If a Range is not selected, you will have to manually
stop playback, after the recording has ‘punched out’)

The Set Punch-In marker and Set Punch-Out marker functions are used to instruct
Samplitude where to punch in/out.

Position the play cursor appropriately (prior to the punch-in point), and start
playback/recording with the Punch Record button, found in the Punch Toolbar.
Note: When working with punch injouts, it is useful to have the Auto Crossfade
mode activated (by clicking on the corresponding button in the Samplitude toolbar).
The Auto Crossfade will create smooth transitions automatically between takes.

Deleting or repositioning punch in/out markers

The In/Out markers can be relocated by repositioning the cursor, and clicking
on the appropriate Toolbar button. To delete punch in/out markers, click on
the Remove Punch In / Out Marker Toolbar button.

Looping Punch In recording

Samplitude can also perform looped punch-in recording. Simply select a Range
over the desired punch region. The Range is played back until you stop playback
with the space bar.

Each time the program loops through the Range, new takes are recorded at the
punch markers. Make use of the Take Manager to find the best take after
recording has completed.

Record Mode/Punch In - Set Punch In/Out Marker, Remove
Punch In/Out Marker

The In/Out markers can be relocated by repositioning the cursor and clicking
on the appropriate toolbar button. To delete punch in/out markers, click on
the remove Punch In / Out Marker toolbar button.

This menu item is mainly present to map a keyboard shortcut on it. You can
set the Punch Markers also via the In and Out Marker buttons on the Transport
Control.

Record Mode/Punch In - Set Punch Additional In/Out Marker,
Remove Additional In/Out Marker

You can define several Punch/Out Ranges in the project, so that you do several
Punch In/Out recordings in one go. This menu item is mainly present to map
a keyboard shortcut on it. You can set additional Punch Markers by pressing
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ALT and clicking the In and Out marker buttons on the Transport Control.
Or drop additional punch markers by moving the play cursor to the desired
position and click on the PunchIn/PunchOut key (Transport Console) whilst
pressing the Alt key.

Record Mode/Punch In > Live Input Mode

The Live Input Mode is another very powerful feature of Samplitude.

It allows you to mix live inputs from the sound card channels via the real-time
mixer.

This turns Samplitude into a full-scale digital real-time mixer with unlimited
channels, internal 32-bit processing, external 24-bit I/O (requires compatible
audio cards) and effects, including third-party plug-ins!

The Basics

The Live Input Mode is somewhat similar to recording with multiple sound
cards inputs. All channels/tracks that are to be used for live mixing need to be
armed for recording — i.e. each track must be configured with the correct
recording device and the track arming buttons need to be active.

Once playback of the VIP is started, live signals on the inputs of the audio
device(s) are routed through the Mixer. Mixer window controls are used to
create a mix. VIP Objects are also played back while the live inputs are processed.

Latency

Audio processing in Samplitude obviously takes time. This may lead to small
delays at the outputs when heard alongside the incoming signal. This delay
(latency) is very much dependent on the VIP buffer size, and can be reduced
by using smaller VIP buffer settings.

You should use settings that enable the real-time processing of audio without
introducing errors, or audio artifacts. A setting of 4 buffers, at a buffer size of
8000 stereo samples, creates a delay of 0.7 seconds. A reduction in buffer size
(to 2000 samples) results in a delay of only 0.2 seconds.

Experiment with the buffer settings to find the optimal settings for your system.
In some systems, the latency may make it impossible to use the Live Input
Mode as an analog mixing console replacement.

Applications
The Live Input Mode may be used for the following:

Digital Mixer for ADATSs (or other multi-track tape machines).

During Playback of an ADAT tape, 8 Tracks are transferred via a digital audio
card and processed by the Samplitude Live Mixer. As the material is transferred
digitally, there is no quality loss, and the latency is inconsequential, as the
ADAT tape does not have any “live” relevance.




“Play/Rec” Menu

Effects and Mix Down during Recording

Use the “Mix to File” function in the Mixer to create a new .WAV file from the
master signal. This allows Samplitude to record an audio file via the Mixer.
Don'’t forget to rename the newly created audio file after recording or you will
overwrite the contents of the previous take, during the next “Mix to File” process.

Samplitude as Live Effect Processor

If you are looking for processes that are not offered by effect units in your
rack, you can make use of some of Samplitude’s integrated effects. A live signal
can be processed with the FFT Filter, the Multi-Band Dynamics processor,
and the Stereo Enhancer. You may also use the many plug-ins available.
New, more flexible input signal monitoring is now available through ASIO
driver support.

Input monitoring on/off

Activates/deactivates input monitoring (depending upon the “REC M” button
on the transport console). Monitoring renders the input signal of the tracks
activated for recording (REC button in the VIP is lit) according to the selected
type of monitoring for the output signal. The LED peak meters in the VIP and
mixer react to the input signal.

Tape player monitoring

The preset method of monitoring as on a tape player and well-known from
earlier Samplitude versions:

When STOP is shown, the input signal is rendered, PLAY renders the track
contents, RECORD renders the input signal except with punch-in recordings
(which renders that which is outside of the track punch markers and within
the input. If the option is deactivated, it is left to the user to choose whether
the input signal is shown. Use the “Force monitoring” button (small
loudspeaker symbol beside/above the peak meter in the VIP/Mixer).

Hardware Monitoring / Software Monitoring / Software FX
Monitoring

The input signal is only given when the monitoring type has been selected.
Nevertheless, the peak meter continues to function. When the monitoring
type has been selected, audio monitoring is activated.

Hardware Monitoring

With MME drivers, this is the only possible type of monitoring within
Samplitude. In addition, the audio hardware must support ZLM (Zero Latency
Monitoring). You may of course offset a monitor signal in the Windows
Multimedia mixer externally from Samplitude. However, it is incompatible
with the punch-in functions.
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Software Monitoring / Software FX Monitoring

For cards with ASIO drivers, it is also possible to use software monitoring if
the card does not support hardware monitoring (ASIO Direct Monitoring).
Software FX monitoring also calculates the track effects into the monitoring
signal with the exception of all high latency-afflicted FX Inserts such as FFT
filters, Dehisser or Vocoder. The amp simulator, however, is applicable.
Samplitude is therefore also usable as an effects device with which one can
play live directly.

If you need all of the mixer effects, use the conventional Live Input mode,
which functions without ASIO, but is afflicted with higher latencies.

In addition, software FX monitoring must be active before VST Instruments
can be played live via the MIDI IN port.




New MIDI Object

A new MIDI Object is created on the selected track. After choosing the
command, you can select a prefabricated MIDI template (from the subdirectory
“Templates” in the Samplitude directory) from a small pop-up menu. It deals
with normal standard MIDI files which can be copied into this directory or
directly exported from Samplitude as a template. If only one file is in the
template listing, no menu appears — the Object is created immediately.

MIDI Editor

This menu point opens the MIDI Editor. Here you can view and edit the content
of the MIDI Object selected in the VIP.

If no MIDI Object is selected, you will be asked if you would like to add one.
Confirm this question with “Yes” to add a MIDI Object in the actual track at
the current cursor position or at the beginning of an area.

For more information on the MIDI Editor refer to the chapter “Working with the
MIDI Editor”.

Object Editor
Please refer to the corresponding section of the “Menu Object” chapter.

Key: Ctrl+O
Glue MIDI Objects

This command lets you glue together two or more subsequent MIDI Objects
of a track. As with the audio version of this command, (Glue Objects in the
“Objects” menu), all Object effects of the following Objects are lost.

This way, a looped Object can be changed to a new MIDI Object. For example,
you can create “real” MIDI data from a looped drum kit pattern for working on
further details.

Trim MIDI Objects

If a MIDI Object only refers to a section of a MIDI file or recording, this is
represented in the MIDI Editor in grey; unused areas are still available in the
MIDI Object and are, for example, available for subsequent length changes to
the Object.
This command removes non-used MIDI data to increase the overview within
the project.

MIDI Bouncing

All selected MIDI Objects are bounced into a new MIDI Object including all
Object and track effects.

You can choose between “whole Object” and “Sel. In Range” (selection/Range
bounce).
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GrosaL MIDI Bounce: All MIDI data are mixed together. Track and Object
effects are accounted for. A new MIDI Object is created in the selected track.
The bounced Objects are removed.

RaNGE/SELECTION BouNnce: All selected Objects in the current Range are
bounced. Track and Object effects are accounted for. A new MIDI Object is
created in the selected track. The bounced Objects are not removed.

Track Information
Refer to the corresponding section of the chapter “Menu Track”.

Key: Alt+i
Track MIDI Record

The MIDI recording mode is activated for the selected track.

MIDI Controllers
Refer to the chapter “MIDI”.

Key: Ctrl+Alt+A
VST-Instrument Editor

Refer to the corresponding section of the chapter “Menu Track”.
Tempo/Beat markers
Read the chapter “Tempo and Bar Changes” in the “MIDI” chapter.

Place new tempo marker
Read the chapter “Tempo and Bar Changes” in the “MIDI” chapter.

Place new beat marker
Read the chapter “Tempo and Bar Changes” in the “MIDI” chapter.

Place new beat position marker
Read the chapter “Tempo and Bar Changes” in the “MIDI” chapter.

Ignore all Tempo markers, use project tempo only

Here you can temporarily bypass all tempo marker settings. For all tempo-
relevant displays (snap and grid) only the project tempo is used.

Metronome active

Switches the Audio/MIDI metronome on/off. You can also click on the CLICK
button on the transport control.

Metronome settings
Refer to the corresponding section of the chapter “Menu Options”.
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MIDI settings
Refer to the corresponding section of the chapter “Menu Options”.

MIDI Record Modes

The MIDI Record modes define how the newly recorded MIDI data is inserted
into the VIP if there are already MIDI Objects at the recording position.

Normal

The record mode corresponds with the audio recording, i.e. a new MIDI Object
is created on top of the existing Object at every recording. The old Objects are
retained. This way you can record several takes of a passage and compare them
afterwards.

Overdub

The MIDI data is recorded in the existing Object; the new data is mixed with
the existing data. If a recording extends over several MIDI Objects, then these
are combined into one.

Multi-Overdub
In Multi-Overdub the new data is also mixed into the existing Objects; however,
individual Objects remain.

Replace

The MIDI data of the existing Objects is replaced. When recording over several
Objects, these are combined into one.

In contrast to audio recording, MIDI Objects already on the recording track
are played back in “Playback while recording” mode. This means that you can
still choose one of the record modes after completing successful recording.
Note: The MIDI Record Mode is also visible in the expanded transport control
and can be selected here.

MIDI Panic - Terminate all notes

This command sends a note off command for all 128 notes on all 16 channels,
excluding all of the MIDI devices deactivated in the MIDI options. In addition,
the sustain (controller 64) is deactivated and the pitch wheel and the modulation
are set to 0. An all-notes-off command is also sent to all of the VSTis used in
the project.

If MIDI tracks or Objects are available in the project, the same function is
accessed by clicking the “Stop” button in the transport control or tool bar (if
the project is in stop state).
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Project Properties

fixer Setup... Ctrl+Shft+hd
5.1 Surround Mode

Flayback Options F
Froject Information...

tedia Link. ..

Broadcast Wawe Manager. .

CD Arrange Mode
[DEstriEtve yiaye Eolibhme
Units of Measurament »

This item provides easy access to various modes, parameters and options.

Project Properties = Mixer Setup

Opens the Mixer Setup dialog, where you can adjust the general settings for
the mixer’s routing design. Please refer to the “Mixer” chapter for details.
This window lets you easily configure, save and load the VIP and mixer settings.

Project Mixer Setup LI
Preset
’7| LI Save | Load Delete |
[ Project and Mixer Configuration
| Tracks | | Submix Busses | ‘ AuxBusses | ‘ Master ‘
[¥ keep current number [¥ keep current number ¥ keep current number ¥ keep current setting

[ [ [

Surround Surround [~ Surround Master
ERNIEL [ e B

Fr Routing I use Advanced Oynamics for Mixer "Dyn Limiter"

j Iv Stereo Master
.

Media

B

Tracks/Busses | Steren Master | ¥ automatic latency compensation

[ Device Setup (frack in/oufput assignment. rauting)

10 Devices:  |Playback - Routing! |Keep current setup LI
Track number (Oforal) |0 Start with track (0 for active track) i
e | = | T |
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Project and Mixer Configuration:

Use this to set the number of tracks, AUX busses and submix busses. You can

also define effects and signal routing for the tracks and the master.

The window of the first track is always opened for effects routing of individual

tracks/busses. In order to reset the settings of all tracks you have to click on

the corresponding “All Tracks” button in the “Effects Routing” window.

There are two further options aside from the routing buttons:

— Adv. Dynamics for Mixer “Dyn.Limiter”: In the mixer master the resource-
saving “normal” dynamics can be used as a Dyn./Limiter or as advanced
dynamics of higher quality.

— Automatic latency compensation: Activates automatic latency compensation
for DirectX and VST plug-ins. This is activated by default.

Signal (output) routing for the master

— Keep current setting: Each track is assigned to an audio device (or a submix
bus). The final mix then takes place in external equipment or on the sound
card.

— Stereo Master: Normal mixing occurs in Samplitude’s stereo master. If your
sound card provides several devices, select one in the mixer (below the volume
faders) or in the Play parameters (key: “P”).

— Surround Master: If this setting is chosen, master channels are provided
for 5.1 surround mastering. Read the chapter “Working in 5.1 Surround
Mode” for more information.

Keep current number (tracks, AUX and submix busses)

By checking this box you can prevent the current settings from being overwritten
when loading a mixer preset. The current status of this checkbox is also saved
when saving a preset. Therefore, if you quickly want to add a few tracks, (e.g.
4 AUX busses and 4 submix busses), you only have to load the “4 Busses +4
Auxes” preset.

So, when loading a preset, the respective tracks and busses where the box is
not checked are added. In other words: Place a tick before saving where the
settings are not to be included in the preset.

Device Setup (track in/output assignment, routing)
In this section, you can conveniently select the in- and output device assignment
for several tracks simultaneously.

I/O Devices: Define the routing for playback, recording or both.

TRACK NUMBER (O FOR ALL): Start with track o as active track:

This option permits a change to I/O routing for a certain number of tracks. If
you set the track number to 4, starting at track 8, the selected routing setup is
applied to tracks 8-12.

223




“Options” Menu

224

Routing
KeEp CURRENT SETUP: No routing assignment takes place if a preset is loaded.

ASSIGN ALL TRACKS TO STEREO MASTER: All tracks (incl. AUX and submix busses)
are routed to the master. The panorama settings are alternatively set to left and
right via L/R panning. Use this if you are recording stereo sources as mono
pairs.

ASSIGN ALL TRACKS TO DIFFERENT MONO/STEREO DEVICES: All tracks are assigned
to the different output devices. In the System/Options Window (key: “Y”) you
can define which devices are available in Samplitude and which are not. When
routing to mono devices, the tracks are also placed right/left in panorama
alternatively.

USE SAVED SETUP OR PRESET: The settings saved in the preset are used.

Project Properties = Playback Options

This item launches the Play Parameter dialog (shortcut — “P”). Please refer to
the Play/Rec menu section, for further details.

Project Properties = Media Link

Nearly all other media files can be linked to Samplitude projects. These can be
complete MIDI songs (.MID files), video clips (AVI or MPEG files), or other
files for which an MCI is installed, practically all formats that the Windows
Media Player can play back.

Media Link x|
—File name SMFTE Offset —
I O File Start:
2 0
Freview Bemove Link
I~ Options
™ Pletilealvays I” Synchronization to Audio playback
I™ Load file always new I prioritize Video Play conection factor for exact positioning: |1
r Video Options
Window for current
Extract Audio from Video | ™ Show current Wideo Frames Lan

™ Show Video Track
Replaca Audio inVideo | Video Overlay (Hardware

viden output)

¥ Play Video without sound

¥ “ideo in Sequois window

OK | Cancel | Help.. |

“Linked” means that the linked media files are played back simultaneously
with the Samplitude project and that no synchronization occurs. The time
position is not verified directly. Samplitude uses the Windows Media Player
for playback, which merely starts and stops the selected file. As the media
player plays back the AVI or MIDI file, the file must be saved on your local
workstation.
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This option does not let you synchronize external devices with Samplitude. If
you require such synchronization, please refer to the chapter entitled
“Synchronization” for all information on conventional synchronization
functions via SMPTE, MMC and MTC.

Samplitude is capable of loading MIDI files and provides convenient editing
functions. It is no longer required to use the media link together with the
MIDI files, even if this is still possible. Playback then is not carried out by
Samplitude, but instead by the multimedia subsystem of Windows. The output
device is set in the Control Panel. Please note that the Microsoft GS Synthesizer
which is frequently used as a standard device for MIDI output prevents the
use of ASIO drivers for many sound cards.

Linking Samplitude projects to videos

Media Link makes it possible to add soundtracks to videos with Samplitude in

real time without requiring additional synchronization hardware.

In theory it is possible to work with digital videos directly in the original

resolution. However, to ensure optimum synchronization and a smooth

workflow the following procedure is recommended:

1. Digitalize your source material with “MAGIX Move Edit Pro” video editing
software (included in Samplitude Professional) and export a pilot video of
small size using a suitable codec which requires low decompression
expenditure and only contains key frames if possible. (DiVX or MPEG are
not suitable). MAGIX’s own MXV format is recommended, as this format
is optimized for real-time processing.

2. Link the video to Samplitude and apply the soundtrack.

. Remove the link again after track bouncing.

4. Replace or store the finished Wave Project in the video using the function
“Replace audio in video”. You can then save the sound in the original high-
resolution movie without requiring recompression (merely the soundtrack
needs to be exchanged). More details available from “File” menu -> Exporting
video sound...

W

Fire Name: Allows you to specify the file name, and source directory of the
media file. Clicking on the folder button launches a file selection dialog that
allows you to browse your hard disk(s) and specify the media file type. Once
you have located the desired media file, simply click on OK, and Samplitude
will make the link.

OFFseT: The Offset allows you to specify a different start time for the media
file. The default is a zero position, which means that the media file will start at
exactly position o (i.e. the beginning of the file). If the offset is varied from the
o position, playback of the media file starts at the entered position.

As an example, imagine that you're working on some audio for an AVI file,
and that this audio section does not occur until 15 minutes into the AVI file. It
would be unnecessary to create 15 minutes of empty space at the beginning of
the VIP, in order to line up the AVI frames and the audio.
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The better alternative is to specify an offset of 15 minutes —i.e. the AVI file will
start playback 15 minutes into the video file. All audio in Samplitude, however,
will start at position o.
It makes sense to write down the offset values of each individual project that
you are working with.

Pray Arways: This checkbox allows you to specify whether or not Samplitude
should play the media file every time you start playback, or recording. If
unchecked, Samplitude will not play back the media file. This is a quick way to
disable playback of the media file.

Loap Arways New: If this option is checked, Samplitude will always load the
media file every time you play back, or record to, your VIP or Wave Project. If
the box is unchecked, playback of the media file is performed from RAM. If
the media file is too large for the buffers, playback is performed from the hard
disk.

SYNCHRONIZATION TO AUDIO PIAYBACK: Synchronizes the new media link (e.g.
AVI-Files) with the existing VIP.

ExtracT Aupio FroM AVL: If the file type is an AVI file with video and audio
data, audio streams are extracted from all other information and the audio
information itself is put into a Wave Project. This allows you to extract and
edit the audio apart from the rest of the contents in the imported file.

You can also edit the audio data from a video file directly (without creating a
Wave Project as a copy of the audio data from the video file). Just open an AVI
file from the Open Project -> Wave Project... dialog.

Reprace Aupio 1N ExisTiNGg AVI: This calls the Export Video Sound function
to replace the audio data in the existing AVI or create a new AVI with new
audio.

P1aAY Vipeo WiTHOUT SoUND: This option applies to AVI files only. If the AVI
file contains audio, the playback of the AVI file and its audio could interfere
with Samplitude’s audio playback. For this reason, it is suggested that you
disable audio playback for the AVI.

VipEo IN SaMPLITUDE WinNDow: This option is only applicable to AVI file
playback. Normally, the AVI file is played back in a completely independent
window. This means that if you maximize the Samplitude window, you will
not see the AVI playback window. You would need to minimize, or scale, the
Samplitude window in order to display both windows on screen.

Checking this option, however, allows you to display the AVI window as another
Samplitude-related window, which always stays ”on top”, during playback. This
allows you to display the AVI movie any time playback or recording occurs in
Samplitude.
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Suow Vipeo Tracks: This option allows you to display a video track in the
VIP window - as individual frames of the AVI file.

In the upper left-hand corner of the VIP window, the current frame is displayed
when the play cursor is clicked/positioned at a particular location in the VIP
tracks. This allows you to position audio events and other material at exact
frame positions.

If you zoom in to the window, the video track is also enlarged, showing the
video frames at a lower resolution level. If you display the window at its lowest
zoom level, each frame is shown in the video track.

CORRECTION FACTOR FOR EXACT POSITIONING: This option allows adjustments
to the small delays that can occur on slower computer systems. The linking of
media files with VIP or Wave Projects is based on two playback processes: one
for the Samplitude window and one for the media file window.

No synchronization of material takes place during the playback process. This
means that on less powerful computers, the digital audio tracks and the media
file may run ‘out of sync’. The FX option allows you to specify a factor, used
for internal sample rate conversion.

Here’s an explanation of how it works:

As we cannot influence the playback speed of the media file, we need to adjust
the playback speed of the digital audio tracks. Imagine that a normal playback
speed is represented by a factor of 100. If the digital tracks play ahead of the
media file, playback needs to be slowed down.

This would be accomplished by multiplying the regular playback speed of 100
with an FX factor just below 1 (e.g. 0.998). This would result in a playback
speed of 99.8, which is slightly slower than the regular speed. This way, we
can align the digital tracks with the media file.

On the other hand, if the digital audio tracks lag behind the media file playback,
a factor higher than 1 must be entered (e.g. 1.002)

The “rule of thumb” for this factor is to use small value increments. The values
should stay around 1. You will need to experiment with this setting, as there is
no ”"one-size-fits-all” rule that can be applied here.

If you don’t have any sync problems with the digital audio tracks and the
media file, you should stay away from this field!

Remove Link: This button will unlink the media file from the Samplitude
window. This effectively stops all association with the media file. Use this
option if you no longer need to reference the media file.

Preview: The “Test” button allows the current link to be tested. Clicking on
the button should commence playback of the media file. If no playback is
visible in a Samplitude window, you may need to check the "Video in Samplitude
window” option. Other media file types should play back via the Windows
multimedia extension, in utilities such as the MIDI file player.
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Suow ActuaL FramEs: This option shows the actual video frames in the preview
windows of the video track.

Project Properties = Project Information

Select this option to display project Information (an ”overview”) about the
currently active project (HD Wave, RAP, or VIP).

This includes creation date, memory size, path and file names.

For Virtual Projects, a list of all included physical files (including linked Wave
Projects) is displayed.

Project Info x|
Nams: | Text Comment (saved in extra ascile)
Comment: d
Adtist |
Engineer: |
Technican: I
Keywords |
Sofwere: |
Copyright | ﬂ
Subject | o | Copy | Peste |
et Global GetGlobal | I Baad anly T Show on start
Broadeast\Wave Manager | oK | Cancel | Help. |

The Project Information window displays information in one of the following
two ways:

I. Project Information window (HD Wave, RAP)

For Hard Disk and RAM Projects (HD Wave, RAP), the Project Information
window will display: path (location on hard disk), file name, number of stored
Ranges, number of stored cursors (markers), date the file was created, date the
file was last edited, size of the file (in samples), and amount of hard disk space
(memory) the file requires. You can also add (type in) the following information:
Name, Comment, Subject, Artist, Engineer, Technician, Keywords, Software,
and Copyright.

Note: This is a very useful option for users who work with banks of loops, Foley/
library sounds, station IDs etc. These “sound libraries” can often appear in multiple
VIPs and can also be used by multiple engineers/producers. By setting important
files as Read Only, multiple users can work without the risk of altering important
files or library files. Additionally, when using the Remove Unused Samples option
(Tools > Remove Unused Samples), files marked as Read Only will not be touched.

2. Project Information window (VIP)
For Virtual Projects (VIP), the Project Information window will display: file
name, path (location on hard disk), number of stored Ranges, number of stored
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cursors (markers), date the file was created, date the file was last edited, number
of Objects in the VIP, and a list of ALL Wave Projects used in the VIP.

You can also add (type in) the following information: Name, Comment, Subject,
Artist, Engineer, Technician, Keywords, Software, and Copyright. This dialog
also allows you to set automatic backup options which run while the Project is
open.

SeT Grosats: Click on this button to save the information you added (typed in)
as a global setting.

GEr Grosats: Click on this button to recall the saved information (global
setting), and add it to the current active project. This allows you to quickly add
the same information to every project you're working on.

Cancer: Click on this button to close the Project Information window, without
accepting changes to the settings.

OK: Click on this button to accept the current settings, and close the Project
Information window.

Reap ON1y: Click on (i.e. enable) this option to make the HD Wave or RAP a
”Read Only” file. You can play the audio file, but cannot alter it in any way.

Project Status

Project Status 1 x|

[~ Project Infarmatian List of used Wave Projects:

Nams: TUTORD VP TUTORDZWAY (1.6 ME)
TUTOROIWAY (1.6 MEB)

Rty ot Ay 1.6 WE)
CAMAGE SequoisdiAudiol Tutorialy, TUTORO WAy (1.0 ME)

Ranges: 0

Markers 0

Creation: 03.04.1998 12:10:54
Last Edit 08.06.2001 1834454

Obijects: 52
Complete File Space; 59 MB

rWawve files outside projectfolder————————————————

I Waming during Loading T ﬂ—l —'I

™ Warming duting Saving

“hrite to Document [ oK | Cancel | Help |

Select this option to display project status (an “overview”) about the current
active project (HD Wave, RAP, or VIP). This includes creation date, memory
size, path and file names.

Exchangefile... | Selectobjects | Openfile |

Project Information
For Virtual Projects, a list of all included physical files (including linked Wave
Projects) is displayed. This dialog also shows you the number of markers and
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stored Ranges that are used. The information about creation and last edit and
how many Objects are contained in the VIP are displayed too.

For Hard Disk- and RAM Projects (HD Wave, RAP), the Project Information
window will display: path (location on hard disk), file name, number of stored
Ranges, number of stored cursors (markers), date the file was created, date the
file was last edited, size of the file (in samples), and amount of hard disk space
(memory) the file requires.

Original Time Position (only Wave Projects)

When you record or import some audio material in your VIP, a Wave Project
is created, which contains the audio data. Samplitude saves this time position,
where the Object was created.

List of used Wave Projects
All used Wave Projects are listed here. You can open the relevant Wave Project
window by double-clicking a list entry or choosing Open file.

ExXCHANGE FILE: You can exchange a Wave Project in all referring Objects at
once here

SeLecT OBJECTS: Selects all Objects referring to the selected Wave Project
You can activate warnings for loading or saving, when the project contains

Wave Projects, which reside outside the project directory.

Copry FILES opens the “Collect project files dialog”
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Project Properties - Broadcast Wave Manager

The Broadcast Wave extension lets you save information on an audio file, so-
called meta data, in a chunk of the BWF file. This meta data can generally be
employed proprietarily. However, we recommend that you observe the
guidelines issued by EBU and SMPTE, respectively.

Broadcast Wave Manager il
Wave Project Eile Description:
Marme | Directony
[Detault tor new YWawve Projects]
TUTORDZ WAy CAMAGH Sequoiash,
TUTOROIMAY CAMAGIX Sequoiad),
tutorl T Ay CAMAGI< Sequoiah,
TUTORDAWAY CAMAGIK Sequoial, Originator Origination Date:
wa_Closed 1x12 waw CAMAGH Sequoialh
Standard-Sarmple.wan CAMAGIX, Sequoiat | [Bo7zoma T+
Criginator Beference: I~ USID Format Origination Time:
- =
[ [132458 =
Timestarnp (HMS Samples)  00:00:00:00000
— Unique Material Identifier (UMID)
Country  Org. User
Coding Histony:
B
[ -]
ll—l —’I Extended options | 0K I Cancel Help |

Menu: Options>Project Properties>Broadcast Wave Manager.
By default, you can open this window via the Alt+Shifi+B shortcut or as a submenu
of the Project Properties.

Wave Project (left half of window)

This displays a list of the data included in the VIP. Select the respective file
using the mouse to display individual information. The corresponding BWF
information is then displayed in the right half of the window.

The main application of the BW Manager, however, is defining the meta data
which is to be included in the Broadcast Wave Extension of the material that is
to be recorded.

This meta data is then available to all users of the audio file in the future.
Some applications can read or extract this meta data for further purposes,
such as the administration of the audio data in the databases.

List of the different fields (right half of window)
All values set by the user are saved referring to the VIP and are applied to new
audio data.

Fire DescripTioN: Text box that accepts any entry. You can enter a short and a
long title here. A maximum of 256 ASCI characters can be entered.
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OricinaToRr: Contains details on the origin of the file, e.g. the description of
the producer. 32 characters max..

ORIGINATOR REFERENCE: Is determined by the Originator. This can be an
internal reference number. Within the scope of the EBU, a recommendation
according to EBU Recommendation R99-1999 on how this field should be
structured applies here. Activate the “USID Format” option to apply this
property to the entry. The entry can then be formatted according to the EBU
recommendation (max. 32 characters).

OriciNATION DATE: Displays the date on which the file was created. This can
also be edited. This makes sense, for example, if material has been stored to
the file for the first time, but has been recorded some time ago and that date is
to be used as reference. If the entry is edited in the BW Manager, the resulting
value is independent of the file properties.

TiMme: The time at which the file was created is entered here. Like the date, this
is automatically created from the file properties but can also be edited due to
the same reasons mentioned above.

TimEestamp: The timestamp saved in the Broadcast Wave extension is displayed
here. This is the timecode for recording the file, which is identical with the
timecode of the first recording if the recording was synchronous. For other
applications, this timestamp can provide information on the time on the day
of recording.

UNIQUE MaTERIAL IDENTIFIER (UMID): Handling of the UMID is regulated
by SMPTE. An appropriate document is available from SMPTE. The code
number is SMPTE 300M-2000. We recommend that you observe this guideline
as well as the agreements regarding the use of the UMID before using this
feature, which are to be agreed for your individual case. Use of UMID is not
absolutely necessary for a valid BWF.

Coping History: Besides including details on the file format (A: coding, e.g.
PCM; F: Sample rate; W: Bit width; B: Bit rate; this value is only used for non-
transparently coded material such as MPEG or MP3; M: channel number;)
each entry in this field contains the value T:. This is a comma-free text string,
which, for example, allows for the entry of the serial number of the recording
analog tape machine, codecs, dither types, AD converters or special signal
processing applied to the file such as denoising.

An entry is made when a file is recorded in Samplitude. If this file is then
processed again (e.g. the bit width has been reduced or encoded to MPEG), a
further entry is added.

Use of the coding history is regulated in the EBU Recommendation R98-1999.
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Extended options

SAVE BWF GRAPHIC DATA IN WAVE FILES: If this option is activated, Samplitude
creates a so-called Peak Chunk that saves graphic information as a meta data
in the file. Samplitude usually saves graphic data in separate files (.ho files).

READING GRAPHIC DATA AND USING SUCH DATA IN SAMPLITUDE: If this option
is activated, the peak chunk included in a BW file is used instead of a .ho file.
Project Properties = CD Arrange Mode

When you activate this menu item, Samplitude re- arranges newly inserted
Objects, and inserts pauses between the Objects (conforming to the Red Book
Standard).

Please refer to the CD > CD Arrange Mode section for more details.

Project Properties = Destructive Wave Editing Mode

This menu point activates or deactivates the destructive editing mode in the
Wave Project window. If this point is deactivated, then Samplitude is put in
“Virtual Wave Editing” mode.

Project Properties = Units of Measurement

This dialog determines the timing method used for the display/grid.
Please refer to the View > Units Of Measurement section for more details.

Project Options

Project Options x|

[Project Sample Fate / Yolume Damping [ Recording Bar/BPh

-
Sample Rate (Hz): 44100 s EockiEeaned Chiees Numeratar

¥ Group ohjects after multirecord

WVolume 0dB [ Ediing Denominatar {4

-EdB IV | Beetrtive e BPH 120.000

e e @ Q

12 dB [ Auto Crosstade Mode
PPQ 6

111

-16 dE [~ CO Atrangemant Mode

[~ Snap/Grid [ AutoSave Mode
[ Snapto. & Objects (objects snap to edges of other objects) " active
" Range Getcurrent range for snap | Save Interval "I[I— Minutes
 Grid/Bars Get BPM from current range |

 Grid/Frames The selected " Sawve on original File

range is Beats: |4 Partitions: |1

Snap offsetto project start: & Save as Backup File (*_bak WVIP)

0 smpl Use current posifion for offset | ~ Save max 10 Backup Files
(*_bakiVIP)
¥ Show grid [camples =] Use Snap offset
also for grid

Define SundDesianer | Farmet | oK Cancal Help.

Project Sample Rate/Volume Damping

Sample Rate

Sets the sample rate of the Virtual Project. If you want or need to use a sample
rate which isn’t supported by your sound card, use the varipitch feature, which
can be set in the playback parameters dialogue. When loading Wave Projects
with differing sample rates than the VIP, the resulting Objects are resampled
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automatically to match the VIP’s sample rate. This is a non-destructive real-
time effect.

Volume

When combining multiple audio tracks with peaks at or near odB, it is very
easy for the combined master output level to exceed odB. The Volume parameter
provides a quick way to scale back the master output level, so as to avoid
exceeding odB.

You can select from four different attenuation values by clicking on (selecting)
one of the following radio buttons:

0dB: This option provides no Input Attenuation, and can be considered the
"Off” setting.

-6dB: This option provides 6dB of Input Attenuation.

-12dB: This option provides 12dB of Input Attenuation.

-18dB: This option provides 18dB of Input Attenuation.

Theoretically, each track of a 4-track stereo project must be reduced by 2 bits
(12 dB). In the real world, tracks are often not recorded or played back at the
maximum level, allowing reductions to be made accordingly. Raising the volume
reduction setting may, however, result in clipping.

Please keep in mind that Samplitude reduces the volume of Wave Projects to
the setting defined in the Virtual Project (that uses the Wave Project). This
allows you to switch between the VIP and Wave Project without the usual
issue of volume differences between the project types. If a Wave Project is
opened in isolation (without using the Wave Project in a VIP), Samplitude
automatically uses the maximum volume playback level.

Snap/Grid
Read details about the Snap to Grid function in the “View Menu” chapter.
Snap To: When this box is checked, the Snap feature is turned on.

OsgjEecTs: This option activates the Object snap.

RANGE activates the Range snap and enables you to use the currently marked
Range as a snap basis by selecting GET CURRENT RANGE FOR sNAP. This can be
used as a simplified form of the Grid/Bar snap. The principle is the same, the
Range borders will become snap reference points and these points are continued
in both directions in equal distances according to the Range length. Mark a
Range with the smallest time fraction (e.g. 1/16 note) and you've got a 1/16
snap. Use this option when you want to snap to distinct time positions without
changing the project tempo.

GRriD/Bars: Activates a snap based on measures. You can enter the tempo in
BPM and additional measure attributes in the Bar/BPM area. The tempo can
also be detected from the current Range selection via “Get BPM from Current
Range”. You can define the number of beats that the current area selection
corresponds to - e.g. 4, if a complete 4/4 measure has been marked. The
program now automatically displays the tempo (BPM) for the marked area.
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PartITIONS are used to define the number of snap positions per beat, i.e. a
value of 4 = 1/16 notes in a 4/4 measure.

Grip/FrAMES: Activates the snap based on frame length. The exact frame length
is dependent on the selected SMPTE format (Options > Synchronization
Settings).

BAR/BEAT: Here you set the meter (numerator/denominator), the tempo in
beats per minute (BPM), and the timer resolution in peaks per quarter (clicks/
pulses per quarter note — often shown as PPQN).

SNAP OFFSET TO PROJECT START: Lets you define a starting point for the snap
and grid.

UsEe SNAP OFFSET ALsO FOR GRID: When this box is checked, the snap offset (if
set) is applied to the grid.

Shortcut: Ctrl+ Shift + R

Recording

Lock RecorpED OBjEcTs: This option locks the newly recorded Objects as
soon as the recording is over. This is useful if you do not want to accidentally
move the new Objects in a VIP.

Note: An Object can be unlocked by first selecting it (click on the Object in the lower
half of the track), then selecting Object > Lock Objects > Unlock Objects.

GrouP OBJECTS AFTER MULTIRECORD: The Objects, which are created while
you record more than one channel at one time, will be grouped. You can also
ungroup these Objects anytime you want.

Editing
DEesTRUCTIVE MoODE: Only available for Wave Projects (see “Wave Editing“
chapter)

Auto CrossraDE MobpE: When performing a cut or moving an Object over
another, a crossfade is automatically inserted.

CD ARRANGEMENT MopE: When you activate this menu item, Samplitude
rearranges newly-inserted Objects, and inserts pauses between the Objects
(conforming to the Red Book Standard).

Please refer to the CD > CD Arrange Mode section for more details.

AutoSave Mode:

This group of settings activates Samplitude’s AutoSave mode for VIPs. This is
a very useful tool which will automatically create backup copies of open VIP’s,
during a Samplitude session.
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Samplitude will not interrupt playback or recording to instigate a backup! The
AutoSave process is activated during brief periods of inactivity, and only backs
up the actual VIP (usually a very small file).

The backup tool can be set to overwrite the open file, or to sequentially save
copies of the open file. Samplitude will automatically name the backup VIPs,
and place them in the project directory.

The save interval can also be set by the user. We cannot think of a reason why
you would leave AutoSave Mode inactive, but you can do so, if you wish!

Bar/BPM

Here you set the meter (numerator/denominator), the tempo in beats per
minute (BPM), and the timer resolution in peaks per quarter (clicks/pulses
per quarter note — often shown as PPQN).

Track information
Please refer to chapter “Track Menu” -> Track information.

Synchronization active

This menu item is mainly present to map a keyboard shortcut onto it. You can
switch the Synchronization on/off via the SYNC Button on the transport control.
Right-clicking this button opens the Synchronization Setup dialog

Shortcut: “G”

Synchronization Setup

Read the “Synchronization” chapter for an introduction on how to synchronize
Samplitude with other programs or external MIDI devices.

Shortcut: Shift + G
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Synchronization - TUTORO1.MIP

—MIDI Clock Input

x|

—MIDI Clock Cutput

[~ MTC Input active

Device:  |MPU-401 | Device:  |MPU-401 |
BPM: 120 BPM : 120
[~ MC Input active [~ MC Output active
—MTC Input —MTC Output
Device:  |MPU-401 | Device:  |MPU-401 |

[~ MTC Qutput active

—AS10 Positioning Frotocal (AFF)
[T APEInput active
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—SMPTE Settings
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28,97 Frames/s non drop
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30 Frames/s
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—%IF starttime / SMFTE Offset
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—Chase Lock Syne (adapt speed by resampling)
Syhc Welocity: |1 0o ™ Use Hardware Pitching (Special cards)

v Use sample-accurate position info

MMC Setup ... |

Cancel Help

MIDI Clock Input

If you want Samplitude to slave to MIDI Clock, use this section. This section
tells Samplitude to look for MIDI Clock signals (start, stop, continue, song
position pointer) on the specified MIDI input device. Set the section to “Active”

if you wish to use this format.

Note: MIDI Clock does not carry any continuous timing information. It is a “Set
and Forge” format, which does not allow Samplitude to monitor its lock with the
external device. Use the SMPTE/MTC Input if you require extremely tight

synchronization.

Device: Use the drop-down list to select the device that will receive MIDI
Clock synchronization signals. This will be an active MIDI port (either virtual

or hardware).
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BPM: Enter the tempo, in beats per minute (BPM), of the audio which you
want to synchronize with. This parameter doesn’t affect the playback speed of
the digital audio tracks, but is responsible for the grid display.

Active: Click on (i.e. enable) this option to activate synchronization to incoming
MIDI Clock signals.

MIDI Clock Output

If you want Samplitude to generate MIDI Clock as the master, use this section.
When active, Samplitude becomes the MIDI Clock Master, meaning that it
will send out the following MIDI Clock signals: start, stop, continue, and song
position pointer. No additional timing information is transmitted. This is often
a quick solution for a synchronization setup which does not require tight sync
between the components.

Device: Use the drop-down list to select the device that will send MIDI Clock
synchronization signals. This will be an active MIDI port (either virtual or
hardware).

BPM: Enter the tempo, in beats per minute (BPM), that Samplitude will send
via MIDI Clock. This parameter will determine the tempo of the slave - i.e. If
this parameter is set to 120, a sequencer slaved to Samplitude will play back at
a tempo of 120 BPM.

Active: Click on (i.e. enable) this option to have Samplitude generate MIDI
Clock Synchronization signals.

MTC Input

If you want Samplitude to slave to SMPTE/MTC, use this section. When active,
Samplitude becomes a SMPTE/MTC slave device. It will listen for incoming
time code signals, including timing information, on the specified MIDI Input
device. If you require extremely tight sync, you should also activate the Chase
Lock Sync option.

Note: Samplitude only understands MTC (the digital counterpart to SMPTE
information). It is therefore necessary to utilize a MIDI interface that is capable of
converting any possible SMPTE signals into MTC (MIDI Time Code).

Device: Use the drop-down list to select the device that will receive SMPTE/
MTC synchronization signals. This will be an active MIDI port (either virtual
or hardware).

Active: Click on (i.e. enable) this option to activate synchronization to incoming
SMPTE/MTC signals.
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MTC Output

If you want Samplitude to generate MTC as the master, use this section.
Samplitude can also generate MTC signals, making it the master device in a
Synchronization setup. MTC signals are sent to the specified output device
whenever Samplitude starts/stops playback or recording.

Device: Use the drop-down list to select the device used for the transmission
of MTC synchronization signals. This will be an active MIDI port (either virtual
or hardware).

Active: Click on (i.e. enable) this option to have Samplitude generate MTC
synchronization signals.

SMPTE Settings

These settings tell Samplitude what time format to use for synchronization.
Different settings are available for various applications, such as the European
and American Video- and Film formats.

Select the proper frame rate. Use 24 frames for cinematic synchronization, 25
frames for PAL video and audio synchronization, 30 frames for NTSC video.
Note that the 29.97 Frames (drop and non drop) settings are also available!
Use the Preroll Frames option to allow for time code lock-up delays of external
equipment.

Type: This parameter allows you to specify the SMPTE/MTC type used for
synchronization.

PreroLL FramEs: This parameter allows you to specify the number of frames
that Samplitude should ignore before synchronization occurs. Many devices
need time to "lock up” to the synchronization signal, and this parameter allows
you to compensate for this delay.

SMPTE Offset

This parameter allows you to specify a SMPTE offset time, in either milliseconds
or SMPTE format. As an example, if you have a multi-track tape machine (as
the master), striped with SMPTE, and you want your Samplitude project to
start slaving to the tape machine at exactly 30 minutes, simply enter 30:00:00
in the SMPTE box.

The offset is removed from the incoming SMPTE time code signal to align the
differences between the tape material and samples recorded in Samplitude.
With an offset of "o1:00:00:00' (1 hour), a tape that was previously striped can
be synchronized if the recording/playback start point is set to 1 hour.

Miriisec.: This numeric display shows the timecode offset in milliseconds.

SMPTE: This numeric display shows the SMPTE offset in SMPTE format
(hours:minutes:seconds:frames).
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FX: This option, similar to the Pitch (multiplication factor) parameter (in the
Varipitch section of the Playback Parameter window), allows adjustments for
small sync problems that can occur when dealing with long audio material.
This feature alters the playback speed of the audio by the entered multiplication
factor. Values above 1 cause an increase in playback speed. Values below 1
cause a decrease in playback speed.

Chase Lock Sync

Samplitude can perform Chase Lock Sync to incoming MTC signals. This is
accomplished by manipulating the sample playback rate "on the fly” to adjust
to fluctuations in the incoming MTC synchronization signals.

Note: This feature is extremely important when synchronizing to an analog tape
machine, because its transport will introduce wow and flutter. If the timing changes
are too big, Samplitude produces heavy pitch changes, which may be reduced by
entering smaller Sync Velocity values in the Sync dialog (see below). Try values of
200 or more when you need fast pitch changes in Sync mode. The lower right status
bar allows you to read the actual/maximum pitch change in cents (1 cent = 1/100
halftone).

Chase Lock Sync performs real-time resampling (if not using ARC44), which requires
a certain amount of processing power. So be careful on slow machines!

Sync VEerocrty: This parameter allows you to specify how closely Samplitude
follows fluctuations (in speed) of incoming MTC signals. In other words, this
parameter will determine how quickly Samplitude follows a pitch change
(caused by speed fluctuations in the MTC Synchronization signals), generated
by the master device. The default value is 100, which will generally perform
well. If you require a quicker response to pitch changes, increase this value to
200 or 300. If you require a slower response to pitch changes, decrease this
value to 50 or 30.

Active: Click on (i.e. enable) this option to have Samplitude Chase Lock to
incoming MTC synchronization signals.

Use HARDWARE PITCHING (SPECIAL cAarDs): Click on (i.e. enable) this option
to allow the card’s hardware to vary the sample playback rate. (If supported by
your card)

Cancer: Click on this button to close the Synchronization window, without
accepting changes to the settings.

OK: Click on this button to accept the current settings, and close the
Synchronization window.
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MMC Setup
See the “Synchronization” chapter.

Program Preferences

These items allow you to select a variety of settings to customize Samplitude
to meet your working preferences and/or system.

Program Preferences = VIP Mouse Mode

The following options allow you to select from a variety of mouse modes.
These modes determine the functionality of the mouse in VIPs.

Universal Mouse Mode

This option enables the Universal Mouse Tool. When using the Universal
Mouse Tool, the upper half of a track is used to mark Ranges, and position the
cursor. The lower half of a track is used to select and move Objects. Object
handles, and volume and panorama curve events take precedence, and can be
modified at any position within the track. The Universal Mouse Tool (default
mouse tool) is the one you’ll use most often.

Tip: You can also select the Universal Mouse Mode by clicking on (i.e. enabling)
the Universal Mode icon in the upper toolbar.
Universal Mode Mouse Functions:

RicuT Mouse Butron: Displays a context-sensitive pop-up menu.

Left Mouse Button:
1. Upper Track Pane:
RaNGE: Selecting and moving Ranges (with Shift key).

Pray Cursor: Single click sets the real-time cursor anywhere in the track.

2. Lower Track Pane:

SeLEcTING OBJECTS: Single click selects Objects (or group of Objects.)

Single click + Shift selects multiple Objects, including all Objects that fall
between the two clicked Objects.

Single click + Ctrl selects multiple single Objects.

MovinG OsjEecTs: Dragging moves Objects or Object groups.
Dragging + Shift moves Objects, or Object groups, up or down the track list,
without changing the time position.

DupiicatiNGg OBjEcTs: Dragging + Ctrl duplicates one or more Objects.
Dragging + Shift + Ctrl duplicates one or more Objects, while allowing the
Objects to be moved up or down the Track list, without changing the time
position.

OgjecT Enitor: Double-click opens the Object Editor 241
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Lasso Funcrion: Clicking next to an Object on the empty track, while right-
dragging the marquee (lasso) across multiple Objects, selects all Objects within
the marquee.

Clicking next to an Object, while left-dragging the marquee (lasso), selects
multiple volume or panorama curve events.

3. Complete Track

Ogject HanD1ES: The upper handle changes the Object volume. The changed
level is shown in dB in the upper left-hand corner of the VIP.

The upper left and right handles change the fade in/out of the Object. Fade
curve parameters can be set in the Object Editor. The lower handles resize the
Object.

VoLUME AND PaNorRaMA AuToMaTION CURVES: Single-clicking on the
automation curve creates a new curve event. Double-clicking on the same curve
event deletes the event.

Single-clicking on an event selects the automation curve event.

Single-click + Ctrl allows selection of multiple events.

Dragging a curve event moves the selected event.

Dragging + Ctrl moves several events.

To delete events, select them, and use Edit- > Delete .... Handle.

Range Mode (Secure Mode)

Select this option to enable the Range Mouse Tool. When using the Range
Mouse Tool, the left mouse button can only be used to mark a Range. A Range
can be marked no matter where (in the track) the mouse pointer is located.
Additional functionality is available through use of the following keys:

Periop Key (.): If the period key is pressed, Samplitude temporarily changes
to Object mode. Once in Object mode, you can easily select and manipulate
Objects.

Minus KEy (-): If this key is pressed, Samplitude temporarily changes to Curve
mode. In Curve mode, you can change the volume, panorama and VST
automation curves.

These special functions provide a quick way of reaching all important functions,
while protecting an Object from accidental movements. This is why this mode
is also called “Secure Mode”.

Tip: You can also select the Range mode by clicking on (i.e. enabling) the Range
mode icon in the upper toolbar.

Range Mode (Secure Mode) Mouse Functions:
Right Mouse Button: Displays context-sensitive pop-up menu.
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Left Mouse Button:

RaNGE: Selecting and moving Ranges (with the “Shift” key). Objects or
automation curves can not be changed by accident (therefore called “Secure
Mode”).

Pray Cursor: Single-click sets the play cursor anywhere in the track.

SeLEcT OBJECT MODE TEMPORARILY: Using the (.) “period” key temporarily
switches to Object mode, which allows Objects to be moved.

SeLecT CURVE MODE TEMPORARILY: Using the (-) dash key temporarily switches
to Curve mode, which allows movements and manipulation of automation
curve events.

Curve Mode

Select this option to enable the Curve Move and Grab Mouse Tool. When
using the Curve Move and Grab Mouse Tool, the left mouse button can ONLY
be used to create, delete, and move handles on custom volume or pan curves.

Tip: You can also select the Curve Move and Grab Mouse Tool by clicking on (i.e.
enabling) the Curve Mode and Grab Mode icon in the upper toolbar.

Curve Mode Mouse Functions:
Right Mouse Button: Displays context sensitive pop-up menu.

Left Mouse Button:
Lasso Funcrion: Dragging the marquee or lasso selects multiple volume or
panorama automation curve events.

VoLUME AND PANorRaMA AuToMAaTION CURVES: Single-clicking on the
automation curve creates a new curve event.

Double-clicking on a curve event deletes the event.

Single-clicking on an event selects the automation curve event.

Single-click + Ctrl allows selection of multiple events.

Dragging a curve event moves the selected event.

Single-click + Shift on a curve event selects all events between it and an already
selected event. (Used to select a range of events)

To delete events, select the events and use Edit- > Delete .... Handle.

Object Mode

Select this option to enable the Object Mouse Tool. When using the Object
Mouse Tool, the left Mouse button can only be used to select and move Objects.
An Object can be selected and moved no matter where (in the track) the mouse
pointer is located.
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Tip: You can also select the Object Mouse Tool by clicking on (i.e. enabling) the
OBJECT MODE icon in the upper toolbar.

Object Mode Mouse Functions:
Right Mouse Button: Displays context sensitive pop-up menu.

Left Mouse Button:

SeLecTING OBJECTS: Single-click selects Objects (or group of Objects.)
Single-click + Shift selects multiple Objects, including all Objects between the
two clicks.

Single-click + Ctrl selects multiple single Objects.

MovinG OsjEecTs: Dragging moves Objects or Object groups.

Dragging + Shift moves Objects or Object groups up or down the track list
without changing the time position. Dragging + “K” key moves the Object
under the mouse pointer, as well as all Objects behind on the same track.

DupricatinGg OBjEcTs: Dragging + Ctrl duplicates one or more Objects.
Dragging + Shift + Ctrl duplicates one or more Objects, while allowing the
Objects to be moved up or down the track list without changing the time
position.

OsjecT Epitor: Double-click opens the Object Editor

Lasso Funcrion: Clicking next to an Object while right-dragging the marquee
(lasso) across multiple Objects selects the Objects within the marquee.
Clicking next to an Object while left-dragging the marquee (lasso) selects
multiple volume or panorama curve events.

Ogject HanD1ES: The upper handle changes the Object volume. The changed
level is shown in dB in the upper left-hand corner of the VIP.

The upper left and right handles change the fade in and fade out of the Object.
Fade curve parameters can be set in the Object Editor.

The lower handles resize the Object.

Object and Curve Mode

Select this option to enable the Object and Curve Mouse Mode. When using
the Object and Curve Mouse Tool, the left mouse button can only be used to
select and move Objects and select and move handles on custom volume or
pan curves. An Object can be selected and moved no matter where (in the
track) the mouse pointer is located.

Tip: You can also select the Object and Curve Mouse Tool by clicking on (enabling)
the Object and Curve Mode icon in the upper toolbar.
Object and Curve Mode Mouse Functions:

Right Mouse Button: Displays context sensitive pop-up menu.
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Left Mouse Button:

SeLeECcTING OBJECTS: Single-click selects Objects (or group of Objects.)

Single click + Shift selects multiple Objects, including all Objects between the
two clicks.

Single click + Ctrl selects multiple single Objects.

MovinG OsjEecTs: Dragging moves Objects or Object groups.
Dragging + Shift moves Objects or Object groups up or down the track list
without changing the time position.

DupiicatiNGg OBjEcTs: Dragging + Ctrl duplicates one or more Objects.
Dragging + Shift + Ctrl duplicates one or more Objects, while allowing the
Objects to be moved up or down the Track list without changing the time
position.

OsjecT Enitor: Double-click opens the Object Editor

Lasso Funcrion: Clicking next to an Object while right-dragging the marquee
(lasso) across multiple Objects selects the Objects within the marquee.
Clicking next to an Object while left-dragging the marquee (lasso) selects
multiple volume or panorama curve events.

Ogject HanD1ES: The upper handle changes the Object volume. The changed
level is shown in dB in the upper left-hand corner of the VIP.

The upper left and right change the fade in and fade out of the Object. Fade
curve parameters can be set in the Object Editor.

The lower handles resize the Object.

VoLUME AND PANORAMA AuToMATION CURVES: Double-clicking on the
automation curve creates a new curve event. Another double-click on the same
curve event deletes the event.

Single-click on an event selects the automation curve event.

Single-click + Ctrl allows selection of multiple events.

Dragging of a curve event moves the selected event.

Dragging + Ctrl moves several events.

To delete events, select the events and use Edit -> Delete .... Handle.

Mouse Mode Studio 4.0

Right Mouse Button:

When using the Mouse Mode Studio 4.0 option (under File Menu >
Preferences) and also restricting the mouse’s function (Range Mode, Object
and Curve Mode, Draw Volume, Draw Panorama, Object Mode, or Curve
Mode), you can select this option to return the mouse function to normal. The
right mouse button will select and move Objects, the left mouse button will
mark Ranges.
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Studio 4.0 Mouse Functions (Right Mouse Active):

Right Mouse Button:

SeLeECTING OBJECTS: Single-click selects Objects (or group of Objects.)
Single-click + Shift selects multiple Objects, including all Objects between the
two clicks.

Single-click + Ctrl selects multiple single Objects.

MovinG OsjEecTs: Dragging moves Objects or Object groups.

Dragging + Shift moves Objects or Object groups up or down the track list
without changing the time position.

Dragging + key ‘k’ move the Object under the mouse pointer, plus all Objects
behind on the same track.

DuptiicatinGg OBjEcTs: Dragging + Ctrl duplicates one or more Objects.
Dragging + Shift + Ctrl duplicates one or more Objects, while allowing the
Objects to be moved up or down the track list without changing the time
position.

OsjecT Epitor: Double-click opens the Object Editor

Lasso Funcrion: Clicking next to an Object while right-dragging the marquee
(lasso) across multiple Objects selects the Objects within the marquee.
Clicking next to an Object while left-dragging the marquee (lasso) selects
multiple volume or panorama curve events.

Ogject HanD1ES: The upper handle changes the Object volume. The changed
level is shown in dB in the upper left-hand corner of the VIP.

The upper left and right handles change the Fade In and Fade Out of the
Object. Fade curve parameters can be set in the Object Editor.

The lower handles resize the Object.

VOLUME AND PANORAMA AuToMATION CURVES: Double-clicking on the
automation curve creates a new curve event. Another double-click on the same
curve event deletes the event.

Single-clicking on an event selects the automation curve event.

Single-click + Ctrl allows selection of multiple events.

Dragging of a curve event moves the selected event.

Dragging + Ctrl moves several events.

To delete events, select the events and use Edit -> Delete .... Handle.

Left Mouse Button:
RaNGE: Selecting Ranges and moving Ranges (with “Shift” key).

Pray Cursor: Single-click sets the play cursor anywhere in the track.

Zoowm: Double-clicking outside of a selected Range (or no Range) zooms out.
Double-clicking inside a selected Range zooms in.
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OreN WaVE Project: Double-clicking on a VIP Object opens the corresponding
Range in the associated Wave Project.

Cut Mode

Select this option to enable the Cut Mode Mouse Tool. When using this mode
in a VIP, the mouse pointer appears as a pair of scissors. Each click on an
Object will split (cut) the Object.

Note: You can also easily cut (split) Objects by selecting an Object and pressing the
“T” key.

Pitchshift/Timestretch Mode

Select this option to enable the Pitchshift/Timestretch Mouse Tool. This Mouse
mode allows quick access to the real-time Object timestretching and
pitchshifting

The lower right handle allows time compression or stretching of an Object by
lengthening or shortening the Object. Using the middle handle, the pitch can
be altered in a range of +/- 6 semitones.

Tip: You can also select the Pitchshift/Timestretch Mouse Tool by clicking on (i.e.
enabling) the Pitchshift/Timestretch icon in the upper toolbar.

Draw Volume

Select this option to enable the Draw Volume Mouse Tool. When using the
Draw Volume Mouse Tool, the left mouse button can only be used to draw
custom volume curves. Notice that the mouse pointer appears as a pencil when
located in a track. When you click and drag the mouse to draw a custom volume
curve, the slower you move the mouse, the more handles are created.

Tip: You can also select the Draw Volume Mouse Tool by clicking on (i.e. enabling)
the Draw Volume Mode icon in the upper toolbar.

Draw Panorama

Select this option to enable the Draw Panorama Mouse Tool. When using the
Draw Panorama Mouse Tool, the left mouse button can only be used to draw
custom pan curves. Notice that the mouse pointer appears as a pencil when
located in a track. When you click and drag the mouse to draw a custom pan
curve, the slower you move the mouse, the more handles are created.

Tip: You can also select the Draw Panorama Mouse Tool by clicking on (enabling)
the Draw Panorama icon in the upper toolbar.

Scrub Mode

Select this option to enable the Scrub Mouse Tool. A speaker icon appears next
to the mouse pointer — the left mouse button can now be used to scrub audio
in real time by clicking/dragging in the desired scrub direction.
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This functions as a pre-listen facility with control over play tempo. The project
will be played forward or backward, with tempo controlled by the distance of
the mouse pointer from the actual play cursor position. The larger the distance
the faster the play tempo.

Tip: You can also select the Scrub Mouse Tool by clicking on (enabling) the Scrub
icon in the upper toolbar.

Zoom Mode

Select this option to enable the Zoom Mouse Tool. In this mode, the mouse
pointer becomes a magnifying glass which enables rapid horizontal zooms
within the VIP. Left-clicking zooms in, right-clicking zooms out.

Tip: You can also select the Zoom Mouse Tool by clicking on (i.e. enabling) the
zoom icon in the upper toolbar.

Program Preferences - Wave (HDP/RAP) Mouse Mode

Range
When working directly in Wave Project windows, this mode (the default mode)
allows the left mouse button to mark Ranges.

Draw Wave

When working directly in Wave Project windows, this mode allows you to
draw over existing waveforms (using the left mouse button), thus creating
new audio. For example, you can use this mode to remove clicks. Simply zoom
in on a click (it will appear as a spike), and draw a line across the bottom that
connects its beginning and end points. In other words, you will be removing
the click by drawing the audio without the spike.

Note: To use this mode, you must be zoomed in to a resolution where 1 pixel = 1
sample. You can quickly zoom in to this resolution by going to the View menu and
selecting Horizontally > 1 Pixel = 1 Sample.

Draw Volume

When working directly in Wave Project windows, this mode allows you to
adjust the height (volume) of a very small portion of the waveform. For example,
you can use this mode to decrease (destructively) the volume of a plosive.
Simply zoom in on a plosive, and click and drag the mouse from left to right
(or vice versa) beneath the plosive. The height of the waveform will decrease,
reflecting the volume change.

Tip: The position of the mouse pointer (above or below the waveform, when you
click and drag), will determine whether the height (volume) of the waveform is
increased or decreased and by what amount. The further the mouse pointer is above
or below the waveform, the more radical the height (volume) change will be. The
middle of the display is volume 100%, the lower border is volume 0%, and the upper
corner is volume 200%.
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Note: To use this mode, you must be zoomed-in to a resolution where 1 pixel = 1
sample. You can quickly zoom in to this resolution by going to the View menu and
selecting Horizontally > 1 Pixel = 1 Sample.

Scrub Mode / Zoom Mode
These two options are functionally identical to the equivalent VIP Mouse Modes.
Please refer to the VIP Mouse Modes section for further details.

Program Preferences - Object Mode

This feature is similar to the Group option (in the Object menu), but provides
a much quicker way of selecting all of the Objects (either on a single track or
all tracks).

Lock ArL Aupro 1N TiMme: All audio tracks are locked in time.

Norwmat: If you've previously selected (i.e. enabled) any of the linking options,
you can select this option to unlink all Objects. Multiple selection of Objects is
possible.

Link CUrvEs To OBJECTS: Select this option and all custom volume and pan
curves will be linked to their respective Objects. In other words, when you
move an Object, the custom volume and pan and automation curves (above
the Object) will move with it. This is especially helpful, if the curves are tailored
to specific Objects and need to be moved with the Objects. Also in the other
Object Link modes (see below) the curves are linked to the Objects. Multiple
selection of Objects is possible.

Link uNTIL S1LENCE: All Objects of a track, starting with the mouse position
up to the next silence, are selected and moved together. This way, parts of a
project — if separated by pauses — will stay unaffected by move operations
made before the gap. Multi- selection of Objects is possible on different tracks.

Link oNE TrAck: Select this option to quickly link all Objects in a track. For
example, You can use this feature to quickly move all of the Objects
(simultaneously), while preserving their relative time positions. Multi- selection
of Objects is possible on different tracks.

Link ALL TRACKS: Select this option to quickly link all Objects in all tracks. As
an example, You can use this feature to quickly move all Objects in the VIP
(simultaneously), while preserving their relative time positions. No multiple
Object selection is possible.

Program Preferences = Edit Keyboard Shortcuts and Menu

Select this option to open the Edit Keyboard Shortcuts window. This window
allows you to create your own shortcut keys for any of the menu options.
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This makes it possible to assign your frequently used commands to specific
keys and key combinations for quick recall.

Edit Keyboard Shortcuts x|

Fil

MNew Yirtual Project (vIF)..
Open Project Help

“irual Project (*WIF)

Sound Designer|l ...

Midli (= MIDY...

Fahd Wawe (*RAP)

HD Wawve (* HDP) - Menu

Object (~0BJ) Restore default

Edit List (“EDL). =

Tahle af Carntent (* TOC) Laad

DDF import file (“tcd)...

Session (*SAM) S
Load Audio file...
Load Audio CD Track(s) Show Menu tem(s)
Save Project T
Save Pro;ect as... Hics Menu tern(s)
Save complete VIR in
Save Projectas EDL
Save Project as Template

Burn Project Backup on CO/DVD — Shortcut
Save Object Restore default
Save Session
Fiename Project.. LI Load
—Description Save
Show Shortcut list..
— Mew Shartcut — Shortcuts

Click in the box below and type in the desired key combination for the selectad menu iterm and press
"Agsign'. Do not assign the keys "Space". "Insert”. "Esc" and "F1". they are hard coded for

special functions. q | _DI

IKEm

Assign new Shortcut | Delete |

The shortcut settings are saved to the file Samplitude.ini in the program directory
when exiting the program. The next time the program is loaded, the customized
shortcuts will be retained.

You can also customize the menus and hide menu items you infrequently or
never use, e.g. import & export of unusual file formats or the surround
functions. You can also save and load your keyboard shortcut and menus to/
from a file. (*.syc; *.men)

The most important aspect of the dialog is the display of the Samplitude menu
tree. You can select which menu option is to be reassigned a new key. To
accomplish this, simply click on the desired menu option in the tree and then
on the “New Shortcut” box.

Next, press the new key or key combination and press or click on the “Assign
new Shortcut” button. Any possible combination of Shift, Alt, and Ctrl with
other keys is possible.

Note: Please do not use the space bar, ESC, or the Insert key. These functions are
hard-coded into Samplitude and cannot be changed!
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In the upper left side of the window is a list of ALL Menu options. You can use
the scroll bar to scroll through them. Any of the menu options can be selected
(highlighted) by clicking on its name in the list.

DescriprioN: When you click on a menu option to select it, the function of the
selected option will be shown here.

New SHORTCUT: After selecting a menu option, you can place the cursor in
this box and type in the key (or combination of keys) that you want to use as a
shortcut.

AssiGN SHORTCUT: After typing in the key (or combination of keys) that you
want to use as a shortcut, click on the Assign new Shortcut button to assign the
shortcut. You should now see the shortcut key (or keys) in the box above the
“Delete” button.

DeLETE: After selecting a menu option, you can click on the “Delete” button to
delete the shortcut key (or keys), thereby removing the shortcut.

Save Suortcurts: Click on the Save button to save your custom shortcuts. A
standard Windows "Name File” dialog will appear. Name the file and click
OK. Your shortcuts are now saved.

Loap SuortcuTs: Click on the Load button to load a previously saved "list” of
custom shortcuts. A standard Windows "Open File” dialog will appear. Select
(click on) the file containing the desired custom shortcuts, and click OK. The
custom shortcuts will now be loaded.

Suow SHortcuT List: Click on the Show Shortcut List button and a list of
assigned shortcuts window will open showing all assigned shortcuts.

Restore DeraurT: Click on the Restore Default button to restore the "list” of
shortcuts to their initial (default) settings.

SHow MENU ITEMS: The selected menu item in the menu item list will be
shown in the Samplitude menus.

Hipe MEenu ITeEms: The selected menu item in the menu item list will be
hidden in the Samplitude menus.

MEeNU ITEMS > REsTorE DEFAULT: This option restores the default menu view
(all items will be shown)

MEenNvU ITEMS > LoaD/SavE: These two buttons function identically to the “Load”
and “Save” buttons for keyboard shortcuts (see above)
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OK: Click on this button (upper right corner of the window) to accept the current
settings and close the Edit Keyboard Shortcuts window.

Program Preferences - Change Toolbar Style

This menu switches between old (non-editable) and new (editable) toolbar style.
Samplitude needs to be restarted for the change to take effect.

Program Preferences - Edit Toolbars

This dialog allows you to determine which toolbars will be visible in Samplitude.
The dialog is simple to use — choose a toolbar from the available selection and
either add or remove it from the current selection, then click close.
Individual toolbars and separators between toolbar sections can be moved using
the Move Up/Down buttons. The Reset button resets all toolbars to the default
view.

All toolbars can be floated and/or docked in accordance with standard Windows
conventions.

The name/function of any toolbar can be easily discovered within the
Samplitude workspace by hovering the mouse pointer above the toolbar — a
tool tip will appear enclosing the toolbar name.

Shortcut: right-click directly on the toolbar

Program Preferences -> Reset Toolbars

This menu item allows you to reset specific toolbar sections (Main, Positions,
Punch, etc.) to the default view.

Program Preferences = Enable VIP Tool tips

This option enables Samplitude’s informative tool tips. To disable the tool
tips, uncheck this item.

Note: Although the tool tips are very informative and useful, they are drawn directly
by the CPU (due to Windows design). There is therefore a very small overhead
associated with using the tool tips. If your PC is underpowered, you may gain a
small benefit by disabling tool tips.

Program Preferences - Grid Lines

This option allows you to select from 5 different grid display options when
working with the grid. To switch off the grid display, select None.

Program Preferences -> Video Height

If an AVI file is Linked to a Samplitude project, select this option to adjust the
height of the AVI display. The different choices are: 25 pixels, 50 pixels, 100
pixels, and 200 pixels.

Program Preferences - Font Selection

Select this option to change the font that is used for general display purposes
in Samplitude.
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Note: If you notice words that are "cut off” when displayed, try using a different font
or a smaller font size.

Program Preferences = Font for Time Display

Select this option to change the font that is used for the Time Display window
in Samplitude. The Time Display window must be open or this option will
have no affect. You can open the Time Display window by going to the Window
Menu and selecting Time Display.

Note: The Time Display window can be resized, so the size of the font is not nearly
as important as choosing a legible font.

Program Preferences - MIDI Options

MIDI-Einstellungen il
2 A MPLU-401 Flayhack
b4 Microsoft GS Wavetable S Synth Devices

Global Play Device:
IMPU-4D1 LI ™ Deactivate all MIDI functions

Global Becord Dew.

JMPU-401 =|

Record Offset: Audio / MIDI ¢

0 ms R Active Syncielocity: 50 %

v Use sample exact reference clock from audio device

Automatic Volume Fader mode for MIDI Tracks

" Don't change Yolume Fader mode

* Controller 7 32 Bit MIDI Engine active
 Midi Yelocity scaling

Hardware Controller Setup ... | ' oK | Cancel | Help |

The MIDI Options found in File -> Preferences -> MIDI Options and in the
Track Info dialog allow you to set specific MIDI related parameters in
Samplitude.

PrayBack Devices: This is the list of all installed MIDI devices in the system.
Here you can hide unused MIDI devices from appearing in the input/output
device list if you never intend to use them.
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GrosaL P1aY/REcorD DEvICES: These settings determine the global MIDI input
and output devices - for any MIDI track in Samplitude that is not specifically
assigned an input or output device. This can be considered the default setting
for the MIDI playback and record device of your system.

Recorp OFFseT: Samplitude allows you to compensate for any delays that may
be introduced by your MIDI setup. It may be necessary from time to time to
adjust the Record Offset here if you notice slight offsets between your audio
tracks and your MIDI tracks. If you do not notice any problems, leave the
default value at o ms.

Aupio/MIDI SyncuHRoNIzaTION: This setting determines how closely
Samplitude matches the MIDI tracks with the audio tracks. On systems that
have plenty of resources and faster CPUs, the values entered here can be
adjusted close to 100% to force a perfect match. However, if your system seems
to have problems coping with a higher setting, you may need to experiment
with smaller values. The lower the percentage setting for the Sync Velocity,
the more easily Samplitude matches the audio with the MIDI tracks.

Automatic volume fader mode for MIDI tracks

The track volume fader reaction can be changed manually at any time (right-
click on the volume fader). When switching a track to MIDI or audio mode,
however, the track-volume fader can be adjusted automatically. The automatic
changeover to MIDI volume controller for MIDI tracks is activated by default.
Select the required control mode you would like activated from a list when
switching a track to MIDI mode (using the MIDI button). You can use controller
7 (MIDI volume) and MIDI velocity. Select “Don’t Change Volume Fader mode”
if you want to exclusively set the volume fader manually.

Note: When switching the audio mode back, the initial audio-volume assignment is
restored.

INro: This section gives you information about what type of MIDI Engine is
used to reproduce the MIDI tracks in Samplitude. Most systems will read
16bit. Emerging sequencing technology is just now introducing 32bit MIDI
engines, which are a better match for pure 32bit environments such as Windows
NT.

You can also disable all MIDI functions for troubleshooting purposes by
checking the option “DEacTIVATE ALL MIDI FuNcTIoNs”. Samplitude will then
refrain from reproducing any MIDI data in any of its project windows.

Program Preferences = MIDI Options = Hardware Controller
Setup

Samplitude makes it easy to tie in a hardware controller. We’ve prepared some
presets for hardware controllers. You can change the presets or completely
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reconfigure them. Take your time doing this, because it requires concentration.
You will also require a MIDI interface (for controllers operating with MIDI) or
a USB interface (for USB hardware controllers).

Is your hardware controller also listed in the Preset List?

To find out, you open the hardware controller Setup dialog. You can do this by
pressing the “Y” key. Now click “MIDI Options”. “MIDI controller Setup”
opens the dialog.

Section “MIDI connection to control”: In the highest flip menu you’ll find a
list with hardware controllers for which presets are available. Among them
you will find the settings of the MIDI ports. USB hardware controllers usually
offer their own MIDI ports. Controllers operated by a normal MIDI interface
should have their MIDI port adjusted. It doesn’t matter whether the equipment
is specified in the Preset list.

Configuring Hardware Controllers/Creating your own sets

Should your equipment not be on the list or if you don’t like some of the
presets — don’t worry. Samplitude is adaptable! In the “Controller” section
(under equipment selection) you will find a flip menu with all remote control
functions in Samplitude — each of which must assign the controller’s messages.
If you select an element (e.g. fader 1 for the first visible fader in the Samplitude
mixer), activate the applicable element with your hardware controller and click
the “Learn” button.

Note: Hardware controllers with touch-sensitive faders send messages to Samplitude
when the fader is touched (or let go), meaning that the “Learn” button must be
pressed after moving and before releasing a fader.

There’s an explanation of the individual remote control parameters in
Samplitude at the bottom of the page.

This is how to place each element of your hardware controller in Samplitude.
If you've adjusted a finished set, save it under the name of the hardware
controller. From now on it will always appear in the Presets list.

Note: You can use any other MIDI controller to control Samplitude (e.g. a
MIDI fader box for individual track volume).

The following is a list of Samplitude parameters that can be remote
controlled:

Key 1...8 Click: Turns mute on/off

Double click: Switches solo on/off

in Shift Mode 1: Automation for tracks

in Shift Mode 2: Plug-ins in each track

in Shift Mode 3: Link track pairs

in Shift Mode 4: Automatic Record on/off

Link Master Volume Turns the link button in the mixer master

section on/off
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Master Normalize
Shift Mode 1
Shift Mode 2

Shift Mode 3

Hold down:

Normalize master

Automation of tracks via keys 1...8 on/off
Plug-ins on/off via keys 1...8 (calls up dialog
when no plug-in is installed)

Link tracks

Shift Mode 4 (Works as a Switch):Automation record (Playback; Automation

Stop at position
Play/Stop
Fader 1...8

Master Vol. left/right
Master EQ
Lo/LM/HM/Hi
Gain/Freq.

Master Stereo Enhancer

Pitch Factor

Mute 1...8

Solo 1...8

Record Ready 1...8
mixer

Pot1...8

Select 1...8
Fadertouch 1...8
automation

Shift

Fader Master

for the tracks must be activated)

1. Click: Displays fader movement;

2. Click: End of display

Frequency regulation of the Master’s 4
Equalizer bands using the fader for gain
regulation

1. Click: Frequency regulator

2. Click: Back to gain regulator

Stop at current position

Repeat from the current position/stop
Volume control of the first 8 visible channels
in the mixer — or the Crossfade Editor Fader
in Crossfade Editor Mode

Regulates the master volume left/right

Controls gain of the master’s 4 equalizer

bands. In Shift Mode 4: Frequency

regulation of the master’s 4 equalizer bands

Regulates the multiband stereo enhancer in

the master

Pitch Factor — used as a scrubber during

playback. Changes are taken up even in Stop

mode. The next playback shows the new pitch

factor setting.

Switches the first 8 visible channels

in the Samplitude mixer to mute

Switches the first 8 visible channels

in the Samplitude mixer to solo

Channel path recording in the Samplitude
is set to “sharp”.

Regulates the assigned value visible in the

Samplitude mixer

Selects VIP track.

Activates the recording of volume

when automation of the individual tracks is

activated. Only required for touch-sensitive

faders.

Shift key for Hardware Controller key

alternative.

Designates Master volume.
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Scrub
Scrubwheel FWD
Scrubwheel REW
Pot Touch 1...8
Play

Stop

Fast FWD
Rewind

Marker Mode:
Object Mode:

Record

Mixertrack 1 UP
Mixertrack 1 DOWN
Mixertrack 8 UP
Mixertrack 8 DOWN

Scrub mode on/off.

Scrub forwards

Scrub backwards

Press VPots on the Mackie Control
Start Playback

Stop Playback

Fast forward

Rewind

Jumps to the next/previous Marker
Selects the next/previous Object in the
selected track.

Starts recording immediately.
Scrolls 2 channels to the right.
Scrolls 2 channels to the left.
Scrolls 8 channel paths to the right.
Scrolls 2 channel paths to the left.

Channel path handling moves too. All channel paths in the mixer can be
operated from the hardware controller.

Zoom

Zoom left
Zoom right
Zoom up
Zoom down

Assig. Pan
Assig. Eq
Assig. Aux
Marker 1...8

Marker Mode
Loop On/Off
Enter

Cancel

Save

Undo/Redo
Automation Read

Automation
Automation Pan Touch

Cursor left
Cursor right

Cursor-controlled zoom (otherwise VIP is
scrolled vertically and horizontally)

Vertical zoom out

Vertical zoom In

Horizontal zoom out

Horizontal zoom in

(Only works when the Zoom key is activated)
The pots (VPots) 1...8 panorama is assigned.
The pots 1...8 Equalizer is assigned.

The pots 1...8 AUX-Sends level is assigned.
Sets markers 1-8. Play cursor jumps to the
position of current marker.

Switches to Marker Mode.

Loop on/off.

Confirms changes (OK/Enter)

Cancels changes

Saves open projects

Undo (Redo with “Shift” + ”Undo/Redo”)
REC/RDY-LED in MACKIE control —
optical control of automation recording.
Signals volume automation curves in
MACKIE control.

Records panorama automation when key is
held down

Scrolls left in open project

Scrolls right in open project
1g pen proj 257




“Options” Menu

258

Cursor up
Cursor down
Mixer

CF Mode
Cut

Option

Switches to the previous track in the current
VIP
Switches to the next track in the current VIP

Opens the mixer

Starts Samplitude Crossfade Editor

Cuts selected Object in two at the current
cursor position

Hold down keys F1-F4 on the Mackie control
or one of the keys assigned by them (the F1-
F4 corresponds) to switch between peak
meter modes.

Program Settings - Metronome Settings

In this dialog, you can activate a metronome click which helps you play in
time while recording. You can choose between a MIDI metronome (requires
an external or internal MIDI sound generator) and an audio metronome, which
then is played back via the mixer master channel.

Metronome Options il

Midi

™ Active while Flayback
I Active while Record

Precount for recording
(Measures):

& Audio Metronome

I etronome

ID ™ Precount clicks only

First Beat IC WWAGE\SequoialitepresetiMetronam way "
Beats IC WWAGE\Sequoiadib-preset\Metranom 2 way L
Wolume: JI 0.0dB

 MIDI Metronome MIDI Channel: IW—
First Beat Beats
Nate Value: |3? |3?
MIDI output dewvice: oie vale
MPU-401 x| wveloeity 127 [6a

ACTIVE WHILE PLAYBACK/RECORD: You can activate the click for playback,
recording or both.
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PRECOUNT FOR RECORDINGS (MEASURES): Enter the number of measures that
the metronome counts in before the recording starts. If the option “Precount
clicks only” is activated additionally, the click is muted after recording start.

Audio Metronome

First BEaT/BEAT: Choose samples for the first beat in the bar and the other
beats in the bar. The sample for first beat should be a more “present” sample
than the other one. Volume adjusts the overall volume of the metronome.
With Device you can select the Output device.

Midi metronome

Here you can make settings for the MIDI metronome: The metronome then
works by sending MIDI Notes, (usually on the drums channel), to an internal
or external MIDI sound device, which must be present to hear any metronome
click. You can assign the MIDI port for the output device, the channel and the
note and velocity for the normal and the accented beat. Which beat is accented
depends on the numerator setting in the Bars/Beats Dialog.

Program Preferences = Draw Setup
Please refer to "Menu View”, "VIP Display Mode”.

Shortcut: Shift + Handle
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Program Preferences = Color Setup

Select this option to change the colors of various Samplitude displays.
You can select any color for options such as sample foreground and background,
curves, VIP arrangement backgrounds, oscilloscope colors and so on.

x|

| Load Delete |

Sample Foreground : ‘olume Curve :
Sample Envelope - Fan Curve D
Object/Sample Background ftop) 1 Gridl ]
Object/Sample Background (bottam) :
Selected Dhject Background (top) : /Time Dis
Selected Ohject Background (bottom) - Visualization Foreground -
Arrangement Background (tap) |:| Visualization Background -
Arrangement Background (bottam) || Visuslization Grid |
Arrangernent Background ftransparent) - Yisualization Peak top -
Arrangement Background (Crossfades) : Wisualization Feak mid :
Arrangement Backgr. (Crossfade Editar) : Wisualization Peak bottom -
Time Display Foreground
v Use automatic Sample colors for Record :
Time Display Background
¢ Options
Bastore Last Setup Restore Original Setup [¥ Semitransparancy view
Colars
Ok | Cancel | Help

Samplitude’s default colors have been carefully chosen to complement most
working situations, but many variations are possible, to suit almost any taste.
The best way to find out how changing the colors affects the working
environment is to spend a little time experimenting.

Please remember that some variations are also available in the View > VIP
Display Mode > Definitions menu item.

Note: Be careful when choosing your custom colors; it’s possible to choose colors
which will result in a screen that is unreadable. For example, if the text and
background share the same color, you won’t be able to see the information in the
window.

The default color scheme can be restored at any time by choosing the Reset All
Colors To Default option.
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Program Preferences = Undo Definitions

Select this option and the Undo Options window will open. The Undo Options
window allows you to specify the number of Undo Levels, and whether or not
Undo is enabled.

Undo Options x|

—“irtual Actions

M Undo enabled Lindo Steps: |2IZI

™ Undo for Direct< plugin settings

—WWawve (destructive)

M Undo enabled Lindo Steps: |1 0

Create ternporary Undo file for BARM wawe projects as HD
waEne project

[a]4 Cancel | Help |

The depth of undo can be specified when working with VIPs and Wave Projects.
A value of “20” means that the last 20 changes can be undone.

VirTual ActioNs: Undo and the number of undo steps can be defined. It is
also possible to disable undo step creation when changing DirectX plug-in
settings. This will remarkably increase graphics performance when editing
larger projects where many DirectX plug-ins are used.

Wave (Destructive): Undo and the number of undo steps can be defined.
You can disable the creation of HDP-based undo files for RAM Projects for the
sake of performance.

Cancer: Click on this button to close the Undo Options window without
accepting changes to the settings.

OK: Click on this button to accept the current settings and close the Undo
Options window.

Program Preferences = Dithering Options

Select this option to open the Dithering Options window. Dithering is used
(in real time) when converting audio from higher resolutions to, e.g. 24bit to
16bit (often to burn a Red Book audio CD). The dithering process adds a very
small amount of noise to the audio signal, which prevents low level audio

from being distorted by quantization errors (truncation artifacts). The tiny bit 261
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of noise introduced by this process is less distracting to the ear than quantization
error, and is thus a good trade-off.

Dithering Options x|
— Dithering Mode (Conversion from Float to §/16/24 Bit)

Mo Dithering, 16 Bit internal resolution
(ot recommended far wvalume, effect ar mix calculations)

r Force 16 Bit resolution for output
(CD Mastering Cluality)

" No Ditheting . math. rounding of sample value
 Dithering with linear spread noise

& Dithering with tiangular spread noise

Dithering Depth in Bits (0.01 ... 16.0) 0.50

" POMW-r#1 (Dithering) pow

o POWy-r #2 (Noise Shaping)

& POWy=r #3 (Noise Shaping)

aF. Cancel Help |

Dithering Mode (Real-time conversion from float to 16bit)

NO DITHERING, I6GBIT INTERNAL RESOLUTION: All real-time calculations are
carried out at an internal resolution of 16bit. Dithering is therefore not required.
Compared to the usual internal resolution of 32bit, this achieves slight
advantages of speed for slower CPUs. However, in this mode Samplitude is
very susceptible to internal clipping. It should not be used for mixdown. One
possible use is high-speed on-the-fly burning of MP3 files to a CD without
effects processing. In this mode it is not possible to work in Surround formats.

No DITHERING MATH ROUNDING OF SAMPLE VALUE: This mode uses a
mathematical rounding process to convert the audio; no dither is applied. Even
without dither, this mode offers an audible advantage over simply truncating
(lopping off) the extra bits.

DITHERING WITH LINEAR SPREAD NoISE: This mode converts the audio using
very low-level noise, which is spread over all sample values. The level of the
noise can be adjusted with the Dithering Depth in Bits parameter (below).
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DITHERING WITH TRIANGULAR SPREAD NoISE: This mode converts the audio
using very low-level noise, which is spread over all sample values in a triangular
shape. This usually results in a more "decentralized” noise than linear dithering,
leading to smoother results. The noise is not modulated by the signal, producing
merging of a fading signal with the noise signal. The level of the noise can be
adjusted with the Dithering Depth in Bits parameter (below).

DITHERING DEPTH IN BITS (0.0I - 16.0): This parameter allows you to adjust
the level of noise (in bits) when applying dither. Generally speaking, values of
0.5 — 2.0 will yield good results. But, use your ears!

Tip: When applying dither, you want to use the least amount of noise necessary to
prevent audible quantization artifacts.

POW-r Dithering
POW-r offers three distinct dithering modes.

POW-r #1: uses a special dithering curve to minimize quantization noise.

POW-r #2: (Noise Shaping): uses additional noise shaping over a wide
frequency Range which can extend the dynamic Range by 5-10 dB.

POW-r #3: (Noise Shaping): uses additional, optimized noise shaping which
can extend the dynamic Range by 20 dB within the 2-4kHz Range - the Range
the human ear is most sensitive to.

Note: Noise shaping minimizes side effects caused by bit reduction, by spectrally
displacing the quantization noise above 10 kHz - the Range the human ear is least
sensitive to.

The mode which will sound best to you is primarily dependent on the program
material and on your personal taste. The “right” setting is best determined by
auditioning the audio material with each of the dithering modes.

How Does Dithering Work?

When an audio signal is quantized, the signal ends up with a “stair step” form
based on the reduction of the possible amplitude values. This is the case for
AD (Analog-to-Digital) conversion and when converting from a higher
resolution to a lower resolution. An 8bit signal contains only 256 amplitude
values. This type of stair step form leads to a deformity and therefore a distortion
of the signal.

If a low level noise signal is added to the audio signal, the decay can be
significantly reduced in respect of human ear perception.

Some excellent information regarding Dither can be found at www.digido.com
POW-R dithering stands for “Psychoacoustically Optimized Wordlength
Reduction”. For more information on POW-r, check out:

http:/ /www.mil-media.com/docs/articles/powr.shtml
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When is Dithering used in Samplitude?

Dithering is always used when converting from a 32bit float format to a 16bit

format. This is the case for the following situations:

1. Playback of Virtual Projects on 16bit cards when using an internal precision
setting of 32bit float.

2. Playback of high resolution Wave Projects on 16bit sound cards.

3. Creating audio CDs in real time using an internal precision setting of 32bit
float.

4. Using track-bouncing of Virtual Projects that contain any resolution content
when the internal precision is set to 32bit float and target format is less than
that.

5. When converting any higher resolution Wave Projects to lower resolution
Wave Projects.

Program Preferences - Advanced Buffer Settings
Please refer to "Menu Options”, “System/Audio Settings”, "Playback”.
Resampling Options

You can set the resampling quality for several uses of resampling in the
program.

Resampling Cuality il

esampling Quality
Record Resampling (44.1; Chaselock) |High LI
Flayhack Fesampling (Scrubbing; Chaselock) INDrmaI LI
Ohbject Resampling for new objects IHigh LI

| Cancel |

Resampling can create aliasing. To avoid that in critical situations you can
enable a high-quality resampling algorithm, but this also creates high CPU
load, which is undesirable in many cases.

You can set the resampling quality for:

RECORDING: Resampling is used when recording from DAT (48 kHz sample
rate) into a standard 44.1IkHZ Wave Project. Default is high (should not be
changed)

Praysack: Used for Scrubbing and the varipitch function. Default is normal,
because the resampled audio is only for listening purposes.
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OBJECT RESAMPLING FOR NEW OBJECTS: Resampling is used when loading a
Wave Project with a different sample rate in a VIP. Default is high. You can
change the quality level in the Object editor -timestretching mode.

Program Preferences - Object Lock Definition

Use this dialog to set Object Lock Definitions. Please refer to the Object > Lock
Objects > Lock Definitions menu item for more details.

Program Preferences = Set PreRoll Time

This option sets the pre-roll time for the cut simulation functions. (The cut
simulation functions are located on the Punch-In toolbar.)
The pre-roll determines how far prior to the selected Range playback starts.

Program Preferences - Destructive effect calculation
Please refer to the chapter “Offline effects” menu.

System/Audio

Use this option for direct access to several items of the "Options” menu.

Shortcut: “v”

System/Audio - Playback Devices

System /Global Audio Options il

Dewvice Info |
Rename |

Orcler:

Buffer s

olution/Driver Communication

1B Bit

& 24Bi VIP Buffer |j |4nnn E
£ e Buffer Mumber: D |4— E

& MME Advanced Buffer Settings |
WD (Multichannel)

 ASIO

AZI0 Device INDne ﬂ ot Fate]

Clock Source: I ;I |

I” | Hiatest Praoram PrEtny;

(8] 4 | Cancel | Help |
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The installed sound cards/sound card outputs are displayed in the large upper
window. A small window is opened when pressing on the Device
Window button. The new window displays information (supported sample
rates, manufacturer, etc.) on the respective sound card in the adjacent window.
Not required devices can be deactivated by unchecking the boxes. These are
then no longer displayed in the device lists of the track properties and in the
mixer. The order in which the outputs appear in the list can also be changed;
the devices can be renamed.

Driver Resolution/Driver Communication

Select the bit resolution for addressing the audio driver during playback and
recording. The selection of the resolution is usually performed automatically.
If the output device cannot output a required resolution (e.g. 24bit), the
corresponding lower resolution is then automatically created by Samplitude
(dithering) and is passed on to the drivers. Under certain circumstances, e.g. if
the driver generates error messages (because it reports certain resolutions, but
cannot play/record these), you can force 16bit resolution.

Driver System

You can choose between MME, WDM Multichannel and ASIO. MME is
Windows multimedia driver system. WDM (Multichannel): try to use this driver
if your sound card supports 24/32bit playback and problems result when playing
back high resolution audio files.

ASIO

ASIO drivers have some advantages over MME (provided that your sound card

model is issued with ASIO drivers):

— Low latency of the driver system: This results in considerably lower response
times for real-time processing. This enables software monitoring of the
inputs (and VST instruments). The CPU load of the system drops, and more
high-quality effects are possible without bouncing operations.

— Synchronization between recording and playback is carried out at the driver
end. This ensures that the timing of overdub recordings is exa ct. This also
enables mechanisms of compensating latency for effects that permit software
effects monitoring.

— Furthermore, ASIO offers a general method for treating multi-channel audio.
All bit resolutions and multi-channel problems that can otherwise occur
with WDM drivers in Win2K/XP are thereby avoided fundamentally.

— Advanced hardware monitoring options are possible as a result of using
ASIO Direct Monitoring (flexible routing inclunding pan and level).

ASIO Setup

ASIO Driver: The drivers of all ASIO Devices currently or previously available
in the system are listed here. Control Panel opens the Setup dialog of the
sound card driver. More information can be found in the sound card manual.
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Buffer Settings

VIP BuUFrER: As error-free playback is usually more important than short
response times, this value should be increased to about 8ooo when playing
back many tracks.

BurrEr NUMBER: You can state here how many of the above-described buffers
are to be used. More buffers increase the safety, but also the memory
requirement. The response times increase. The current buffer utilization during
playback can be seen in the bottom right of the status bar.

These are the only relevant settings when playing Virtual Projects and when
working with the mixer.

Advanced Buffer Settings

This window permits optimization of the buffer settings for VIP, hard disk
caching and plug-in settings. No changes are usually required here. If you
encounter problems just experiment with the provided presets.

Program Buffer (in Stereo Samples)

VIP BuFrreRr: As error-free playback is usually more important than short
response times, this value should be increased to about 8ooo when playing
back many tracks.

HD/Scrus Burrer: This buffer is used for playback directly in HD Wave
Projects. You should also test lower values in terms of shorter response times!

Test Burrer: This buffer is only used for a real-time preview of effects.

BurrEr NUMBER: You can state here how many of the above-described buffers
are to be used. More buffers increase the safety, but also the memory
requirement. The response times increase. The current buffer utilization during
playback can be seen in the bottom right of the status bar.

HD Performance (Track Speed)
PREVIEW TIME FOR CACHING: You can state how many seconds of the VIP are
to be preloaded into the cache.

PRELOAD AT Pray START: States the percentage of the cache that is loaded at
play start. Higher values delay the start process, but also increase stability
when playing back large track amounts.

PreLoAD FILE CACHE DURING Pray Stop: When this option is activated and
you position the play cursor, the file cache is always preloaded. In the status
line the message “Cache Preloaded” appears. Playback is started really quickly
since all the audio data required is already available in RAM.
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Plug-in Buffer

The four numeric value entry fields define the buffer sizes of both plug-in
types irrespective of each other as well as the resolution (in samples) for VST
plug-in automation. All buffer sizes can have the same settings as the ASIO
driver by entering “-1” as a value. Entering “o” states no limit for the buffer
size.

DirecTX PRELOAD BUFFER SIZE: If no value is entered here, the entire buffer
size is used for DirectX startup initialization.

System/Audio = Record Devices

The installed sound cards or available record devices are displayed in the large
upper window. A small window is opened when pressing on the “Device
Window” button. The new window displays information (supported sample
rates, manufacturer, etc.) on the respective sound card in the adjacent window.

Monitoring Settings (Record Devices)
There are several monitoring possibilities. These settings are set for new
projects. More info on monitoring can be found in the “Menu Play/Rec” chapter.

System/Audio - MIDI Options

Please refer to "Menu Options > Program Preferences > MIDI/Metronome
Options”.
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System/Audio = Program Options

Program Settings x|
Programm Setlings
Opens YIP and Recaord Window o HideWawve Projects loaded into
oh program start wirtual Projects

Open Wave Projects in
destructive editing mode

¥ Show Project Tool Tips

Check Space key for playhack

- .
stop also in background ¥ Show extended Project Tool Tips

o Disable menus and butions if

Petf dizpl . .
o Peimmeee ey function is not availakle

Midi I” Treatknobs like faders ™ Activate Rewire
! v (F:;gll:ir:q\!\igglr;lzatmns
h.ﬂeln:l.ru:lrne Reset all "Don't show this message again hoxes |
v Preolim ocondsy  [£ (i Bevstme o iecs [
;:jgr:am Postroll time (seconds): |2— Freview Time (seconds): 4

Extended Options

Dithering Options ... Advanced Buffer Settings ..

Undo Definitions

4 Point Cut Preferences... | Crossfade Editor Preferences...

Keyhoard Shartcuts and Menu ... Resampling Quality ...

|
|
Object Lock Definitians |
|
|

Destructive effect calculation... | Direct< / ¥ST Settings ..

Colors

Ok | Cancel | Help |

OrENs VIP AND RECORD WINDOW ON PrROGRAM STaRT: Enable this option and
Samplitude will automatically open a VIP and Record window when the
program is started.

OrEN WAVE PROJECTS IN DESTRUCTIVE EDITING MODE: Samplitude offers a
non-destructive editing mode for Wave Projects which is pre-set for opening
Wave Projects independently. Thus, all cut operations, effect settings, volume
level changes, fades, and more are completely virtual in VIPs and in Wave
Projects (WAV, RAP, HDP) - the audio material is not destroyed. This allows
you to select the proper cut position, cut length, volume level, effect setting,
etc. by experimenting without losing audio material or altering it. The
"workspace” menu at the bottom left of the Wave Project screen allows you to
select between ”destructive editing” and "Wave editing” (non-destructive
editing).

If you prefer the destructive editing, you can select this option for opening
Wave Projects in destructive editing mode.

Note that opening Wave Projects directly from the VIP, so opening the Wave
Project in the Object context, however results in working in Destructive Editing
Mode.
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CHECK SPACE KEY FOR P1ayBack Stor ALso IN BackGgrounD: Click on (i.e.
enable) this option and Samplitude will continue checking the space bar (to
stop playback) while multi-tasking in another program. If you wish to use the
space bar in the other program (without stopping playback), do NOT enable
this option.

PERFORMANCE Dispiay: This menu option allows you to enable the DSP power

display in the lower left corner of the screen. Always be sure to use less than

100% to avoid the system hanging during playback.

If your project needs too much processing power, you can:

— Reduce the number of DSP effects in the Mixer or in the Object Editor.

— Reduce the number of tracks with audio Objects.

— Increase the VIP buffer size in Menu “System>Playback/Record Devices”
to 16000 or 32000 samples.

The status bar will display suggestions to remedy problems if the processing
capabilities of the CPU are exceeded (for example during use of the Noise
Reduction or FFT Analyze Filter ).

Suow ProjecT ToorT1ps: This switches Samplitude’s ToolTips in VIP window
on/off. You can choose between simple and extended ToolTips. Extended
ToolTips show detailed information on the selected element and available
keyboard shortcuts.

DisaBLE MENUS AND ButroNs 1F FUuNCTION Is NoT avAaILABLE: Click on (i.e.
enable) this option and Samplitude will "gray out” functions that are not
available. That is, some of the functions in the Effect menu are not available
while working in the VIP window (they can only be applied destructively). In
this case, the functions that are unavailable will appear "grayed out.” If this
option is not enabled, ALL functions will be listed "normally” whether they are
available or not. It is recommended that you enable this option.

PentiuMm III OpriMIzATIONS: Samplitude is designed to utilize the PIII
algorithm extensions. This option is available on PIII-combatible CPUs istalled.

Preview TiME (SeconDs): This parameter allows you to specify the length of
ALL calculated previews (in seconds). As an example, if you set this parameter
to 10 seconds, when you click on the Preview button in the room simulator,
Samplitude will calculate a 10 second preview of the results.

TREAT KNOBS LIKE FADERS: When active, you adjust the value of a knob by
clicking on it and dragging the mouse up and down (as with faders). When
inactive, you can “turn” a knob by dragging the mouse around it. For a finer
resolution of the control, you can increase the radius of the circle.

Hipe Wave Projects LoADED INTO VIP: The windows of the Wave Projects
loaded directly into the VIP are hidden by default (to maintain clarity on the
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program desktop, because the program assumes that you want to work with
them only inside the VIP). You can change this behavior here.

You can unhide all Wave Projects by “Window>Iconise all Wave Projects” and
hide it again by “Window>Hide all Wave Projects”.

RESET ALL “DON’T SHOW THIS MESSAGE AGAIN” BOXEs: In a “fresh installed”
state, Samplitude shows a lot of security questions at several places of the
program. You can disable each of them by checking a little box named “Don’t
show this message again!” at the lower edge of the message box. If you want to
see these messages again, press this button.

PreroLi/PosTROLL TIME: When you perform cut simulations (play from/into
cut start/end, play over cut in the “Playback” menuy), then playback will start/
end this time span before/after the chosen reference point.

MAXIMUM REVERB TIME FOR OBJECTS WITHOUT FADEOUTS: The time span the
fx calculation will be continued after Object end to avoid cutting of reverb.
Make sure that the Object volume is placed before the reverb in the effect
chain or this will not work with Objects that have a fade out.

PreviEw TIME: The “Preview Time” setting determines the length of the preview
function in various effect dialogs.

DITHERING OPTIONS/ADVANCED BUFFER SETTINGS/UNDO DEFINITIONS/OBJECT
Lock DErFINITIONS ...: You have direct access to this menu item. Please refer to

the corresponding chapters of the menu ”"Options”!

OK: Click on this button to accept the current settings and close the System
window.
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System/Audio - Path/Skins
x|

MNew Vinual Projects: IC'\MAGIX\SequuiaE\Audm\ ﬂl
Project Files: IC.\MAGIX\SequuiaE\Aud\U\PrDjed Files', QI
FTF Download: IC.\MAGIX\SequuiaE\Aud\U\l——rp\ EI
Tempaorary files IC.\DOKUME“’T yroland\ LOKALE™ 14 Temp!, EI
ST Plugins: I.\VstPlugma EI

Froject IDefauIt LI
hixer IDefauIt LI
Transport IDefauIt ﬂ
Crossfade Editor IDefault LI
Cancel | Help |

Paths
New VirTUAL ProjECTS: Defines where all new VIPs and the newly recorded
and imported wave files are saved.

ProjEecT Fires: All other WAV files that are to be saved on the HD and which
cannot be assigned to a concrete VIP are saved here.

FTP DownroaD: All files downloaded via the integrated FIP client end up
here.

TEMPORARY FILES: Default folder for temporary files. This folder should be on
a HD/partition with sufficient storage space.

VST-Pruc-Ins: defines the search path for VST Plug-in effects and VST
instruments. At first start and if the VST path is valid, a VST scan is started
when opening the track settings for the first time. If many VST plug-ins are
installed, this can take several minutes. All plug-ins are then checked for
usability in Samplitude. However, this scan is only required once. All used
VST plug-ins are saved. If you have several VST plug-in folders, you can define
a further folder that then only requires scanning once. Samplitude finds newly
installed plug-ins automatically, but only at the stated location.
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Skins

This window allows you to choose between different skins for the project, the
mixer and the transport control. By using different skins you can change the
colors and parts of Samplitude’s graphic display.

There are skins that are specially adapted to different work situations, such as
the “Multi-Track Mixer”, which helps to maintain an overview in recording
situations with many recording sources.

Further skins can be downloaded from http://www.samplitude.com

You can also choose between different skins at the left of the title bar in the
System Menu of the corresponding window (Mixer, VIP).

System/Audio - View Options
Please refer to "Menu View > VIP Display Mode”.

System/Audio - Colors

Please refer to "Menu Options > Program Preferences > Color setup”.
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"Window” Menu

Cascade
Choose this option to cascade all open windows.
Tile

Choose this option to tile all open windows.

Shortcut: Return

Untile

(shortcut key - Shift + Return) - If you previously chose the Tile option, you
can choose this option to return all open windows to their original locations.
Arrange Icons

Choose this option to organize all icons (minimized windows) at the bottom
of the screen.

Main Toolbar

Select (enable) this option to display the Main Toolbar. Unselect (disable) this
option to hide the Main Toolbar.

Position bar

Select (enable) this option to display the Position bar. Unselect (disable) this
option to hide the Position bar.

Punch/Play bar

Select (enable) this option to display the Punch/Play bar. Unselect (disable)
this option to hide the Punch/Play bar.

Mouse Mode Toolbar

Select (enable) this option to display the Mouse Mode Toolbar. Unselect (disable)
this option to hide the Mouse Mode Toolbar.

Range bar

Select (enable) this option to display the Range bar. Unselect (disable) this
option to hide the Range bar.

Workspace bar

Workspaces should help you organize the huge amount of menu items and
toolbar buttons to get a better overview over the functions of Samplitude. There
are several items in the menus, toolbars and toolbar entries, that you never
use, or only use at a certain point of your workflow.

The possibilities to hide menu items (menu "Options>program
preferences>Edit Keyboard shortcuts and menu....” and toolbars (menu
"Window”) and reorganize the contents of the toolbars ("Options>Program
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preferences>Edit toolbars” or simply right-click a toolbar) are present in former
versions of Samplitude. A workspace brings this all together and offers the
ability to save such a setup under a certain name.

Several workspaces are predefined by the Samplitude team for different working
tasks like recording, editing or CD mastering. The “Power User” workspace
shows every toolbar and menu item. Use this if you are an experienced user or
if you want to build your own custom workspace.

NEew wORKSPACE: Create a new workspace with "New Workspace”. The currently
chosen settings are copied to this workspace and all changes made from now
on are stored in this workspace. You don’t have to save the workspace explicitly.

Epit worksPACE: The upper area allows you to select the toolbars to show, the
middle area allows you to customize the toolbars, Edit menu calls the menu
”Options > program preferences > Edit Keyboard shortcuts and menu....”
command.

Button bar

Shows or hides the Button bar on the lower part of the display. The buttons on
the Button bar allow you to open/close the main windows of Samplitude.

Status bar

Select (i.e. enable) this option to display the Status bar. Unselect (i.e. disable)
this option to hide the Status bar.

Mixer

Choose this option to open the Mixer window.

Shortcut: “M”

Time Display

Choose this option to open the Time Display window.
See chapter "VIP window — a detailed look” for more details.
Visualization

Choose this option to open the Visualization window.
See chapter "VIP window — a detailed look” for more details.
Transport Control

Choose this option to open the floating transport control.

See chapter "VIP window — a detailed look” for more details.

Shortcut: Shift + T
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Close all Windows

Choose this option to close all windows.

Shortcut: “Ctrl + H”

Iconise all Wave Projects

Choose this option to iconise (minimize) all HD Wave windows.

Hide all Wave Projects
Choose this option to hide all Wave Projects.

Half Height

Choose this option to reduce the program display to half height. This is useful
when multitasking.
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Help

Choose this option to open Samplitude’s online help. By default, the online
help will open with information about projects (HDP, RAP, and VIP) with an
emphasis on the VIP window.

Help Index...

Choose this option to display a list of available help contents.

Context Help...

Choose this option to enable context based help. The mouse pointer will display
a question mark, allowing you to click on any item or function to display relevant
information.

Shortcut: Shift + F1
About Help...

Choose this option to display information on how to use online help.

Startup wizard/Tip of the day
Choose this option to display the “Start wizard” and “Tip of the Day” function.

About Samplitude...

Choose this option to display information about Samplitude. You can read
your license serial number from here as well.

System Information...

A window is displayed which contains information about memory status and
other parameters.

Particularly useful is the display of free storage on all connected disk drives,
the system resources utilized by Samplitude and the memory usage. Make
sure the parameter for system memory used by Samplitude never grows larger
than the displayed overall system memory available (physical RAM). If this
happens, the performance of Samplitude is reduced due to page-swapping
(virtual memory) to compensate for the missing memory.
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Button Overview

When the program is first started, only the tools and mouse mode bars are
opened in the upper right corner of the monitor. All further ones may be
added via the menu "Windows”.

All toolbars may be placed on the screen at one’s discretion, and they are
automatically arranged in the upper part of the screen by double-clicking on
the header line.

Tools bar (left)

DE&HE~-| % R 2 [8hLaBE
I 2 3 4 5 67 8 9 10 II 12 13 I4 1I§

1 New multi-track project 10 Redo

2 Open VIP I Snap on

3 Open WAV file 12 Auto Crossfade Mode
4 Export/Store project 13 Crossfade .EdltOI'
5 Cut 14 Group Ob]ecjcs

A Copy 15 Ungroup Objects
7 Insert

8 Split Object

9 Undo

10 Redo

11 Snap on

12 Auto Crossfade Mode

13 Crossfade Editor

14 Group Objects

15 Ungroup Objects

Tools bar (right)

SR =
S 5
w i"“
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MO L e e
5 67 89 i10m 121314

Set Marker

Set Track Index

Set Sub Index

Set Pause

Set CD End

Auto Track Markers
Make CD

Play Once

278 Play Loop
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Button Overview

10 Play into Range

11 Stop

12 Record Options

13 Multi-I/O-Recording
14 Mixer

Punch/Playback bar
o o |t e e e |

123 4 5 6 7 8 910 1I

To Start Cut

From Start Cut

To Cut End

From Cut End
Beyond Cut

Punch-In Mode active
Punch-In Recording
Punch Start Marker
Punch End Marker
Delete Punch Marker
Live Input Mode active

550 oN avth W N A

Mouse Mode bar

For mouse mode functionality see “Menu Options > Settings*.
SN N AL N e e
I 2 3 4 56 7 8 9 10 1 12 13 14 151617 18 19

I Universal Mode

2 Range Mode

3 Object Mode

4 Curve Edit Mode

5 Object and Curve Mode

6 Mouse Mode Samplitude 4.0

7 Cut Object Mode

8 Pitchshift/Timestretch Mouse Mode

9 Draw Volume Mode

10 Draw Panorama Mode

I Draw Wave Freehand (only for Wave Projects)
12 Scrub Mouse mode

13 Zoom Mouse mode

4 Arrange all Objects

15 Normal Object mode

16 Link Curves to Objects

17 Link until silence

18 Link Objects on 1 track 279
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19 Link Objects on all tracks

Position bar

M4 | @ER|GEERR |G @& G| )R]

I 2 3 4 5 6 78 9 10 11 12 13 14 15 16 17 18 19 20 2I

I — Cropping at start

2 — Half cropping to left

3 — Half cropping to right

4 — Cropping at end

5 — Object edge left

6 — Object edge right

7 — Range to last marker

8 — Range to next marker

9 — Zoom all

10 — Range as clipping

I1 — I:I presentation

12-15 — Zooming Range 1 sec, 10 sec, 60 sec or 10 min
16 — Zoom in vertically

17 — Zoom out vertically

18 — Zoom all vertically

19 — Range as vertical clipping
20-21 — Waveform zoom in/out

Range bar

e omEE u EE .
1 2 3 4 5 067 8 9

1 — Play cursor to start of Range

2 — Play cursor to end of Range

3 — Fold Range to the left

4 — Fold Range to the right

5 — Range start to previous zero-crossing
6 — Range start to next zero-crossing

7 — Range end to previous zero-crossing
8 — Range end to next zero-crossing

9 — Range editor
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Index

A

A/B/C 85

About Help.... 277

About Sequoia 277

Absorption 122, 127

Activate next 59

Activate previous 59

Add Time 166

Advanced Buffer Settings 264, 267
Advanced Dynamics 100, 106

Aiff 26

AIFF File with QuickTime 26
Algorithms for Pitchshifting / Timestretching 147
Algorithms for Timestretching/ Pitchshifting 193
Algorithms Internal Parameters 122
All edits 72

All Tracks 57

Allow Bonus Tracks before Track 1 183
Amp Model 135

Amplitude/Normalize - Fade In/Out 80
Amplitude/Normalize = Normalize 78
Amplitude/Normalize = Normalize (quick access) 80
Amplitude/Normalize > Set Zero 82
AmpSimulation 134

Analysis Accuracy Noise 93

Analysis Accuracy Tones 93

Analysis Precision High 93

Analysis Precision Normal 93
Analysis Time (s) 93

Analyze - Filter 91

Analyze all 91

Append Projects 36, 38

Arrange Icons 274

Artefact Suppression 123

ASIO 266

ASIO Setup 266

Assign Shortcut 251

Attack 108, 112

Audio / MIDI Synchronization 254
Audio Device 56, 58

Audio Marker Manager 190

Audio Metronome 259

Auto Crossfade 72
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Auto Crossfade Active 39
Auto Crossfade Mode 235
Auto Number 164
AutoSave Mode 235
Autoscroll 204

Background 48

Band Separation 84

Bar Definitions 57

Bar/Beat 45, 235

Bar/BPM 236

Batch Processing 28

Beat marker 194

Beat marker-based slicing 148
Beat marker-based stretching 148
Beat recognition threshold 152
BMP 238

Bouncing Sub Mix Busses 188
BPM 205, 238

BPM value 194

Bright 135

Broadcast Wave Manager 231
Buffer Settings 264, 267

Build Loop Object 68

Build Physical Loop 153

Burn OnTheFly 178

Burn Project Backup on CD 20
Button bar 275

Button Overview 278

Bypass 87, 105, 128, 141
Bypass all 112

Bypass dyn. 111, 112

c

Cancel 166

Carrier signals 137

Cascade 274

CD Arrange Mode 184, 233

CD Arrangement Mod 235

CD Disc Options.... 183

CD Text / MP3 ID Editor 183

CD Title 183

CD Track Options.... 183

CD Track/Index Manager 181
282 CD-Drive Configuration 175




Index

CD-drive dialog 174

“CD/DVD” Menu 172

Change Mouse Cursors 49

Change Playback Direction 203

Change sample rate 150

Change Toolbar Style 252

Channels Both 93

Channels Left 93

Channels Right 93

Check Space Key for Playback Stop 270
Circle 94

Circle/Direct 94

Clear 37

Clipping Definition 117

Close all Windows 276

Close Project 31

Collect Project Files 189

Color Setup 260

Colors 273

Comp Max 103

Comparisonics Audio Search 167
Comparisonics colors 47

Complete Project 185

Compressor 103

Connect to the Internet 31

Context Help.... 277

Controller Options 57

Convert Audio 21

Convert Audio > 1 Mono > LR Wave 23
Convert Audio = 2 Mono = Stereo/LR Wave 23
Convert Audio > LR Wave > 1 Mono 23
Convert Audio > LR Wave > 2 Mono 23
Convert Audio - Save In Format 22
Convert Audio - Stereo Wave > 2 Mono 23
Convolution 132

Convolution Sample 133

Copy 34

Copy + Clear 37

Copy as... 37

Copy only samples used in VIP 19

Copy to all 111

Copy Track(s) 54

Copying audio marker to VIP marker 168
Create AVI / Audio Copy 226

Create Copy 91

Create DVD-Audio 180
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Create Vip Object with Name 210

Creating a DVD-Audio disc 180

Crossfade Editing 39

Crossfade with Clip 38

Curve Display 89

Curve Mode 243

Curve Numbers 94

Cut 33

Cut Mode 247

Cut Objects > Duplicate Objects (in place] 61

Cut Objects = Split Object On Marker Positions 62
Cut Track(s) 54

Cut with Ripple 37

Cutting Objects - Copy Objects 60

Cutting Objects - Cut Objects 60

Cutting Objects & Delete Object 61

Cutting Objects - Duplicate Objects 61

Cutting Objects — Duplicate Objects multiple.... 61
Cutting Objects & Extract Object 61

Cutting Objects - Insert Objects 60

DB lin/ log 120, 127

DB lin/log (to the right of Freq lin/log) 90
De-clipping 116

De-clipping Mode 117

Default color settings 47

Dehissing 126

Delete 34

Delete All Markers 166, 168

Delete Curve Handles 39

Delete Curve Handles = Delete Panorama Handle 40
Delete Curve Handles = Delete Surround Handle 40
Delete Curve Handles = Delete Volume Handle 39
Delete Freeze Data 189

Delete Marker 168

Delete marker 168

Delete Matching Markers 166

Delete Track(s) 54

Delete Undo Levels 40

Delete Virtual Project 21

Delete Wave Project(s] 21

Delete with Time/Ripple 37

Deleting or repositioning punch in/out markers 215
Delta Time 62
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Destination format 30

Destructive 80

Destructive effect calculation 265
Destructive Mode 235

Destructive Wave Editing Mode 233

Device 203, 237, 238, 239

Device Info 210

Device Setup (track in/output assignment, routing) 223
Diga System Export 27

Digital Mixer for ADATs (or other multi-track tape 216
Digital reverberation units 196

Digital Reverbs 198

Direct / Match 91

Direction Pan Mode 84

Disable Deleting 65

Disable Fade-In/Out 65

Disable Length Changes 65

Disable Menus and Buttons 270

Disable Moving 64

Disable Volume Changes 65

Disk Space 213

Display Filter 191

Distortion 134, 135

Dithering depth in bits (0.01 - 16.0) 263
Dithering Mode (Realtime Conversion) 262
Dithering Options 261

Dithering with linear spread noise 262
Dithering with triangular spread noise 263
Draw Envelope 46

Draw Grid 94

Draw Mode 120

Draw mode 127

Draw mode (below the Zoom buttons) 90
Draw Panorama 247

Draw Samples 46

Draw Setup 259

Draw Volume 247, 248

Draw Wave 248

Draw while move 49

Driver Resolution/Driver Communication 266
Driver System 266

Dry 145

Duplicating Objects 241, 244, 245, 246
Duration 62

Dynamic end 90

Dynamic filter parameters 136
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Dynamic parameters 108

Dynamic reduction 136

Dynamic scope 106

Dynamic start 90

Dynamics 100

Dynamics (Compressor / Expander....) 102
Dynamics Options/Bypass 111

Dynamics Setup 112

Early Reflect 140

Echo/Delay/Reverb 144

Edit a copy of Wave Content 72

Edit Keyboard Shortcuts and Menu 249
Edit List (*.EDL) 17

“Edit” Menu 32

Edit Mode 91

Edit Objects > Move Objects 65

Edit Range 159

Edit Range &> 0 > Range & 0 162

Edit Range — Beginning of Range & 0 161
Edit Range - Beginning of Range > 0 160
Edit Range - End of Range & 0 161

Edit Range - End of Range > 0 161

Edit Range — Flip Range Left 160

Edit Range — Flip Range Right 160

Edit Range - Range to Beginning 160
Edit Range - Range to End 160

Edit Time Display 169

Edit Toolbars 252

Edit workspace 275

Editing 235

Effects 29

Effects and Mix Down during Recording 217
Elastic Audio 76

Elastic Audio Editor 76

Enable VIP Tool tips 252

Envelope 104

Envelope Curve Duration (Enhancedoptions) 140
Envelope only 46

EQ-Section 135

EQ1, EQ2, EQ3, EQ4 86

Evaluating patched markers 152

Exit 31

EXP 81
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Export as Dump 26

Export Audio 23

Export Audio = 16 / 24 / 32 Bit Float Aiff 26
Export Audio = 32 Bit Float as 16 / 20 / 24 Bit 26
Export Audio - AIFF File with QuickTime 26
Export Audio - Export as Dump 26

Export Audio - Export MIDI File 26

Export Audio > MP3 25

Export Audio - MP3 with external Encoder 25
Export Audio > MPEG 25

Export Audio - Real Audio (*.ra) 25

Export Audio > Wave 25

Export Audio - Windows Media (*.wma) 25
Export MIDI File 26

Export to Video delLuxe pro 28

Export video sound 27

Extract 35

Extract Audio from AVI 226

F

Fade Curve 81

Fade End in % 81

Fade In 82

Fade Out 82

Fade Startin % 81

Faders 89

Fast 108

Fast Beats / Percussion 121
Feedback 144

FFT Filter / Analyzer.... 88
FFT-EQ 140

File list 21

“File” Menu 15

File selection 21

Filter 91

Filter curves 136

Filter Mode 90

Filter Settings 111

Find beat marker 152

Fix Vertically 42

Font for Time Display 253
Font Selection 252
Formant 136, 149
Format 22, 187

Format New Wave Project 190

Freqlin/log 120 287
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Freq lin/log (to the right of Hz/Notes) 90
Freq. 87

Freq. lin/log 127

From VIP Start to last Object end 185
FTP Download 31

FX 227, 240

G

Gain 85

Gain Db 87

Gate 104, 112

Gate level 108

Generate a complete new file 179
Get Globals 229

Get Level from height 117

Get Marker 165

Get Noise Sample 119

Get parameters 80

Get Position and Zoom Level 50
Get Range 163

Get Range Length 164

Get Zoom Level 50

Global MIDI Devices 254

Glue MIDI Objects 219

Glue Objects 63

Gramophone 1 Medium 121, 124
Gramophone 2 Hard 121, 124
Graphic Display Curves 126
Green 139

Grid Lines 43, 252

Group created Objects 62
Group Number 48

Group Objects 70

Half Height 276
Halftones 205
Halve 46
Hard 106
Hard Broadband Noise (e.g. 121, 124
Hard Tonal Noise (e.g. 121, 124
Hardware Controller Setup 254
Hardware Monitoring 217
HD Performance (Track Speed] 267
HD Wave (HDP) 17

288 Heal/Unsplit Objects 63
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Help 107, 277

Help Index.... 277

“Help” Menu 277

Hide all Wave Projects 276

Hide Menu Items 251

Hide Submix/AUX busses 42

Hide Track 59

Hide Wave Projects loaded into VIP 270
High Freq 140

Horizontal 51

Hz/Notes (to the right of Draw Mode] 90

[conise all Wave Projects 276

Ignore all Tempo markers, use project tempo only 220
Import Audio 21

Import project 174

Impulse response extraction 194

In/Out Meters 87

Independent normalization 80

Info 254

Input display 106

Input monitoring on/off 217

Insert new Tracks = Add one Track 53
Insert new Tracks = Add several Tracks 53
Insert new Tracks — Insert empty track 53
Insert new Tracks = New AUX Bus 53
Insert new Tracks = New Submix Bus 53
Insert new Tracks = New Surround AUX Bus 54
Insert Silence 36

Insert Trackl(s) 54

Interleaved 47

Internal Rate 205

Inverse Dehissing 128

Invert Filter 91

Invert Phase 74, 86

J

Jobs 28
Jog/Two Speed/Shuttle 206

K
Keyboard Shortcuts and Menu 249
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L

Large Object Handles 48

Lasso Function 242, 243, 244, 245, 246
Late Reverb 140

Latency 141, 216

Left 58

Length 140, 190

Level 106

Limiter 103

Limiter 100 103, 104

Limiter level 108

Limiter On (Only in the Mixer Master section) 113
LINEAR 82

Link 145

Link all Tracks 249

Link Bands 111

Link Curves to Objects 249

Link one Track 249

Link until Silence 249

Linking Sequoia projects to videos 225
List of used Wave Projects 230

Load 105, 113

Load / Save 251

Load Always New 226

Load Audio CD Trackl(s) 172

Load audio file 18

Load Setup 118, 124, 129, 133, 146
Load Shortcuts 251

Lock all Audio in Time 249

Lock Objects - Lock Definitions 64
Lock Objects - Lock Objects 64
Lock Objects - Unlock Objects 64
Lock Recorded Objects 235

Lock VIP size against Zoom Out 49
LOG 82

Looping Punch In Recording 215
Low Broadband Noise (e.g. 121, 124
Low Freq 140

Lower toolbars 280

LR Wave = 1 Mono 23

LR Wave = 2 Mono 23

M
Main Toolbar 274
Make CD.... 178
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Make up 108

Manager - Clipstore 190

Manual Declicker 131

Marker 213

Marker on Range Borders 165
Master Section 72

Match Time 191

Max Range (dB) 94

Media Link 224

Medium Broadband Noise (e.g. 121, 124
Medium Tonal Noise (e.g. 121, 124
Menu CD 172

Menu Effects 77

Menu File 15

Menu File Save in format 72

Menu ltems 251

Menu Range 158

Menu Tools 185

Menu View 41

Menu Window 274

Metronome active 220

Metronome Settings 258
Metronome settings 220

MIDI (*.mid) 16

MIDI Bouncing 219

MIDI Controller / VST-Automation 220
MIDI Controllers 59, 220

MIDI Editor 219

“MIDI” Menu 219

Midi metronome 259

MIDI Options 57, 253, 268

MIDI Panic - Terminate all notes 221
MIDI Record Modes 221

MIDI settings 221

Midi Track Options 57

Millisec 239

Min Level of clipped samples 117
Min Number of clipped samples 117
Min Range (dB) 94

Min. Time (ms]) 166

Minimize Track / Maximize Track / Minimize none 59
Mix 133, 141

Mix (Reduction) 122

Mix Balance in % 145

Mix with Clip 38

Mixer 275

Mixer Setup 222 291
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MMC Setup 241

Mode 107, 144

Modulator/Exchange carriers 137

Monitor 210

Monitoring Settings (Record Devices) 268

Mono 58

Monophone Voice 149

More 37

More = Clear 37

More = Copy + Clear 37

More - Copy as.... 37

More — Cut with Ripple 37

More - Delete with Time/Ripple 37

More - Mix with Clip 38

More — Overwrite with Clip 38

More — Paste with Ripple 38

Mouse Behaviour 49

Mouse Mode bar 278, 279

Mouse Mode Studio 4.0 245

Mouse Mode Toolbar 274

Move Play Cursor - Left Move in Page Mode 158
Move Play Cursor - Left Move in Scroll Mode 158
Move Play Cursor - Marker left 159

Move Play Cursor - Marker right 159

Move Play Cursor = Object border left/right 159
Move Play Cursor - Right Move in Page Mode 158
Move Play Cursor - Right Move in Scroll Mode 158
Move Play Cursor — to Beginning 158

Move Play Cursor - to End 158

Move Play Cursor - to Range End 158

Move Play Cursor - to Range Start 158

Move Range end right 160

Move Range start left 159, 160

Move Thresh 49

Move/Edit Objects 65

Move/Edit Objects - Arrange Objects 68

Moving Objects 241, 244, 245, 246

MP3 25

MP3 with external Encoder 25

MPEG 25

Multi Band Mode 84

Multi-Band Dynamics 110

Multi-Overdub 221

Multiband Dynamics 100

Multiple selection 80

Multitap 144

Mute Objects 64, 68
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Naming and rearranging devices 265
Natural rooms 196, 198

New File with Drag and Drop 72

New MIDI Object 219

New Object 60

New Sample Rate 151

New separate Object in actual VIP 187
New Shortcut 251

New VIP 187

New Virtual (Multitrack) Project (VIP]) 15
New workspace 275

No Dithering math rounding of sample value 262
No Indices on Object Crossfades 177
Noise Gate 104

Noise Reduction 119

Noise Reduction Tips 124

Noise Sample 120

Noise(dB) 137

Normal 128, 131, 249

Normalize to 79

Number of Bands 111

Number of first CD Track 183

Number of Objects 62

Number of steady samples after clip (1....10) 117

1]

Object 44, 234

Object (*.0bj) 17

Object Amp Simulation 75

Object Background Color 70, 71
Object Dehisser 75

Object DirectX / VST Pluglns 76
Object Distortion 75

Object Dynamics 75

Object Editor 71, 241, 244, 245, 246
Object EQ 74

Object FFT Filter 74

Object Foreground Color 71

Object Freeze 63, 64

Object Freeze - Object Unfreeze 64
Object Handles 242, 244, 245, 246
Object Lasso 70, 169

Object Lock Button 48

Object Lock Definition 265

Object Manager 71 293
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“Object” Menu 60

Object Mode 249

Object Multiband Enhancer 74

Object Name 48

Object Properties 48

Object Resampling/Timestretching 76
Object Room Simulator 75

Object Switch Channels 74

Object To Play Cursor Position 67

Object Vocoder 75

Objects 48

Objects Mode 243

Objekt Editor 219

"Offline Effects” Menu 77

Offset 225

OGG Vorbis 25

Only a Wave Project 186

Only marked Range 185

Open Audio CD Track(s) 19

Open Project - AVI - Video for Windows video files 17
Open Project = DDP import file (*.tcd) 18
Open Project = Edit List (*.EDL) 17

Open Project = HD Wave (HDP) 17

Open Project > MIDI (*.mid) 16

Open Project = Object (*.0bj) 17

Open Project > RAM Wave (RAP) 17

Open Project = Session (*.SAM] 18

Open Project = Table Of Contents (*.TOC) 17
Open Project — Virtual Project 16

Open Wave Project 247

Open Wave Projects in destructive editing mode 269
Open Windows Mixer 210

Opens VIP and Record Window on Program Start 269
“Options” Menu 222

Orchestral Instruments 121, 124

Original (%) 133

Original Time Position (only Wave Projects) 230
Output display 106, 107

Overdub 221

Overlap 128

Overwrite with Clip 38

P

Pan 85
Parametric Equalizer.... 86
Paste with Ripple 38
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Paste/Insert Clip 35

Patches in brief 194

Path/Skins 272

Paths 272

PEAK 108

Peak change 79

Peak maximum 79

Pentium Il Optimizations 270
Performance Display 270
Performance Options 141

Period Key (.) 242

Phase Correlation 85

Pitch (Filter shift] 136, 148

Pitch Factor 205

Pitchshift- / Timestretch Mode 247
Pitchshifting/Timestretching 147
Place new beat marker 220

Place new beat position marker 220
Place new tempo marker 220

Play 120

Play Always 226

Play Cursor 241, 243, 246

Play Cut 216

Play Cut - Play from Cut end 202
Play Cut - Play from Cut start 202
Play Cut - Play over Cut 202

Play Cut - Play to Cut end 202
Play cut & Play to Cut start 201
Play In Range 201

Play Loop 201

Play Once 201

Play only selected Objects 201

Play Orig 123

Play Orig. 129

Play original 92

Play With Preload 201

“Play/Rec” Menu 201

Play/Stop 87, 113

Playback 85

Playback Dev 57

Playback Devices 265

Playback Mode — Auto scroll 206
Playback Mode — Autoscroll soft 206
Playback Mode — Change Playback Direction 205
Playback Mode — Loop Mode 205
Playback Mode — O-Tone Mode 205
Playback Options 203, 224 295
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Plottable envelope curves 140

Plug-in Buffer 267

Plug-ins.... 154

Position bar 274

Positioning bar 280

POW-r #1 263

POW-r #2 263

POW-r #3 263

POW-r Dithering 263

Precision 93, 122, 124

Precision Real Time 93

Precision Realtime 122, 124

Predelay 140

Prefix 166

PRELoad 208

Preroll Frames 239

Presets 105, 107, 113, 121

Prevent Clip. 91

Preview 108, 118, 123, 129, 133, 227

Preview Time (Seconds) 270

Program Options 269

Program Preferences 241

Program Preferences — Color Setup 263
Program Preferences - Draw Setup 263

Program Preferences — Edit Keyboard Shortcuts 253
Program Preferences — Enable VIP Tool tips 260
Program Preferences — Font for Time Display 261
Program Preferences > MIDI / Metronome Options 261
Program Preferences — Object Mode 252
Program Preferences - Paths 263

Program Preferences - Reset Toolbars 260
Program Preferences - VIP Mouse Mode 243
Program Preferences - Wave (HDP/RAP) Mouse Mode 251
Project Information 228, 229, 233

Project list 21

Project Name 48

Project Properties 222

Project Properties - Broadcast Wave Extension 231
Project Properties > CD Arrange Mode 233
Project Properties > Media Link 224

Project Properties - Mixer Setup 222

Project Properties - Playback Options 224
Project Properties - Units of Measurement 233
Project Status 229

Punch In 214, 216

Punch In/Out Marker 215

Punch-In/Out On-The-Fly 214
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Punch-In/Out with Markers 214
Punch/Play bar 274
Punch/Playback bar 279

Quality 141, 151
Quick Access 80

R
RAM Wave (RAP) 17

Range 22, 44, 234, 241, 243, 246, 248

Range all 158
Range bar 274, 280
Range Bouncing 188
Range Editor 169

Range end to right Object border 162

Range end to rigjt marker 162
Range Length to 162

Range Manager 169, 190
“Range” Menu 158

Range over aln selected Objects 162

Range start to left marker 162

Range start to left Object border 162
Ranges Mode (Secure Mode] 242

Ratio 107, 108, 112
Ratio/Threshold 104

Read CD/DAT Marker 211
Read Only 229

Real Audio (*.ra) 25
"Real-time Effects” Menu 74
Rebuild Graphic Data 41
Recall last Range 164, 168
Record 207

Record button 213

Record Controller Curves 57
Record Dev. 57

Record Devices 268

Record File 58

Record Format 208

Record Information 213
Record Mode 58, 208
Record Offset 210, 254
Record Options 207, 210, 211
Record Pause 213

Record Start Time/Length 209
Record Time 213
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Record to RAM 58
Recording 235
Recording Device Capabilities Dialog 210
Red 89
Red/Blue alternation 47
Redo 33
Reducing the CPU Load 115
Reduction 127
Reduction display 106
Release 108, 112
Remain. Time 213
Remix Agent 194
Remove All Indices 178
Remove DC Offset 118
Remove Index 177
Remove Link 227
Remove unused Samples 188
Rename Project 20
Replace Objects in actual VIP 187
Replace! 191
Resamp. To 44.1 209
Resample / Timestretching 146
Resampling 146
Resampling Options 212, 264
Reset 87, 91, 106, 107
Reset all Dontshowthismessageagain boxes 271
Reset filter 136
Reset Freehand Drawing 140
Reset Pk 213
Reset Toolbars 252
Resolution 122, 128
Resolution (Number of filter bands) 136
Response time (Release) 136
Restart Play 203
Restore Default 251
Result (dB) 133
Reverb 141, 145
Reverb Color 145
Reverb Properties 145
Reverse 153
Right (lower) fader 89
Right (upper) fader 89
RMS (Root Mean Square] 108
Room Simulation: Tips and Tricks 142
Room Simulator 138
Room Size 145
298 Routing 224
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S

Same file only 191

Same Track only 191
Sample (dB) 137

Sample Data *2 153

Sample Data /2 153

Sample Manipulation 153
Sample Rate 203, 209, 233
Sample Rate/Resolution 210
Sample selection list 137

Samplitude as Live Effect Processor 217

Save complete VIP in 19

Save In Format 22

Save, Load, Delete Setup 85

Save Object 20

Save Projectas 19

Save Project as EDL 19

Save Project as Template 20

Save Projects 19

Save Session 20

Save Setup 118, 124, 129, 133, 146
Save Shortcuts 251

Scale with Fades/Curves 46

Scrub left /right 206

Scrub Mode 247

Scrub Mode / Zoom Mode 249
Scrubbing 204

Scrubbing active 206

Sections 41

Select Curve Mode temporarily 243
Select Object Mode temporarily 243
Select Objects - Select All Objects 69
Select Objects - Select Objects 69
Select Objects - Switch Selection 69
Select previous Object 69

Selecting Objects 241, 244, 245, 246
Separate Stereo 46

Set CD End 177

Set Globals 229

Set Hotspot 69

Set Markers on Silence.... 165

Set parameters 80

Set Pause 176

Set Pause Indices on Object Ends 177
Set Pause Time.... 184

Set PreRoll Time 265
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Set Start Pause Time.... 184
Set Sub Index 176
Set Track 176
Set Track Indices on Object Edges 177
Set Track Indices On Object Edges Options 177
Set Track Indices On Silence 177
Setting markers 152
Settings 92
Settings & Analysis Parameters 93
Settings & Draw Settings 94
Settings — Dynamic Filter Mode 94
Settings — Filter Parameters 93
Settings - Load Setup 95
Settings & Resolution 95
Settings - Save Setup 95
Setup 1, 2and 3 87
SetupABC 87
Shift 66
Show Actual Frames 228
Show CDR Disc Information.... 181
Show CDR Drive Information.... 181
Show Grid 42
Show Menu Items 251
Show Project ToolTips 270
Show Shortcut List 251
Show Video Tracks 227
Signal (output) routing for the master 223
Singing Voice 121
Skins 272, 273
Smooth 128, 130
Smooth Attack 123, 125
Smooth Release 123, 125
Smooth/normal overlapping 137
Smoothed 147
SMPTE 239
SMPTE Generator 190
Snap active 43
Snap and Grid Setup 44
Snap Offset to project start 45, 235
Snap On 44, 234
Snap/Grid 234
Soft Knee 106
Software Monitoring / Software FX Monitoring 218
Solo 113
Solo Mode 85
Songs 121, 124

300 Source files 29
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Source/Destination 55
Source/Destination cut 39
Speaker Model 135

Speaking Voice 121

Spectral Editor - Algorithmix reNOVAtor 131
Split Objects 62

Split Range 163

Split Range for Video 163

Split VIP Objects 166

Start Number 166

Start Windows Explorer 193
Static 90

Static Filter Smooth 123, 125
Statistic (brief] 192

Statistic (verbose) 191

Status bar 275

Stereo 58

Stereo (Base Width) 85

Stereo channel as carrier 137
Stereo Enhancer 83

Stereo Wave > 2 Mono 23

Stop 202, 213

Stop and Go to Current Position 202
Store Marker 164

Store Position and Zoom Level 49
Store Range 163

Store Zoom Level 50

Strip Silence 36

Support 14

Switch Channels 82

Sync Velocity 240
Synchronization 236
Synchronization active 236
Synchronization to Audio playback 226
System — MIDI Options 273
System = Path/Skins 273
System — Program Options 273
System Information.... 277
System/Audio 265

T

Table Of Contents (*.TOC) 17

Take List 192

Take Manager 71

Take Manager... 190

Tape player monitoring 217 301
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Tempo/Taktmarker... 220

Test 166

Test Stereo 123, 128

Threshold 94, 107, 112

Threshold (dB) 166

Tile 274

Time Display 275

Time Offset for Indices on Object Edges 177
Timestretch/Pitchshift Patcher 193

TOOLS bar 278

“Tools” Menu 185

Track 213

Track Bouncing.... 185

Track Delay 144

Track Effects & Track Routing Dialog 55
Track Freeze 59

Track FX 55, 56

Track FX = Aux Sends 56

Track FX = Copy/Paste Track Effects Settings 55
Track FX = Dynamics/Distortion/Delay/Reverb/EQ/ 56
Track FX = Pan/Surround Editor 56

Track FX = Plug-ins 55

Track FX = Reset Track Effects settings 55
Track FX = Track Dynamics/Distortion/Delay/Rev 56
Track FX = Track Routing Dialog 55

Track Information 56, 220

Track information 236

“Track” Menu 53

Track MIDI Record 220

Track Name 58

Track Properties 54

Track Visualization 59

Transparent 47

Transport Control 275

Treat knobs like faders 270

Trim MIDI Objects 219

Trim Objects 63

Tutorial 277

Type 87, 239

V)

Ultra High 1 151
Ultra High 2 151
Undo 32

Undo Definitions 261
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Ungroup Objects 70

Unified normalization 80

Units Of Measurement 43

Units of Measurement 233

Universal Mouse Mode 241

Untile 274

UPC/EAN Code 183

Use Hardware Pitching (Special cards) 240
Use Snap Offset also for Grid 45, 235
Using the Take Manager 192

v

Varipitch 205

Vertical 51

Vertical slider 205

Very High 151

Video Height 252

Video in Sequoia Window 226
"View” Menu 41

View Options 273

VIP Border Scroll 49

VIP Display Mode 45

VIP Mouse Mode 241

Virtual 79

Virtual Action 261
Visualization 275

Visualizer 212

Vocoder 135

Vocoder control elements 136
Volume 87, 135, 137, 234
Volume and Panorama Automation Curves 242, 243, 245, 246
Volume/Objects 244
VST-Instrument Editor 220

w

Wave 25

Wave (HDP/RAP) Mouse Mode 248
Wave Editing 71
Wave(Destructive) 261

Waveform 190

Waveform Colors 47

Waveform Display 46

Waveform Generator 189
Waveform Parameters 190

Wet 145

"Window” Menu 274 303
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Windows Media (*.wma) 25
Workspace bar 274

4

Zero Latency Monitoring (ZLM] 210
Zoom 89, 246
Zoom Mode 248, 249
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